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•

•

•

•

Success in today’s office-based environment is assessed based on the computer literacy 
of an individual. MS Office Tools is considered as a necessary computing skills for being 
employable in the market.

The knowledge of CAAT Tools enable budding professionals to better analyze the data, 
detect fraud/mistakes, recommend steps to ensure better control and efficient functioning 
of business, apart from offering compliance services.

The Overview of Statutory & Tax Compliances is critical for budding accountants to 
understand compliances under various laws.

The practical hands-on Accounting Software during the Articleship helps them in 
recording and managing day-to-day financial transactions of clients in the CA firms.

The revolutionary developments of various IT tools and techniques have a far-reaching impact 
on the organizations. The survival and growth of a dynamic profession such as Chartered 
Accountancy depends largely on adoption of new techniques/methods and equipping the 
students to face the emerging challenges in this globalized competitive business environment. 
The Institute of Chartered Accountants of India has been incessantly making earnest efforts to 
develop a contemporary curriculum for honing  knowledge and skill sets of CA students. 

Keeping in view the changes in the various IT tools and techniques, the Institute has revised its 
syllabus of Information Technology Training under its New Scheme of Education and Training. 
While formulating the syllabus, the focus has been laid primarily on the application software 
relevant for Accounting and Auditing so as to enable CA articles with requisite IT skills beneficial 
to them during their Articleship.

The Board of Studies (Academic) has thoroughly revised its course material prepared in 
accordance with the especially designed curriculum to disseminate quality education to its 
students. We hope that this course material would help the students in building their IT skills 
which is a must for all, in the current scenario. 

PREFACE
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MS WORD

CHAPTER 1
FORMAT TEXT AND PARAGRAPHS

LEARNING OBJECTIVES

a Understand the importance of proper text and paragraph formatting in Microsoft 
Word for creating professional and visually appealing documents.

a Learn how to change font styles, sizes, and apply special effects to text to enhance 
document appearance.

a Familiarize with text alignment options and how to adjust text alignment to left, 
center, or right as needed.

a	 Gain	proficiency	in	adjusting	line	spacing	to	improve	document	readability,	including	
options	for	double-spaEcing.

a Master the technique of indenting text for academic documents, enhancing visual 
structure	and	readability.

a	 Learn	 how	 to	 set	 1-inch	 margins	 on	 all	 sides	 of	 a	 document	 to	 meet	 standard	
academic formatting requirements.

a Acquire the skill of inserting headers and footersto include information at the top and 
bottom	margin	of	 the	document	and	ensure	proper	sequencing	when	combining	
with	page	numbers.

a	 Learn	about	different	types	of	breaks	in	Microsoft	Word,	including	page	breaks	and	
section	breaks,	and	their	respective	applications.

1.1. BASIC FORMATTING

In this module, we will explore the essential techniques and tools to format text and paragraphs 
in Microsoft Word. Proper formatting is crucial for creating professional and visually appealing 
documents. Whether you are working on academic papers, reports, or any other document type, 
understanding text and paragraph formatting will help you present your content effectively. We 
will cover various aspects of formatting, including font styles, alignment, line spacing, indentation, 
margins,	headers,	footers,	and	page	breaks.	By	the	end	of	this	module,	you	will	have	the	skills	to	
enhance the appearance and structure of your documents, making them more organized and 
reader friendly.

For any type of measurements, we can use different scales in our word document. For changing 
the scales following the procedure. 
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Step 1: Click	the	File	menu	tab	and	select	the	feature	“Options”.

Figure 1- Scale Change

Step 2: Click	the	side	tab	“Advanced”	and	scroll	down	to	the	display	category.	Now	here	in	this	
section you can change the scale.

Figure 2-Change the Unit
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1.1.1. TEXT FORMATTING
By	default,	the	font	of	each	new	document	is	set	to	“Calibri”.	We	can	edit	the	text	font	and	size	
at	the	beginning	of	a	new	document	or	by	selecting	the	text	you	want	to	modify.	Use	the	Font	
features to make necessary changes in the document. Like font family, font size or any other type 
of special effects in the text.

Figure 3-Font settings

1.1.2. TEXT ALIGNMENT
By	default,	Word	aligns	text	 to	the	 left	margin	 in	the	new	documents.	However,	 there	may	be	
times when we want to adjust the text alignments to the center or right. For this type of setting 
please	go	to	the	“Paragraph”	group	and	click	the	features	to	make	appropriate	settings.

Figure 3-Text Alignments

1.1.3. LINE SPACING
In	the	same	“Paragraph”	group,	we	can	adjust	the	line	spacing.	To	change	to	the	double-spacing	
option,	select	2	from	the	drop-down	menu.	Or	select	the	“Line	Spacing	Options”.	In	the	“Spacing”	
section	under	the	“Line	Spacing”	select	“double”,	click	“OK”.

Figure 4-Line spacing
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1.1.4. INDENTING TEXT

 Figure 5- First Line Indent

In	many	academic	documents,	we	may	need	to	indent	the	fi	rst	line	of	each	paragraph.	Place	the	
insertion	point	at	the	very	beginning	of	the	paragraph	you	want	to	indent.	Press	the	“Tab”	key	on	
your	keyboard.	On	the	ruler	you	should	see	the	fi	rst	line	indent	marker.

1.1.5. MARGIN

Figure 6- Margins

Most	academic	documents	require	a	1-inch	margin	on	all	sides	of	the	paper.	To	do	this	click	the	
“Layout”	tab.	Select	the	“Margins”	drop-down	arrow.	The	default	setting	is	“Normal”	and	should	
read	one	inch	for	the	top,	bottom,	left	and	right	margins.	

1.1.6. INSERTING A HEADER

Figure 7- Headers
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The	header	is	a	section	in	a	document	that	appears	in	the	top	margin.	To	insert	a	header,	click	
“Insert”	tab.	Then	click	the	“Header”	drop-down	arrow	and	select	what	kind	of	header	you	want	
to	use.	Type	the	information.	When	fi	nished,	close	the	“Header	and	Footer”	for	changes	to	take	
effect. 

Note: If	you	want	to	insert	text	in	the	header	as	well	as	a	page	number,	always	insert	the	page	
number	fi	rst.	Click	the	“Insert”	tab	then	click	the	“Page	Number”	drop-down	arrow.	Choose	the	
location	that	you	want	the	page	number.	To	add	additional	information	in	the	header,	place	the	
cursor	in	front	of	the	page	number,	type	the	information	in	front	of	the	page	number	and	add	a	
space.	Close	the	“Header	and	Footer”	for	changes	to	take	effect.	

1.1.7. INSERTING A FOOTER

Figure 8- First Line Indent

The	footer	is	a	section	of	the	document	that	appears	in	the	bottom	margin.		To	insert	a	footer,	
click	the	“Insert”	tab,	then	click	the	“Footer”	drop-down	arrow	and	select	the	type	of	footer	you	
want	to	use	in	the	document.	Type	the	information,	and	click	close	the	“Header	and	Footer”	when	
fi	nished.	

1.1.8. BREAKS
Breaks	in	the	word	will	help	us	to	split	up	the	document	into	independent	chunks.	There	are	two	
types	of	breaks	that	we	can	add	in	our	word	document.

i.		Page	Break
ii.	Section	Break

Page Break
By	default,	when	you	are	working	away	in	word,	word	automatically	adds	a	page	break	when	
you	get	into	the	end	of	the	page.	However,	you	can	insert	a	manual	page	break	anytime	you	
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want and start a new page in your document. In the document where ever you want a new page 
to	be	inserted,	make	sure	you	have	cursor	clicked	at	that	position.	Click	the	“Layout”	tab	and	go	
for	the	“Break”	option	in	the	“Page-Set	up”	group.	From	that	drop-down	click	“Page”,	in	the	“Page	
Break”	section.

Figure 9- Page Break

Once	you	complete	this	process,	you	will	notice	that	the	text	where	you	placed	the	cursor,	has	
been	shifted	to	a	new	page.	The	shortcut	method	to	add	a	new	page	to	the	document	is	CTRL	+	
ENTER.

In	order	to	view	where	the	page	breaks	have	been	applied	in	the	document,	go	to	the	“Home”	
tab,	click	the	“Show	Hide	Button,	placed	in	the	paragraph	group.	

Figure 10- Show-Hide Button

Figure 11- Page Break

Column Break
This	feature	is	used	mainly	when	you	are	utilizing	columns	in	your	document	and	you	want	to	
place	the	cursor	on	the	other	portion	of	the	column	in	the	document.	Once	the	column	break	
is	 inserted	 in	 the	 document,	 the	 cursor	 can	 be	 placed	 and	 you	 can	 add	 contents	 or	 image	
according to your requirement. 
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Figure 12- Column Break

Section Break
If	you	want	to	apply	different	features	in	different	page,	“Section	Break”	will	help	you	to	do	the	
settings. For example, if you want to change the orientation of any page in a document, from 
Landscape	or	Portrait	or	vice	versa,	you	can	apply	“Continuous”	section	break	at	that	specifi	c	
point in the document. 

Figure 13- Continuous Break
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If	 you	 want	 to	 create	 a	 new	 section	 break,	 and	 it	 should	 be	 defi	ned	 as	 a	 new	 page,	 in	 that	
scenario	click	the	“Next	Page”	in	the	section	breaks	group.

Figure 14- Section Break- Next Page

In this module, we have learned how to format text and paragraphs in Microsoft Word effectively. 
Proper	formatting	is	essential	for	creating	documents	that	are	not	only	visually	appealing	but	
also easy to read and understand. We explored various formatting options, including changing 
font styles, aligning text, adjusting line spacing, indenting text, setting margins, and inserting 
headers	and	footers.	We	also	discussed	the	use	of	page	breaks	and	section	breaks	to	control	the	
layout and structure of our documents.

By	 mastering	 these	 formatting	 techniques,	 you	 can	 create	 professional-looking	 documents	
that	meet	academic,	business,	or	personal	requirements.	Remember	that	consistent	and	well-
organized formatting enhances the overall quality of your work and helps convey your message 
more effectively. We encourage you to practice and apply these formatting skills in your future 
documents to achieve polished and professional results.
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SUMMARY
FORMAT TEXT AND PARAGRAPHS:

 • Understanding text and paragraph formatting is essential for creating visually  
appealing	and	well-organized	documents	in	Microsoft	Word.

	•	 Proper	formatting	enhances	the	readability	and	professionalism	of	your	 
documents, making them more effective in conveying your message.

BASIC FORMATTING:

1. Changing Measurement Scales:

•				Access	by	clicking	on	“File”	>	“Options”	>	“Advanced”	>	Display	Category.

•    Adjust the scale to your preference.

2. Text Formatting:

•    Modify font family, size, and special effects using the Font features.

•				Edit	text	appearance	at	the	start	or	by	selecting	specific	text.

3. Text Alignment:

•			 Adjust	text	alignment	(left,	center,	or	right)	using	options	in	the	“Paragraph”	group.

4. Line Spacing:

•		 Modify	line	spacing	by	selecting	options	from	the	drop-down	menu	or	accessing

				 “Line	Spacing	Options”	under	“Paragraph.”

5. Indenting Text:

•				Indent	the	first	line	of	a	paragraph	using	the	“Tab”	key,	and	adjust	as	needed.

6. Margins:

•			 Set	margins	by	clicking	the	“Layout”	tab	and	selecting	from	the	“Margins”	
				drop-down		menu.

7. Inserting a Header:

•				Access	the	“Insert”	tab,	click	“Header,”	and	choose	a	header	type.	Add	information	 
and close for changes to take effect.

8. Inserting a Footer:

•			Similar	to	inserting	a	header,	select	“Footer”	from	the	“Insert”	tab	to	add	information	 
in	the	bottom	margin.

9. Inserting Breaks:

•		Page	breaks	and	section	breaks	help	organize	the	document	into	independent	

   sections.

10. Page Breaks:

•			Automatically	added	at	the	end	of	a	page,	or	manually	inserted	with	“Layout”	>	“Break”	>	
“Page	Break.”
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•			View	page	breaks	with	the	“Show	Hide	Button”	in	the	“Home”	tab.

11. Column Breaks:

•   Useful in documents with multiple columns. Insert to move cursor to the   
next portion of the column.

12. Section Breaks:
•			Useful	for	applying	different	settings	to	specific	pages.	Apply	“Continuous”	 

section	break	for	varied	orientations.
•						Create	new	section	breaks,	including	new	pages,	by	selecting	“Next	Page”	in	the	 

section	breaks	group.
13. Conclusion: 

•   Mastering text and paragraph formatting in Microsoft Word empowers you to  
create	professional	and	well-structured	documents.

•   Consistent and organized formatting enhances the quality and effectiveness of your 
work, making it more impactful for your audience.

MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the purpose of proper text and paragraph formatting in Microsoft Word?
		 a)	To	enhance	document	security
		 b)	To	create	visually	appealing	and	professional	documents
		 c)	To	improve	document	searchability
		 d)	To	reduce	file	size

2. Which tab in Microsoft Word is used to change the scale of measurements?
		 a)	Home
		 b)	File
  c) Layout
  d) Insert

3.  Which option is used to adjust line spacing in a document?
		 a)	Font	Style
		 b)	Paragraph	Settings
		 c)	Line	Spacing
		 d)	Page	Breaks

4. How can you indent the first line of a paragraph in Microsoft Word?
		 a)	Press	the	spacebar	key
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		 b)	Click	the	“Indent”	button
		 c)	Press	the	Tab	key
		 d)	Use	the	Enter	key

5. What is the default margin setting for most academic documents?
  a) 0.5 inches on all sides
		 b)	1	inch	on	all	sides
  c) 1.5 inches on all sides
  d) 2 inches on all sides

6. Where can you find the option to insert a header in Microsoft Word?
		 a)	Home	tab
		 b)	Insert	tab
		 c)	Layout	tab
		 d)	Header	tab

7. Which type of break is used to start a new page in a document?
		 a)	Section	Break
		 b)	Column	Break
		 c)	Page	Break
		 d)	Line	Break

8. What is the shortcut method to add a new page to a document?
		 a)	CTRL	+	N
		 b)	CTRL	+	P
		 c)	CTRL	+	S
		 d)	CTRL	+	ENTER

9. Which break is used when you want to change the orientation of a specific page 
in a document?
		 a)	Page	Break
		 b)	Column	Break
		 c)	Continuous	Section	Break
		 d)	Next	Page	Section	Break

10. What is the purpose of a footer in a document?
		 a)	To	add	information	at	the	top	margin
		 b)	To	add	information	at	the	bottom	margin
		 c)	To	change	font	styles
		 d)	To	adjust	line	spacing

13



MS WORD

Answers
	 1.				b)	To	create	visually	appealing	and	professional	documents
	 2.			b)	File
	 3.			c)	Line	Spacing
	 4.			c)	Press	the	Tab	key
	 5.			b)	1	inch	on	all	sides
	 6.			b)	Insert	tab
	 7.			c)	Page	Break
	 8.			d)	CTRL	+	ENTER
	 9.			c)	Continuous	Section	Break
	 10.		b)	To	add	information	at	the	bottom	margin

These	 questions	 can	 be	 used	 for	 practice	 and	 self-assessment.	 Students	 can	 check	 their	 
answers against the provided answers to gauge their understanding of the chapter.

SELF-EXAMINATION QUESTIONS FOR PRACTICE:

Remember	to	attempt	these	questions	without	referring	to	the	module	content	 initially.	Use	 it	
only	for	reference	if	you	get	stuck	on	a	particular	question.	This	practice	will	help	reinforce	your	
understanding of text and paragraph formatting in Microsoft Word.

1.		 How	can	you	change	the	measurement	scales	in	a	Word	document?	Explain	the	steps.

2.		What	are	the	Font	features	used	for	in	text	formatting?	Provide	examples	of	Font	features.

3.		How	can	you	align	text	in	a	Word	document?	Describe	the	steps	to	change	text	 
alignment.

4.		Explain	how	to	adjust	line	spacing	in	a	document.	What	are	the	options	available?

5.		How	do	you	indent	the	first	line	of	a	paragraph?	Provide	a	step-by-step	process.

6.		Describe	how	to	set	margins	in	a	Word	document.	What	is	the	default	margin	setting?

7.		What	is	the	purpose	of	inserting	a	header	in	a	document?	Explain	the	steps	to	insert	a	
header.

8.		How	do	you	insert	a	footer	in	a	Word	document?	Provide	a	step-by-step	process.

9.		Differentiate	between	a	page	break	and	a	section	break.	When	would	you	use	each	type?

10.		How	do	you	view	page	breaks	in	a	document?	Explain	the	process	using	the	“Show	Hide		
Button.”

11.		What	is	a	column	break,	and	when	would	you	use	it	in	a	document?

12.			How	can	you	apply	different	settings	to	specific	pages	in	a	document?	Explain	the	use	of			
section	breaks.
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CHAPTER 2
INTRODUCTION TO MACROS

LEARNING OBJECTIVES

a  Understand the concept of macros in Microsoft Word and their role in  
 automating repetitive tasks for Chartered Accountants.

a		 Recognize	the	benefits	of	using	macros,	including	time-saving,	increased	accuracy,		
 improved productivity, and maintaining consistency in documents and reports.

a		 Learn	how	to	record	and	name	macros	and	describe	their	functions	for	 
 future reference.

a		 Acquire	the	skill	of	executing	macros	through	keyboard	shortcuts	for	efficient	task		
 automation.

a		 Familiarize	with	the	process	of	executing	macros	from	the	Macros	Dialog	Box,			
 providing an alternative method for task automation.

a		 Apply	the	knowledge	gained	to	a	practical	scenario	like	formatting	financial	reports		
 using macros.

a		 Gain	proficiency	in	accessing	the	Visual	Basic	for	Applications	(VBA)	Editor	to	edit		
	 and	debug	macros.

a		 Understand	the	structure	of	VBA	code	and	make	necessary	changes	to	recorded		
	 macros	as	per	specific	requirements.

2.1. UNDERSTANDING MACROS

A macro in Microsoft Word is a set of instructions that automate repetitive tasks. It allows 
users	to	record	a	series	of	actions	and	play	them	back	with	a	single	command.	For	Chartered	
Accountants,	 this	means	that	 tasks	 like	 formatting,	data	entry,	and	report	generation	can	be	
automated,	saving	significant	time	and	reducing	the	risk	of	errors.

Purpose and Benefits of Macros:
• Time-saving: Macros can complete tasks in a fraction of the time it would take a human, 

especially for tasks that involve multiple steps or large datasets.
• Accuracy: Humans	are	prone	to	making	mistakes,	especially	when	performing	repetitive	

tasks. Macros execute commands consistently and without error.
• Increased Productivity: By	automating	routine	tasks,	Chartered	Accountants	can	free	up	
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time	to	focus	on	more	critical,	value-added	activities	such	as	analysis,	strategy,	and	client	
interactions.

• Consistency: Macros ensure that documents and reports follow a standardized format. 
This	is	crucial	in	maintaining	a	professional	image	and	adhering	to	industry	standards.

2.2. RECORDING AND RUNNING MACROS

RECORDING A MACRO:
1. Opening the Macros Dialog Box:

	•		Navigate	to	the	“View”	tab	in	the	ribbon.
	•		Select	“Macros”	from	the	dropdown	menu.
	•		Click	“Record	Macro.”

Figure: Macros menu in View tab

2. Naming and Describing the Macro:

Figure: Naming and Describing the Macro

 •   Provide a descriptive name for the macro.
	•			Optionally,	add	a	description	for	future	reference.
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3. Performing Actions to Record:
•	 Carry	out	the	series	of	tasks	you	want	to	automate.	Every	action	will	be	recorded.

RUNNING A MACRO:
1.  Executing a Macro with a Keyboard Shortcut:

	•	 Assign	a	keyboard	shortcut	during	the	recording	process.
 • Press the assigned keys to execute the macro.

Figure: Assignment of Keyboard shortcut to Macro

Ctrl+H	is	assigned	to	“FormatReport”	macro.	So,	Ctrl+H	can	be	used	to	perform	the	formatting	
of headings instead of pressing Macros View Macros Choose the appropriate Macro each 
time.

2. Executing a Macro from the Macros Dialog Box:
	•	 Navigate	to	the	“View”	tab	and	select	“Macros.”
	•	 Choose	the	desired	macro	from	the	list	and	click	“Run.”

Scenario: Imagine	 a	 Chartered	 Accountant	 frequently	 needs	 to	 format	 fi	nancial	 reports	 by	
applying	 specifi	c	 styles,	 fonts,	 and	 alignments.	 This	 process	 can	 be	 time-consuming	 and	
repetitive. A macro can automate this task.
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RECORDING THE MACRO:
1. Open Microsoft Word:

 • Launch Microsoft Word and open the document you want to format.
2. Start Recording:

	•	 Navigate	to	the	“View”	tab	on	the	ribbon.
	•	 Select	“Macros”	from	the	dropdown	menu.
	•	 In	the	“Macro	name”	box,	type	a	name	like	“FormatReport”	and	click	“Create.”

3.  Perform Formatting Actions:
 • Format the document as desired. For example, change font, adjust font size, set   

alignment,	add	borders,	etc.	These	actions	will	be	recorded.

4. Stop Recording:
	•	 Once	you’ve	applied	the	desired	formatting,	go	back	to	the	“Macros”	dialog	box.
	•	 Click	“Stop	Recording.”

 Note: The	name	assigned	to	Macro	should	not	contain	space.

RUNNING THE MACRO:

1. Executing the Macro with a Keyboard Shortcut:

	•	 During	the	recording	process,	you	can	assign	a	keyboard	shortcut.	Let’s	say	you	 
assigned	Ctrl	+	Shift	+	F	to	this	macro.

	•	 Open	a	new	document	or	any	other	report	that	needs	formatting.
	•	 Press	Ctrl	+	Shift	+	F.	The	macro	will	automatically	apply	the	formatting.

2. Executing the Macro from the Macros Dialog Box:

•	 Navigate	to	the	“View”	tab	and	select	“Macros.”
•	 Choose	“Format	Report”	from	the	list	of	macros	and	click	“Run.”

The	macro	will	now	apply	the	same	formatting	actions	to	the	active	document.

Benefits:	By	using	this	macro,	CA	professionals	can	save	time	and	ensure	consistency	in	report	
formatting. Instead of manually applying the formatting each time, they can do it with a simple 
keyboard	shortcut	or	by	selecting	the	macro	from	the	Macros	dialog	box.

Note: Remember	 to	 save	 your	 macros	 in	 a	 trusted	 location	 and	 be	 cautious	 when	 running	
macros	from	unknown	sources	to	prevent	security	risks.	Always	review	the	code	if	you’re	unsure	
about	its	origin.
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2.3. EDITING AND DEBUGGING MACROS

Accessing the Visual Basic for Applications (VBA) Editor:

	 1.				Press	Alt	+	F11	to	open	the	VBA	Editor.

Figure: VBA Editor window

Understanding VBA Code:
•	 The	VBA	Editor	displays	the	recorded	macro	as	a	series	of	commands	in	the	VBA	

programming language.

Making Changes to Recorded Macros:
•	 In	the	VBA	Editor,	locate	the	macro	and	make	necessary	changes	to	the	code.

Debugging Macros for Errors:
	•	 Identify	and	correct	errors	in	the	VBA	code	to	ensure	the	macro	functions	correctly.

This	chapter	provides	a	comprehensive	introduction	to	macros,	covering	it’sdefi	nition,	purpose,	
and	benefi	ts.	Additionally,	it	outlines	the	process	of	recording,	running,	editing,	and	debugging	
macros, which are essential skills for automation for a CA. 
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SUMMARY

INTRODUCTION TO MACROS

UNDERSTANDING MACROS:
•	 Macros	automate	repetitive	tasks	in	Microsoft	Word,	allowing	for	the	recording	and	playback	

of a series of instructions.
• For Chartered Accountants, macros streamline tasks like formatting, data entry, and report 

generation, saving time and reducing errors.

PURPOSE AND BENEFITS OF MACROS:
• Time-saving: Macros complete tasks quickly, especially those involving multiple steps or 

large datasets.
• Accuracy: Macros execute commands consistently, minimizing human error.
• Increased Productivity: Automating routine tasks frees up time for more critical activities.
• Consistency: Macros ensure standardized document formatting, maintaining a professional 

image.

RECORDING AND RUNNING MACROS:
Recording a Macro:
	 1.			Open	Macros	Dialog	Box	from	“View”	tab.
 2.   Provide a name and optional description for the macro.
 3.   Perform actions to record.

Running a Macro:
	 1.			Execute	with	a	keyboard	shortcut	or	from	the	Macros	Dialog	Box.
	 2.			Keyboard	shortcuts	can	be	assigned	during	recording	for	quick	execution.

Scenario Example:
•	 A	Chartered	Accountant	can	use	a	macro	named	“FormatReport”	to	automate	the	formatting	

of	financial	reports,	saving	time	and	ensuring	consistency.

EDITING AND DEBUGGING MACROS:
•	 Access	the	Visual	Basic	for	Applications	(VBA)	Editor	with	Alt	+	F11.
•	 VBA	Editor	displays	the	recorded	macro	as	a	series	of	commands	in	VBA	language.
•	 Make	changes	to	recorded	macros	in	the	VBA	Editor.
•	 Debug	macros	for	errors	to	ensure	correct	functionality.

Conclusion:
• Macros are powerful tools for automating tasks in Microsoft Word, providing Chartered 
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	 	 Accountants	with	the	ability	to	save	time,	enhance	accuracy,	 increase	productivity,	and	

maintain	consistency	in	their	work.	By	understanding	how	to	record,	run,	edit,	and	debug	
macros,	CA	professionals	can	leverage	this	functionality	to	streamline	their	workflow	and	
improve	overall	efficiency.

MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is a macro in Microsoft Word?
  a) A type of font style
		 b)	A	set	of	instructions	that	automate	repetitive	tasks
		 c)	A	type	of	page	break
  d) A formatting tool

2. What is one of the benefits of using macros for Chartered Accountants?
		 a)	Reducing	font	size	in	documents
		 b)	Automating	repetitive	tasks	and	saving	time
		 c)	Inserting	unnecessary	page	breaks
  d) Changing the color of text

3. How does a macro contribute to increased productivity for Chartered Accountants?
		 a)	By	slowing	down	document	processing
		 b)	By	automating	routine	tasks,	freeing	up	time	for	critical	activities
		 c)	By	creating	visual	appeal	in	documents
		 d)	By	converting	files	into	PDF	format

4. Which of the following is not a purpose of macros?
		 a)	Time-saving
		 b)	Accuracy	in	executing	commands
		 c)	Enhancing	document	security
  d) Maintaining consistent formatting

5. What is the shortcut key to open the Visual Basic for Applications (VBA) Editor?
		 a)	Ctrl	+	V
		 b)	Alt	+	F11
		 c)	Ctrl	+	B
		 d)	Alt	+	VBA
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6. What is the function of assigning a keyboard shortcut to a macro during recording?
		 a)	It	allows	the	macro	to	be	executed	using	voice	commands.
		 b)	It	provides	an	alternative	method	to	run	the	macro.
  c) It changes the font style in the document.
  d) It adjusts line spacing in the document.

7. In the context of macros, what does VBA stand for?
		 a)	Visual	Basic	Application
		 b)	Visual	Business	Automation
		 c)	Visual	Basic	for	Applications
		 d)	Visual	Basic	Algorithm

8. What is the purpose of editing a recorded macro in the VBA Editor?
		 a)	To	correct	spelling	mistakes	in	the	macro	name
		 b)	To	make	necessary	changes	to	the	code	for	specific	requirements
		 c)	To	change	the	font	size	of	the	document
		 d)	To	add	more	steps	to	the	recorded	actions

9. How can a macro be executed using a keyboard shortcut?
		 a)	By	pressing	Ctrl	+	Shift	+	M
		 b)	By	pressing	Alt	+	F11
		 c)	By	pressing	the	assigned	keys	during	recording
		 d)	By	pressing	Alt	+	F12

10. What precaution should be taken when running macros from unknown sources?
  a) Always run macros without reviewing the code.
		 b)	Save	the	macros	in	a	trusted	location.
		 c)	Disable	macros	completely.
		 d)	Share	macros	with	colleagues	without	verification.

Answers
	1.	 b)	A	set	of	instructions	that	automate	repetitive	tasks
	2.	 b)	Automating	repetitive	tasks	and	saving	time
	3.	 b)	By	automating	routine	tasks,	freeing	up	time	for	critical	activities
	4.	 c)	Enhancing	document	security
	5.	 b)	Alt	+	F11
	6.	 b)	It	provides	an	alternative	method	to	run	the	macro.
	7.	 c)	Visual	Basic	for	Applications
	8.	 b)	To	make	necessary	changes	to	the	code	for	specific	requirements
	9.	 c)	By	pressing	the	assigned	keys	during	recording
	10.	b)	Save	the	macros	in	a	trusted	location.
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SELF-EXAMINATION QUESTIONS FOR PRACTICE

Remember	to	attempt	these	questions	without	referring	to	the	module	content	 initially.	Use	 it	
only	for	reference	if	you	get	stuck	on	a	particular	question.	This	practice	will	help	reinforce	your	
understanding of macros in Microsoft Word.

	1.	 What	is	a	macro	in	Microsoft	Word,	and	how	does	it	benefit	Chartered	Accountantsin	
their	work?

	2.	 Name	three	key	benefits	of	using	macros	for	Chartered	Accountants.

	3.	 Explain	the	process	of	recording	a	macro	in	Microsoft	Word.

	4.	 How	can	you	run	a	recorded	macro	using	a	keyboard	shortcut?

	5.	 Describe	the	steps	to	run	a	macro	from	the	Macros	Dialog	Box.

 6. Provide an example scenario of how a Chartered Accountant could use a macro  
to automate a task.

	7.	 How	can	you	access	the	Visual	Basic	for	Applications	(VBA)	Editor	in	Microsoft	 
Word?

	8.	 What	does	the	VBA	Editor	display,	and	why	is	it	important	for	working	with	macros?

	9.	 How	can	you	make	changes	to	a	recorded	macro	in	the	VBA	Editor?

	10.	What	is	the	purpose	of	debugging	macros,	and	how	can	you	identify	and	correct	 
errors	in	VBA	code?
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CHAPTER 3
MAIL MERGE FUNDAMENTALS

LEARNING OBJECTIVES

a		 Understand	the	concept	of	Mail	Merge	and	its	significance	for	Chartered	 
	 Accountants	in	generating	personalized	documents	efficiently.

a		 Recognize	the	benefits	of	using	Mail	Merge,	including	personalization,	efficiency,	 
 and consistency in document creation.

a		 Learn	the	step-by-step	process	of	setting	up	a	Mail	Merge	in	Microsoft	Word,	 
 including selecting the document type and initiating the Mail Merge Wizard.

a		 Acquire	the	skill	of	selecting	recipients	for	the	Mail	Merge	by	choosing	an	existing	 
 data source, typing a new list.

a		 Familiarize	with	the	process	of	inserting	merge	fields	as	placeholders	for	 
 personalized information from the data source.

a		 Learn	how	to	preview	the	merged	documents	to	ensure	accuracy	before	finalizing	 
 the Mail Merge process.

a		 Understand	the	final	steps	of	completing	the	Mail	Merge,	including	options	for	 
 printing or saving the merged documents.

By	mastering	the	concepts	and	techniques	outlined	in	this	chapter,	Chartered	Accountants	will	
be	equipped	to	efficiently	utilize	Mail	Merge	for	generating	personalized	documents,	saving	time,	
and ensuring consistency in their professional communications.

3.1. WHAT IS MAIL MERGE?
Mail	Merge	is	a	feature	in	Microsoft	Word	that	enables	the	creation	of	personalized	documents,	
such	as	letters,	envelopes,	or	labels,	using	a	template	and	a	data	source.	It	allows	for	the	automatic	
insertion of information from a dataset into placeholders in the document, streamlining the 
process of generating mass communications.

Key Benefits of Mail Merge
• Personalization: Each	document	can	be	customized	with	individualized	information	from	

the	dataset,	such	as	names,	addresses,	or	account	numbers.
• Efficiency: Saves	time	and	effort	compared	to	manually	entering	information	for	each	

document.
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• Consistency: Ensures	uniformity	in	formatting	and	content	across	all	generated	
documents.

3.2. SETTING UP A MAIL MERGE

Setting	up	a	Mail	Merge	involves	several	steps	to	defi	ne	the	document	type,	select	a	data	source,	
and	insert	merge	fi	elds.

STEPS TO SET UP A MAIL MERGE:

1. Open Microsoft Word:

  •   Launch Microsoft Word and open a new or existing document.

2. Navigate to the “Mailings” Tab:

		 •		Click	on	the	“Mailings”	tab	in	the	ribbon	at	the	top	of	the	Word	window.

3. Select the Document Type:

		 •		Choose	the	type	of	document	you	want	to	create	(e.g.,	letters,	envelopes,	labels).

4. Start Mail Merge Wizard:

		 •		Click	“Start	Mail	Merge”	to	initiate	the	Mail	Merge	process.	

Choose	 the	 type	 of	 document	 that	 you	 want	 to	 create	 and	 you	 may	 click	 on	 “Step-by-step	
Mail	Merge	Wizard”	to	get	 	step	by	step	 instructions	of	Mail	Merge.Or	else	you	may	follow	the	
steps	 	given	 in	 the	 following	sub-headings	below:	selecting	 recipients,	 inserting	merge	fi	elds,	
previewing and completing mail merge.

Figure: Start Mail Merge Wizardin Mailings Tab
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Figure: Step-by-step Mail Merge Wizard

3.3. SELECTING RECEPIENTS
Selecting	a	data	source	of	recipients	is	a	critical	step	in	Mail	Merge	as	it	provides	the	information	
that	will	be	inserted	into	the	document.

Figure: Options available to choose recipients of Mail merge
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OPTIONS FOR DATA SOURCE:

 1.  Use an Existing List:
			 	•	Utilize	an	existing	Excel	spreadsheet,	Access	database,	or	other	data	fi	le.
 2.  Type a New List:
   • Manually enter the data directly into Word, useful for small datasets.

Figure: Window to add a list of recipients

3.  Choose from Outlook Contacts:
			 •		Access	contact	information	from	your	Outlook	address	book.
 4.  Select Recipients:
		 •		Once	the	data	source	is	chosen,	you	can	refi	ne	the	selection	to	include	specifi	c	

entries from the dataset.

3.4. INSERTING MERGE FIELDS
Merge	fi	elds	are	placeholders	in	the	document	where	personalized	information	from	the	data	
source	will	be	inserted.

STEPS TO INSERT MERGE FIELDS:

 1.   Position the Cursor:
		 •	Place	the	cursor	where	you	want	to	insert	the	merge	fi	eld.
 2.  Click “Insert Merge Field”:
						•	 In	the	“Mailings”	tab,	click	“Insert	Merge	Field”	and	select	the	fi	eld	from	the	

  dropdown list.
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Figure: Insert Merge Field menu and the fi elds available to insert

3. Repeat for Additional Fields:
					•	 Insert	all	the	necessary	merge	fi	elds	for	the	information	you	want	to	include.

3.5. PREVIEWING AND COMPLETING MAIL MERGE
After	inserting	merge	fi	elds,	it’s	crucial	to	preview	the	merged	documents	to	ensure	accuracy	
before	fi	nalizing	the	process.

PREVIEWING THE MAIL MERGE:
1.   Navigate to “Finish & Merge”:
						•	 In	the	“Mailings”	tab,	click	“Finish	&	Merge.”

Figure: Finish & merge menu

2.  Select “Edit Individual Documents”:
						•		This	option	allows	you	to	preview	the	merged	documents	before	printing	or	saving.
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Figure: Edit Individual documents option
3.  Review the Merged Documents:
		 •			Scroll	through	the	documents	to	verify	that	the	information	is	correctly	inserted.

COMPLETING THE MAIL MERGE:
 1.   Finalize and Print:
	•			Once	you’re	satisfi	ed	with	the	preview,	you	can	choose	to	print	the	documents	or	

save	them	as	separate	fi	les.

This	 chapter	 provides	 a	 comprehensive	 overview	 of	 Mail	 Merge	 fundamentals,	 including	 its	
defi	nition,	 setup	 process,	 data	 source	 selection,	 merge	 fi	eld	 insertion,	 and	 the	 fi	nal	 steps	 of	
previewing and completing the Mail Merge. 

      SUMMARY

 MAIL MERGE FUNDAMENTALS

• Mail Merge is a powerful tool in Microsoft Word for generating personalized documents 
effi	ciently.	Chartered	Accountants	can	use	it	to	automate	the	creation	of	multiple	
documents with individualized information.

What is Mail Merge:
• Mail Merge is a feature in Microsoft Word that automates the creation of personalized 

documents	like	letters,	envelopes,	or	labels	using	a	template	and	a	data	source.
• It allows for the automatic insertion of information from a dataset into placeholders in the 

document.

Key Benefi ts of Mail Merge:
• Personalization: Each	document	can	be	customized	with	individualized	information	from	

the dataset.
• Effi ciency:	Saves	time	and	effort	compared	to	manual	data	entry	for	each	document.
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• Consistency: Ensures	uniformity	in	formatting	and	content	across	all	generated	
documents.

Setting Up a Mail Merge:
•	 Open	Microsoft	Word	and	navigate	to	the	“Mailings”	Tab.
• Choose the document type and start the Mail Merge Wizard.

Selecting Recipients:
•	 Selecting	a	data	source	is	crucial.	Options	include	using	an	existing	list,	typing	a	new	list,	

choosing	from	Outlook	Contacts,	or	refining	the	selection.

Inserting Merge Fields:
•	 Merge	fields	are	placeholders	where	personalized	information	will	be	inserted.	They	are	

added	using	the	“Insert	Merge	Field”	option.

Previewing and Completing Mail Merge:
•	 After	inserting	merge	fields,	it’s	important	to	preview	the	merged	documents	for	

accuracy.
•	 Navigate	to	“Finish	&	Merge”	and	select	“Edit	Individual	Documents”	to	review	the	merged	

documents.
•	 Finalize	the	Mail	Merge	by	choosing	to	print	the	documents	or	save	them	as	separate	files.

This	chapter	provides	a	comprehensive	overview	of	Mail	Merge	fundamentals,	covering	its	
definition,	setup	process,	data	source	selection,	merge	field	insertion,	and	the	final	steps	of	
previewing and completing the Mail Merge.

MULTIPLE CHOICE QUESTIONS (MCQS) 

1.What is the purpose of Mail Merge in Microsoft Word?

  a) Formatting text and paragraphs
		 b)	Creating	personalized	documents	with	a	template	and	data	source
  c) Inserting headers and footers
		 d)	Sorting	and	filtering	data

2.What is one of the key benefits of using Mail Merge for Chartered Accountants?
  a) Adjusting line spacing in documents
		 b)	Saving	time	and	effort	in	generating	personalized	documents
  c) Changing font styles for emphasis
		 d)	Applying	page	breaks	for	document	organization

30



MS WORD

3.Which step initiates the Mail Merge process in Microsoft Word?
		 a)	Selecting	Recipients
		 b)	Inserting	Merge	Fields
		 c)	Starting	the	Mail	Merge	Wizard
		 d)	Previewing	Merged	Documents

4.What does selecting a data source of recipients involve in Mail Merge?
  a) Choosing the font style for the document
		 b)	Providing	the	information	that	will	be	inserted	into	the	document
		 c)	Selecting	the	type	of	document	to	create
		 d)	Determining	the	document’s	page	orientation

5.What is a merge field in Mail Merge?
  a) A placeholder for personalized information from the data source
		 b)	A	feature	to	change	font	colors	in	the	document
		 c)	A	tool	for	inserting	page	numbers
  d) A function to apply line spacing in the document

6.What does the “Edit Individual Documents” option allow you to do in Mail Merge?
  a) Customize font styles for individual documents
		 b)	Preview	the	merged	documents	before	finalizing	the	process
  c) Add new recipients to the data source
		 d)	Insert	additional	merge	fields

7.Which option in the Mailings tab initiates the Mail Merge process in Microsoft Word?
		 a)	Select	Recipients
		 b)	Insert	Merge	Field
		 c)	Start	Mail	Merge
		 d)	Finish	&	Merge

8.What is the final step in completing the Mail Merge process after previewing the merged 
documents?

		 a)	Inserting	additional	merge	fields
		 b)	Printing	the	documents	or	saving	them	as	separate	files
		 c)	Editing	individual	documents
		 d)	Applying	page	breaks

9.What is the primary purpose of personalization in Mail Merge?
  a) Changing font styles for emphasis
		 b)	Inserting	page	numbers	in	the	document
  c) Customizing documents with individualized information
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		 d)	Adjusting	line	spacing	for	readability

10. Which option allows you to utilize an existing Excel spreadsheet or data file as a data 
source in Mail Merge?

		 a)	Use	an	Existing	List
		 b)	Type	a	New	List
		 c)	Choose	from	Outlook	Contacts
		 d)	Select	Recipients

Answers
	1.	 b)	Creating	personalized	documents	with	a	template	and	data	source

	2.	 b)	Saving	time	and	effort	in	generating	personalized	documents

	3.	 c)	Starting	the	Mail	Merge	Wizard

	4.	 b)	Providing	the	information	that	will	be	inserted	into	the	document

 5. a) A placeholder for personalized information from the data source

	6.	 b)	Preview	the	merged	documents	before	finalizing	the	process

	7.	 c)	Start	Mail	Merge

	8.	 b)	Printing	the	documents	or	saving	them	as	separate	files

 9. c) Customizing documents with individualized information

	10.	a)	Use	an	Existing	List

SELF-EXAMINATION QUESTIONS FOR PRACTICE

Remember	to	attempt	these	questions	without	referring	to	the	module	content	 initially.	Use	 it	
only	for	reference	if	you	get	stuck	on	a	particular	question.	This	practice	will	help	reinforce	your	
understanding of Mail Merge fundamentals.

1.	 What	is	Mail	Merge,	and	how	does	it	benefit	Chartered	Accountants	in	their	work?

2.	 List	three	key	benefits	of	using	Mail	Merge	for	generating	documents.

3.	 Describe	the	steps	involved	in	setting	up	a	Mail	Merge	in	Microsoft	Word.

4.	 What	are	the	options	available	for	selecting	recipients	in	Mail	Merge,	and	when	would	you	

32



MS WORD

use	each	option?

5.	 How	do	you	insert	merge	fields	into	a	document	during	the	Mail	Merge	process?

6.	 Why	is	it	important	to	preview	the	merged	documents	before	finalizing	a	Mail	Merge?

7.	 Explain	the	process	of	previewing	merged	documents	in	Mail	Merge.

8.	 What	are	the	final	steps	to	complete	a	Mail	Merge	after	previewing	the	merged	docu-
ments?

9.	 Can	you	briefly	outline	the	process	of	using	an	existing	list	as	a	data	source	for	Mail	
Merge?

10. When might a Chartered Accountant choose to manually type a new list as a data 
source	for	Mail	Merge?
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CHAPTER 4
PROJECTS WITH MAIL MERGE

As	discussed	in	the	previous	chapter,	Mail	Merge	is	a	feature	in	Microsoft	Word	that	enables	the	
creation	of	personalized	documents,	such	as	letters,	envelopes,	or	labels,	using	a	template	and	a	
data source. It allows for the automatic insertion of information from a dataset into placeholders 
in the document, streamlining the process of generating mass communications.

LEARNING OBJECTIVES

a  Understand the practical applications of Mail Merge in Chartered Accountancy.

a		 Learn	to	create	Standard	Confirmation	Letters	using	Mail	Merge.

a		 Gain	proficiency	in	generating	Audit	Engagement	Letters	through	Mail	Merge		 	 	
 automation.

a		 Master	the	process	of	creating	Management	Representation	Letters	(MRLs)	using	

   Mail Merge.

a		 Acquire	the	skills	to	automate	the	generation	of	Board	Minutes	with	Mail	Merge.

a		 Learn	to	efficiently	create	Audit	Reports	using	Mail	Merge	for	consistency	and	 
	 time-saving.

 
These	 objectives	 cover	 the	 key	 skills	 and	 knowledge	 that	 Chartered	 Accountants	 need	 to	
effectively	utilize	Mail	 Merge	 for	 various	professional	 tasks.	 This	 chapter	delves	 into	practical	
projects	 that	Chartered	Accountants	commonly	encounter	 in	 their	day-to-day	work,	utilizing	
Mail Merge to automate the generation of documents.

4.1. STANDARD CONFIRMATION LETTERS
Project	 Overview:	 Standard	 Confirmation	 Letters	 are	 essential	 documents	 in	 the	 auditing	
process.	 They	are	 sent	 to	 third	parties	 to	confirm	specific	details,	 such	as	account	balances	
or agreements. Utilizing Mail Merge streamlines the process of generating and sending these 
letters.

Steps to Create Standard Confirmation Letters:
1.  Set Up Data Source:
  • Prepare a dataset with the necessary information, including recipient names,    

addresses,	and	confirmation	details.
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Figure: Window to add a list of recipients

2. Design the Confi rmation Letter Template:
		 •	Create	a	Word	document	with	placeholders	for	recipient	details	and	confi	rmation	infor	

mation.
3. Insert Merge Fields:
		 •		Place	merge	fi	elds	in	the	template	to	dynamically	insert	recipient-specifi	c	data.

Figure: Insert Merge Field menu and the fi elds available to insert
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4. Initiate Mail Merge:
 • Use the Mail Merge Wizard to link the template with the data source.

Figure: Start Mail Merge Wizardin Mailings Tab

Figure: Step bystep Mail Merge Wizard
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5. Preview and Verify:
	•	Review	merged	letters	to	ensure	accuracy.

6. Complete the Mail Merge:
	•		Print	or	save	the	confirmation	letters	for	distribution.

 
Below	is	a	template	for	a	Standard	Confirmation	Letter	with	placeholders	for	recipient	details	
and	confirmation	information:

[Your	Name]
[Your	Title]
[Your	Company	Name]
[Address	Line	1]
[Address	Line	2]
[City,	State,	ZIP	Code]
[Date]

[Recipient	Name]
[Recipient	Title]
[Recipient	Company	Name]
[Recipient	Address	Line	1]
[Recipient	Address	Line	2]
[Recipient	City,	State,	ZIP	Code]
Dear	[Recipient	Name],

Subject: Confirmation	of	[Details	to	be	Confirmed]

I	hope	this	letter	finds	you	well.	We	are	writing	to	formally	confirm	[details	to	be	confirmed,	e.g.,	
account	balances,	agreements,	etc.]	in	accordance	with	our	ongoing	[nature	of	relationship	or	
engagement].

The specifics of the confirmation are as follows:

[Provide	detailed	information	that	needs	confirmation.	You	may	include	specific	figures,	terms,	
or	any	other	relevant	details.]

Please	review	the	provided	information	and	confirm	its	accuracy	at	your	earliest	convenience.	
If	 there	are	any	discrepancies	or	 if	 you	 require	 further	clarification,	please	do	not	hesitate	 to	
contact us.

Your prompt attention to this matter is greatly appreciated. We value our continued partnership 
and	look	forward	to	your	confirmation.
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Thank you for your cooperation.
Sincerely,
[Your Name]
[Your Title]
[Your Company Name]
[Contact Information]
 
Note:	Replace	the	placeholders	enclosed	in	square	brackets	with	actual	details	before	sending	
the	letter.	This	template	provides	a	structure	for	a	Standard	Confirmation	Letter,	and	you	should	
customize	it	according	to	the	specific	details	of	your	confirmation.

4.2. AUDIT ENGAGEMENT LETTERS
Project Overview:	Audit	Engagement	Letters	are	crucial	 for	establishing	the	terms	and	scope	
of an audit engagement. Automating the creation of these letters with Mail Merge enhances 
efficiency	and	ensures	consistency.

Steps to Create Audit Engagement Letters:

1. Define Engagement Terms:

		 •		Clearly	outline	the	scope,	objectives,	and	responsibilities	of	the	audit	engagement.

2. Design the Engagement Letter Template:

		 •			Create	a	template	with	placeholders	for	client	and	engagement-specific	information.

3. Insert Merge Fields:

		 •		Incorporate	merge	fields	for	client	name,	engagement	dates,	and	other	relevant	details.

4. Link Template with Data Source:

  •  Use Mail Merge to connect the template with the dataset.

5. Preview and Verify:

		 •			Review	merged	letters	to	confirm	accuracy	of	information.

6. Finalize and Distribute:

  • Print or save the engagement letters for client review and signature.

Below	is	a	template	for	an	Audit	Engagement	Letter	with	placeholders	for	client	and	engagement-
specific	information:

[Your	Name]
[Your	Title]
[Your	Company	Name]
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[Address	Line	1]
[Address	Line	2]
[City,	State,	ZIP	Code]
[Date]
[Client	Name]
[Client	Title]
[Client	Company	Name]
[Client	Address	Line	1]
[Client	Address	Line	2]
[Client	City,	State,	ZIP	Code]

Subject: Engagement	Letter	for	Audit	Services
Dear	[Client	Name],
We	are	pleased	to	confirm	our	engagement	with	[Client	Company	Name]	(“Client”)	to	perform	
an	audit	of	the	financial	statements	for	the	year	ending	[Year].

Scope of Services:
Our	 audit	 will	 be	 conducted	 in	 accordance	 with	 [Applicable	 Audit	 Standards,	 e.g.,	 Generally	
Accepted	Auditing	Standards	(GAAS)].	The	objective	of	the	audit	is	to	express	an	opinion	on	the	
fairness	of	the	financial	statements.

Responsibilities:
• The	management	of	the	Client	is	responsible	for	the	preparation	and	fair	presentation	of	

the	financial	statements.
• Our	responsibility	is	to	express	an	opinion	on	the	financial	statements	based	on	our	audit.

Timing and Reporting:
We	 will	 commence	 the	 audit	 on	 [Start	 Date]	 and	 plan	 to	 complete	 it	 by	 [End	 Date].	 Upon	
completion, we will issue our audit report.

Fee Arrangements:
Our	fees	for	these	services	will	be	[Specify	Fee	Structure,	e.g.,	hourly	rates	or	fixed	fee].	An	estimate	
of	the	total	fee	is	[Amount].	Invoices	will	be	issued	[Specify	Billing	Frequency,	e.g.,	monthly].

Engagement Contact:
For	the	purpose	of	this	engagement,	[Your	Name]	will	be	your	primary	contact.	You	can	reach	
[him/her]	at	[Contact	Information].

Please sign and return a copy of this letter to indicate your agreement with the terms and scope 
of	 our	 engagement.	 If	 you	 have	 any	 questions	 or	 require	 further	 clarification,	 please	 do	 not	
hesitate to contact us.
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Thank	you	for	entrusting	us	with	this	important	engagement.	We	look	forward	to	working	together.

Sincerely,
[Your	Name]
[Your	Title]
[Your	Company	Name]
[Contact	Information]

Note: Replace	the	placeholders	enclosed	in	square	brackets	with	actual	details	before	sending	
the	 letter.	This	template	provides	a	structure	for	an	Audit	Engagement	Letter,	and	you	should	
customize	it	according	to	the	specific	details	of	your	engagement.

4.3. MANAGEMENT REPRESENTATION LETTERS (MRLS)
Project Overview: Management	Representation	Letters	are	essential	documents	 that	 request	
confirmation	 from	 management	 regarding	 the	 accuracy	 and	 completeness	 of	 information	
provided	 during	 an	 audit.	 Automating	 the	 generation	 of	 MRLs	 using	 Mail	 Merge	 enhances	
efficiency.

Steps to Create Management Representation Letters:

1. Prepare Requested Information:

		 •	Identify	the	specific	details	and	assertions	that	need	to	be	confirmed	by	management.

2. Design the MRL Template:

  •  Create a template with placeholders for management and engagement details.

3. Insert Merge Fields:

		 •		Add	merge	fields	to	dynamically	insert	recipient-specific	data.

4. Connect Template with Data Source:

  •  Use Mail Merge to link the template with the dataset.

5. Preview and Confirm:

		 •		Review	merged	letters	to	ensure	accuracy	of	information.

6. Complete the Mail Merge:

		 •		Print	or	save	the	MRLs	for	distribution	and	collection	of	management	signatures.

Below	 is	 a	 template	 for	 a	 Management	 Representation	 Letter	 (MRL)	 with	 placeholders	 for	
management	and	engagement	details:

[Your	Name]

40



MS WORD

[Your	Title]
[Your	Company	Name]
[Address	Line	1]
[Address	Line	2]
[City,	State,	ZIP	Code]
[Date]

[Client	Name]
[Client	Title]
[Client	Company	Name]
[Client	Address	Line	1]
[Client	Address	Line	2]
[Client	City,	State,	ZIP	Code]

Subject: Management	Representation	Letter

Dear	[Client	Name],

We	are	in	the	process	of	conducting	our	audit	of	the	financial	statements	of	[Client	Company	
Name]	(“Client”)	 for	the	year	ending	[Year].	As	part	of	our	audit,	we	request	management	to	
provide certain representations.

Management Representations:

1.		 	 The	financial	statements	have	been	prepared	in	accordance	with	[Applicable	Financial	 
	 Reporting	Framework,	e.g.,	GAAP].

2.		 	 Management	is	responsible	for	the	accuracy	and	completeness	of	the	financial	records,	 
   including the disclosure of all relevant information.

3.			 All	transactions	have	been	recorded	and	are	reflected	in	the	financial	statements.

4.   Management has disclosed all information regarding fraud, actual or suspected, affecting  
   the entity.

5.   Management has provided us with all information relevant to the audit.

6.			 There	are	no	circumstances	that	could	have	a	material	effect	on	the	financial	statements									 
				and	have	not	been	disclosed	to	us.

Please	confirm	your	agreement	with	the	above	representations	by	signing	and	returning	a	copy	
of	this	letter	at	your	earliest	convenience.	If	there	are	any	matters	you	believe	should	be	brought	
to our attention, please let us know.
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We appreciate your cooperation and assistance in facilitating the audit process. If you have any 
questions	or	require	further	clarification,	please	do	not	hesitate	to	contact	us.

Thank	you	for	your	attention	to	this	matter.

Sincerely,

[Your	Name]
[Your	Title]
[Your	Company	Name]
[Contact	Information]

Note: Replace	the	placeholders	enclosed	in	square	brackets	with	actual	details	before	sending	
the	letter.	This	template	provides	a	structure	for	a	Management	Representation	Letter,	and	you	
should	customize	it	according	to	the	specific	details	of	your	engagement.

4.4. BOARD MINUTES
Project	Overview:	Generating	Board	Minutes	is	a	crucial	task	for	Chartered	Accountants	involved	
in corporate governance and compliance. Automating this process with Mail Merge ensures 
consistent and accurate documentation.

STEPS TO CREATE BOARD MINUTES:

1. Compile Meeting Information:

		 •	Gather	details	of	the	board	meeting,	including	attendees,	discussions,	decisions,	and	
resolutions.

2. Design the Board Minutes Template:

		 •	Create	a	template	with	placeholders	for	meeting	specifics.

3. Insert Merge Fields:

		 •	Add	merge	fields	to	dynamically	insert	meeting	details.

4. Link Template with Data Source:

  • Utilize Mail Merge to connect the template with the dataset.

5. Preview and Confirm:

		 •	Review	merged	minutes	to	ensure	accuracy	of	information.

6. Finalize and Distribute:

		 •	Print	or	save	the	minutes	for	distribution	to	board	members.

42



MS WORD

Below is a template for Board Minutes with placeholders for meeting specifics:

[Your	Name]
[Your	Title]
[Your	Company	Name]
[Address	Line	1]
[Address	Line	2]
[City,	State,	ZIP	Code]
[Date]

[Board	of	Directors’	Name]
[Board	of	Directors’	Title]
[Company	Name]
[Company	Address	Line	1]
[Company	Address	Line	2]
[City,	State,	ZIP	Code]

Minutes	of	the	[Meeting	Type]	Meeting
Date:	[Meeting	Date]
Time:	[Meeting	Time]

Location:	[Meeting	Location]

Present:

1.	[Name	of	Attendee	1]	-	[Title]
2.	[Name	of	Attendee	2]	-	[Title]
...
[Add	more	attendees	as	necessary]

Agenda:

1.	[Agenda	Item	1]
2.	[Agenda	Item	2]
...
[Add	more	agenda	items	as	necessary]

Minutes:
1.  Approval of Previous Meeting Minutes:
    -	The	minutes	of	the	previous	meeting	were	reviewed	and	approved	unanimously.
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2.  Discussion of Agenda Items:
a.	[Agenda	Item	1]
-	[Details	of	discussion]
b.	[Agenda	Item	2]
-	[Details	of	discussion]
...
[Add	details	for	each	agenda	item]

3. Decisions and Resolutions: 
a.	[Decision/Resolution	1]
-	[Details	of	the	decision/resolution]
	b.	[Decision/Resolution	2]
	-	[Details	of	the	decision/resolution]
...
[Add	details	for	each	decision/resolution]

4. Next Meeting:
 -	The	next	meeting	is	scheduled	for	[Date],	at	[Time],	in	[Location].

Adjournment:	
The	meeting	was	adjourned	at	[Time].
espectfully	Submitted,
Your	Name]
[Your	Title]
[Your	Company	Name]
[Contact	Information]

Note:	Replace	the	placeholders	enclosed	in	square	brackets	with	actual	details	before	sending	
the	minutes.	This	template	provides	a	structure	for	Board	Minutes,	and	you	should	customize	it	
according	to	the	specific	details	of	your	board	meeting.

4.5. AUDIT REPORTS
Project Overview:	Audit	Reports	are	critical	documents	summarizing	 the	findings	of	an	audit	
engagement. Automating the creation of these reports using Mail Merge ensures consistency 
and	saves	valuable	time.

STEPS TO CREATE AUDIT REPORTS:

 1. Compile Audit Findings:

		 •	Gather	all	relevant	information,	including	audit	scope,	procedures,	findings,	and	
recommendations.
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2. Design the Audit Report Template:

		 •	Create	a	template	with	placeholders	for	audit	specifics.

3. Insert Merge Fields:

		 •	 Incorporate	merge	fields	to	dynamically	insert	audit	details.

4. Connect Template with Data Source:

  • Use Mail Merge to link the template with the dataset.

5.  Preview and Review:

  • Carefully review the merged report to ensure accuracy and completeness.

6.  Finalize and Distribute:

		 •	Print	or	save	the	audit	reports	for	distribution	to	stakeholders.

Below is a template for an Audit Report with placeholders for audit specifics:
[Your	Name]
[Your	Title]
[Your	Company	Name]
[Address	Line	1]
[Address	Line	2]
[City,	State,	ZIP	Code]
[Date]

[Client	Name]
[Client	Title]
[Client	Company	Name]
[Client	Address	Line	1]
[Client	Address	Line	2]
[Client	City,	State,	ZIP	Code]

Independent	Auditor’s	Report

[Report	Date]

To the Board of Directors of [Client Company Name]:
We	have	audited	 the	accompanying	financial	statements	of	 [Client	Company	Name],	which	
comprise	 the	balance	sheet	as	of	 [Date],	and	 the	 related	statements	of	 income,	changes	 in	
equity,	and	cash	flows	for	the	year	then	ended,	and	a	summary	of	significant	accounting	policies	
and other explanatory information.
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Management’s Responsibility for the Financial Statements:
Management	is	responsible	for	the	preparation	and	fair	presentation	of	these	financial	statements	
in	 accordance	 with	 [Applicable	 Financial	 Reporting	 Framework,	 e.g.,	 GAAP].	 This	 includes	 the	
design, implementation, and maintenance of internal control relevant to the preparation and 
fair	presentation	of	financial	statements	that	are	free	from	material	misstatement,	whether	due	
to fraud or error.

Auditor’s Responsibility:
Our	responsibility	is	to	express	an	opinion	on	these	financial	statements	based	on	our	audit.	We	
conducted	our	audit	in	accordance	with	[Applicable	Audit	Standards,	e.g.,	Generally	Accepted	
Auditing	Standards	 (GAAS)].	 Those	standards	 require	 that	we	plan	and	perform	 the	audit	 to	
obtain	 reasonable	assurance	about	whether	 the	financial	 statements	are	 free	 from	material	
misstatement.

Opinion:
In	our	opinion,	the	financial	statements	referred	to	above	present	fairly,	in	all	material	respects,	
the	financial	position	of	[Client	Company	Name]	as	of	[Date],	and	the	results	of	its	operations	
and	its	cash	flows	for	the	year	then	ended	in	accordance	with	[Applicable	Financial	Reporting	
Framework,	e.g.,	GAAP].

Report Signature:
[Your	Name]
[Your	Title]
[Your	Company	Name]

[Contact	Information]
[Signature]
[Date]

Note: Replace	the	placeholders	enclosed	in	square	brackets	with	actual	details	before	finalizing	
and	sending	the	audit	report.	This	template	provides	a	structure	for	an	Audit	Report,	and	you	
should	customize	it	according	to	the	specific	details	of	your	audit	engagement.

This	chapter	provides	detailed	guidance	on	utilizing	Mail	Merge	for	various	CA	office	assignments,	
including	confirmation	 letters,	engagement	 letters,	 representation	 letters,	board	minutes,	and	
audit	reports.	These	projects	demonstrate	the	practical	applications	of	Mail	Merge	in	the	field	of	
Chartered Accountancy.
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SUMMARY

PROJECTS WITH MAIL MERGE

4.1. STANDARD CONFIRMATION LETTERS

Project Overview: Standard	Confirmation	Letters	are	crucial	in	auditing.	They	confirm	specific	
details,	like	account	balances	or	agreements,	with	third	parties.	Mail	Merge	streamlines	their	
creation	and	distribution.

Steps to Create Standard Confirmation Letters:

1. Set Up Data Source: Prepare a dataset with recipient names, addresses, and 
confirmation	details.

2. Design Confirmation Letter Template: Create a Word document with placeholders for 
recipient	details	and	confirmation	information.

3. Insert Merge Fields: Place	merge	fields	in	the	template	to	dynamically	insert	 
recipient-specific	data.

4. Initiate Mail Merge: Link the template with the data source using the Mail Merge Wizard.

5. Preview and Verify: Review	merged	letters	to	ensure	accuracy.

6. Complete the Mail Merge: Print	or	save	confirmation	letters	for	distribution.

4.2. AUDIT ENGAGEMENT LETTERS

Project Overview: Audit	 Engagement	 Letters	are	crucial	 in	setting	 terms	and	scope	 for	an	
audit.	Automating	their	creation	with	Mail	Merge	ensures	efficiency	and	consistency.

Steps to Create Audit Engagement Letters:

1. Define Engagement Terms: Clearly	outline	the	scope,	objectives,	and	responsibilities	of	
the audit engagement.

2. Design Engagement Letter Template: Create a template with placeholders for client and 
engagement-specific	information.

3. Insert Merge Fields: Incorporate	merge	fields	for	client	name,	engagement	dates,	and	
other relevant details.

4. Link Template with Data Source: Use Mail Merge to connect the template with the 
dataset.

5. Preview and Verify: Review	merged	letters	to	confirm	accuracy	of	information.
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6. Finalize and Distribute: Print or save the engagement letters for client review and 
signature.

4.3. MANAGEMENT REPRESENTATION LETTERS (MRLS)

Project Overview: Management	Representation	Letters	seek	confirmation	from	management	
regarding the accuracy and completeness of information provided during an audit. Automat-
ing	MRLs	with	Mail	Merge	enhances	efficiency.

Steps to Create Management Representation Letters:

1. Prepare Requested Information: Identify	specific	details	and	assertions	requiring	confir-
mation	by	management.

2. Design MRL Template: Create a template with placeholders for management and en-
gagement details.

3. Insert Merge Fields: Add	merge	fields	to	dynamically	insert	recipient-specific	data.
4. Connect Template with Data Source: Use Mail Merge to link the template with the dataset.
5. Preview and Confirm: Review	merged	letters	to	ensure	accuracy	of	information.
6. Complete the Mail Merge: Print	or	save	the	MRLs	for	distribution	and	collection	of	manage-

ment signatures.

4.4. BOARD MINUTES

Project Overview: Generating	 Board	 Minutes	 is	 crucial	 for	 Chartered	 Accountants	 involved	
in corporate governance and compliance. Automating this process with Mail Merge ensures 
consistent and accurate documentation.

Steps to Create Board Minutes:

1. Compile Meeting Information: Gather	details	of	the	board	meeting,	including	attendees,	
discussions, decisions, and resolutions.

2. Design Board Minutes Template: Create a template with placeholders for meeting spe-
cifics.

3. Insert Merge Fields:	Add	merge	fields	to	dynamically	insert	meeting	details.
4. Link Template with Data Source: Utilize Mail Merge to connect the template with the 

dataset.
5. Preview and Confirm: Review	merged	minutes	to	ensure	accuracy	of	information.
6. Finalize and Distribute: Print	or	save	the	minutes	for	distribution	to	board	members.
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4.5. AUDIT REPORTS

Project Overview: Audit	Reports	are	critical	documents	summarizing	the	findings	of	an	audit	
engagement. Automating the creation of these reports using Mail Merge ensures consistency 
and	saves	valuable	time.

Steps to Create Audit Reports:

1. Compile Audit Findings: Gather all relevant information, including audit scope, procedures, 
findings,	and	recommendations.

2. Design Audit Report Template:	Create	a	template	with	placeholders	for	audit	specifics.
3. Insert Merge Fields: Incorporate	merge	fields	to	dynamically	insert	audit	details.
4.	 Connect	Template	with	Data	Source:	Use	Mail	Merge	to	link	the	template	with	the	dataset.
5. Preview and Review: Carefully review the merged report to ensure accuracy and 

completeness.
6. Finalize and Distribute:	Print	or	save	the	audit	reports	for	distribution	to	stakeholders.

These	projects	demonstrate	how	Mail	Merge	can	significantly	streamline	document	creation	
and	distribution	for	Chartered	Accountants	in	various	scenarios.

MULTIPLE CHOICE QUESTIONS (MCQS) 

1.  What is the purpose of using Mail Merge in Chartered Accountancy?
 A) Automating data entry
	B)	Generating	personalized	documents
	C)	Conducting	financial	analysis
	D)	Creating	presentations

2. Which of the following is a key benefit of using Mail Merge?
 A) Personalization
	B)	Data	encryption
 C) File compression
	D)	Network	security

3. Which step comes after designing the template in setting up a Mail Merge?
	A)	Inserting	merge	fields
	B)	Selecting	recipients
	C)	Starting	the	Mail	Merge	Wizard
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	D)	Opening	Microsoft	Word

4. What is the purpose of selecting recipients in Mail Merge?
	A)	Designing	the	template
	B)	Defining	the	document	type
 C) Providing dataset information
	D)	Inserting	merge	fields

5. Which option allows manual entry of data for small datasets in Mail Merge?
	A)	Use	an	Existing	List
	B)	Type	a	New	List
	C)	Choose	from	Outlook	Contacts
	D)	Select	Recipients

6. In Mail Merge, where do you insert merge fields in the document?
	A)	In	the	“View”	tab
	B)	In	the	“Mailings”	tab
	C)	In	the	“Insert”	tab
	D)	In	the	“Home”	tab

7. In Mail Merge, where can you find the option to preview and verify the merged documents?
	A)	“Review”	tab
	B)	“Insert”	tab
	C)	“Mailings”	tab
	D)	View”	tab

8. Which project involves sending documents to third parties to confirm specific details?
	A)	Standard	Confirmation	Letters
	B)	Audit	Engagement	Letters
	C)	Management	Representation	Letters
	D)Board	Minutes

9. What is the purpose of an Audit Engagement Letter?
	A)	To	request	confirmation	from	management
	B)	To	establish	terms	and	scope	of	an	audit
	C)	To	request	information	for	an	audit	report
	D)	To	automate	the	audit	process

10. Which project involves confirming the accuracy and completeness of information 
provided during an audit?

	A)	Standard	Confirmation	Letters
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	B)	Audit	Engagement	Letters
	C)	Management	Representation	Letters
	D)	Board	Minutes

11. What type of information is typically included in a Management Representation Letter 
(MRL)?

	A)	Details	of	audit	procedures
	B)	Request	for	payment
	C)	Confirmation	of	information	accuracy
	D)	Terms	and	scope	of	engagement

12. Which project involves documenting discussions, decisions, and resolutions of a board 
meeting?

	A)	Standard	Confirmation	Letters
	B)	Audit	Engagement	Letters
	C)	Management	Representation	Letters
	D)	Board	Minutes

13. What is the purpose of an Audit Report?
	A)	To	request	confirmation	from	management
	B)	To	establish	terms	and	scope	of	an	audit
	C)	To	summarize	audit	findings	and	opinions
	D)	To	document	board	meeting	minutes

Answers
	1.	 B)	Generating	personalized	documents
 2.  A) Personalization
	3.		A)	Inserting	merge	fields
 4.  C) Providing dataset information
	5.		B)	Type	a	New	List
	6.		B)	In	the	“Mailings”	tab
	7.		C)	“Mailings”	tab
	8.		A)	Standard	Confirmation	Letters
	9.		B)	To	establish	terms	and	scope	of	an	audit
	10.		C)	Management	Representation	Letters
	11.			C)	Confirmation	of	information	accuracy
	12.		D)	Board	Minutes
	13.		C)	To	summarize	audit	findings	and	opinions
 14.  A) Financial statements
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SELF-EXAMINATION QUESTIONS FOR PRACTICE

STANDARD CONFIRMATION LETTERS:

1.	 What	is	the	purpose	of	Standard	Confirmation	Letters	in	the	auditing	process?

2.	 List	the	steps	involved	in	creating	Standard	Confirmation	Letters	using	Mail	Merge.

3.	 How	do	you	set	up	a	data	source	for	Standard	Confirmation	Letters?

4.	 Why	is	it	important	to	preview	and	verify	the	merged	letters	before	finalizing	the		 	 	
Mail	Merge	process?

5.	 Can	you	provide	an	example	of	a	situation	where	automating	Standard		 	 	
Confirmation	Letters	with	Mail	Merge	would	be	beneficial	for	a	Chartered	Accountant?

AUDIT ENGAGEMENT LETTERS:

1.	 Explain	the	significance	of	Audit	Engagement	Letters	in	the	auditing	process.

2.	 Enumerate	the	steps	for	creating	Audit	Engagement	Letters	using	Mail	Merge.

3.	 What	information	should	be	included	in	the	Audit	Engagement	Letter	template?

4.	 How	does	Mail	Merge	assist	in	streamlining	the	process	of	creating	Audit	 
Engagement	Letters?

5.	 Provide	an	example	of	a	scenario	where	automating	Audit	Engagement	Letters	with	Mail	
Merge	would	be	advantageous	for	a	Chartered	Accountant.

MANAGEMENT REPRESENTATION LETTERS (MRLS):

1.	 Why	are	Management	Representation	Letters	important	in	the	audit	process?

2.	 Outline	the	steps	involved	in	creating	Management	Representation	Letters	using	 
Mail Merge.

3.	 What	information	should	be	included	in	a	Management	Representation	Letter	template?

4.	 How	does	Mail	Merge	enhance	the	efficiency	of	generating	Management	 
Representation	Letters?

5.	 Give	an	example	of	a	situation	where	automating	Management	Representation	Letters	
with	Mail	Merge	would	be	valuable	for	a	Chartered	Accountant.
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BOARD MINUTES:

1. What	is	the	purpose	of	generating	Board	Minutes	for	a	Chartered	Accountant?

2. List	the	steps	for	creating	Board	Minutes	using	Mail	Merge.

3. What	information	should	be	included	in	a	Board	Minutes	template?

4. How	does	Mail	Merge	contribute	to	consistency	in	documenting	Board	Minutes?

5. Provide	an	example	of	a	scenario	where	automating	Board	Minutes	with	Mail	Merge
would	be	beneficial	for	a	Chartered	Accountant.

AUDIT REPORTS:

1. Why	are	Audit	Reports	crucial	in	the	auditing	process?

2. Enumerate	the	steps	for	creating	Audit	Reports	using	Mail	Merge.

3. What	information	should	be	included	in	an	Audit	Report	template?

4. How	does	Mail	Merge	improve	efficiency	in	generating	Audit	Reports?

5. Give	an	example	of	a	situation	where	automating	Audit	Reports	with	Mail	Merge	would	be
advantageous for a Chartered Accountant.
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KNOWLEDGE STATEMENT 

Create a document showcasing various text 
formatting, techniques, include font size, size 
and color settings, alignment and paragraph 

Students must understand the basics of 
documentation and presentation 

Create a macro all type of formatting 
including page border and color 

Summaraize the concept of macros in 
pointwise 

generate the flowchart about the mail merge 
fundamentals 

TASK STATEMENT 
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MS EXCEL

CHAPTER 1
INTRODUCTION TO MICROSOFT EXCEL
Microsoft Excel is a powerful spreadsheet application that has become an indispensable tool for 
professionals across various industries. Developed by Microsoft, Excel offers a versatile platform 
for organizing, analysing, and presenting data in a structured and efficient manner.

Excel’s intuitive interface allows users to create electronic spreadsheets, commonly referred 
to as worksheets, where data can be entered, manipulated, and displayed. These worksheets 
are organized within workbooks, providing a convenient way to manage related data and 
calculations.

1. MANAGING WORKSHEETS

LEARNING OBJECTIVES

a  Understand the fundamental features of Microsoft Excel, including workbook structure 
and worksheet components.

a  Develop proficiency in organizing data through tasks such as creating, deleting, and 
renaming worksheets.

a  Learn advanced techniques for managing and navigating large datasets efficiently, 
including using grouping, freezing panes, and utilizing hyperlinks.

a  Master data manipulation skills by practicing tasks like copying, moving, and protecting  
 worksheets.

a  Explore collaboration and data sharing capabilities within Excel, including sharing  
workbooks and protecting data with password security.

Managing worksheets in Excel is a crucial aspect of efficient data organization and analysis. 
Worksheets serve as individual spreadsheets within an Excel workbook, while workbooks are files 
containing one or more worksheets. They collectively help you compartmentalize and evaluate 
your data. An illustrative instance of the Excel interface displays various sheets within the default 
workbook, often named “Book1,” providing a basic layout that aids in the management of data 
across different sections.

1.1. WORKSHEET BASICS
In the realm of Excel, worksheets serve as the foundation for organizing data, computations, 
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and visual representations. Each worksheet operates within a workbook—a repository of related 
worksheets. This section delves into the essentials of worksheet management, from creating new 
ones to navigating between them, facilitating a comprehensive grasp of Excel’s organizational 
structure.

1.1.1 INTRODUCTION TO WORKSHEETS AND WORKBOOKS:
Worksheets are individual spreadsheets within an Excel workbook. Workbooks are fi les that 
contain one or more worksheets. They are used to organize and analyse data.

Figure: Basic layout of MS Excel

Above is the example of home screen of Excel with multiple sheets added to the default workbook 
named “Book1”.
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Figure: Basic layout of MS Excel

1.1.2.CREATING NEW WORKSHEETS AND WORKBOOKS:
To create a new workbook, go to “File” > “New” and choose “Blank Workbook”. To add a new 
worksheet, right-click on an existing worksheet tab and select “Insert” and choose “Worksheet”. 
You may also add worksheets by clicking on the “Plus” button next to the worksheet name.

1.1.3.NAVIGATING WITHIN A WORKSHEET AND WORKBOOK: 
Use the arrow keys, mouse scroll, or navigation buttons to move within a worksheet. The tabs at 
the bottom of the Excel window allow you to switch between worksheets in the same workbook.

1.1.4.SELECTING CELLS, ROWS, AND COLUMNS: 
Click on a cell to select it. Hold Shift and click to select a range of cells. Click on column/row 
headers to select entire columns or rows.

1.2. ENTERING AND EDITING DATA
Excel’s prowess isn’t just in calculations—it’s also an adept data entry and editing tool. This 
section delves into the art of populating cells with data, guiding you through input methods and 
facilitating content adjustments, contributing to a thorough understanding of data manipulation 
in Excel.

1.2.1 Inputting Data into Cells: 
Click on a cell and start typing to input data. Press Enter to move to the next cell.

1.2.2 EDITING AND DELETING CELL CONTENTS:
 Double-click on a cell to edit its contents. Press Delete or Backspace to clear cell contents.
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1.3 FORMATTING WORKSHEETS
Presenting data in a visually coherent and appealing manner is pivotal. This segment delves into 
formatting techniques that elevate your worksheet’s aesthetics and clarity, demonstrating how 
to imbue your content with visual impact through font adjustments, cell borders, shading, and 
numeric formatting.

1.3.1 CHANGING FONT STYLES AND SIZES:
Select cells and use the font options in the “Font” group of 
“Home” tab to change font styles, sizes, and colors.       

                                                                                                                                 
Figure: Font group

1.3.2 APPLYING CELL BORDERS AND SHADING: 
Use the “Borders” button in the ribbon to add borders around cells. Use the “Fill Color” option to 
shade cells with colors.

1.3.3 FORMATTING NUMBERS AS CURRENCY, PERCENTAGES, ETC.:
Select cells and use the “Number Format” dropdown to 
format numbers as currency, percentages, dates, etc.

                            Figure: Number group
Note: Formatting worksheets is covered in detail in the sub-topic “Handling Data Formats”.

1.4 MANAGING ROWS AND COLUMNS
Managing the layout of your worksheet involves more than data input. This section offers insights 
into structuring rows and columns effectively, along with advanced techniques like freezing 
panes. By harnessing these tools, your data stays organized, easily accessible, and aesthetically 
pleasing.

1.4.1. INSERTING AND DELETING ROWS AND COLUMNS: 
Right-click on a row/column header and choose “Insert” or “Delete” to add or remove rows/
columns.

1.4.2. HIDING AND UNHIDING ROWS AND COLUMNS:
 Select rows/columns, right-click, and choose “Hide” or “Unhide” to make data temporarily visible 
or invisible.

1.4.3. ADJUSTING COLUMN WIDTHS AND ROW HEIGHTS:
Drag the column/row boundary to adjust width or height. Double-click the boundary to 
automatically fi t the content.

“Home” tab to change font styles, sizes, and colors.       
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1.4.4. FREEZING PANES FOR IMPROVED VISIBILITY: 
Use “Freeze Panes” under the “View” tab to keep certain rows/columns visible while scrolling 
through large datasets.

Figure: Freeze panes

Note:  Apply Freeze panes on row 10 if you want to freeze till row 9. If you want to freeze only row 
9, apply freeze panes on row 9 alone.

1.5 WORKING WITH MULTIPLE WORKSHEETS
Working with multiple worksheets expands Excel’s capacity for multifaceted data management. 
This segment delves into techniques like renaming, copying, moving, and linking sheets. By 
mastering these skills, you harness the potential to orchestrate intricate data relationships 
across your workbook, fostering a deeper understanding of interconnected data manipulation.
1.5.1 Renaming and Reordering Worksheets: 

Right-click on a worksheet tab to rename or change the tab colour. Drag tabs to reorder 
worksheets.

1.5.2 COPYING AND MOVING WORKSHEETS WITHIN WORKBOOKS: 
Right-click on a tab and choose “Move or Copy” to duplicate or move a worksheet to another 
location within the same or different workbook.
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Figure: Move or Copy Sheet

Note: Tick the check box “Create a copy” to make a copy of the sheet. Otherwise, the sheet will 
be permanently moved to the selected workbook.

1.5.3. LINKING DATA BETWEEN WORKSHEETS:
 Use formulas to link data between worksheets. For instance, 
use “=Sheet2!A1” to reference cell A1 on Sheet2.

Note: After typing “=” on the cell you may directly go to sheet 2 and select the respective cell to 
reference it.

     

SUMMARY

•  Worksheets are individual spreadsheets within an Excel workbook.

•  Create a new workbook through “File” > “New” > “Blank Workbook.”

•  Tabs at the bottom allow switching between worksheets within the same workbook.

•  Click a cell to select it; hold Shift and click for cell range selection.

•  Select entire columns or rows by clicking column/row headers.

• Start typing in a cell to input data; press Enter to move to the next cell.

•  Double-click a cell to edit its contents; use Delete or Backspace to clear content.

•  Format numbers as currency, percentages, etc., using the “NumberFormat” dropdown.

•  Freeze Panes under “View” tab keeps specifi c rows/columns visible during scrolling.

•  Check “Create a copy” to duplicate sheet across same/different workbooks.
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MULTIPLE CHOICE QUESTIONS (MCQS)

1.What is a workbook in Microsoft Excel?
 a. A single spreadsheet
 b. A collection of related worksheets
	 c.	A	file	format	used	to	save	data
	 d.	A	formatting	option	for	cells

2. How do you create a new worksheet in Excel?
 a. Right-click on an existing worksheet tab and select “Insert”
 b. Go to “File” > “New” and choose “Blank Worksheet”
 c. Press Ctrl + N
	 d.	Click	on	the	“Plus”	button	next	to	the	worksheet	name

3. Which option allows you to add borders around cells in Excel?
	 a.	Format	Cells
 b. Borders Button
 c. Cell Options
	 d.	Cell	Formatting

4. What does freezing panes in Excel mean?
 a. Locking a cell so it cannot be edited
	 b.	Keeping	certain	rows/columns	visible	while	scrolling
	 c.	Removing	all	formatting	from	a	cell
	 d.	Deleting	a	row	or	column

5. How do you adjust the width of a column in Excel?
	 a.	Drag	the	column	boundary
 b. Right-click and select “Adjust Width”
	 c.	Go	to	“Format”	>	“Column	Width”
 d. Press Ctrl + A

6. Which formula would you use to reference cell A1 on Sheet2?
 a. =Sheet2!A1
 b. =Sheet1!A1
 c. =A1(Sheet2)
 d. =Sheet2(A1)

7. How do you select an entire column in Excel?
	 a.	Click	on	the	column	header
	 b.	Double-click	on	a	cell	in	the	column
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	 c.	Right-click	and	select	“Select	Column”
 d. Press Ctrl + Shift + C

8. What is the purpose of the “Fill Color” option in Excel?
 a. Change the font color
 b. Add borders to cells
 c. Shade cells with colors
 d. Change the cell size

9. How do you delete a worksheet in Excel?
 a. Right-click on the worksheet tab and select “Delete”
 b. Press Ctrl + D
 c. Go to “Edit” > “Delete Worksheet”
 d. Worksheets cannot be deleted in Excel

10. What is the keyboard shortcut to move to the next cell in Excel?
 a. Ctrl + Enter
 b. Tab
 c. Alt + Enter
 d. Shift + Enter

11. Which menu option allows you to create a new workbook in Excel?
 a. File > New
 b. Edit >New
 c. View > New
	 d.	Format	>	New

12. What is the purpose of the “Freeze Panes” feature in Excel?
	 a.	Lock	certain	cells	so	they	cannot	be	edited
	 b.	Keep	certain	rows/columns	visible	while	scrolling
	 c.	Hide	selected	rows/columns
	 d.	Apply	a	freezing	effect	to	the	worksheet

13. How do you rename a worksheet in Excel?
	 a.	Right-click	on	the	worksheet	tab	and	select	“Rename”
	 b.	Go	to	“File”	>	“Rename	Worksheet”
 c. Double-click on the worksheet tab
	 d.	Worksheets	cannot	be	renamed	in	Excel

14. What is the keyboard shortcut to undo the last action in Excel?
 a. Ctrl + Z
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 b. Ctrl + U
 c. Ctrl + Y
 d. Ctrl + A

15. How do you select multiple non-adjacent cells in Excel?
 a. Hold Ctrl and click on the cells
 b. Hold Shift and click on the cells
	 c.	Use	the	arrow	keys	while	holding	Ctrl
 d. It’s not possible to select non-adjacent cells in Excel

ANSWERS
 1.  What is a workbook in Microsoft Excel?
   Option b. A collection of related worksheets
 2.  How do you create a new worksheet in Excel?
   Option a. Right-click on an existing worksheet tab and select “Insert”
 3.  Which option allows you to add borders around cells in Excel?
   Option b. Borders Button
 4.  What does freezing panes in Excel mean?
   Option b. Keeping certain rows/columns visible while scrolling
 5.  How do you adjust the width of a column in Excel?
   Option a. Drag the column boundary
 6.  Which formula would you use to reference cell A1 on Sheet2?
   Option a. =Sheet2!A1
 7.  How do you select an entire column in Excel?
   Option a. Click on the column header
 8.  What is the purpose of the “Fill Color” option in Excel?
   Option c. Shade cells with colors
 9.  How do you delete a worksheet in Excel?
   Option a. Right-click on the worksheet tab and select “Delete”
 10.  What is the keyboard shortcut to move to the next cell in Excel?
   Option b. Tab
 11.  Which menu option allows you to create a new workbook in Excel?
   Option a. File > New
12.  What is the purpose of the “Freeze Panes” feature in Excel?
   Option b. Keep certain rows/columns visible while scrolling
 13.  How do you rename a worksheet in Excel?
   Option c. Double-click on the worksheet tab and then rename the worksheet
 14.  What is the keyboard shortcut to undo the last action in Excel?
   Option a. Ctrl + Z
 15.  How do you select multiple non-adjacent cells in Excel?
   Option a. Hold Ctrl and click on the cells
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SELF EXAMINATION QUESTIONS FOR PRACTICE

1. What is the purpose of worksheets and workbooks in Excel? How do they help in 
organizing and managing data effectively?

2. Describe the steps to create a new workbook and add a new worksheet to an existing 
workbook.

3. How can you navigate between different worksheets within the same workbook? Explain 
the methods you can use.

4. Explain the process of selecting cells, rows, and columns in Excel. How would you select 
an entire column using the keyboard?

5. What are the steps to input data into a cell in Excel? How do you move to the next cell 
after entering data?

6. Describe the process of editing the contents of a cell in Excel. How would you clear the 
contents of a cell?

7. How can you change the font styles, sizes, and colors of cells in Excel? Provide a brief 
explanation of the “Number Format” dropdown.

8. Explain how to add cell borders and shading to enhance the appearance of your 
worksheet. What is the purpose of using shading?

9. How would you adjust the column width and row height of cells in Excel? Is there a 
shortcut to automatically fit the content within a cell?

10. What is the purpose of freezing panes in Excel? Describe how to use the “Freeze Panes” 
feature to keep specific rows or columns visible while scrolling.

11. Describe the steps to rename a worksheet and change its tab color. How can you reorder 
worksheets within a workbook?

12. Explain the process of copying and moving worksheets between workbooks. What does 
the “Create a copy” option do during this process?

13. How can you link data between different worksheets using formulas? Provide an example 
of a formula that references a cell in another sheet.
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CHAPTER 2
HANDLE DATA FORMATS AND LAYOUTS

LEARNING OBJECTIVES

a	 Understand the fundamental concepts of data formats and layouts in MS Excel, 
 including cell formatting, number formats, and text alignment.

a  Learn to effi ciently organize and manipulate data by applying various Excel features,   
 such as sorting, fi ltering, and grouping, to improve data layout and readability.

a  Master the techniques of importing, exporting, and converting data between different   
 fi le formats (e.g., CSV, XLSX) while maintaining data integrity.

a  Gain profi ciency in creating visually appealing and structured Excel spreadsheets   
   through the effective use of tables, charts, and cell merging for improved data 
 presentation.

a  Develop the skills to troubleshoot and resolve common data formatting and 
   layout issues in Excel to ensure accurate data analysis and reporting.

These learning objectives aim to provide CA students with a comprehensive understanding 
of handling data formats and layouts in Microsoft Excel, especially in the context of fi nancial 
spreadsheets.

Effectively managing data formats and layouts is a cornerstone of Excel usage, particularly when 
dealing with fi nancial information. Accurate representation and appealing presentation of data 
are crucial. This section delves into techniques that ensure your worksheets are well-structured 
and that data is formatted in accordance with the formal standards, thus facilitating easier 
comprehension and analysis.

2.1. NUMBER FORMATTING
Accurate portrayal of numerical data is paramount in fi nancial spreadsheets. Number formatting 
allows you to represent currency values, percentages, and decimals as they should appear. 
Properly formatting numbers is crucial in fi nancial spreadsheets to refl ect currency, percentages, 
and decimals appropriately.
	To	format	a	cell:
 •  Select the cell or range.
 •  Go to the “Home” tab.
 •  Choose a format from the 
 •  “Number “ group. Figure: Number formatting
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•  For currency, use the “Currency” option, and for percentages, select the “Percentage” 
option. For custom formats, click “More Number Formats” to defi ne specifi c formats like 
displaying negatives in parentheses.

                                                                                    
Figure: More Number formatting

                                                                                                              

Figure: Format cell
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2.2. DATE AND TIME FORMATTING
The precision demanded by accounting often extends to date and time representation. The 
formatting of dates and time ensures accurate communication of temporal data.Accounting 
often involves precise date and time representation.

Format	dates	and	times	as	follows:
 •  Select the cell or range.
 •  Go to the “Home” tab.
 • Choose a format from the “Number Format”  dropdown, such as “Short Date” or  
    “Long Date.”

Use custom formatting for specifi c date layouts and calculations, 
like applying “yyyy-mm-dd” for uniform date entries.

Figure: Date and time formatting
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2.3. CONDITIONAL FORMATTING
Conditional formatting introduces an intelligent layer to data visualization. It enables you to 
automatically highlight cells that meet certain criteria, making key insights easily discernible. 

Highlight	important	data	points	using	conditional	formatting:
 •  Select the cell range.
 •  Go to the “Home” tab.
 •  Click “Conditional Formatting” and choose a rule type.

For instance, you can highlight cells with values above a threshold in a different color. Use color 
scales for value comparisons and data bars for visual data assessment.

Figure: Conditional formatting

2.4. CELL ALIGNMENT AND ORIENTATION
The layout of data within cells signifi cantly infl uences readability. Alignment ensures a clean 
presentation that is easy on the eyes. 

Aligning	text	within	cells	enhances	readability:
 • Select the cell or range.
 •  Go to the “Home” tab
 •  Use the “Alignment” options to align text left, center, or right.
 • To rotate text for better fi t, use the “Orientation” dropdown and choose an angle.
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Figure: Cell alignment and Orientation
    .
2.5. MERGING AND CENTERING CELLS

Creating distinct headers and enhancing the overall aesthetic of your spreadsheet is achieved 
through the merging and centering of cells.

Merging cells can help create clear headers:
 •  Select the cells to merge.
 •  Go to the “Home” tab.
 •  Click the “Merge &Center” dropdown and choose a merging option.

Ensure you center the merged cell’s content for a polished appearance.

2.6. CELL STYLES AND THEMES

Maintaining consistency in formatting 
is essential for professional-looking 
worksheets. Cell styles and themes 
provide a systematic approach to 
achieving uniformity.

Consistency	 in	 formatting	 is	 crucial	
for professional worksheets:
 • Select the cell or range.
 • Go to the “Home” tab.
 • Apply a cell style from the 
“Cell Styles” gallery.

Use predefi ned styles to maintain 
uniformity, or customize styles to 
match your organization’s branding. Figure: Cell styles
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2.7. FORMATTING COLUMNS AND ROWS

Adjusting the dimensions of columns and rows plays a crucial role in enhancing the presentation 
of your spreadsheet. By dragging column borders, you can fi ne-tune the width of columns to 
accommodate content. Hovering over row boundaries and adjusting the row height allows you 
to optimize readability.

Adjusting	column	widths	and	row	heights	improves	presentation:
 •  Drag column borders to adjust widths.
 •  Hover over the row boundary to adjust row height.
Using the “Format” menu in the “Home” tab, you can autofi t columns to match content length.

2.8. USING BORDERS AND GRIDLINES

Effectively using borders and gridlines helps draw attention to specifi c cells, guiding the viewer’s 
focus and enhancing readability. 

Adding borders enhances focus on specifi c cells:
 •  Select the cells to format.
 •  Go to the “Home” tab.
 •  Click the “Borders” dropdown to 
                 choose border styles.

Enable or disable gridlines via the “View” tab to differentiate cells.                 

Fig : Show group in View tab
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SUMMARY

• Proper number formatting is essential for financial spreadsheets.

• Precision in accounting requires accurate date and time representation.

• Conditional formatting highlights data meeting specific criteria, enhancing data 
visualization.

• Alignment influences data readability significantly.

• Merging and centering cells create clear headers and improve aesthetics.

• Uniform formatting enhances professional appearance. Cell styles help with that.

• Adjusting column and row dimensions enhances spreadsheet presentation.  
Drag column borders to adjust widths. Hover over row boundary to adjust row height.

• Borders and gridlines focus attention on cells and enhance readability.  
Enable or disable gridlines via the “View” tab.

MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the purpose of number formatting in Excel?
 a. To change the font size
 b. To accurately represent numerical data
 c. To apply colors to cells
 d. To merge cells

2. Which option in the “Home” tab allows you to format a cell with currency values?
 a. Font
 b. Alignment
 c. Number
 d. Format

3. How can you format a date to display as “dd/mm/yyyy” in Excel?
 a. Select the cell, go to “Home” tab, choose “Short Date” from the “Number Format” dropdown.
 b. Select the cell, go to “Home” tab, choose “Long Date” from the “Number Format” dropdown.
 c. Select the cell, go to “Home” tab, choose “More Number Formats” and enter the format 

manually.
 d. This cannot be done in Excel.
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4. What does conditional formatting allow you to do in Excel?
 a. Automatically highlight cells based on certain criteria.
 b. Add conditional statements to cells.
 c. Adjust cell alignment based on content.
 d. Change the font style of selected cells.

5. How do you align text to the right within a cell in Excel?
 a. Use the “Alignment” options in the “Home” tab.
 b. Select the cell, right-click, and choose “Align Right”.
 c. Press Ctrl + R.
 d. It cannot be done in Excel.

6. Which option allows you to merge and center cells in Excel?
 a. Format Cells
 b. Alignment Options
 c. Merge &Center Dropdown
 d. Cell Styles

7. What is the purpose of adjusting column widths and row heights in Excel?
 a. To change the font size in the cells.
 b. To optimize the presentation of the spreadsheet.
 c. To apply conditional formatting.
 d. To merge cells.

8. How do you add borders to specific cells in Excel?
 a. Go to the “Home” tab, click the “Borders” dropdown, and choose a border style.
 b. Right-click on the cell and choose “Add Border”.
 c. Press Ctrl + B.
 d. This cannot be done in Excel.

9. What is the purpose of gridlines in Excel?
 a. To differentiate cells and enhance readability.
 b. To apply conditional formatting.
 c. To merge cells.
 d. To change the font color.

10. How do you format a cell to display currency values in Excel?
 a. Select the cell, go to “Home” tab, choose “Currency” from the “Number Format” dropdown.
 b. Select the cell, right-click, and choose “Format Currency”.
 c. Press Ctrl + C.
 d. It cannot be done in Excel.
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11. Which option allows you to adjust the row height in Excel?
 a. Use the “Format” menu in the “Home” tab.
 b. Drag the row boundary.
 c. Right-click on the row and choose “Adjust Height”.
 d. Press Ctrl + H.

12. How can you highlight cells with values above a specified threshold in Excel?
 a. Use the “Conditional Formatting” option in the “Home” tab.
 b. Right-click on the cell and choose “Highlight Values”.
 c. Press Ctrl + H.
 d. This cannot be done in Excel.

13. Which formatting option is essential for accurate representation of numerical data in 
financial spreadsheets?

 a. Number Formatting
 b. Conditional Formatting
 c. Date and Time Formatting
 d. Cell Alignment and Orientation

14. How can you rotate text within a cell for better fit in Excel?
 a. Use the “Alignment” options in the “Home” tab.
 b. Right-click on the cell and choose “Rotate Text”.
 c. Select the cell, go to “Home” tab, choose an angle from the “Orientation” dropdown.
 d. Press Ctrl + R.

Answers
1. What is the purpose of number formatting in Excel?

  Answer: b. To accurately represent numerical data

2. Which option in the “Home” tab allows you to format a cell with currency values?

  Answer: c. Number

3. How can you format a date to display as “dd/mm/yyyy” in Excel?

  Answer: c. Select the cell, go to “Home” tab, choose “More Number Formats” and enter the 
format manually.

4. What does conditional formatting allow you to do in Excel?

  Answer: a. Automatically highlight cells based on certain criteria.

5. How do you align text to the right within a cell in Excel?

  Answer: a. Use the “Alignment” options in the “Home” tab.

6. Which option allows you to merge and center cells in Excel?

  Answer: c. Merge &Center Dropdown
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7. What is the purpose of adjusting column widths and row heights in Excel?

  Answer: b. To optimize the presentation of the spreadsheet.

8. How do you add borders to specific cells in Excel?

  Answer: a. Go to the “Home” tab, click the “Borders” dropdown, and choose a border style.

9. What is the purpose of gridlines in Excel?

  Answer: a. To differentiate cells and enhance readability.

10. How do you format a cell to display currency values in Excel?

  Answer: a. Select the cell, go to “Home” tab, choose “Currency” from the “Number Format” 
dropdown.

11. Which option allows you to adjust the row height in Excel?

  Answer: b. Drag the row boundary.

12. How can you highlight cells with values above a specified threshold in Excel?

  Answer: a. Use the “Conditional Formatting” option in the “Home” tab.

13. Which formatting option is essential for accurate representation of numerical data in 
financial spreadsheets?

  Answer: a. Number Formatting

14. How can you rotate text within a cell for better fit in Excel?

  Answer: c. Select the cell, go to “Home” tab, choose an angle from the “Orientation” 
dropdown.

SELF-EXAMINATION QUESTIONS FOR PRACTICE

1. Number Formatting:
 a. How does proper number formatting benefit financial spreadsheets?
 b. Explain the steps to format a cell as currency.
 c. What does the “More Number Formats” option allow you to do?

2. Date and Time Formatting:
 a. Why is accurate date and time formatting important in financial data?
 b. Describe the steps to format a cell as a short date.
 c. How can you apply custom formatting to dates for uniformity? 

3. Conditional Formatting:
 a. How does conditional formatting enhance data visualization?
 b. Give an example of a situation where you might use color scales for conditional 

formatting.
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 c. Explain the process of highlighting cells with values above a certain threshold using con-
ditional formatting.

4. Cell Alignment and Orientation:
 a. Why is proper cell alignment important in spreadsheets?
 b. How can you align text within a cell to the right?
 c. What is the purpose of using the “Orientation” dropdown in cell alignment?

5. Merging and Centering Cells:
 a. How does merging and centering cells contribute to spreadsheet aesthetics?
 b. Describe the steps to merge a group of cells and center their content.
 c. Why is it important to ensure that merged cell content is centered?

6. Cell Styles and Themes:
 a. Why is consistency in formatting important for professional-looking worksheets?
 b. How can you apply a cell style from the “Cell Styles” gallery?
 c. Can you customize cell styles to match your organization’s branding? If yes, how?

7. Formatting Columns and Rows:
 a. Why is adjusting column widths and row heights important for presentation?
 b. Describe how you can autofit columns to match content length.
 c. How do you adjust the width of a column using drag borders?

8. Using Borders and Gridlines:
 a. How do borders and gridlines enhance the readability of a spreadsheet?
 b. Explain the steps to add borders around a group of cells.
 c. How can you enable or disable gridlines in Excel
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CHAPTER 3
CREATE AND MANAGE TABLES

LEARNING OBJECTIVES

a	 Understand the fundamental concepts of data organization and table structures in   
 Microsoft Excel.

a  Learn how to create tables efficiently to store and manage data in Excel, including  
 defining headers and formatting options.

a  Explore advanced table management techniques such as sorting, filtering, and using  
 formulas within tables.

a  Gain proficiency in modifying and customizing table designs to suit specific data needs.

a  Develop the skills to troubleshoot and resolve common issues that may arise when  
 working with tables in MS Excel.

By mastering these objectives, you will be proficient in creating, managing, and utilizing tables in 
Excel for efficient data organization and analysis in financial and accounting tasks.

Excel’s feature to create and manage tables is invaluable in organizing, analyzing, and 
manipulating data efficiently. The ability to structure information with defined headers and 
intrinsic functionalities enhances your financial and accounting endeavours. This section will 
guide you through the process of creating and adeptly managing tables within your spreadsheet 
tasks.

3.1. CREATING A TABLE
Creating a table grants you the capability to categorize data with clear headings and integrated 
features, fostering a structured approach to data management. It allows you to organize data 
with distinct headers and built-in functionalities.

Step 1: Select the data range you want to convert into a table.
Step 2: Go to the “Insert” tab.
Step 3: Click the “Table” button in the Tables group.
Step 4: Confirm that Excel has selected the correct range and that 
             the “Create Table” dialog box displays the correct range.
Step 5: Ensure “My table has headers” is checked if your data range includes headers.
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Step 6: Click “OK” to create the table.

Figure: Creating a Table

Figure: Created table

3.2. ADDING DATA TO A TABLE
After creating a table, the seamless process of data addition becomes evident. Starting from the 
last row of the table, the simple action of typing initiates the expansion of the table to include 
the newly inserted row. This dynamic feature streamlines the incorporation of new information, 
ensuring the coherence of your data layout remains intact.

Once	a	table	is	created,	adding	data	is	seamless:

 Step 1: Navigate to the last row of the table.

 Step 2: Start typing data. Excel automatically expands the table to include the new row3. 

3.3. FILTERING AND SORTING IN TABLES
Tables provide indispensable tools for data analysis, particularly through fi ltering and sorting. 
Filtering, achieved by clicking the dropdown arrow on a column header, enables the display of 
specifi c data based on chosen fi lter criteria. Sorting, on the other hand, involves clicking the sort 
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icon on a column header, effectively arranging data in either ascending or descendingorder.
These capabilities empower you to extract meaningful insights from your data with ease.

Step 1 (Filtering):  

Click the dropdown arrow on a column header. Choose a fi lter criterion to display specifi c data.

Step 2 (Sorting): 

Click the sort icon on a column header to sort data in ascending or descending order.

Figure: Sorting and Filtering

3.4. TOTAL ROW IN TABLES
Integrating total rows within tables simplifi es calculations by providing a designated row for 
aggregations.

Total	rows	simplify	calculation	within	a	table:

Step 1: Ensure the table is selected.

Step 2: Go to the “Table Design” tab.
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Figure: Table style options

Step 3: Check the “Total Row” checkbox. Excel adds a new row at the bottom of the table.

Step 4: Click on the cell in the Total Row where you want to display a calculation 

(e.g., sum, average).

Step 5: Choose the desired calculation from the dropdown arrow that appears.

Figure: Total row aggregation

3.5. RESIZING AND FORMATTING TABLES
The process of adjusting the dimensions and formatting of tables contributes to their effectiveness 
in presenting data. Clicking on the table provides access to resize handles, facilitating easy 
adjustment of the table’s size to suit your needs. Additionally, the “Table Design” tab offers a 
range of table styles that can be applied to enhance the overall appearance and readability of 
your data.

Adjusting	table	dimensions	and	formatting	is	straightforward:

Step 1: Click on the table.

Step 2: Use the resize handles to adjust the table size.
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Step 3: Go to the “Table Design” tab to apply table styles.

Figure: Table Styles

3.6. CONVERTING TABLES TO A RANGE
• The fl exibility of Excel extends to the  ability to convert table back to range if required.

Figure: Tools group

If needed, you can convert a table back to a range:

Step 1: Click on the table.

Step 2: Go to the “Table Design” tab.

Step 3: Click the “Convert to Range” button.

Step 4: Confi rm the action in the prompt.t

                                                                                                                                                                                  

Figure: Prompt window of Convert Table to Range

3.7. NAMED RANGES WITHIN TABLES
Named ranges simplify complex formulas within tables, contributing to effi cient data analysis. 
Once named, this range can be seamlessly utilized in formulas, streamlining calculations and 
enhancing the clarity of your data analysis.
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Named	ranges	simplify	formulas	within	tables:
Step 1: Select the cell range you want to name.

Step 2: Go to the “Formulas” tab.

Step 3: Click the “Create from Selection” button.

Step 4: Choose “Top row” if your table has headers.

Step 5: Click “OK” to create the named range.   

Figure: Defi ned names group

By comprehensively understanding and implementing these techniques, you can harness the 
power of Excel’s table functionalities to effectively manage, organize, and analyze fi nancial and 
accounting data with precision and ease.

 SUMMARY

• Tables enhance data organization with clear headings and  built-in functionalities.

• After table creation, adding data is simple by typing in the last row.

• Filtering involves dropdown menus on column headers to display specifi c data based on 
criteria.

• Sorting is achieved by clicking sort icons, arranging data in ascending or descending 
order.

• Total rows within tables simplify calculations by offering a designated row for 
aggregations.

• Adjusting table dimensions enhances data presentation and appearance.”Table Design” 
tab provides various table styles to improve readability.

• Named ranges simplify complex formulas within tables.Steps include selecting the range, 
accessing the “Formulas” tab, and creating the named range.
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MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the purpose of creating a table in Excel?
 a. To add colors to the data
 b. To categorize data with clear headings and integrated features
 c. To merge cells for better organization
 d. To change the font size

 
2. How do you create a table in Excel?

 a. Go to the “Insert” tab and click the “Table” button
 b. Go to the “Format” tab and select “Create Table”
 c. Right-click on the data range and choose “Create Table”
 d. Press Ctrl + T

3. What is the significance of the “My table has headers” option when creating a table?
 a. It changes the font style of the headers
 b. It indicates that the data range includes headers for each column
 c. It merges the headers for better visibility
 d. It applies conditional formatting to the headers

4. How do you add data to a table after it is created?
 a. Go to the first row after the table and start typing
 b. Right-click on the table and choose “Add Data”
 c. Select the last row of the table and press Enter
 d. Use the “Add Data” button in the “Table Design” tab

5. What is the purpose of filtering in tables?
 a. To automatically add new data to the table
 b. To display specific data based on chosen filter criteria
 c. To sort data in ascending order
 d. To merge cells with similar values

6. How do you sort data in a table in Excel?
 a. Click the sort icon on a column header
 b. Right-click on a cell and choose “Sort”
 c. Go to the “Data” tab and select “Sort”
 d. Press Ctrl + S

7. What does the Total Row in a table allow you to do?
 a. It indicates the total number of rows in the table
 b. It provides a designated row for aggregations and calculations
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 c. It merges all the cells in the last row
 d. It changes the font color of the last row

8. How do you apply a table style to a table in Excel?
 a. Use the “Format Table Style” option in the “Table Design” tab
 b. Right-click on the table and choose “Apply Table Style”
 c. Go to the “Home” tab and select a style from the “Table Styles” gallery
 d. Press Ctrl + Shift + S

9. How can you convert a table back to a range in Excel?
 a. Go to the “Table Design” tab and click “Convert to Range”
 b. Right-click on the table and choose “Convert to Range”
 c. Press Ctrl + R
 d. Use the “Convert Table” option in the “Data” tab

10. What is the purpose of named ranges within tables?
 a. To simplify complex formulas within tables
 b. To change the font style of the table
 c. To merge cells with specific names
 d. To apply conditional formatting to the table

ANSWERS
 1.   What is the purpose of creating a table in Excel?

  Answer: b. To categorize data with clear headings and integrated features

 2.  How do you create a table in Excel?

  Answer: a. Go to the “Insert” tab and click the “Table” button

 3.  What is the significance of the “My table has headers” option when creating a table?

  Answer: b. It indicates that the data range includes headers for each column

 4.  How do you add data to a table after it is created?

  Answer: a. Go to the first row after the table and start typing

 5.  What is the purpose of filtering in tables?

  Answer: b. To display specific data based on chosen filter criteria

 6.  How do you sort data in a table in Excel?

  Answer: a. Click the sort icon on a column header

 7.  What does the Total Row in a table allow you to do?

  Answer: b. It provides a designated row for aggregations and calculations

 8.  How do you apply a table style to a table in Excel?
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  Answer: c. Go to the “Home” tab and select a style from the “Table Styles” gallery

 9.  How can you convert a table back to a range in Excel?

  Answer: a. Go to the “Table Design” tab and click “Convert to Range”

 10.  What is the purpose of named ranges within tables?

  Answer: a. To simplify complex formulas within tables

SELF-EXAMINATION QUESTIONS FOR PRACTICE

1. How does creating a table in Excel enhance the management of data? What are the key 
advantages of using tables for data organization?

2. Outline the steps involved in creating a table in Excel. Explain the purpose of confirming the 
correct range and selecting the “My table has headers” option.

3. Once a table is created, how does Excel facilitate the process of adding data? Describe the 
dynamic feature that ensures the coherence of the data layout.

4. How can filtering and sorting capabilities in tables enhance data analysis? Explain the steps 
for filtering data based on specific criteria and sorting data in ascending or descending 
order.

5. What is the significance of the “Total Row” feature in tables? Describe the steps to activate 
the “Total Row” and perform calculations within it.

6. In what ways does resizing and formatting contribute to the effectiveness of tables in data 
presentation? How can you adjust the dimensions of a table using the resize handles?

7. How can you convert a table back to a range in Excel? Outline the steps involved in 
converting a table to a range and explain the purpose of this action.

8. What is the role of named ranges within tables? How do named ranges simplify complex 
formulas and contribute to efficient data analysis?

9. Imagine you have a table in Excel with sales data for different products. How would you use 
the filtering feature to display only the rows where sales are above a certain threshold?

10. Explain the difference between sorting data in ascending and descending order within a 
table. Provide an example scenario where you might need to perform each type of sorting.
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CHAPTER 4
PERFORM OPERATIONS WITH  
FORMULAS & FUNCTIONS

     LEARNING OBJECTIVES

a	 Understand the fundamental concepts of formulas and functions in MS Excel, including  
 cell references and mathematical operators.

a  Learn to create and manipulate basic mathematical formulas to perform calculations  
 such as addition, subtraction, multiplication, and division.

a	 Gain proficiency in using a variety of Excel functions, including SUM, AVERAGE, MAX, MIN,  
 and COUNT, to analyze and summarize data effectively.

a	 Explore advanced functions like IF, VLOOKUP, and CONCATENATE to solve complex data  
 analysis problems and enhance spreadsheet functionality.

a  Develop the skills to troubleshoot errors and optimize formula efficiency for more effi  
 cient data processing in Microsoft Excel.

Mastering formulas and functions is a cornerstone of Excel proficiency, especially in accounting 
and finance. Let’s explore the key operations you can perform using formulas and functions to 
streamline your data processing tasks effectively.

4.1. BASIC ARITHMETIC OPERATIONS
Basic arithmetic operations are the building blocks of Excel calculations. By using these operators 
within formulas, you can perform fundamental mathematical computations with ease.Enter a 
formula in a cell, starting with the equals sign (=), followed by the mathematical expression.

Performing	straightforward	arithmetic	calculations	is	fundamental	to	Excel’s	utility:
• Addition (+): Use the plus symbol (+) to sum up values, for example, =A1 + B1.
• Subtraction (-): Minus symbol (-) subtracts values, like =A1 - B1.
• Multiplication (*): Asterisk (*) multiplies values, as in =A1 * B1.
• Division (/): Forward slash (/) divides values, such as =A1 / B1.

4.2. USING BUILT-IN FUNCTIONS
Excel offers a vast library of built-in functions that simplify complex calculations. These functions 
cater to various calculations, from simple addition to complex statistical analysis. Using functions 

87



MS EXCEL

streamlines calculations and ensures accuracy.

Leveraging	Excel’s	extensive	library	of	functions	simplifies	complex	calculations:
• Syntax: Start a formula with “=” followed by the function name and parentheses.
• Arguments: Enclose arguments (data ranges or values) within the parentheses.
• Example: =SUM (A1:A10) adds up values from A1 to A10.
• Press Enter to compute the result.

4.3. CELL REFERENCES IN FORMULAS
Cell references enable you to perform consistent calculations across multiple cells, with the 
ability to adjust or lock references as needed.Use cell references like A1, B2 to refer to specific 
cells. Relative references adjust automatically when copied to other cells. Absolute references 
($A$1, $B$2) stay fixed when copied.

Referencing	cells	in	formulas	allows	dynamic	calculations:
• Relative References: Reference cells relatively, like =A1 + B1.
• Absolute References: Fix cell references with dollar signs, e.g., =$A$1.
• Mixed References: Combine relative and absolute references, such as =$A1.

4.4. MATH AND STATISTICAL FUNCTIONS
Math and statistical functions enable you to quickly perform calculations that are integral to 
financial analysis and reporting. Excel’s functions cater to a wide range of mathematical and 
statistical needs. SUM calculates the sum of values in a range. AVERAGE computes the average 
of values in a range.MIN and MAX find the minimum and maximum values, respectively.

• SUM: Adds up a range of values, like =SUM (A1:A10).
• AVERAGE: Calculates the average of values, as in =AVERAGE (B1:B10).
• MIN and MAX: Find the smallest and largest values, e.g., =MIN (C1:C5).

4.5. LOGICAL FUNCTIONS
Logic functions helps to make decisions based on specific conditions.They are invaluable 
for accounting tasks that involve condition-based calculations. They allow you to automate 
decisions based on specific criteria.

IF function evaluates a condition and returns one value if true and another if false.AND and OR 
functions combine multiple conditions.NOT function negates a condition.

Logic	functions	aid	in	decision-making	by	evaluating	conditions:

IF Function: Evaluates a condition and returns one value if true and another if false. Syntax: 
=IF(condition, value_if_true, value_if_false).

 • Example: =IF(B2>100, “Above Target”, “Below Target”)
  • Explanation: In this example, if the value in cell B2 is greater than 100, the    
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formula returns “Above Target”; otherwise, it returns “Below Target.”

AND Function: Checks if all conditions are true. Syntax: =AND(condition1, condition2, ...).

OR Function: Checks if at least one condition is true. Syntax: =OR(condition1, condition2, ...).
  • Example: =AND(B2>100, C2<50)
  • Explanation: This formula checks if both conditions (B2>100 and C2<50) are true.   

 If both are true, the formula returns TRUE; otherwise, it returns FALSE.

NOT Function: Negates a condition.
 •  Syntax: =NOT(condition)
 • Example: =NOT(D2=”Pending”)
 • Explanation: The NOT function evaluates whether the value in cell D2 is not  

 equal to  “Pending.” If it’s not “Pending,” the formula returns TRUE; otherwise, it  
 returns FALSE.

4.6. TEXT FUNCTIONS
In financial tasks, dealing with textual data is common. Text functions help you manipulate, 
extract, and analyze text data. CONCATENATE combines text from different cells. LEFT and RIGHT 
extract characters from the beginning or end of a text.LEN calculates the length of a text string.

CONCATENATE Function: Combines text from different cells.
 • Syntax:=CONCATENATE(text1, text2, ...)

 • Example:=CONCATENATE(“Invoice #”, A2)

 • Explanation: This formula combines the text “Invoice #” with the value in cell A2.

LEFT and RIGHT Functions: Extract characters from the beginning or end of a text.
 • Syntax (LEFT):=LEFT(text, num_chars)

 • Syntax (RIGHT):=RIGHT(text, num_chars)

 • Example (LEFT):=LEFT(A2, 5)

 • Explanation: The LEFT function extracts the leftmost 5 characters from the value   
in cell A2.

LEN Function: Calculates the length of a text string.
 • Syntax: =LEN(text)

 • Example: =LEN(C2)

 • Explanation: The LEN function returns the number of characters in the value  
 of cellC2.

89



MS EXCEL

4.7. DATE AND TIME FUNCTIONS
Accounting often involves precise date-based calculations. Date and time functions ensure 
accurate handling of time-sensitive data. They are integral in financial calculations, particularly 
for managing payment schedules, interest accruals, and more. Excel’s date and time functions 
are vital for financial calculations:

TODAY and NOW Functions: Provide current date and time, respectively. 
• Syntax (TODAY):=TODAY()

• Syntax (NOW):=NOW()

• Example (NOW):=NOW()

• Explanation: The NOW function returns the current date and time.

EOMONTH Function: Calculates the end of the month based on a given date. 
• Syntax:=EOMONTH(start_date, months)

• Example:=EOMONTH(A2, 3)

• Explanation: This formula calculates the date that is 3 months after the value in cell A2.

DATEDIF Function: Computes the difference between two dates. 
• Syntax:=DATEDIF(start_date, end_date, unit)

• Example:=DATEDIF(B2, C2, “d”)

• Explanation: The DATEDIF function calculates the number of days between the dates in  
cells B2 and C2.

4.8. FINANCIAL FUNCTIONS
Excel includes specialized financial functions for accounting tasks. They are pivotal for calculating 
loan payments, investment returns, and assessing the present value of future cash flows.PMT 
calculates periodic loan payments.FV calculates future value of an investment.NPV computes 
the net present value of cash flows.

PMT Function: Calculates periodic loan payments.
 • Syntax:=PMT(rate, nper, pv)

 • Example:=PMT(0.05/12, 36, -10000)

 • Explanation: In this example, the formula calculates the monthly payment  
 for a loan of $10,000 with a 5% annual interest rate for 3 years (36 months).

FV Function: Computes future value of an investment.
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• Syntax:=FV(rate, nper, pmt, pv)

• Example:=FV(0.06/12, 24, -250, 0)

• Explanation: The formula calculates the future value of an investment where $250 is 
invested monthly for 2 years at a monthly interest rate of 0.5% (6% annually).

NPV Function: Calculates the net present value of cash flows.
• Syntax:=NPV(rate, value1, value2, ...)

• Example: =NPV(0.1, -10000, 3000, 4000, 5000)

• Explanation: This formula calculates the net present value of cash flows with a discount 
rate of 10%. The initial investment is -$10,000, and subsequent cash flows are $3,000, 
$4,000, and $5,000.

4.9. LOOKUP AND REFERENCE FUNCTIONS
Lookup functions assist in retrieving specific data from tables.They are invaluable when dealing 
with large datasets. They assist in retrieving precise information quickly and accurately.
VLOOKUP searches for a value in a table and returns a related value.HLOOKUP performs a similar 
operation horizontally. INDEX and MATCH together provide flexible lookup capabilities.

VLOOKUP (Vertical Lookup)Function: VLOOKUP stands for “Vertical Lookup,” and it is used to 
search for a value (lookup value) in the leftmost column of a table or range and retrieve a 
corresponding value from a specified column to the right of the lookup column. VLOOKUP is 
typically used when you have data organized in vertical column.

•  Syntax:=VLOOKUP( lookup_value, table_array, col_index_num, [range_lookup])
 

Explanation:
• lookup_value: The value you want to find in the leftmost column of the table_array.
• table_array: The range of cells that contains the data you want to search. The leftmost 

column should contain the lookup value.
• col_index_num: The column number (counting from the left) from which you want to 

return a value.
• range_lookup (optional): A logical value (TRUE/FALSE) that specifies whether to find an 

exact or approximate match. TRUE (or omitted) means approximate match, and FALSE 
means exact match.

 
Example: Suppose you have a table of product prices and you want to find the price of a product 
with the product code “A123.” You can use VLOOKUP as follows:
=VLOOKUP (“A123”, A2:B6, 2, FALSE) 
 • lookup_value: “A123”
 • table_array: A2:B6 (Assuming your data is in cells A2:B6)
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 • col_index_num: 2 (We want to retrieve the price from the second column)
 • range_lookup: FALSE (Exact match)

This formula would return the price associated with product code “A123.”

HLOOKUP Function: (Horizontal Lookup):HLOOKUP stands for “Horizontal Lookup,” and it is used to 
search for a value (lookup value) in the top row of a table or range and retrieve a corresponding 
value from a specified row below the lookup row. HLOOKUP is typically used when you have data 
organized in horizontal rows.

•   Syntax: =HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup]) 

Explanation:
 • lookup_value: The value you want to find in the topmost row of the table_array.
 • table_array: The range of cells that contains the data you want to search. The   
    topmost row should contain the lookup value.
 •  row_index_num: The row number (counting from the top) from which to 
    return a value.
 •   range_lookup (optional): A logical value (TRUE/FALSE) that specifies whether to find 
an exact or approximate match. TRUE (or omitted) means approximate match, and FALSE means 
exact match.

Example:
Suppose you have a table of employee information, and you want to find the department of an 
employee with employee ID “101.” You can use HLOOKUP as follows:

=HLOOKUP(“101”, A1:E3, 2, FALSE) 
 • lookup_value: “101”
 • table_array: A1:E3 (Assuming your data is in cells A1:E3)
 • row_index_num: 2 (We want to retrieve the department from the second row)
 • range_lookup: FALSE (Exact match)

This formula would return the department associated with employee ID “101.”

INDEX function: The INDEX function in Excel is a versatile tool that allows you to fetch a specific 
value from a table or range of data. It operates by specifying an array or range of data and 
then designating the row and, optionally, the column within that array from which you want to 
retrieve information. If you omit the column number, INDEX will return the entire row. This function 
is particularly useful when you need to extract data based on certain criteria or positions within 
a dataset.
 • Syntax:=INDEX(array, row_num, [column_num]) 
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 • array: The range or array from which you want to retrieve a value.
 • row_num: The row number that specifies which row within the array you want to  retrieve 
data from.

 •  column_num (optional): The column number that specifies which column within the 
array you want to retrieve data from. If omitted, INDEX will return the entire row specified 
by row_num.

MATCH function: The MATCH function in Excel is designed to locate a specified value within a 
given range or array. It scans through the data in the lookup_array and returns the relative 
position (either row or column number) of the lookup_value. By using the optional match_type 
argument, you can control whether you want to find an exact match, the closest smaller value, 
or the closest larger value. MATCH is commonly used to identify the position of a specific item in 
a list or dataset.

• Syntax:=MATCH(lookup_value, lookup_array, [match_type]) 

• lookup_value: The value you want to find within the lookup_array.

• lookup_array: The range or array where you want to search for the lookup_value.

• match_type (optional): A numerical value that specifies the type of match you 
want. 1 (or omitted) means find the largest value less than or equal to the lookup_
value, -1 means find the smallest value greater than or equal to the lookup_value, 
and 0 means find an exact match.

• Example: Suppose you are managing financial data for a company, and you 
have a table that contains employee names in column A and their corresponding 
salaries in column B. You want to find the salary of a specific employee, “John,” 
using the INDEX and MATCH functions.

Explanation:
• In cell C1, enter the name you want to search for, which is “John.”

• In cell D1, you can use the MATCH function to find the position of “John” in the list of 
employee names:=MATCH(C1, A1:A10, 0) 

• C1 contains the lookup value “John.”

• A1:A10 is the range where Excel will search for the lookup value.

• 0 specifies an exact match.

• In cell E1, you can use the INDEX function to retrieve John’s salary based on the 
position found by the MATCH function:=INDEX(B1:B10, D1) 

• B1:B10 is the range where Excel will retrieve the data (salaries).

• D1 contains the position found by the MATCH function.
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• The combined INDEX and MATCH formula in cell E1 will return John’s salary, and the result 
will be displayed there. This approach allows you to dynamically look up and retrieve 
data based on a specific criterion, which is a valuable skill for financial and accounting 
tasks.

INDEX and MATCH Functions: Combined, they provide flexible lookup capabilities.

• Syntax (INDEX): =INDEX(array, row_num, col_num)
• Syntax (MATCH):=MATCH(lookup_value, lookup_array, match_type)
• Example:=INDEX(C2:E10, MATCH(“Product B”, B2:B10, 0), 3)
• Explanation: The INDEX function uses the row number returned by the MATCH 

function to retrieve the value in the third column of the matched row.

4.10. ERROR HANDLING FUNCTIONS
Dealing with errors is essential in financial calculations. Handling errors effectively ensures that 
your financial calculations remain accurate and reliable.Accurate calculations are paramount 
in accounting. Error handling functions help you identify and address errors effectively.

ISERROR and ISNA functions check for errors in formulas.IFERROR function replaces errors with a 
specified value.NA function returns the #N/A error value.

• ISERROR and ISNA Functions: Check for errors in formulas.
• Syntax (ISERROR):=ISERROR(value)
• Syntax (ISNA):=ISNA(value)
• Example:=IF(ISERROR(B2/C2), 0, B2/C2)
• Explanation: The formula checks if division results in an error. If an error occurs, it returns 

0; otherwise, it calculates the division.

• IFERROR Function: Replaces errors with a specified value.
• Syntax:=IFERROR(value, value_if_error)
• Example:=IFERROR(AVERAGE(B2:B10), 0)
• Explanation: The formula calculates the average of values in the range B2:B10. If an error 

occurs, it returns 0.

• NA Function: Returns the #N/A error value.
• Syntax:=#N/A
• Example:=VLOOKUP(“Product X”, B2:E10, 3, FALSE)
• Explanation: If the value “Product X” is not found, the formula returns the #N/A error.
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SUMMARY

• Use operators (+, -, *, /) within formulas for addition, subtraction, multiplication, 
and division.Start a formula with the equals sign (=) followed by the mathematical 
expression.

• Excel offers a wide range of built-in functions for various calculations.

• Cell references allow for consistent calculations across cells.Relative references adjust 
automatically when copied to other cells.Absolute references stay fixed when copied.
Mixed references combine relative and absolute references.

• Functions like SUM, AVERAGE, MIN, and MAX is used to find totals, averages, minimums, 
and maximums in ranges.

• Logic functions aid in decision-making based on conditions.IF function evaluates 
conditions and returns values based on the results.AND and OR functions combine 
conditions, while NOT function negates conditions.

• Text functions help manipulate and analyze textual data.CONCATENATE combines text 
from different cells.LEFT and RIGHT extract characters from the beginning or end of text.
LEN calculates the length of a text string.

• Date and time functions are crucial for accurate time-sensitive calculations.TODAY 
and NOW functions provide current date and time.EOMONTH calculates the end of the 
month based on a date.DATEDIF computes the difference between two dates.

• Financial functions are specialized for accounting tasks.Functions like PMT, FV, and NPV 
are essential for loan calculations, investment returns, and present value calculations.

• Lookup functions retrieve specific data from tables.VLOOKUP searches for values in 
tables and returns related values.HLOOKUP performs similar operations horizontally.
INDEX and MATCH together provide flexible lookupcapabilities

• Error handling functions are crucial for accurate financial calculations. ISERROR and ISNA 
functions check for errors in formulas. IFERROR function replaces errors with specified 
values.NA function returns the #N/A error value
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MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the purpose of using basic arithmetic operations in Excel?
 a. To format cells
 b. To perform mathematical computations
 c. To add colors to cells
 d. To insert images

2. What does the formula “=SUM(A1:A10)” do in Excel?
 a. Adds the values in cells A1 to A10
 b. Subtracts the values in cells A1 to A10
 c. Multiplies the values in cells A1 to A10
 d. Divides the values in cells A1 to A10

3. What is the purpose of using cell references in formulas?
 a. To perform consistent calculations across multiple cells
 b. To change the font size of cells
 c. To add colors to cells
 d. To insert images

4. Which function is used to calculate the average of a range of values in Excel?
 a. AVERAGE
 b. SUM
 c. MAX
 d. MIN

5. What is the purpose of the IF function in Excel?
 a. To perform logical operations
 b. To calculate averages
 c. To concatenate text
 d. To find the maximum value in a range

6. Which function is used to combine text from different cells in Excel?
 a. CONCATENATE
 b. LEFT
 c. RIGHT
 d. LEN

7. What does the function =TODAY() return in Excel?
 a. Current time
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 b. Current date
 c. Current date and time
 d. Current year

8. Which function is used to calculate the future value of an investment in Excel?
 a. PMT
 b. FV
 c. NPV
 d. AVERAGE

9. What is the purpose of the VLOOKUP function in Excel?
 a. To search for a value in the leftmost column of a table
 b. To search for a value in the top row of a table
 c. To calculate the sum of a range of values
 d. To concatenate text

10. What function is used to find the position of a specific item in a list or dataset in Excel?
 a. VLOOKUP
 b. HLOOKUP
 c. INDEX
 d. MATCH

11. Which function checks for errors in formulas and returns TRUE if an error is found?
 a. ISERROR
 b. IFERROR
 c. ISNA
 d. NA

12. What is the purpose of the EOMONTH function in Excel?
 a. To calculate the end of the week
 b. To calculate the end of the month based on a given date
 c. To calculate the end of the year
 d. To calculate the end of the quarter

13. Which function is used to calculate periodic loan payments in Excel?
 a. PMT
 b. FV
 c. NPV
 d. SUM
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14. What does the function =DATEDIF(B2, C2, “d”) calculate in Excel?
 a. The number of days between the dates in cells B2 and C2
 b. The difference between two times
 c. The average of values in cells B2 and C2
 d. The product of values in cells B2 and C2

Answers
1. B. To perform mathematical computations
2. A. Adds the values in cells A1 to A10
3. A. To perform consistent calculations across multiple cells
4. A. AVERAGE
5. A. To perform logical operations
6. A. CONCATENATE
7. B. Current date
8. B. FV
9. A. To search for a value in the leftmost column of a table
10. D. MATCH
11. A. ISERROR
12. B. To calculate the end of the month based on a given date
13. A. PMT
14. A. The number of days between the dates in cells B2 and C2

SELF-EXAMINATION QUESTIONS FOR PRACTICE

1. Describe the importance of mastering formulas and functions in Excel, especially in the 
context of accounting and finance.

2. Explain the process of performing basic arithmetic operations in Excel formulas. Provide 
examples of each operation.

3. How do you start a formula in Excel? Why is the equals sign (=) important at the beginning 
of a formula?

4. Explain the concept of using built-in functions in Excel. How do these functions simplify 
complex calculations?

5. What is the syntax for using a function in Excel? How do you provide arguments to a 
function?
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6. Provide an example of using the SUM function to calculate the sum of values in a specific 
range.

7. What are cell references, and why are they important in Excel formulas?

8. Differentiate between relative references, absolute references, and mixed references in 
Excel formulas. Give examples of when each type of reference is useful.

9. Explain the purpose of math and statistical functions in Excel. Give examples of functions 
used for summing, averaging, finding minimums, and finding maximums.

10. How do logical functions assist in decision-making in Excel? Describe the IF function and 
provide an example of its usage.

11. Explain the roles of the AND, OR, and NOT functions in Excel. Provide examples of scenarios 
where these functions are useful.

12. Why are text functions important in financial tasks? Provide examples of how CONCATENATE, 
LEFT, RIGHT, and LEN functions are used.

13. Describe the significance of date and time functions in financial calculations. Explain the 
TODAY, NOW, EOMONTH, and DATEDIF functions.

14. How are financial functions in Excel helpful for accounting tasks? Provide examples of when 
to use the PMT, FV, and NPV functions.

15. Explain the purpose of lookup and reference functions in Excel. Provide examples of when 
to use the VLOOKUP, HLOOKUP, and INDEX-MATCH functions.

16. Describe the importance of error handling functions in financial calculations. How do 
ISERROR, ISNA, IFERROR, and NA functions help in dealing with errors?

17. Provide an example of using the IFERROR function to handle errors in a calculation.

18. Explain the process of using INDEX and MATCH functions together to perform a flexible 
lookup in Excel.

19. How can Excel’s functions be leveraged to streamline calculations and ensure accuracy in 
financial tasks?

20. In what scenarios might you need to use date and time functions in financial calculations? 
Give examples of specific calculations where these functions are useful.
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CHAPTER 5
CREATING CHARTS
     

LEARNING OBJECTIVES

a	 Understand the various types of charts available in Excel and their specific use 
cases in financial analysis and reporting.

a  Learn the step-by-step process of creating charts, including selecting data, 
choosing the appropriate chart type, and inserting and customizing the chart.

a  Familiarize yourself with design elements in charts, such as titles, legends, and 
data labels, and learn how to use them effectively for clear communication of 
data.

a	 Gain proficiency in formatting charts to ensure they are visually appealing, easy 
to read, and consistent with the overall document design.

a  Learn how to add context and emphasis to charts using data labels and callouts, 
enhancing the understanding of specific data points or trends.

Creating charts in Excel is a dynamic process, allowing you to explore various visualizations and 
tailor them to your data’s specifics. This section covers types of charts, steps involved in creating 
charts, chart design and formatting.

5.1. TYPES OF CHARTS
Charts are powerful tools for visualizing data, and there are various types of charts available 
in Excel, each suited for different data scenarios. Understanding these chart types and when 
to use them is crucial for effective data representation.Different types of charts serve varying 
purposes in financial analysis and reporting. Understanding when to use each type is essential 
for effectively conveying information.

The key chart types are:

 
Figure: Chart types
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1. Bar Charts: These are excellent for comparing data across different categories or groups. 
They can be either vertical or horizontal and can include stacked or clustered bars for 
added complexity.

2. Line Charts: Line charts are ideal for showing trends over time. They are often used to display 
data points connected by lines, making it easy to see how values change sequentially.

3. Pie Charts: Pie charts are useful when you want to display the parts of a whole. Each  
“slice” of the pie represents a portion of the total, with the size of each slice proportional to 
its value.

4. Scatter Plots: Scatter plots are used to visualize relationships or correlations between  
two sets of data. Points on the chart represent data pairs, making it easy to spot trends  
or clusters.

5. Area Charts: These are similar to line charts but with the area beneath the lines filled in, 
which can help emphasize proportions and trends over time.

6. Other Specialized Charts: Excel offers various specialized charts for specific needs. 
Waterfall charts are great for showing cumulative effects of sequential data changes. 
Radar charts are effective for multivariate comparisons, while bubble charts add a third 
dimension to your data visualization.

 

Figure: Chart types
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Examples
• Bar charts can be used for comparing revenue across different product categories.
• Line charts for tracking stock prices over several months.
• Pie charts for representing the distribution of expenses in a budget.

5.2. CREATING CHARTS
Excel makes it easy to create charts from your data. The Chart Wizard guides you through the 
process step by step, allowing you to customize your chart to meet your specifi c needs.

Steps to Create Charts
1. Select Data: Start by highlighting the data you want to include in the chart. Ensure you 

select both the labels and the corresponding values.
2. Insert Chart: After selecting your data, go to the “Insert” tab in Excel and choose the chart 

type that suits your data.

Figure: Chart group

3. Design Elements: Once your chart is created, you can customize various elements. These 
include adding a chart title, a legend, data labels, and more.

Figure: Chart elements
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4. Formatting: Excel offers extensive formatting options. You can adjust colors, styles, and 
fonts to match your document’s design.

Figure: Chart Styles, Change colors in Chart Design tab

Figure: Chart Styles, Change colors

5. Fine-Tuning: For further customization, you can right-click on individual chart elements 
(e.g., data series, data points) to make specifi c modifi cations.

Figure: Format data series, Format data labels option from right click
5.3. CHART DESIGN AND FORMATTING
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Design and formatting play a crucial role in the effectiveness of your charts. Properly designed 
charts are not only visually appealing but also easy to understand.
Design Tips:

1.	 Colors	and	Themes:	Choose color schemes that are visually appealing and easy to read. 
Excel provides themes that can help maintain consistency with yourdocument’s design.

 
Figure: layout of Charts

2. Labels and Titles: Always include descriptive chart titles and axis labels. This helps view-
ers quickly understand the chart’s context.

3. Gridlines and Axes: Adjust gridlines and axes to match the scale and granularity of your 
data. Gridlines should be present but not overpowering.

4. Data Labels: Data labels provide clarity by displaying exact values on the chart. You can 
choose to display values, percentages, or custom labels.

5. Legend:  Place the legend where it doesn’t obstruct the chart. If your chart has only a few 
data series, you can even label data directly instead of using a legend.

Effective design and formatting enhance the communication of your data and insights to your 
audience.
5.4.  DATA LABELS AND CALLOUTS

104



MS EXCEL

Data labels and callouts are essential tools for adding context and emphasis to your charts. 
They provide additional information about specifi c data points or trends.

5.4.1 ADDING DATA LABELS:
1. Select Data Series: To add data labels to a specifi c data series in your chart, right-click on 

the data series to access the “Add Data Labels” option.
2.	 Customize	Labels:	Excel allows you to customize data labels extensively. You can choose 

to display values, percentages, or custom text. Right-click on a data label to access 
formatting options.

Figure: Format data labels

5.4.2 USING CALLOUTS:
1. Insert Shape: To create a callout, go to the “Insert” tab in Excel and choose a shape from 

the “Shapes” menu. Typically, arrow or speech bubble shapes work well for callouts.
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Figure: Insert shapes

2. Add Text: Once you’ve inserted a shape, double-click it to add text. Enter the text you 
want to appear in the callout.

3. Positioning: Drag the callout to the desired location on the chart. You can use callouts to 
draw attention to specifi c data points or trends.

Thus, this module equips you with the knowledge and skills needed to create a variety of charts 
in Excel, choose the right chart type for your data, and enhance chart effectiveness through 
design, formatting, data labels, and callouts. Effective chart creation is essential for conveying 
fi nancial insights and analysis effectively.
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SUMMARY

• Key chart types include bar charts, line charts, pie charts, scatter plots, 

  area charts, and specialized charts.

• Steps to create charts include selecting data, inserting the chart, designing elements, 
formatting, and fine-tuning.

• Design and formatting significantly impact chart effectiveness.Consider color schemes, 
summarised title, appropriate gridlines, and clear data labels.

• Excel allows extensive customization of data labels, including displaying values, 
percentages, or custom text.

• Callouts are tools for emphasizing specific data points or trends in a chart.To create a 
callout, go to the “Insert” tab and choose a shape from the “Shapes” menu.Double-click 
the shape to add text and position it as needed.

     MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the purpose of a bar chart in Excel?
 a) Showing trends over time
 b) Comparing data across different categories
 c) Displaying parts of a whole
 d) Visualizing relationships between two sets of data

2. When would you use a line chart in Excel?
 a) To compare data across different categories
 b) To display trends over time
 c) To show parts of a whole
 d) To visualize relationships between two sets of data

3. Which type of chart is suitable for displaying the distribution of expenses in a budget?
 a) Bar Chart
 b) Line Chart
 c) Pie Chart
 d) Scatter Plot

4. In Excel, what does a scatter plot visualize?
 a) Trends over time
 b) Relationships or correlation between two sets of data
 c) Parts of a whole
 d) Comparison of data across different categories
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5. When might you use an area chart instead of a line chart?
 a) To emphasize proportions and trends over time
 b) To display data points connected by lines
 c) To compare data across different categories
 d) To visualize relationships between two sets of data

6. What does a pie chart represent in Excel?
 a) Trends over time
 b) Relationships or correlations between two sets of data
 c) Distribution of parts of a whole
 d) Comparison of data across different categories

7. What type of chart adds a third dimension to data visualization?
 a) Waterfall Chart
 b) Radar Chart
 c) Bubble Chart
 d) Area Chart

8. How do you start creating a chart in Excel?
 a) By selecting data and clicking the “Create Chart” button
 b) By selecting data and choosing the chart type from the “Insert” tab
 c) By typing the chart command in a cell
 d) By right-clicking on the data and selecting “Create Chart”

9. What step follows after selecting data when creating a chart in Excel?
 a) Customizing chart elements
 b) Inserting the chart
 c) Choosing the chart type
 d) Formatting the chart

10. What is an essential design tip for creating effective charts in Excel?
 a) Using random color schemes
 b) Including descriptive chart titles and axis labels
 c) Avoiding the use of gridlines
 d) Not providing a legend

11. How can you customize data labels in Excel?
 a) By right-clicking on a data label and selecting “Customize”
 b) By accessing the “Format Data Labels” option
 c) By pressing Ctrl+D while the data label is selected
 d) By double-clicking on the data label
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12. What is the purpose of a callout in a chart?
 a) Adding context and emphasis to specific data points or trends
 b) Highlighting the entire chart
 c) Adjusting the chart’s color scheme
 d) Providing a legend for the chart

13. How can you add a callout in Excel?
 a) By right-clicking on a data point and selecting “Add Callout”
 b) By going to the “Insert” tab and choosing a shape
 c) By typing a callout command in a cell
 d) By clicking on the chart title and selecting “Add Callout”

14. Which element is crucial for ensuring data clarity in a chart?
 a) Gridlines
 b) Legend
 c) Data Labels
 d) Axis Titles

ANSWERS
 1. b) Comparing data across different categories

 2. b) To display trends over time

 3. c) Pie Chart

 4. b) Relationships or correlations between two sets of data

 5. a) To emphasize proportions and trends over time

 6. c) Distribution of parts of a whole

 7. c) Bubble Chart

 8. b) By selecting data and choosing the chart type from the “Insert” tab

 9. b) Inserting the chart

 10. b) Including descriptive chart titles and axis labels

 11. b) By accessing the “Format Data Labels” option

 12. a) Adding context and emphasis to specific data points or trends

 13. b) By going to the “Insert” tab and choosing a shape

 14. c) Data Labels
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      SELF-EXAMINATION QUESTIONS FOR PRACTICE

1. What are the key advantages of using charts in financial analysis and reporting?

2. Name three common types of charts used in Excel and briefly explain when each one is 
most suitable.

3. You want to compare the quarterly sales of different products in your company. Which 
type of chart would you choose, and why?

4. Explain the steps involved in creating a chart in Excel.

5. What are the important elements you can customize when designing a chart in Excel?

6. Why is it essential to choose an appropriate color scheme and labelling for your 
charts?

7. Describe when it’s appropriate to use data labels in a chart, and how can they enhance 
data visualization?

8. What is the purpose of a legend in a chart, and where should it be placed for maximum 
clarity?

9. Explain the significance of gridlines and axes in chart design. How should you adjust 
them for different types of data?

10. How can you use callouts to draw attention to specific data points or trends in a chart?

110



MS EXCEL

CHAPTER 6
PIVOT TABLES

      LEARNING OBJECTIVES

a	 Understand the fundamental concept of pivot tables in MS Excel, including their purpose  
 and benefits.

a  Learn how to create pivot tables from raw data, selecting appropriate fields for rows,   
 columns, and values.

a  Explore advanced pivot table functionalities such as filtering, grouping, and custom   
 calculations to analyze data effectively.

a   Gain proficiency in formatting and customizing pivot tables to present data in a clear   
 and visually appealing manner.

a  Master the art of updating and refreshing pivot tables as new data becomes available,  
 ensuring data accuracy and relevance.

6.1. INTRODUCTION TO PIVOT TABLES
Pivot tables are a dynamic tool in Microsoft Excel that empowers users to extract insights from 
complex datasets. They enable users to reorganize and summarize data quickly, facilitating 
better decision-making.Pivot tables offer an efficient way to analyze large volumes of data, 
transforming it into understandable summaries. The user-friendly interface requires minimal 
technical expertise, making them accessible to a wide range of users.

6.1.1. BENEFITS OF PIVOT TABLES:
• Efficient Data Summarization: Pivot tables eliminate the need for manual calculations by 

automatically aggregating data. This ensures accuracy and saves valuable time.

• Flexibility: Users can effortlessly modify the arrangement of data fields, helping them 
gain diverse perspectives and insights from the same dataset.

• Quick Ad-Hoc Analysis: Pivot tables enable users to interactively dissect data, refining 
their analysis on-the-fly without altering the original dataset.

6.1.2. WHEN TO USE PIVOT TABLES:
• For Large Datasets: Pivot tables excel when handling substantial datasets where manual 

analysis would be impractical and time-consuming.
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• Exploratory Analysis: They’re invaluable for uncovering trends, patterns, and outliers, 
making them an indispensable tool for data exploration.

• Reporting: Pivot tables simplify the creation of concise, informative summary reports, 
aiding in effective communication of data-driven insights.

6.1.3. EXERCISE:
 Scenario: Imagine you’re an analyst at a retail company. You have a sales dataset 

containing product information, sales dates, quantities, and revenues.

 Task: Try using a pivot table to summarize total sales revenue by product categories and 
analyze trends over months.

6.2. CREATING PIVOT TABLES

6.2.1. SOURCE DATA SELECTION:
Instructions: The foundation of a pivot table is the data you select for analysis. This data range 
should include column headers to help Excel recognize fi eld names accurately.

Steps:
1. Select Data Range: Click any cell within your dataset.

2.	 Insert	PivotTable:	Go to the “Insert” tab on the Excel ribbon and click 
“PivotTable.” The “Create PivotTable” dialog box appears.

3.	 Defi	ne	Data	Range:	Ensure your data range is correctly displayed in the 
“Table/Range” fi eld.

4. Choose Location: Choose whether you want to place the pivot table in a 
new or existing worksheet.

5.	 Confi	rm:	Click “OK” to create the pivot table.

Figure: Tables group
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Figure: Create Pivot table window

6.2.2. CREATING A PIVOT TABLE:
Steps:

• PivotTable Field List: After creating the pivot table, the “PivotTable Field List” pane 
appears on the right.

• Drag and Drop Fields: Drag fi elds from the Field List into the following areas:
• Rows: Specify the criteria by which you want to categorize data vertically.
• Columns: Defi ne how you want to categorize data horizontally.
• Values: Choose fi elds to be summarized, such as sales amounts or quantities.
• View the Pivot Table: Excel generates the pivot table based on your fi eld selections.
• Modify Layout and Format: The “PivotTable Analyze” tab provides options to customize 

the layout, format, and calculations.

Figure: Pivot Table Fields
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Figure: Dragging items from Pivot table fi elds

Figure: Created Pivot table
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 Figure: Pivot table Analyze tab

Figure: Pivot table Analyze tab

6.2.3. EXERCISE:
Scenario: You’re managing HR data with employee details, departments, and salaries.
Task: Create a pivot table to display the average salary by department and analyze if there 
are any signifi cant variations.

6.3. PIVOT TABLE LAYOUT AND STRUCTURE
6.3.1. LAYOUT COMPONENTS:
Pivot tables consist of specifi c areas – rows, columns, values, and fi lters – that determine how 
data is organized and presented.

Row Area: Categorizes data vertically.

Column Area: Categorizes data horizontally.

Values Area: Displays summarized data.

Filter Area: Applies fi lters to limit data.

You can easily modify the pivot table structure by dragging fi elds between different areas of the 
Field List.

6.3.2. EXERCISE:
Move a “Region” fi eld from the Row Area to the Column Area to analyze sales trends by region.

6.4. MANAGING DATA SOURCE
6.4.1. UPDATING AND REFRESHING DATA:
Pivot tables are connected to source data. When the source data changes, you must refresh the 
pivot table to refl ect the updates.
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• Automatic Refresh: Pivot tables can be set to refresh automatically when the fi le is 
opened.

• Manual Refresh: Manually refresh by right-clicking the pivot table and selecting “Re-
fresh.”

Figure: Refresh pivot table option

6.4.2. HANDLING CHANGES:
If you add, remove, or modify data, refresh the pivot table to include those changes.

 Scenario: You add new sales data for the current month. Refreshing the pivot table will 
incorporate this new data.

6.4.3. CONNECTING TO EXTERNAL DATA:
You can connect pivot tables to external data sources such as databases or other Excel 
workbooks.
  
6.4.4. EXERCISE:
Connect a pivot table to a SQL database to directly analyze up-to-date sales records.

6.5. WORKING WITH PIVOT TABLE FIELDS
6.5.1. DATA FIELD TYPES:
Pivot tables have three main types of data fi elds: value fi elds, label fi elds, and calculated fi elds.

• Value Fields: Numeric data that is summarized (e.g., total sales).
• Label Fields: Categorical data used to categorize rows or columns (
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e.g., product categories).
• Calculated Fields: Custom calculations based on existing fi elds.

6.5.2.	Custom	Calculations	and	Calculated	Fields:
• Instructions: Create calculated fi elds by using mathematical expressions involving 

existing fi elds.
• Example: Calculate profi t margin by subtracting the cost from the revenue and dividing 

by revenue.

Figure: Calculated Field

Figure: Insert Calculated Field window
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6.5.3.	Formatting	and	Summarizing	Values:
Format value fi elds to enhance readability (e.g., currencysymbols, decimal places).Summarization 
Options choose how values are summarized (sum, average, count, etc.).
Example: Format a “Profi t” value fi eld to show as currency and summarize “Sales” as the sum.

Figure: Pivot table before number formatting

Figure: Value Field Settings Option
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Figure: Number formatting option in Value fi eld settings

Figure: Number formatting window
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Figure: Pivot table after number formatting

6.6. SORTING, FILTERING AND SLICING DATA
6.6.1. SORTING DATA:
Sort data within rows or columns to identify trends.
Example: Sort products by sales based on the Sum of Revenue in descending order.

Figure: More Sort options
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Figure: Sort option window

Figure: Sorted Pivot table

In the above fi gure, the data is sorted based on the Sum of Revenue in descending as chosen in 
the Sort options above.
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6.6.2. APPLYING FILTERS:
Use fi lters to focus on specifi c subsets of data in the pivot table.
Example: Apply a fi lter to show only sales data from a certain year.

Figure: Filter in Pivot table

6.6.2.1.  APPLYING VALUE-BASED FILTERS:
Use value-based fi lters to show specifi c data ranges.
Example: Filter sales data to show products with sales above a certain threshold.

Figure: Value Filter Option
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6.6.3 SLICERS AND TIMELINES
Slicers are interactive visual fi lters. Timelines offer easy fi ltering by dates.
Usage: Insert slicers for categorical fi elds like regions or timelines for date fi elds.

Figure: Slicer and Timeline in fi lter group

Figure: Insert Slicerswindow
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Figure: Inserted Slicer

Figure: InsertTimelines window

Figure: Inserted Timelines
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6.6.4 CONDITIONAL FORMATTING
Conditional formatting visually highlights cells based on specifi ed rules.
Example: Apply color scales to profi t values to visually identify high and low-profi t areas.
Scenario: Apply data bars to show relative sales performance. The longer the bar, the higher the 
sales.

Figure: Data bars in conditional formatting

Figure: Data Bar applied Pivot table
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SUMMARY

• Pivot tables in Excel empower users to extract insights from complex datasets quickly.

• Steps to create a pivot table involve selecting data, accessing the “Insert” tab, defining the 
data range, choosing the location, and confirming.

• Pivot tables are constructed by dragging fields from the PivotTable Field List to rows, 
columns, and values areas.

• Refresh pivot tables to reflect changes in source data.

• Filters are used to focus on specific subsets of data.

• Slicers and timelines enhance data filtering and visualization.

• Value-based filters allow showing specific data ranges.

• Conditional formatting can be combined with pivot tables to highlights cells  
based on rules.

MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the primary function of a Pivot Table in Microsoft Excel?
 a) Data entry
 b) Data summarization and analysis
 c) Data formatting
 d) Data encryption

2. When did the concept of Pivot Tables first emerge?
 a) 1960s
 b) 1970s
 c) 1980s
 d) 1990s

3. Which area of a Pivot Table is used to categorize data vertically?
 a) Rows
 b) Columns
 c) Values
 d) Filters

4. What is the purpose of refreshing a Pivot Table?
 a) To change its formatting
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 b) To update it with the latest data
 c) To delete it from the worksheet
 d) To apply conditional formatting

5. Which field type is used for custom calculations based on existing fields in a Pivot  
Table?

 a) Value Fields
 b) Label Fields
 c) Calculated Fields
 d) Summary Fields

6. How can you modify the layout and format of a Pivot Table in Excel?
 a) Through the Format menu
 b) By right-clicking and selecting “Format Table”
 c) Using the PivotTable Analyze tab
 d) None of the above

7. What is the purpose of using Slicers in a Pivot Table?
 a) To add color to the table
 b) To filter data interactively
 c) To create charts from the table
 d) To calculate custom fields

8. How can you sort data within rows or columns in a Pivot Table?
 a) By using the “Sort” option in the Home tab
 b) By right-clicking and selecting “Sort”
 c) Through the PivotTable Analyze tab
 d) All of the above

9. Which aspect of design and formatting plays a crucial role in the effectiveness of charts?
 a) Data labels
 b) Gridlines and axes
 c) Chart colors and themes
 d) Legend placement

10.In Excel, how can you adjust gridlines and axes in a chart?
 a) Through the Format menu
 b) By right-clicking on the chart
 c) Using the Chart Tools Design tab
 d) None of the above
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11. What is the primary function of the Chart Wizard in Excel?
 a) To create charts from Pivot Tables
 b) To format text in charts
 c) To add data labels to charts
 d) To delete existing charts

12. Which option allows you to automatically refresh a Pivot Table when the file is opened?
 a) Automatic Refresh
 b) Manual Refresh
 c) Refresh on Demand
 d) Refresh on Save

13. When creating a Pivot Table, why is it important for the source data to include column 
headers?

 a) To allow for automatic aggregation
 b) To help Excel recognize field names accurately
 c) To enable sorting and filtering
 d) To apply conditional formatting

14. What is the purpose of applying conditional formatting in a Pivot Table?
 a) To change the font size
 b) To highlight cells based on specified rules
 c) To create a chart from the table
 d) To add new data fields

ANSWERS
 1.  b) Data summarization and analysis
 2.  c) 1980s
 3.  a) Columns
 4.  b) To update it with the latest data
 5.  c) Calculated Fields
 6.  c) Using the PivotTable Analyze tab
 7.  b) To filter data interactively
 8.  d) All of the above
 9.  c) Chart colors and themes
 10.  b) By right-clicking on the chart
 11.  a) To create charts from Pivot Tables
 12.  a) Automatic Refresh
 13.  b) To help Excel recognize field names accurately
 14.  b) To highlight cells based on specified rules
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       SELF-EXAMINATION QUESTIONS FOR PRACTICE

1. Analyze why pivot tables are considered a powerful tool for data analysis.

2. Explain the step-by-step process of creating a pivot table in Excel.

3. Define the purpose of each area in a pivot table: Rows, Columns, Values, and Filters.

4. How would you handle changes in the source data (e.g., adding new data) to ensure 
your pivot table remains accurate?

5. Provide an example of a calculated field you might create to analyze data.

6. Describe the purpose of applying filters in a pivot table.

7. Use a scenario to explain when you would use a timeline in a pivot table.

8. What are slicers and how do they enhance data filtering in pivot tables?

9. Provide an example of how you might use conditional formatting to highlight data in a 
pivot table.
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CHAPTER 7
INTRODUCTION TO XML & SCHEMA, XML TO  
EXCEL TO XML

 LEARNING OBJECTIVES

a	 Understand the fundamentals of XML: Learn the basic syntax, structure,  
 and purpose of XML (Extensible Mark-up Language) and its role in data representation.

a  Mastery of XML Schema: Gain proficiency in creating XML Schema Definition (XSD)   
 documents to define and validate the structure and data types of XML documents.

a  XML to Excel Transformation: Learn techniques and tools to convert XML data into Excel  
 spreadsheets, enabling efficient data manipulation and analysis.

a	 Excel to XML Conversion: Explore methods to reverse the process and convert Excel data  
 back into XML format while preserving data integrity.

a  Practical Applications: Apply your knowledge to real-world scenarios, including   
 data interchange, integration, and reporting, using XML and Excel as essential data   
 transformation tools.

These learning objectives provide a comprehensive overview of the key concepts and skills that 
will be covered in the chapter. They aim to equip learners with a strong foundation in working 
with XML and understanding its practical applications in the financial sector.

7.1. INTRODUCTION TO XML (EXTENSIBLE MARKUP LANGUAGE)
XML, or eXtensible Markup Language, is a versatile data format used for structuring and storing 
information. It’s a text-based language that’s both human-readable and machine-readable. 
XML has become a standard for data exchange between different systems because of its 
simplicity and flexibility. XML uses tags to define elements and their relationships within a 
document, allowing you to create customized data structures.

Steps involved in Creating an XML Document for Book Inventory
1. Open a text editor like Notepad.
2. Define the XML prolog: <?xml version=”1.0” encoding=”UTF-8”?>.
3. Create the root element, e.g., <library>.
4. Add child elements for each book, with details like <title>, <author>, and <price>.
5. Close the root element </library>.
6. Save the file with a .xml extension.
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 Example XML Document for Book Inventory

<?xml version=”1.0” encoding=”UTF-8”?>
<library>
<book>
<title>Introduction to XML</title>
<author>John Doe</author>
<price>29.99</price>
</book>
<book>
<title>Data Science Essentials</title>
<author>Jane Smith</author>
<price>34.95</price>
</book>
</library>

7.2. XML SYNTAX AND RULES
XML documents follow a set of syntax rules. Each piece of data is enclosed in a tag, and tags are 
nested within one another to create a hierarchy. Tags must be properly opened and closed, and 
they are case-sensitive. Attributes provide additional information about elements. Well-formed 
XML documents adhere to these rules, making them valid and suitable for processing by XML 
parsers.

Steps of preparinga Well-Formed XML Document
1. Open a text editor.
2. Create a simple XML document with opening and closing tags.
3. Ensure all tags are properly nested and closed.
4. Make sure attributes are enclosed in double quotes.
5. Save and validate the XML using an online XML validator.

Example of a Well-Formed XML Document

<?xml version=”1.0” encoding=”UTF-8”?>
<data>
<item>Apple</item>
<item>Banana</item>
<item>Cherry</item>
</data>

7.3. XML DOCUMENT STRUCTURE
An XML document starts with a root element that encapsulates all other elements. Elements can 
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contain other elements, forming a hierarchical structure. This tree-like structure makes it easy 
to represent complex relationships and data structures. Additionally, XML allows you to define 
namespaces to avoid naming conflicts when using elements and attributes from different 
sources.

Steps involved in creating an XML document representing a Company’s Employee Hierarchy
1. Define the root element <company>.
2. Create child elements for departments, e.g., <hr>, <sales>.
3. Nest elements for employees within departments.
4. Use attributes like <employee id=”1”> for unique identification.
5. Add relevant data within each element.

Example XML document representing a Company’s Employee Hierarchy

<?xml version=”1.0” encoding=”UTF-8”?>
<company>
<department>
<name>HR</name>
<employee>John</employee>
<employee>Alice</employee>
</department>
<department>
<name>Sales</name>
<employee>Bob</employee>
<employee>Eve</employee>
</department>
</company>

7.4. DOCUMENT TYPE DEFINITION (DTD) AND XML SCHEMA
DTD and XML Schema are mechanisms used for validating the structure and content of XML 
documents. DTD is an older method and defines the allowed elements, attributes, and their 
order. XML Schema, on the other hand, provides a more powerful and flexible way to define data 
types, constraints, and relationships within an XML document. It’s a critical tool for ensuring data 
integrity in XML-based systems.

Steps involved increating an XML Schema for a Customer Database
1. Write an XML Schema with elements, attributes, data types, and constraints.
2. Define elements like <customer> with attributes for name and ID.
3. Specify data types, e.g., string, integer, for attributes.
4. Add constraints such as uniqueness or required elements.
5. Associate the XML document with the schema using schemaLocation.
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Example XML document for Creating an XML Schema for a Customer Database

<!-- XML Schema Definition (XSD) -->
<xs:schemaxmlns:xs=”http://www.w3.org/2001/XMLSchema”>
<xs:element name=”customer” type=”customerType”/>
<xs:complexType name=”customerType”>
<xs:sequence>
<xs:element name=”name” type=”xs:string”/>
<xs:element name=”id” type=”xs:int”/>
</xs:sequence>
</xs:complexType>
</xs:schema>

The provided code is an example of an XML Schema Definition (XSD) document used to define 
the structure and constraints for an XML document representing customer data. Let’s break 
down the code step by step:

1. <!-- XML Schema Definition (XSD) -->: This is a comment line that provides information 
about the purpose of the XML document. It indicates that this XML document is an XML 
Schema Definition.

2. <xs:schemaxmlns:xs=”http://www.w3.org/2001/XMLSchema”>: This is the root element 
of the XSD document. It defines the XML Schema itself. Let’s break down its components:
• <xs:schema>: This is the opening tag for the schema element, indicating that this 
document is an XML Schema.

• xmlns:xs=”http://www.w3.org/2001/XMLSchema”: This attribute defines the 
XML namespace for the “xs” prefix. In this case, it’s associated with the XML Schema 
namespace provided by the World Wide Web Consortium (W3C).

3. <xs:element name=”customer” type=”customerType”/>: This line defines an XML 
element called “customer” within the schema. Let’s dissect it:
• <xs:element>: This is the opening tag for the element definition.

• name=”customer”: This attribute specifies the name of the element, which is 
“customer” in this case.

• type=”customerType”: This attribute specifies the data type of the “customer” 
element. It references a complex type called “customerType,” which is defined 
elsewhere in the schema.

4. <xs:complexType name=”customerType”>: This line defines a complex type named 
“customerType” within the schema. Complex types are used to define the structure of 
elements that have child elements. Breakdown:
• <xs:complexType>: This is the opening tag for the complex type definition.
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• name=”customerType”: This attribute specifies the name of the complex type, which is  
“customerType” in this case.

5. <xs:sequence>: This line defines a sequence of child elements for the “customerType” 
complex type. It indicates that the elements defined inside the <xs:sequence> must appear 
in a specific order within an XML instance document.

6. <xs:element name=”name” type=”xs:string”/>: This line defines an element named 
“name” within the “customerType” complex type. Breakdown:
• <xs:element>: This is the opening tag for the element definition.

• name=”name”: This attribute specifies the name of the element, which is “name.”

• type=”xs:string”: This attribute specifies the data type of the “name” element. In this 
case, it’s a string.

7. <xs:element name=”id” type=”xs:int”/>: This line defines an element named “id” within 
the “customerType” complex type. Breakdown:
• <xs:element>: This is the opening tag for the element definition.

• name=”id”: This attribute specifies the name of the element, which is “id.”

• type=”xs:int”: This attribute specifies the data type of the “id” element. In this case, it’s 
an integer.

In summary, the provided XML Schema (XSD) defines the structure of an XML document 
representing customer data. It specifies that the document must contain a “customer” element, 
which in turn must contain a “name” element (with a string data type) and an “id” element 
(with an integer data type). This XSD provides a blueprint for creating valid XML documents that 
conform to this structure.

7.5. XML DATA TRANSFORMATION
XML data transformation involves changing the structure or presentation of XML data. XSLT 
(eXtensible Stylesheet Language Transformations) is commonly used for this purpose. XSLT scripts 
can convert XML data into various formats, such as HTML, plain text, or other XML documents. This 
transformation capability is valuable for presenting data in different ways without altering the 
underlying data.

Steps involved intransforming XML Sales Data into HTML Report
1. Write an XSLT stylesheet that specifies the transformation rules.
2. Define templates for elements you want to transform.
3. Apply styles, formatting, and layout instructions in the XSLT.
4. Use an XSLT processor to apply the stylesheet to your XML data.
5. Save the transformed output as an HTML file.

Example XML document for transforming XML Sales Data into HTML Report
(Note: XSLT examples can be extensive. This is a simplified example.)

134



MS EXCEL

XML Data:
<?xml version=”1.0” encoding=”UTF-8”?>
<sales>
<sale>
<product>Widget</product>
<quantity>50</quantity>
<revenue>2500.00</revenue>
</sale>
<!-- ... More sales data ... -->
</sales>
XSLT for HTML Transformation:
<!-- XSLT stylesheet -->
<xsl:stylesheet version=”1.0” xmlns:xsl=”http://www.w3.org/1999/XSL/Transform”>
<xsl:template match=”/”>
<html>
<head>
<title>Sales Report</title>
</head>
<body>
<h1>Sales Report</h1>
<table border=”1”>
<tr>
<th>Product</th>
<th>Quantity</th>
<th>Revenue</th>
</tr>
+

<?xml version=”1.0” encoding=”UTF-8”?>
<sales>
<sale>
<product>Widget</product>
<quantity>50</quantity>
<revenue>2500.00</revenue>
</sale>
<!-- ... More sales data ... -->
</sales>
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<tr>
<xsl:for-each select=”sales/sale”>
<td><xsl:value-of select=”product”/></td>
<td><xsl:value-of select=”quantity”/></td>
<td><xsl:value-of select=”revenue”/></td>
</tr>
</xsl:for-each>
</table>
</body>
</html>
</xsl:template>
</xsl:stylesheet>

The provided code consists of an example XML document and an associated XSLT (eXtensible 
Stylesheet Language Transformations) stylesheet for transforming the XML data into an HTML 
sales report. Let’s break down each part:

XML Data:
This XML data represents sales information, including products, quantities sold, and revenue. It 
starts with a root element <sales> and contains multiple <sale> elements, each representing a 
sale.

• <sales>: The root element that encapsulates all sales data.
• <sale>: Child elements representing individual sales, including product, quantity,  

and revenue.

XSLT for HTML Transformation:

<!-- XSLT stylesheet -->
<xsl:stylesheet version=”1.0” xmlns:xsl=”http://www.w3.org/1999/XSL/Transform”>
<xsl:template match=”/”>
<html>
<head>
<title>Sales Report</title>
</head>
<body>
<h1>Sales Report</h1>
<table border=”1”>
<tr>
<th>Product</th>
<th>Quantity</th>
<th>Revenue</th>
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</tr>
<xsl:for-each select=”sales/sale”>
<tr>
<td><xsl:value-of select=”product”/></td>
<td><xsl:value-of select=”quantity”/></td>
<td><xsl:value-of select=”revenue”/></td>
</tr>
</xsl:for-each>
</table>
</body>
</html>
</xsl:template>
</xsl:stylesheet>

This XSLT stylesheet defines rules for transforming the XML sales data into an HTML sales report. 
Let’s break down the key elements:

• <xsl:stylesheet>: This element declares the XSLT stylesheet. It specifies the XSLT version 
and defines the namespace for XSLT using xmlns:xsl.

• <xsl:template match=”/”>: This template defines how the root element of the XML (/) 
should be transformed. It represents the starting point of the transformation.

• <html>, <head>, <title>, <body>, <h1>, <table>, <tr>, <th>, <td>: These are HTML elements 
that are included in the output HTML. The XSLT stylesheet essentially generates an HTML 
structure.

• <xsl:for-each select=”sales/sale”>: This construct iterates over each <sale> element 
within the <sales> element in the XML data. For each <sale>, it generates an HTML table 
row (<tr>) and extracts values from the <product>, <quantity>, and <revenue> elements to 
populate the table cells (<td>).

• <xsl:value-of select=”product”/>, <xsl:value-of select=”quantity”/>, <xsl:value-of 
select=”revenue”/>: These elements extract and output the values of the <product>, 
<quantity>, and <revenue> elements from the XML data into the HTML table cells.

In summary, this XSLT stylesheet takes the provided XML sales data and transforms it into an HTML 
sales report. It generates an HTML table with headers for “Product,” “Quantity,” and “Revenue,” 
and then populates the table rows with data from each <sale> element in the XML. This is a 
simplified example of how XSLT can be used to convert XML data into various output formats, in 
this case, HTML.
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7.6. USING XML WITH EXCEL
Excel supports importing XML data directly into spreadsheets. This feature allows you to bring 
external data sources into Excel for analysis, reporting, and further manipulation. Excel offers 
tools for mapping XML elements to specific cells or columns in your worksheet, giving you control 
over how XML data is presented.

Steps involved in Importing XML Sales Data into Excel
(Note: This example assumes that you have an XML file with sales data.)

1. Open Excel and create a new worksheet.
2. Go to the “Data” tab and select “From XML” or “Get Data.”
3. Choose the XML file you want to import.
4. Excel will prompt you to map XML elements to cells or columns.
5. Review the import settings and load the data into Excel.

7.7. EXCEL TO XML CONVERSION
Conversely, Excel can export spreadsheet data into XML format. This is useful when you need to 
share structured data with systems that require XML input. Excel provides options for mapping 
Excel tables and worksheets to XML elements and attributes, allowing you to tailor the XML 
structure to your needs.

Steps involved in Exporting Excel Sales Data to XML
1. In Excel, open the worksheet with the data you want to export.
2. Go to the “File” menu and select “Save As.”
3. Choose “XML Data (*.xml)” as the file format.
4. Excel will prompt you to map cells to XML elements.
5. Review the mapping and save the file as XML.

7.8. XML DATA MANIPULATION IN EXCEL
Excel provides various features for working with XML data once it’s imported. You can filter, sort, 
and query XML data as you would with any other Excel data. Additionally, you can use Excel 
formulas and functions to perform calculations or create new data based on XML content.

Steps involved in using Excel Formulas with Imported XML Data
(Note: This example assumes you have imported XML sales data into Excel.)

1. Import XML data into Excel as explained previously.

2. In Excel, use formulas like SUM, AVERAGE, or IF to analyze XML data.

3. Create calculated columns based on XML data.You can calculate the total revenue, 
average quantity sold, or any other relevant metrics based on the imported data.

4. Visualize results using Excel charts or tables.
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7.9. XML VALIDATION AND ERROR HANDLING
XML validation ensures that an XML document conforms to its defined structure and data types. 
XML Schema can be used to specify the expected format and content of an XML document. 
Validation is essential for data integrity and preventing errors. Excel provides options for 
validating XML data during import and handling validation errors gracefully.

Steps involved in Validating XML Data in Excel
1. Import XML data into Excel.
2. Excel will automatically validate data based on the associated schema.
3. Review validation results in Excel’s “XML Source” task pane.
4. Handle validation errors by correcting or marking problematic data.

7.10. A SCENARIO FOR PRACTICAL APPLICATION
Real-world applications of XML in the financial industry are numerous. For instance, XML is 
commonly used for exchanging financial data between different accounting systems, for 
regulatory reporting, and for data interoperability (the ability to access and process data from 
multiple sources without losing meaning and then integrate that data for visualization, and other 
forms of representation and analysis). 

A financial analyst can use Excel to import XML data containing quarterly financial reports. The 
XML data is transformed into a structured Excel format using XSLT. Excel formulas are applied to 
calculate key financial ratios, and the data is presented in visually appealing charts. The analyst 
then exports the Excel report back to XML for sharing with stakeholders.

SUMMARY

7.1. INTRODUCTION TO XML (EXTENSIBLE MARKUP LANGUAGE):
• XML is a versatile data format used for structuring and storing information.
• It is both human-readable and machine-readable.
• XML is widely used for data exchange between different systems due to its simplicity and 

flexibility.
• XML uses tags to define elements and their relationships within a document, allowing for 

customized data structures.
• Steps to create an XML document for book inventory include defining the XML prolog, 

creating the root element, adding child elements for each book, and saving the file with a 
.xml extension.

7.2. XML SYNTAX AND RULES:
• XML documents follow specific syntax rules.
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• Data is enclosed in tags, which are case-sensitive.
• Tags must be properly nested and closed.
• Attributes provide additional information about elements.
• Well-formed XML documents adhere to these rules and are suitable for processing by XML 

parsers.
• Steps for preparing a well-formed XML document include ensuring proper nesting, closing 

tags, and enclosing attributes in double quotes.

7.3. XML DOCUMENT STRUCTURE:
• An XML document starts with a root element that encapsulates all other elements.
• Elements can contain other elements, creating a hierarchical structure.
• XML’s hierarchical structure is useful for representing complex relationships and data 

structures.
• Namespaces are used to avoid naming conflicts when using elements and attributes from 

different sources.
• Steps to create an XML document representing a company’s employee hierarchy involve 

defining the root element, creating child elements for departments, nesting elements for 
employees, and using attributes for unique identification.

7.4. DOCUMENT TYPE DEFINITION (DTD) AND XML SCHEMA:
• DTD and XML Schema are used for validating the structure and content of XML documents.
• DTD defines allowed elements, attributes, and their order.
• XML Schema provides a more powerful way to define data types, constraints, and 

relationships.
• XML Schema is crucial for ensuring data integrity in XML-based systems.
• Steps to create an XML Schema for a customer database include defining elements, 

attributes, data types, constraints, and associating the XML document with the schema.

7.5. XML DATA TRANSFORMATION:
• XML data transformation involves changing the structure or presentation of XML data.
• XSLT (eXtensible Stylesheet Language Transformations) is commonly used for this purpose.
• XSLT can convert XML data into various formats, such as HTML.
• Transformation allows for presenting data differently without altering the underlying data.
• Steps to transform XML sales data into an HTML report include writing an XSLT stylesheet, 

defining templates, applying styles, using an XSLT processor, and saving the transformed 
output.

7.6. USING XML WITH EXCEL:
• Excel supports importing XML data directly into spreadsheets.
• This feature allows for bringing external data sources into Excel for analysis and reporting.
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• Tools in Excel enable mapping XML elements to specific cells or columns for data 
presentation.

• Steps for importing XML sales data into Excel involve selecting the XML file, mapping 
elements, and loading the data.

7.7. EXCEL TO XML CONVERSION:
• Excel can export spreadsheet data into XML format.
• This is useful for sharing structured data with systems that require XML input.
• Excel allows mapping Excel tables and worksheets to XML elements and attributes.
• This customization tailors the XML structure to specific needs.
• Steps for exporting Excel sales data to XML include mapping cells, reviewing mapping, and 

saving as XML.

7.8. XML DATA MANIPULATION IN EXCEL:
• Excel provides features for working with imported XML data.
• You can filter, sort, and query XML data.
• Excel formulas and functions can be used to perform calculations based on XML content.
• Calculated columns can be created to derive metrics from imported data.
• Visualizations like charts and tables can be used to present results.

7.9. XML VALIDATION AND ERROR HANDLING:
• XML validation ensures conformance to structure and data type rules.
• XML Schema can specify the expected format and content.
• Excel validates XML data during import and handles errors gracefully.
• Validation results can be reviewed in Excel’s “XML Source” task pane.
• Validation errors should be corrected or marked for handling.

7.10. A SCENARIO FOR PRACTICAL APPLICATION:
• XML is widely used in the financial industry for data exchange, regulatory reporting, and 

interoperability.
• Excel can be used to import XML data for financial analysis.
• XSLT can transform XML data into structured Excel format.Excel formulas can calculate 

financial metrics. The data can be presented using charts.
• The Excel report can be exported back to XML for sharing with stakeholders.
 

These takeaways cover the key concepts and practical applications of XML and XML-
related processes in Excel, making it a valuable module for handling structured data.
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MULTIPLE CHOICE QUESTIONS (MCQS)

1. What does XML stand for?
 a.  eXtensible Markup Language
 b.  eXtra Modern Language
 c.  Extended Markup Language
 d.  Extended Modern Language

2. Which of the following is a step involved in creating a basic XML document?
 a.  Define the XML prolog
 b.  Insert images
 c.  Use JavaScript code
 d.  Apply styles using CSS

3. Which of the following is a characteristic of well-formed XML documents?
 a.  Properly nested tags
 b.  Case-insensitive tags
 c.  Single-line structure
 d.  No attribute usage

4. In XML, what is used to encapsulate all other elements in a document?
 a.  Root element
 b.  Parent element
 c.  Container element
 d.  Core element

5. What is the purpose of namespaces in XML?
 a.  To define attributes
 b.  To avoid naming conflicts
 c.  To create hyperlinks
 d.  To apply styles

6. Which mechanism is used for validating the structure and content of XML documents?
 a.  DTD (Document Type Definition)
 b.  CSS (Cascading Style Sheets)
 c.  SQL (Structured Query Language)
 d.  HTML (HyperText Markup Language)
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7. What does XML Schema provide a fl exible way to defi ne within an XML document?
 a.  Data types, constraints, and relationships
 b.  Document formatting
 c.  Hyperlinks
 d. Images

8. In XML Schema, what is used to ensure the uniqueness of elements or attributes?
 a.  Constraints
 b.  Datatypes
 c.  Uniqueness validators
 d.  Key elements

9. What is the role of XSLT in XML data transformation?
 a.  Converting XML data to binary format
 b.  Converting XML data to various formats
 c.  Storing XML data in databases
 d.  Validating XML data

10. Which element in XSLT represents the starting point of the transformation process?
 a.  xsl:apply-templates
 b.  <xsl:template match=”/”>
 c.  xsl:transform
 d.  xsl:output

11. In Excel, how can XML data be imported into a spreadsheet?
 a.  From CSV fi les
 b.  From XML fi les
 c.  From PDF fi les
 d. From Word documents

12. What is the purpose of Excel to XML conversion?
 a.  Exporting Excel data to XML format
 b.  Importing XML data into Excel
 c.  Converting XML data to JSON format
 d.  Creating charts in Excel

13. In Excel, what is used to validate imported XML data based on the associated schema?
 a.  XML Validator
 b.  Data Checker
 c.  XML Source task pane
 d.  Excel Inspector
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14. Which of the following is an example of a practical application scenario for XML in the 
financial industry?

 a.  Storing images in XML format
 b.  Exchanging financial data between accounting systems
 c.  Creating interactive web pages
 d. Analyzing social media trends

15.What is the key advantage of using XML for data exchange between different systems?
 a.  Complexity
 b.  Flexibility
 c.  Narrow applicability
 d.  Incompatibility

Answers
1. eXtensible Markup Language
2. Define the XML prolog
3. Properly nested tags
4. Root element
5. To avoid naming conflicts
6. DTD (Document Type Definition)
7. Data types, constraints, and relationships
8. Constraints
9. Converting XML data to various formats
10. <xsl:template match=”/”>
11. From XML files
12.  Exporting Excel data to XML format
13.  XML Source task pane
14.  Exchanging financial data between accounting systems
15.  Flexibility

     
SELF-EXAMINATION QUESTIONS FOR PRACTICE

1. XML Basics
 a. Define XML and explain its significance in data exchange.
 b. What is the structure of an XML document? 
 c. Explain the purpose of XML tags.

2. Creating XML Documents
 a. Describe the steps involved in creating a well-formed XML document. 
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 b. Provide an example of an XML document representing a personal address book. 
 c. How are attributes used in XML? Give an example.

3. XML Document Structure
 a. Explain the hierarchical structure of XML documents using an example. 
 b. What is the purpose of namespaces in XML? Give an example.

4. Document Type Definition (DTD) and XML Schema
 a. Compare and contrast DTD and XML Schema for XML validation.
 b. Describe the steps to create an XML Schema for a product catalog. 
 c. Why is XML Schema considered more powerful than DTD?

5. XML Data Transformation
 a. What is XSLT, and how is it used for XML data transformation? 
 b. Provide an example of transforming XML data into HTML using XSLT. 
 c. Explain the role of templates in XSLT.

6. Using XML with Excel
 a. How does Excel support importing XML data? 
 b. Describe the steps involved in importing XML sales data into Excel. 
 c. Why is mapping XML elements important in Excel?

7. Excel to XML Conversion
 a. Explain the process of exporting Excel sales data to XML. 
 b. What is the purpose of mapping cells to XML elements during export? 
 c. Provide a scenario where Excel to XML conversion is useful.

8. XML Data Manipulation in Excel
 a. How can Excel formulas be used with imported XML data? 
 b. Give an example of using Excel functions with XML data. 
 c. What visualizations can be used to present XML data in Excel?

9. XML Validation and Error Handling
 a. What is XML validation, and why is it important? 
 b. Describe how Excel handles XML validation and errors. 
 c. Explain the steps to correct validation errors in Excel.

10. Practical Applications
 a. Provide real-world examples of how XML is used in the financial industry. 
 b. Describe a scenario where Excel and XML are used together for financial analysis and 

reporting. 
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CHAPTER 8
INTRODUCTION TO JSON AND SCHEMA  
MAPPING WITH MS EXCEL

LEARNING OBJECTIVES

a	 Understand the fundamentals of JSON (JavaScript Object Notation)  
 and its role in data interchange.

a  Learn how to efficiently import JSON data into Microsoft Excel and manipulate it 
 effectively.

a  Explore the concept of schema mapping and its importance in data transformation  
 processes.

a	 Gain practical experience in mapping JSON data to Excel worksheets using various  
 Excel functions and techniques.

a  Develop the skills to automate JSON data retrieval and mapping workflows for  
 improved data management and analysis in Excel.

These learning objectives aim to provide a comprehensive understanding of utilizing JSON, JSON 
Schema, and Excel for effective financial data management, covering various aspects from 
schema mapping to practical applications in financial scenarios.

8.1. UNDERSTANDING JSON (JAVASCRIPT OBJECT NOTATION)
8.1.1. INTRODUCTION TO JSON AS A DATA INTERCHANGE FORMAT
JSON, short for JavaScript Object Notation, is a lightweight and widely used data interchange 
format. It is easy for both humans and machines to read and write. JSON is often employed to 
transmit data between a server and a web application, as well as between different parts of an 
application.

8.1.2. COMPARISON BETWEEN JSON AND XML
JSON is often compared to XML, another popular data interchange format. While XML uses 
tags and attributes to structure data, JSON uses a simpler format of key-value pairs. JSON is 
more concise and easier to read for humans, making it a preferred choice for many modern 
applications.

146



MS EXCEL

8.1.3. ADVANTAGES OF USING JSON IN DATA EXCHANGE
JSON offers several advantages, including simplicity, ease of parsing (the process of converting 
a JSON object in text format to a JavaScript object that can be used inside a program), and 
efficient data transmission. It is particularly well-suited for web APIs and web services due to its 
lightweight nature.

8.2. JSON SYNTAX AND STRUCTURE
8.2.1. JSON objects, arrays, and key-value pairs
In JSON, data is organized into objects andarrays. Objects are enclosed in curlybraces {} and 
consist of key-value pairs. Arrays are ordered lists of values enclosed in square brackets [].
Example of JSON Array:[“apple”, “banana”, “cherry”]

This example is a JSON array containing three string values.

8.2.2. RULES FOR WRITING VALID JSON: 
JSON has strict syntax rules. For example, keys must be enclosed in double quotes, and strings 
must be enclosed in double quotes as well. Commas are used to separate key-value pairs or 
elements in an array.

8.2.3. EXAMPLES ILLUSTRATING JSON DATA STRUCTURES: 
Examples of JSON data structures, including simple objects, nested objects, and arrays are given 
below. See how data is represented in JSON format.

1.  Simple JSON Object: This represents a simple JSON object with key-value pairs.
{
    “name”: “John Doe”,
    “age”: 30,
    “city”: “New York”
}

2. Nested JSON Object: This demonstrates a JSON object with nested objects.
{
    “employee”: {
        “name”: “John Doe”,
        “job”: {
            “title”: “Software Engineer”,
            “department”: “Development”
        },
        “salary”: 80000
    }
}
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3. JSON Array: This shows a JSON array with multiple items.
[
    “apple”,
    “banana”,
    “cherry”
]

4. Nested JSON Array and Object: This combines arrays and nested objects.
{
    “company”: “ABC Inc.”,
    “employees”: [
        {
            “name”: “Alice”,
            “department”: “HR”
        },
        {
            “name”: “Bob”,
            “department”: “Sales”
        }
    ]
}

These examples illustrate the flexibility of JSON in representing structured data, from simple key-
value pairs to complex nested structures and arrays.

8.3. CREATING JSON DOCUMENTS
Sample JSON Document:
This is a sample JSON document representing a book with properties such as title, author, and 
publication year.

{
  “book”: {
    “title”: “The Great Gatsby”,
    “author”: “F. Scott Fitzgerald”,
    “year”: 1925
  }
}

8.3.1. STEPS FOR MANUALLY CREATING JSON DOCUMENTS USING A TEXT EDITOR: 
Given below is the process of creating JSON data from scratch using a plain text editor like 
Notepad. Have included the examples of defining objects, arrays, and key-value pairs.
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1. Open a Text Editor (e.g., Notepad).
2. Start with an Object:

 • JSON data begins with an object enclosed within curly braces {}.
3. Add Key-Value Pairs:

 • Inside the object, add key-value pairs separated by colons.
 • Keys must be enclosed in double quotes, and values can be strings, numbers, or 

other    JSON data types.
4. Use Commas to Separate Pairs:

 • Separate key-value pairs with commas (no comma after the last pair).
5. Nested Objects:

 • You can nest objects within objects by adding objects as values.
6. Arrays:

 • Arrays are enclosed in square brackets [] and can contain multiple values.
 • Arrays can also contain objects.

7. Save the File:
 • Save the file with a .json extension (e.g., “data.json”).

These steps allow you to manually create JSON data using a text editor. 
Ensure proper formatting, including indentation, for better readability.

8.3.2. TOOLS AND LIBRARIES FOR GENERATING JSON DATA:
Generating JSON data manually can be time-consuming, especially for complex structures. 
To streamline this process, various tools and libraries are available that automate JSON data 
generation. Here are the various options available for the same:

1. Programming Languages:
Many programming languages come with built-in support for generating JSON data. 

For example:
• In Python, the json module allows you to create JSON data structures from native 

Python data types.
• In JavaScript, you can directly create JSON objects and arrays within your code.

2. Online Generators:
• Several online tools and websites offer JSON data generation. These tools often 

provide user-friendly interfaces for defining JSON structures and values. Users can 
input data, and the tool generates the corresponding JSON.

• Online generators are helpful for quick and simple JSON creation without writing 
code.

3. Software Libraries:
• Specialized software libraries and packages are available for generating JSON data. 
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These libraries are often used in specific development environments or frameworks.
• For example, in web development, libraries like Jackson in Java or Newtonsoft.Json in 

C#(pronounced as “C sharp”) simplify JSON generation from data objects.
4. Code Templates:

• Developers can create code templates or scripts that generate JSON data based on 
predefined patterns. These templates can be reused to create JSON for similar data 
structures.

 
8.3.3. BEST PRACTICES FOR ORGANIZING AND FORMATTING JSON DATA:
Maintaining consistency and readability in JSON data is essential for easy understanding and 
debugging. Here’s an explanation of best practices for organizing and formatting JSON data:

1. Consistent Indentation:
• Use consistent and meaningful indentation to represent the hierarchy of objects and 

arrays. Typically, each level of nesting is indented by a fixed number of spaces (e.g., 
2 or 4 spaces).

• Consistent indentation makes the JSON structure visually clear and helps developers 
quickly grasp the hierarchy.

2. Clear Key Naming:
• Choose descriptive and meaningful key names. Key names should represent the 

data they hold and follow a consistent naming convention. Avoid using overly 
abbreviated or cryptic names.

• Clear key naming improves the understanding of data and enhances maintainability.
3. Use Arrays and Objects Appropriately:

• Use JSON arrays [...] when dealing with lists of similar items (e.g., a list of products).
• Use JSON objects {...} when modelling structured data with key-value pairs (e.g., 

representing a person’s attributes).
• Properly choosing between arrays and objects ensures the data structure accurately 

represents the information.
4. Validation and Schema Compliance:

• Ensure that the generated JSON adheres to a predefined schema or structure. Using 
a JSON schema helps validate data consistency and conformity.

• Compliance with a schema aid in data validation and integration with systems that 
expect specific JSON structures.

5. Comments (where supported):
• Some JSON parsers allow comments (though it’s not part of the official JSON 

standard). You can use comments to provide additional context or explanations 
within the JSON data.

• Comments can be helpful for documenting JSON structures.

By following these best practices, developers can create well-organized and maintainable JSON 
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data, making it easier for themselves and others to work with the data in various applications 
and scenarios.

8.4. JSON Schema
A JSON Schema is a JSON document that specifies the structure, constraints, and validation 
rules for JSON data. It acts as a blueprint that specifies what the JSON data should look like, 
including the expected properties, their data types, and any validation criteria.

Example of a JSON Schema:
{
  “$schema”: “http://json-schema.org/draft-07/schema#”,
  “type”: “object”,
  “properties”: {
    “name”: {
      “type”: “string”
    },
    “age”: {
      “type”: “integer”,
      “minimum”: 18
    }
  },
  “required”: [“name”, “age”]
}

This is an example of a JSON Schema using JSON Schema Draft 7. It defines the structure of an 
object with properties “name” (string type) and “age” (integer type with a minimum value of 18). 
It also specifies that both “name” and “age” are required properties.

8.4.1. THE ROLE OF JSON SCHEMA IN DEFINING STRUCTURE AND VALIDATION OF JSON DATA
JSON Schema plays a crucial role in ensuring the structure, consistency, and validity of JSON 
data. Here’s a breakdown of its role:

• Defining Allowed Properties: JSON Schema allows you to specify which properties 
(fields) are allowed within a JSON document. For instance, if you’re working with JSON 
data representing employees, you can define that each employee object must have 
properties like “name,” “age,” and “department.” This ensures that your JSON data 
adheres to a consistent structure.

• Data Type Specification: JSON Schema lets you define the data types expected for 
each property. You can specify that “name” should be a string, “age” should be a 
number, and “department” should be a string as well. This ensures that the data 
conforms to the intended types.
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• Validation Rules: JSON Schema allows you to set validation rules for properties. For 
instance, you can specify that the “age” property must be a positive integer, ensuring 
that the age is always represented as a valid positive whole number. These validation 
rules help maintain data integrity.

• Optional vs. Required Fields: JSON Schema lets you define which properties are 
required and which are optional. For example, you can specify that “name” and 
“age” are required fields, meaning they must be present in every JSON object, while 
“department” is optional. This enforces consistency in your data.

• Complex Structures: JSON Schema is not limited to simple properties. It can describe 
complex structures, including nested objects and arrays. This is particularly useful 
when dealing with hierarchical or nested data.

• Formal Definition: JSON Schema provides a formal, machine-readable definition 
of your JSON data’s structure. This means that both humans and machines can 
understand the expected structure and data types.

In essence, JSON Schema acts as a blueprint for your JSON data. It defines the rules and 
constraints that JSON data must adhere to, ensuring that data remains consistent, valid, and 
predictable.

8.4.2. KEY CONCEPTS IN JSON SCHEMA
JSON Schema introduces several key concepts to achieve its goals:

• Properties: Properties in JSON Schema are like the fields or attributes of your JSON 
data. They represent the key-value pairs within a JSON object. Each property can 
have its own data type, validation rules, and other attributes.

• Required Fields: You can specify which properties are required using the “required” 
keyword. This ensures that certain properties must be present in every JSON object 
that adheres to the schema. For example, in an employee schema, you might require 
that “name” and “age” are always present.

• Data Types: JSON Schema supports various data types, including strings, numbers, 
booleans, objects, and arrays. You can specify the expected data type for each 
property, ensuring that your data remains consistent.

• Nested Objects: JSON Schema allows you to define objects within objects. This is 
useful for representing complex, nested data structures. For example, an “address” 
property might contain sub-properties like “street,” “city,” and “postalCode.”

• Arrays: JSON Schema also supports arrays. You can define that a property should be 
an array containing items of a particular data type. This is handy for scenarios where 
you have a list of items, such as “employees” containing multiple employee objects.

• Validation Keywords: JSON Schema provides a set of validation keywords that 
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allow you to set constraints on properties. For example, you can use “minimum” and 
“maximum” to specify allowable numeric ranges, ensuring that values fall within a 
certain range.

• Pattern Constraints: JSON Schema supports pattern constraints using regular 
expressions. This is particularly useful for validating string properties with specific 
patterns, like email addresses or phone numbers.

• Default Values: You can set default values for properties. If a property is missing in 
a JSON object, it will be automatically assigned the default value specified in the 
schema.

In summary, JSON Schema introduces a rich set of concepts and tools for defining and validating 
the structure and content of JSON data. These concepts help maintain data consistency, improve 
data quality, and ensure that your JSON data aligns with your application’s requirements.

8.5. CREATING JSON SCHEMA

8.5.1. STEPS TO CREATE A JSON SCHEMA FOR A SPECIFIC JSON DATA FORMAT
Step 1: Start with a Basic JSON Schema Template

{
  “$schema”: “http://json-schema.org/draft-07/schema#”,
  “type”: “object”,
  “properties”: {
    // Add your properties here
  },
  “required”: []
}

Step 2: Define the Object Properties In the properties section, define the properties you 
expect in your JSON data. For example, in a financial context, let’s say we want to create a 
JSON Schema for a transaction:

{
  “transaction_id”: {
    “type”: “string”
  },
  “amount”: {
    “type”: “number”,
    “minimum”: 0
  },
  “currency”: {
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    “type”: “string”,
    “enum”: [“USD”, “EUR”, “GBP”]
  },
  “timestamp”: {
    “type”: “string”,
    “format”: “date-time”
  }
}

Here, we have properties like transaction_id, amount, currency, and timestamp. We specify their 
data types and any additional constraints. For example, the “amount” must be a non-negative 
number, and “currency” must be one of the specified values.

Step 3: Specify Required Properties In the required section, list the properties that are mandatory 
in your JSON data:
“required”: [“transaction_id”, “amount”, “currency”, “timestamp”]
This ensures that these properties must be present in any valid JSON data conforming to this 
schema.

8.5.2. VALIDATION OF JSON DATA AGAINST A JSON SCHEMA
After creating a JSON Schema as shown above, the next step is to validate JSON data against this 
schema. This is crucial to ensure that the data adheres to the specified format and constraints.
How Validation Works:
Use a JSON Schema Validation Library.There are libraries available in various programming 
languages (e.g., ajv in JavaScript) that allow you to load your JSON Schema and use it to validate 
JSON data.

Example Code for JavaScript using ajvLibrary
Assuming you have the JSON Schema saved in a file named schema.json and your JSON data in 
a file named data.json, here’s how you can validate it using JavaScript and the ajv library:

constAjv = require(“ajv”);
const fs = require(“fs”);
// Load the JSON Schema
const schema = JSON.parse(fs.readFileSync(“schema.json”, “utf-8”));
// Load the JSON Data
const data = JSON.parse(fs.readFileSync(“data.json”, “utf-8”));
// Create an instance of Ajv
constajv = new Ajv();
// Compile the schema
const validate = ajv.compile(schema);
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// Validate the data
constisValid = validate(data);
if (isValid) {
console.log(“JSON data is valid according to the schema.”);
} else {
console.log(“JSON data is not valid.”);
  console.log(validate.errors);
}

Handling Validation Errors:
If the JSON data doesn’t conform to the schema, validation errors will be raised. These errors 
typically include details about what went wrong. For instance, it might indicate that a required 
property is missing or that a value is out of range. In a financial context, these errors can be 
critical as they may indicate data integrity issues.

8.5.3. COMMON USE CASES FOR JSON SCHEMA IN DATA VALIDATION:

1. Validating User Input in Web Forms:
• Scenario: In a financial application, a user is entering their transaction details. The 

JSON Schema ensures that the data entered, such as account numbers or transaction 
amounts, meets the required format and constraints.

• Benefits: Prevents erroneous data submissions, enhancing user experience and data 
accuracy. It also reduces the risk of security vulnerabilities by validating user inputs 
rigorously.

2. Ensuring Data Consistency in Databases:
• Scenario: Large financial databases store customer profiles, transaction history, and 

investment data. JSON Schema ensures that data consistently adheres to predefined 
standards, avoiding discrepancies.

• Benefits: Guarantees data consistency, which is vital for accurate financial analysis, 
regulatory reporting, and compliance.

3. Verifying the Correctness of JSON-based APIs (Application Programming Interface):
• Scenario: Many financial applications use APIs for data exchange. JSON Schema 

ensures that data exchanged via APIs is accurate and follows the expected structure, 
reducing the risk of processing incorrect data.

• Benefits: Enhances the reliability of API-based financial services. Minimizes data-
related errors in processes like algorithmic trading or account balance queries.

In the financial sector, where data accuracy and compliance are paramount, JSON Schema 
validation ensures that data conforms to predefined standards, reducing errors, improving data 
quality, and enhancing trust in financial systems and applications.
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Note: API (Application Programming Interface) in Context:

An API, short for Application Programming Interface, is a set of rules and protocols that allows 
different software applications to communicate and interact with each other. APIs define how 
requests and responses should be structured, which functions or data can be accessed, and 
what actions can be performed by one software component when interacting with another.

8.6. SCHEMA MAPPING
8.6.1. UNDERSTANDING THE SCHEMA MAPPING CONCEPT:
Schema mapping is a fundamental concept in data management and integration. It involves 
defining relationships and correspondences between elements in different schemas. These 
schemas can represent various data structures, such as JSON data, database tables, or XML 
documents. It’s a critical step in data integration.

Schema mapping involves associating JSON properties with database table columns or Excel 
cells. It ensures data is correctly imported, mapped, and validated.

Example Scenario - Mapping JSON to Database:
Consider a scenario where you have JSON data representing customer information, and you want 
to store this data in a relational database. Schema mapping, in this case, involves associating 
the properties in the JSON data with specific columns in a database table.

JSON Property:
{
  “name”: “John”,
  “age”: 30
}
Database Table:
| ID | Name | Age |
|----|-------|-----|
| 1  | John  | 30  |

In this example, you’ve mapped the “name” property in the JSON data to the “Name” column 
in the database table and the “age” property to the “Age” column. This mapping ensures that 
the JSON data is correctly imported, and the data fields are aligned with their corresponding 
database columns.

8.6.2. HOW SCHEMA MAPPING RELATES TO DATA TRANSFORMATION AND INTEGRATION
Schema mapping is closely related to data transformation and integration processes. Here’s 
how it fits into these processes:

1. Data Transformation: Data often comes in various formats and structures. Schema 
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mapping plays a pivotal role in transforming data from one schema to another. 
For instance, you might need to convert XML data into a JSON object, and schema 
mapping defines how elements in the XML map to properties in the JSON object.

2. Data Integration: Data integration involves combining data from diverse sources or 
systems to provide a unified view. Schema mapping ensures that data from different 
sources is harmonized, allowing for effective data integration. For example, you may 
integrate customer data from both a CRM system and an e-commerce platform into 
a single database. Schema mapping ensures that the customer data from these two 
sources aligns in terms of structure.

8.6.3. IMPORTANCE OF SCHEMA MAPPING IN DATA CONSISTENCY:
The importance of schema mapping in data consistency cannot be overstated. Here’s why:

1. Structural Consistency: Schema mapping helps maintain structural consistency by 
ensuring that data elements from different sources adhere to a common structure 
or schema. This consistency simplifies data processing and analysis.

2. Format Consistency: It also ensures format consistency, meaning data is represented 
uniformly. For instance, when integrating data from multiple sources into a reporting 
tool like Excel, schema mapping ensures that date formats, numerical precision, and 
other data formatting conventions are consistent.

3. Quality Assurance: Schema mapping acts as a quality assurance step, reducing the 
risk of data anomalies or discrepancies during data integration. This is particularly 
crucial in financial applications, where data accuracy is paramount.

In summary, schema mapping is a foundational concept in data management and integration. 
It defines how data elements in different schemas relate to each other and plays a pivotal role 
in ensuring data consistency, facilitating data transformation, and supporting seamless data 
integration in various scenarios, including financial applications.

8.7. SCHEMA MAPPING WITH MS EXCEL
8.7.1. WHY MICROSOFT EXCEL CAN BE USED FOR SCHEMA MAPPING?
Microsoft Excel is a powerful and versatile tool that can be effectively used for schema mapping 
and data transformation. Here’s why Excel is valuable for this purpose:

• Familiar Interface: Excel’s spreadsheet layout is familiar to many users, making it 
accessible for mapping and working with structured data. Financial professionals, in 
particular, are often well-versed in using Excel for various tasks.

• Data Visualization: Excel provides a clear and structured way to visualize data, making 
it easier to map and understand data relationships.
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8.7.2. IMPORTING JSON DATA INTO EXCEL FOR MAPPING
Scenario: Imagine you have a JSON dataset containing financial transactions, and you want to 
analyze and map this data in Excel for further processing and reporting.

Steps to Import JSON Data into Excel
1. Open Microsoft Excel.

2. Click on the “Data” tab in the Excel ribbon.

3. Select “Get Data” or “Get & Transform Data,” depending on your Excel version.

4. Choose the data source. In this case, you’d select “From JSON” since you want to import 
JSON data.

5. Browse to the location of your JSON file and select it.

6. Excel will then open the Power Query Editor, where you can preview and transform your 
JSON data.

7. You can perform various transformations and data cleaning tasks using the Power Query 
Editor. For example, you can filter columns, remove unnecessary data, and rename col-
umns to align with your desired schema.

8. Once you’ve prepared the data, click “Close & Load” to import the JSON data into an Excel 
worksheet.

Advantages of Using Excel for Importing JSON Data:
• Data Transformation: Excel’s Power Query tools allow you to transform and clean 

the data during import, ensuring it matches your desired schema.

• User-Friendly: The import process is user-friendly, even for those without extensive 
programming experience.

8.7.3. CREATING EXCEL TABLES AND WORKSHEETS TO REPRESENT JSON DATA STRUCTURES
Scenario: Let’s say your JSON data contains a list of financial transactions, each with attributes 
like date, description, amount, and category. You want to map this data to an Excel table.

Steps to Create Excel Tables and Worksheets:
1. After importing your JSON data, it will be loaded into a new worksheet in Excel.

2. Select the data range you want to work with.

3. Click on the “Insert” tab in the Excel ribbon.

4. Choose “Table.” This will convert your selected data range into an Excel table.

5. You can then rename the table and its columns to match your desired schema. For ex-
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ample, you can rename columns like “Column1” to more descriptive names like “Date,” 
“Description,” “Amount,” and “Category.”

6. You can create additional worksheets or tabs in your Excel file to represent different JSON 
data structures, such as objects or arrays.

In summary, Microsoft Excel’s familiar interface and data manipulation capabilities make it a 
valuable tool for schema mapping and data transformation in financial scenarios. Excel allows 
you to import JSON data, clean and transform it to match your desired schema, and work with 
the data efficiently, supporting various financial analysis and reporting tasks.

8.8. MAPPING JSON ELEMENTS TO EXCEL CELLS

8.8.1. STEPS TO MAP JSON ELEMENTS TO EXCEL CELLS
Scenario:  You have a JSON dataset containing financial transaction records. You want to map 
specific elements of this JSON data to corresponding cells in an Excel worksheet for further 
analysis.

1. Import JSON Data: Import the JSON data into an Excel worksheet following the steps 
mentioned earlier.

2. Identify Elements: Review your JSON data and identify the specific elements you 
want to map to Excel cells. For example, if your JSON contains transaction details, you 
might want to map “Date,” “Description,” and “Amount.”

3. Select the Excel Cell: In your Excel worksheet, select the cell where you want to map 
the first JSON element. For instance, you might select cell A2 for “Date.”

4. Input Element: Type an Excel formula to extract the desired JSON element. You can 
use Excel’s built-in functions for this purpose. For example, if the JSON is in cell B2 and 
you want to extract the “Date” element, you can use the following formula:

 =JSON.VALUE(B2, “Date”)

Suppose your JSON data looks like this:

{ “transaction”: { “date”: “2023-08-15”, “description”: “Groceries”, “amount”: 50.00,                             
“category”: “Food” } } 

You can map the “date” element to cell A2 in Excel by entering the 
formula=TransactionData[@[date]] in cell A2.

5. Repeat for Other Elements: Repeat the process for other elements you want to map. 
For example, in cell B2, you can input a formula to extract the “Description” element:

 =JSON.VALUE(B2, “Description”) 
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6. Drag/Fill Down: If you have multiple rows of JSON data, you can drag or fill down the 
formulas to apply them to all rows.

8.8.2. HANDLING NESTED JSON STRUCTURES AND ARRAYS IN EXCEL:
Scenario: Your JSON data contains nested structures or arrays, such as transactions within an 
account. You want to map these nested elements to Excel tables and rows.

Steps for Handling Nested JSON Structures and Arrays:
1. Import your JSON data into Excel and create a table for the main JSON structure, 

such as accounts.

2. Identify the nested JSON elements you want to map, such as individual transactions 
within each account.

3. Create a new worksheet or table in Excel to represent the nested data. For example, 
create a table named “Transactions” to hold transaction data.

4. Use Excel formulas or Power Query to extract and map the nested JSON data to the 
corresponding Excel table. You can use functions like FILTER or VLOOKUP to accomplish 
this.

5. Ensure that you maintain data integrity by correctly associating nested data with its 
parent data. For example, each transaction should be associated with the correct 
account.

Scenario:
Suppose you have JSON data like this:

{
  “customer”: “John Doe”,
  “transactions”: [
    {
      “date”: “2023-01-15”,
      “description”: “Purchase 1”,
      “amount”: 50.00
    },
    {
      “date”: “2023-02-05”,
      “description”: “Purchase 2”,
      “amount”: 75.50
    }
  ]
}
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Step-by-Step Instructions:
1.  Import JSON Data into Excel:

• Copy your JSON data.

• In Excel, select the cell where you want to start the import. For example, you can 
select cell A1.

• Go to the “Data” tab in Excel.

• Click on “Get Data” or “Get & Transform Data” (this might vary slightly depending on 
your Excel version).

• Choose “From Text/JSON.”

• Paste your JSON data into the dialog box and click “Load.”

 Excel will import your JSON data into a table in the worksheet.

2. Working with Nested JSON Arrays:
• In this example, the “transactions” field is an array. To work with it, you can use Excel’s 

built-in Table functionality.

• Click anywhere within the table that contains the JSON data.

• Go to the “Table Design” tab (this might be named differently in older Excel versions).

• In the “Properties” group, give your table a meaningful name, like “TransactionData.”

• Now, you can work with the array data efficiently.

3. Mapping Nested JSON Elements:
• In your Excel worksheet, you can add columns to map the elements within the JSON 

array.

• For example, you can add columns “Date,” “Description,” and “Amount.”

• In the cell next to the “Date” column header, type the following formula to extract the 
“date” element from the JSON array:=INDEX(TransactionData[date],ROW()-1) 

• TransactionData[date] references the “date” column in your JSON data table.

• ROW()-1 ensures that the formula starts from the second row (since the first row 
contains column headers).

• Similarly, add formulas for the “Description” and “Amount” columns:

• For “Description”: =INDEX(TransactionData[description],ROW()-1) 

• For “Amount”:=INDEX(TransactionData[amount],ROW()-1) 

4.  Drag/Fill Down:
• After entering the formulas for one row, you can fill down these formulas for all rows 

in the Excel table. Excel will automatically adjust the references.
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• Click on the small square in the lower-right corner of the cell containing the formula 
(the cursor will change to a small black cross).

• Drag this down to fill all the rows you need. Excel will copy the formulas accordingly.

5. Result:
Your Excel worksheet should now contain a structured representation of the nested JSON 
array data, with each transaction in a separate row.

 
 Date Description Amount

 2023-01-15 Purchase 1 50.00

 2023-02-05 Purchase 2 75.50

This example demonstrates how to handle nested JSON arrays in Excel and extract data 
from them into separate rows. Excel’s built-in Table functionality and formulas like INDEX are 
valuable tools for such data manipulation.

8.8.3. MAPPING JSON PROPERTIES TO EXCEL COLUMN HEADERS
Scenario: You want to ensure that the column headers in your Excel worksheet match the JSON 
properties, providing clear labelling and structure to your data.

Steps for Mapping JSON Properties to Excel Column Headers
1. Open your Excel worksheet where you’ve imported JSON data.

2. Review the JSON properties and identify the Excel columns where you want to place 
the corresponding data.

3. Rename the Excel column headers to match the JSON property names. This ensures 
that your data is appropriately labelled and structured.

4. To rename an Excel column header, simply double-click on the existing header, type 
the desired name, and press Enter.

Example:
Suppose your JSON data has properties like “transaction_date,” “transaction_description,” 
“transaction_amount,” and “transaction_category.” You can rename the Excel column headers 
to match these properties for clarity.

In summary, mapping JSON elements to Excel cells involves identifying the data you want to 
map, using appropriate Excel formulas or functions to extract JSON elements, handling nested 
structures or arrays, and ensuring that Excel column headers align with JSON properties for clear 
labelling and structured data representation.
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8.9. DATA TRANSFORMATION AND VALIDATION
8.9.1. USING EXCEL FORMULAS AND FUNCTIONS TO TRANSFORM JSON DATA

Excel offers a powerful set of formulas and functions that can be used to manipulate and 
transform JSON data within Excel. Here’s a scenario and a step-by-step example:
Scenario: You have JSON data containing sales transactions in various currencies, and you want 
to convert them to a single currency and calculate the total revenue.

Step-by-Step Instructions:
1. Import JSON Data into Excel:

• First, you’ll need to import your JSON data into Excel using the steps discussed earlier 
on the same topic.

2. Create a Currency Conversion Table:
Create a table or a list that contains currency conversion rates. For example:

 Currency Conversion Rate

 USD  1.00

 EUR  0.85

 GBP  0.73

 JPY  110.25

3. Perform Currency Conversion:
• In Excel, create a new column where you want to display the converted amounts 

(e.g., “Amount in USD”).

• Use Excel’s VLOOKUP function to convert amounts from different currencies to USD. 
Assuming your JSON data has currency information in the “Currency” column and 
the original amount in the “Amount” column, you can use a formula like this:

 =B2 * VLOOKUP(A2, CurrencyConversionTable, 2, FALSE) 

• B2 references the original amount in the current row.

• A2 references the currency in the current row.

• CurrencyConversionTable is the table containing conversion rates.

• 2 specifies that you want to retrieve the conversion rate.

• FALSE ensures an exact match.

4. Calculate Total Revenue:
• In a new cell, you can calculate the total revenue by using the SUM function: 
 =SUM(D2:Dn) 
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 D2:Dn refers to the range of converted amounts (e.g., “Amount in USD”).

8.9.2. Validating JSON Data Against a Predefined JSON Schema Within Excel
Excel doesn’t have built-in native support for JSON Schema validation. However, you can set up 
a basic validation check using Excel’s features. Here’s an example scenario:

Scenario: You have JSON data representing customer information, and you want to ensure that 
each record contains essential fields such as “name” and “email.”

1. Define Required Fields:
•  Create a list of required fields in your JSON data. In this case, you need “name” and 

“email.”

2. Use Excel’s Data Validation:
• Select the cells or columns where your JSON data is imported.

• Go to the “Data” tab in Excel.

• Choose “Data Validation.”

• In the “Data Validation” dialog box, select “Custom.”

• In the “Formula” field, you can use a formula like this to check if both “name” and 
“email” are present in each row:

=AND(ISNUMBER(SEARCH(“name”, A2)), ISNUMBER(SEARCH(“email”, A2))) 
This formula checks if both “name” and “email” exist in cell A2 (modify the cell reference 
as needed).

• If this formula returns TRUE, the data is considered valid. If FALSE, there’s a validation 
error.

3. Handling Validation Errors:
• You can set up conditional formatting to highlight rows with validation errors or use 

Excel’s built-in error checking features.

• For more advanced JSON Schema validation, you might need to use VBA (Visual 
Basic for Applications) to create custom validation functions.

Scenario: You have JSON data representing invoices, and you want to validate if the “total-
Amount” in each invoice is greater than zero.
Step-by-Step Instructions:

1. Open Excel and Press Alt + F11 to Open the VBA Editor:

 • This is where you’ll write your custom validation script.

2. Insert a New Module:
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 • In the VBA editor, go to Insert>Module to create a new module.

3. Write a Custom Validation Function:

 • Write a VBA function that parses the JSON data and validates it against your JSON 
Schema. Below is a simplified example:

Function ValidateInvoice(json As String) As Boolean
    ‘ Parse the JSON string (you’ll need a JSON library reference)
    Dim jsonObject As Object
    Set jsonObject = JsonConverter.ParseJson(json)

    ‘ Check if the totalAmount is greater than zero
    If jsonObject(“totalAmount”) > 0 Then
ValidateInvoice = True
    Else
ValidateInvoice = False
    End If
End Function

This function takes a JSON string as input, parses it using a JSON library (you need to 
reference a JSON library in VBA), and checks if the “totalAmount” is greater than zero.

4.  Call the Validation Function:

• You can call this function from an Excel cell like this:=ValidateInvoice(A2) 

• A2 contains the JSON data you want to validate.

8.9.3. HANDLING ERRORS AND INCONSISTENCIES DURING DATA TRANSFORMATION:
Handling errors and inconsistencies is vital to maintain data quality during the transformation 
process. Here are some best practices:

• Use Data Validation Rules: Implement data validation rules to check data consistency 
and correctness during transformation.

• Error Handling: In VBA, you can use error handling techniques to gracefully manage 
errors during transformation.

• Logging: Create logs or reports to record errors and inconsistencies encountered 
during data transformation. This can help identify and resolve issues efficiently.

• Testing: Thoroughly test your data transformation process with various datasets 
to identify and address potential problems before deploying it in a production 
environment.
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• Feedback Mechanism: If the data transformation process involves user interaction, 
provide feedback to users about errors and inconsistencies, and guide them on how 
to correct them.

These best practices ensure that your data transformation process is reliable, even when dealing 
with complex transformations and potential errors.

8.10. SCENARIOS AND PRACTICAL APPLICATIONS OF JSON, JSON SCHEMA,  
AND EXCEL
Below are some scenarios where financial professionals applying JSON, JSON Schema, and Excel 
for practical tasks, such as financial analysis, data integration, or reporting, and get benefits of 
automating data integration tasks with JSON and Excel including time savings and reduced 
error rates.

8.10.1. AUTOMATING FINANCIAL DATA INTEGRATION
Scenario: A financial services company receives daily data feeds from various banks and 
financial institutions, each providing data in a different format (XML, JSON, CSV). They need to 
consolidate and integrate this data for analysis and reporting.

Application: JSON and JSON Schema can be used to standardize the data format. Excel can be 
used for data transformation and consolidation.

Benefits:
• Automation: JSON Schema ensures incoming data adheres to a standardized structure.

• Efficiency: Excel can automate the transformation and consolidation process.

• Data Consistency: JSON Schema enforces data consistency across sources.

• Accuracy: Reduced manual data entry leads to fewer errors.

8.10.2. FINANCIAL ANALYSIS AND REPORTING
Scenario: An investment firm manages a portfolio of stocks and bonds. They receive daily market 
data in JSON format from multiple sources. Analysts need to calculate portfolio performance 
metrics and generate reports.

Application: JSON data can be imported into Excel for analysis. JSON Schema ensures data 
consistency. Excel formulas calculate metrics and generate reports.

Benefits:
• Real-time Analysis: JSON data import allows for real-time analysis.

• Custom Reports: Excel’s flexibility enables custom report generation.

• Data Quality: JSON Schema ensures data quality and consistency.

• Efficiency: Automation reduces manual work.
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8.10.3. RISK MANAGEMENT WITH JSON SCHEMA
Scenario: A bank needs to assess credit risk by analyzing data from different departments. JSON 
data (e.g., customer profiles, transaction history) is collected. Validation and standardization 
are critical.

Application: JSON Schema validates incoming data. Excel is used to create dashboards for risk 
analysis.

Benefits:
• Data Integrity: JSON Schema ensures data integrity.

• Risk Assessment: Excel’s data visualization tools help in risk assessment.

• Compliance: Ensures compliance with data standards.

• Efficiency: Reduces manual data validation efforts.

8.10.4. Automating Financial Data Feeds
Scenario: An accounting firm receives financial statements from clients in various formats (PDF, 
Excel, CSV). They need to extract structured data for analysis and tax preparation.

Application: JSON Schema can be used to define structured data. JSON data is generated from 
extracted data and then imported into Excel for further analysis.

Benefits:
• Structured Data: JSON Schema defines the structure of data extraction.

• Data Consistency: Ensures consistent data format.

• Accuracy: Reduced manual data entry errors.

• Automation: Saves time during data processing.

8.10.5. FINANCIAL DATA VALIDATION AND COMPLIANCE
Scenario: A financial regulator requires investment firms to submit quarterly reports in JSON 
format. Compliance and data quality are essential.

Application: JSON Schema defines the required report structure and data types. Excel can 
validate data against the schema before submission.
Benefits:

• Compliance: Ensures data conforms to regulatory standards.

• Data Quality: Validation against JSON Schema improves data quality.

• Efficiency: Identifies and rectifies data issues early.

• Documentation: Schema acts as documentation for report structure.
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In these scenarios, JSON, JSON Schema, and Excel work together to streamline data-related 
tasks, improve accuracy, and enhance reporting capabilities for financial professionals. The 
combination of structured data, schema validation, and automation provides significant 
benefits in terms of efficiency and data quality.

SUMMARY

8.1. Understanding JSON (JavaScript Object Notation):

• Introduces JSON as a data interchange format.

• Compares JSON with XML, highlighting JSON’s advantages in simplicity and 
readability.

• Discusses the advantages of using JSON in data exchange.

8.2. JSON Syntax and Structure:

• Explains JSON’s syntax, including objects, arrays, and key-value pairs.

• Provides rules for writing valid JSON data.

• Offers examples illustrating various JSON data structures.

8.3. Creating JSON Documents:

• Details the steps for manually creating JSON documents using a text editor.

• Introduces tools and libraries for generating JSON data.

• Offers best practices for organizing and formatting JSON data.

8.4. JSON Schema:

• Explores the role of JSON Schema in defining the structure and validation of JSON 
data.

• Describes key concepts in JSON Schema, including properties, required fields, and 
data types.

8.5. Creating JSON Schema:

• Provides step-by-step guidance on creating a JSON Schema for specific JSON data 
formats.

• Explains how to validate JSON data against a JSON Schema.

• Discusses common use cases for JSON Schema in data validation.
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8.6. Schema Mapping:

• Defines schema mapping and its importance in data integration.

• Explores how schema mapping relates to data transformation and integration.

• Highlights the significance of schema mapping in maintaining data consistency.

8.7. Schema Mapping with MS Excel:

• Explains why Microsoft Excel is a suitable tool for schema mapping.

• Describes the process of importing JSON data into Excel for mapping.

• Demonstrates how to create Excel tables and worksheets to represent JSON data 
structures.

8.8. Mapping JSON Elements to Excel Cells:

• Provides a step-by-step guide for mapping JSON elements to specific cells in Excel.

• Discusses strategies for handling nested JSON structures and arrays in Excel.

• Details the process of mapping JSON properties to Excel column headers.

8.9. Data Transformation and Validation:

• Explores how Excel’s formulas and functions can be used for transforming JSON data.

• Demonstrates how to validate JSON data against a predefined JSON Schema within 
Excel.

• Discusses best practices for handling errors and inconsistencies during data 
transformation.

8.10. Scenarios and Practical Applications:

• Presents real-world scenarios and practical applications of JSON, JSON Schema, and 
Excel.

• Highlights automation in financial data integration, financial analysis and reporting, 
risk management, data feeds, and compliance.

 This module equips learners with the fundamental knowledge and practical skills 
required to work with JSON data, create JSON Schemas, perform schema mapping in 
Excel, and apply these concepts to real-world financial scenarios.
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MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the primary purpose of schema mapping in data management and integration?

 A) Defining relationships between people
 B) Defining relationships and correspondences between elements in different schemas
 C) Defining relationships between tables
 D) Defining relationships between databases

2. In the context of financial applications, why is schema mapping crucial?

 A) It helps in drawing financial graphs
 B) It ensures data accuracy and consistency during integration
 C) It helps in creating financial reports
 D) It helps in conducting financial audits

3. Which of the following best describes the role of schema mapping in data integration?

 A) It combines data from diverse sources and provides a unified view
 B) It converts data into different formats
 C) It validates data
 D) It creates data visualizations

4. What does Excel’s Power Query Editor allow you to do during the process of importing 
JSON data?

 A) Perform various transformations and data cleaning tasks
 B) Create new JSON schemas
 C) Export data to JSON format
 D) Generate random JSON data

5. When mapping JSON elements to Excel cells, what formula can be used to extract a  
specific JSON element?

 A) =JSON.GET
 B) =JSON.EXTRACT
 C) =JSON.VALUE
 D) =JSON.PULL

6. What does the INDEX function in Excel do when used in the context of mapping JSON data?

 A) Returns the index of a JSON element
 B) Returns the value of a specified JSON element
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 C) Returns the total number of JSON elements
 D) Returns the type of a JSON element

7. How can you handle nested JSON structures or arrays in Excel?
 A) By using the IF function
 B) By using the INDEX function
 C) By using Excel’s built-in Table functionality
 D) By using the VLOOKUP function

8. In Excel, how can you rename an Excel column header to match a JSON property name?
 A) Right-click on the header and choose “Rename”
 B) Double-click on the header, type the desired name, and press Enter
 C) Go to the “Data” tab and select “Rename Column”
 D) Use the CTRL + R keyboard shortcut

9. What does VBA stand for in Excel?
 A) Visual Basic for Applications
 B) Visual Binary Analysis
 C) Visual Business Automation
 D) Visualized Business Analytics

10. In VBA, what function can be used to parse a JSON string?
 A) JSON.PARSE
 B) JSON.CONVERT
 C) JSON.VALUE
 D) JSON.PULL

11. What does the JSON Schema primarily ensure when validating data?
 A) Data accuracy
 B) Data integrity and structure
 C) Data visualization
 D) Data encryption

12. In the context of data transformation, what does error handling in Excel VBA involve?
 A) Identifying data errors
 B) Managing errors that occur during data transformation
 C) Displaying error messages to users
 D) Creating error logs

13. How can you create custom validation functions in Excel using VBA?
 A) By using the “Custom Validation” option in the Data tab
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 B) By going to the “Validation” tab in Excel options
 C) By opening the VBA editor and writing custom validation scripts
 D) By using the “Advanced Functions” feature in Excel

14. In the context of financial data management, what is a practical application of JSON, 
JSON Schema, and Excel?

 A) Creating 3D financial models
 B) Automating financial data integration from multiple sources
 C) Simulating financial market scenarios

Answers
 1. B) Defining relationships and correspondences between elements in different schemas
 2. B) It ensures data accuracy and consistency during integration
 3. A) It combines data from diverse sources and provides a unified view
 4. A) Perform various transformations and data cleaning tasks
 5. C) =JSON.VALUE
 6. B) Returns the value of a specified JSON element
 7. C) By using Excel’s built-in Table functionality
 8. B) Double-click on the header, type the desired name, and press Enter
 9. A) Visual Basic for Applications
 10. A) JSON.PARSE
 11. B) Data integrity and structure
 12. B) Managing errors that occur during data transformation
 13. C) By opening the VBA editor and writing custom validation scripts
 14. B) Automating financial data integration from multiple sources

        

SELF-EXAMINATION QUESTIONS FOR PRACTICE

Understanding	JSON	(JavaScript	Object	Notation):
1. Explain the differences between JSON and XML. Provide examples of scenarios where 

JSON is a better choice than XML for data exchange.
2. Given the following JSON data, identify the key-value pairs and their corresponding 

data types:
            {
  “name”: “Alice”,
  “age”: 28,
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  “isStudent”: true,
  “grades”: [85, 92, 78]
}

JSON	Syntax	and	Structure:
1. Create a JSON object representing information about a book, including title, author, 

and publication year.
2. Write valid JSON data that includes a nested object and an array.
3. Identify and correct the errors in the following JSON structure:

             {
  “employee”: {
    “name”: “Bob”,
    “position”: “Manager”,
    “salary”: 60000
  }
}
“department”: “HR”

Creating	JSON	Documents:
1. Manually create a JSON document using a text editor for a list of your favourite 

movies, including their titles and release years.
2. Research and list three tools or libraries that can generate JSON data automatically. 

Explain when and why you might use these tools.

JSON	Schema:
1. Create a JSON Schema for validating a product’s information, including its name 

(string), price (number), and availability (Boolean).
2. Explain the importance of defining required fields in a JSON Schema using practical 

examples.

Schema	Mapping:
1. Describe a scenario where schema mapping is crucial for integrating data from 

multiple sources. Discuss the challenges and benefits.
2. Given a JSON structure representing customer data, map it to an Excel spreadsheet 

with appropriate column headers.

Schema	Mapping	with	MS	Excel:
1. Import a sample JSON dataset into Excel and create an Excel table to represent the 

data.
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2. Using a financial dataset in JSON format, demonstrate how Excel’s layout can 
facilitate schema mapping. Include the steps.

Mapping	JSON	Elements	to	Excel	Cells:
1. Take a complex JSON structure and map its elements to specific Excel cells. Include 

nested structures in your example.
2. Explain how you would map JSON properties to Excel column headers when dealing 

with JSON data from a financial report.

             Data Transformation and Validation:
1. In Excel, create a formula to calculate the total cost of products in a JSON dataset 

where each product has a price and quantity.
2. Validate JSON data against a JSON Schema using Excel functions. Describe the steps 

involved.
3. Discuss the potential errors and inconsistencies that can occur during data 

transformation in Excel and propose strategies for handling them.

Practical Applications:
1. Provide examples of how JSON and schema mapping can be used in financial 

analysis and reporting.
2. Describe a real-world scenario in the financial sector where automating data 

integration tasks with JSON and Excel would be highly beneficial.
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TASK STATEMENT KNOWLEDGE STATEMENT 

Design a workbook, structure 
demonstrating effective 
organaization and management of 
multiple worksheet to enhance 
data 

Students must understand all 
basics and advanced level 
functions, and features including 
charts 

Analyze the workbook and 
evaluate the benefits for the 
management of the company 

Apply the knowledge and 
technique to secure the 
spreadsheet  

Create a visualize diagaram 
illustrating the relationship 
between worksheet 

Demonstrating proficiency in 
using different types of functions 

Create formulas and functions in 
excel to solve real world data 
analysis problem 

Compose a scenario for 
integrating various excel tools and 
techniques to solve the complex 
solutions  

Generate Pivot table by creating a 
case study and alayze the data 
summaraize, filtering, grouping, 
validating etc 

Design data layout templates for 
different reporting and analysis 
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CHAPTER 1
MANAGE PRESENTATIONS AND SLIDES

LEARNING OBJECTIVE: 

     Upon completion of this module, participants will gain the skills to:

a  Create presentations from scratch or using templates.

a		 Efficiently	manage	slides	by	adding,	duplicating,	rearranging,	and	formatting	them.

a		 Customize	slide	masters,	handouts,	and	notes	for	a	professional	look.

a		 Organize	slides	effectively.

a		 Adjust	presentation	options	and	views	as	needed.

a		 Configure	presentations	for	printing	or	digital	distribution.

a		 Create	and	deliver	engaging	slide	shows,	including	custom	presentations,	timing,	
and	Presenter	View.

These	skills	will	enable	participants	to	master	presentation	software	and	enhance	their	ability	to	
communicate	effectively	in	various	contexts.

1.1. INTRODUCTION:
PowerPoint	365	makes	managing	presentations	and	slides	very	simple.	The	Microsoft	Office	365	
suite	includes	PowerPoint	365,	which	has	a	number	of	tools	to	help	you	make,	edit,	and	arrange	
your	presentations	and	slides.	Here’s	a	guide	on	how	to	manage	presentations	and	slides:

1.2. CREATE PRESENTATION:
The	term	“presentations”	refers	to	PowerPoint	files.	In	order	to	begin	a	new	project	with	PowerPoint,	
you	must	first	build	a	brand-new	presentation,	which	can	be	either	blank	or	based	on	a	template.	
Also	necessary	is	the	ability	to	open	a	previously	created	presentation.

1.2.1. CREATE A NEW PRESENTATION:
• Open	PowerPoint.
• In	the	left	pane,	select	New.
• Select	an	option:
• To	create	a	presentation	from	scratch,	select	Blank	Presentation.
• To	use	a	prepared	design,	select	one	of	the	templates.
• To	see	tips	for	using	PowerPoint,	select	Take	a	Tour,	and	then	select	Create.
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 Figure 1.1. Create new presentation

1.2.2. CREATE A PRESENTATION BASED ON A TEMPLATE:
If you want to use a template for your next presentation, here’s how.

• On	the	File	tab,	click	New.

• Select	Personal	or	Custom.	(The	name	varies,	depending	on	circumstance.)

Figure 1.2. Create a presentation based on a template (personal)

Figure 1.3. Create a presentation based on a template (custom)
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•	 Double-click	 your	 template	 and	 a	 new	 presentation	 will	 open	 with	 your	 template	
applied	to	it.

 
1.3. INSERT AND FORMAT SLIDES: 
        •	 						Add	and	delete	slides	to	organize	your	presentation	how	you	want.

1.3.1. ADD SLIDES:
•	 Select	the	slide	you	want	your	new	slide	to	follow.
•	 Select	Home	>	New	Slide.
•	 Select	a	layout.
•	 Select	the	text	box	and	type.

1.3.2. DELETE SLIDES:
• For a single slide:	Right-click	the	slide	in	the	thumbnail	pane	on	the	left,	and	select	

Delete	Slide.

• For multiple slides: Press	and	hold	Ctrl,	and	in	the	thumbnail	pane	on	the	left,	select	
the	slides.	Release	the	Ctrl	key.	Then	right-click	the	selection	and	choose	Delete	Slide.

• For a sequence of slides: Press	and	hold	Shift,	and	in	the	thumbnail	pane	on	the	left,	
select	the	first	and	last	slides	in	the	sequence.	Release	the	Shift	key.	Then	right-click	
the	selection	and	choose	Delete	Slide.

1.3.3. DUPLICATE A SLIDE:
•	 In	 the	thumbnail	pane	on	the	 left,	 right-click	 the	slide	thumbnail	 that	you	want	 to	

duplicate,	and	then	click	Duplicate	Slide.	The	duplicate	is	inserted	immediately	after	
the original.

1.3.4. REARRANGE THE ORDER OF SLIDES:
•	 In	the	pane	on	the	left,	click	the	thumbnail	of	the	slide	that	you	want	to	move,	and	

then	drag	it	to	the	new	location.

• To	select	multiple	slides:	Press	and	hold	Ctrl,	and	in	the	pane	on	the	left,	click	each	
slide	that	you	want	to	move.	Release	the	Ctrl	key,	and	then	drag	the	selected	slides	
as	a	group	to	the	new	location.

1.3.5. HIDE AND UNHIDE SLIDES:
You	can	conceal	a	slide	if	you	wish	to	keep	it	in	the	presentation	file	but	not	have	it	show	up	in	
the	slide	show.	When	you	open	Slide	Show	view,	a	hidden	slide	is	only	hidden,	but	it	is	still	present	
in	the	file.	Any	slide	in	the	presentation	has	the	ability	to	be	hidden	or	revealed	using	the	choices	
Hide	Slide	and	Unhide	Slide.
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HIDE A SLIDE:
• In	the	left	navigation	pane,	select	the	thumbnail	image	of	the	slide	you	want	to	hide.

• Right-click	the	slide,	then	select	Hide	Slide.	The	slide	now	shows	a	slash	through	the
slide	number	to	indicate	that	it’s	hidden.

Figure 1.4. Hide a slide

UNHIDE A SLIDE:
• In	the	left	navigation	pane,	select	the	hidden	slide	you	want	to	unhide.

• Right-click	the	slide,	then	select	Unhide	Slide.

SHOW A HIDDEN SLIDE DURING A PRESENTATION:
If	you’re	in	Slide	Show	view	and	you	decide	that	you	want	to	show	a	hidden	slide,	you	can	do	so:

• Right-click	the	current	slide	and	select	See	All	Slides.

(The	screen	switches	to	a	thumbnail	list	of	all	the	slides	in	the	presentation.)

• Select	the	hidden	slide	you	want	to	show.

(The	selected	slide	is	shown	full-screen	and	the	slide	show	resumes.)

If	you	are	using	the	presenter	view,	your	audience	won’t	see	the	steps	you	take	to	select	the	slide.	
They	will	simply	see	the	slide	you	select	in	step	2.

1.3.6. INSERT SPECIFIC SLIDE LAYOUTS:
There	are	predefined	arrangements	for	your	slide	material	included	in	each	theme	in	PowerPoint.	
“Placeholder”	boxes	provide	you	with	areas	where	you	can	insert	your	material	with	little	to	no	
manual	formatting	and	organizing.	After	selecting	a	layout	in	PowerPoint	from	a	menu,	you	may	
add	text	and	images.	The	predefined	layouts	include	a	Title	slide	to	begin	with,	a	general	Title	
and	Content	layout,	a	side-by-side	Comparison	layout,	and	a	Picture-with-Caption	layout.

• Arrange	slide	content	with	different	slide	layouts	to	suit	your	taste	and	preference,	or
to	improve	the	clarity	and	readability	of	the	content.
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•	 Select	the	slide	that	you	want	to	change	the	layout	for.
•	 Select	Home	>	Layout.
•	 Select	the	layout	that	you	want.

The	layouts	contain	placeholders	for	text,	videos,	pictures,	charts,	shapes,	clip	art,	a	background,	
and	more.	The	layouts	also	contain	the	formatting	for	those	objects,	like	theme	colours,	fonts,	
and	effects.

1.3.7. EDIT AND RE-APPLY A SLIDE LAYOUT:
When	you	apply	a	slide	layout	to	one	or	more	slides	in	your	presentation	and	later	amend	that	
layout	by	 inserting	a	placeholder,	 adding	custom	prompt	 language,	or	 carrying	out	another	
layout-altering	activity,	you	must	reapply	the	layout	to	the	slides	in	order	for	the	slides	to	follow	
the	revised	layout.

Change an existing layout:
•	 On	the	View	tab,	click	Slide	Master.

•	 In	the	thumbnail	pane	that	contains	the	slide	masters	and	layouts,	pick	the	layout	
that	has	the	closest	arrangement	of	placeholders	to	how	you	want	your	slide	to	look.

Figure 1.5. Change an existing layout
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To change an existing layout, do one or more of the following:

•	 To	 add	 a	 placeholder,	 on	 the	 Slide	 Master	 tab,	 click	 Insert	 Placeholder,	 and	 then	
select	a	placeholder	type	from	the	list.	Click	a	location	on	the	layout,	and	then	drag	
to	draw	the	placeholder.

•	 Add,	edit,	or	remove	a	placeholder	on	a	slide	layout.

•	 To	rename	the	layout,	in	the	thumbnail	list	of	layouts,	right-click	the	layout	that	you	
customized,	and	then	click	Rename	Layout.

•	 In	the	Rename	Layout	dialog	box,	type	a	new	name	that	describes	the	layout	you’ve	
just	created,	and	then	click	Rename.

•	 On	the	Slide	Master	tab,	click	Close	Master	View.

Apply the updates so that they appear on your slides:

•	 In	Normal	View,	in	the	thumbnail	pane,	click	the	slide	that	you	want	to	reapply	the	
updated	layout	to.

•	 On	the	Home	tab,	in	the	Slides	group,	click	Layout,	and	then	select	the	layout	that	you	
updated	in	Slide	Master	View.

1.3.8. INSERT SLIDE HEADERS, FOOTERS AND PAGE NUMBERS:
Standard	footer	elements	can	be	added,	and	they	will	show	up	on	each	slide	in	your	presentation.	
You	may	include	the	date	and	time,	the	title	of	the	presentation,	or	the	page	number,	for	instance.

Add page numbers to slides and notes:

All	slides,	including	hidden	slides,	are	counted	when	slide	numbers	are	added.	Page	numbers	
are	present	in	the	notes	when	printed.

•	 On	the	Insert	tab,	click	Header	&	Footer	Header	&	Footer	button.

•	 In	the	Header	and	Footer	box,	on	the	Slide	tab,	select	the	Slide	number	check	box,	and	
then	in	the	Starts	at	box,	type	the	page	number	that	you	want	to	start	with	on	the	first	
slide.

•	 Click	Apply	to	All.

Add footer text:

•	 On	the	Insert	tab,	click	Header	&	Footer	Header	&	Footer	button.
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•	 In	the	Header	and	Footer	box,	on	the	Slide	tab,	select	the	Footer	check	box,	and	then	
type	the	footer	text	that	you	want.

•	 Click	Apply	to	All.

If footers don’t appear on slides:

•	 If	footers	don’t	appear	on	title	slides,	in	the	Header	and	Footer	box,	make	sure	they	
Don’t	show	on	title	slide	check	box	is	not	selected.

•	 If	the	footers	are	missing	from	other	slides,	the	placeholders	for	these	items	might	
have	been	removed	from	specific	slide	layouts	or	the	slide	master.

Add the date and time:

Adding	the	date	and	time	to	a	PowerPoint	presentation	 in	PowerPoint	365	 is	a	useful	 feature,	
especially	for	keeping	your	audience	informed	about	when	the	presentation	was	created	or	when	
it’s	being	delivered.	You	can	add	the	date	and	time	manually	or	set	it	to	update	automatically.	
Here’s	how	to	do	both:

Manually Adding Date and Time:

•	 Go	to	the	slide	where	you	want	to	add	the	date	and	time.

•	 Click	on	the	text	box	or	placeholder	where	you	want	to	insert	the	date	and	time.

•	 Go	to	the	“Insert”	tab	in	the	ribbon.

•	 In	the	“Text”	group,	click	on	the	“Date	&	Time”	button.

•	 A	dialog	box	will	appear.	You	can	select	the	date	and	time	format	you	prefer	from	the	
options.

•	 Check	the	box	next	to	“Update	automatically”	if	you	want	the	date	and	time	to	update	
automatically	whenever	you	open	the	presentation.

•	 Click	“OK”	to	insert	the	date	and	time	into	the	selected	text	box	or	placeholder.

Automatically Adding Date and Time (Header/Footer):

If	you	want	to	add	the	date	and	time	to	the	header	or	footer	of	every	slide	in	your	presentation,	
you	can	use	the	Header	&	Footer	feature:

•	 Go	to	the	“Insert”	tab	in	the	ribbon.

•	 In	the	“Text”	group,	click	on	the	“Header	&	Footer”	button.

•	 In	the	Header	&	Footer	dialog	box,	go	to	the	“Slide”	tab.

•	 Check	the	boxes	for	“Date	and	time”	and	“Update	automatically”	if	you	want	the	date	
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and	time	to	update	automatically.

• Choose	the	format	and	 location	(Header	or	Footer)	where	you	want	the	date	and
time to appear.

• Click	“Apply”	to	add	the	date	and	time	to	all	slides.

• If	you	have	existing	slides,	you	may	need	to	manually	add	them	by	editing	the	Slide
Master.	To	do	this,	click	on	the	“View”	tab,	and	then	select	“Slide	Master.”	Here,	you
can	customize	the	date	and	time	format	and	placement	for	all	slides.

Note: Remember	that	when	you	choose	the	“Update	automatically”	option,	the	date	and	time	
will	refl	ect	the	current	date	and	time	each	time	you	open	or	print	the	presentation.	This	can	be	
helpful	for	keeping	your	presentation	information	up-to-date.

1.3.9. INSERT ZOOM:

If	 you	would	 like	 to	make	your	presentations	more	dynamic	and	exciting,	 try	using	 zoom	 for	
PowerPoint.		

• To	add	a	zoom,	go	to	Insert	>	Zoom.

• To	summarize	the	entire	presentation	on	one	slide,	choose	Summary	Zoom.

• To	show	selected	slides	only,	choose	Slide	Zoom.

• To	show	a	single	section	only,	choose	Section	Zoom.

Figure 1.6. Insert zoom
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SUMMARY ZOOM:

A	summary	zoom	is	like	a	landing	page	where	you	can	see	the	pieces	of	your	presentation	all	at	
once.	When	you’re	presenting,	you	can	use	the	zoom	to	go	from	one	place	in	your	presentation	
to	another	in	any	order	you	like.	You	can	get	creative,	skip	ahead,	or	revisit	pieces	of	your	slide	
show	without	interrupting	the	flow	of	your	presentation.

SLIDE ZOOM:

A	slide	 zoom	can	help	you	make	your	presentation	more	dynamic,	allowing	you	 to	navigate	
freely	between	slides	in	any	order	you	choose	without	interrupting	the	flow	of	your	presentation.	
They’re	a	good	option	for	shorter	presentations	without	lots	of	sections,	but	you	can	use	slide	
zooms	for	lots	of	different	presentation	scenarios.

Slide	zooms	help	you	drill	down	into	multiple	pieces	of	information	while	feeling	as	though	you’re	
staying	on	the	same	canvas.

SECTION ZOOM:

A	section	zoom	is	a	link	to	a	section	already	in	your	presentation.	You	can	use	them	to	go	back	
to	sections	you	want	to	really	emphasize,	or	to	highlight	how	certain	pieces	of	your	presentation	
connect.

1.4. MODIFY SLIDES, HANDOUTS AND NOTES:
Modifying	slides,	handouts,	and	notes	is	a	common	task	when	preparing	for	a	presentation	or	
lecture.

1.4.1. CHANGE THE SLIDE MASTER THEME OR BACKGROUND:
Use	a	slide	master	to	assist	you	in	unifying	the	format	of	your	presentation	and	give	uniformity	to	
your	presentation’s	colours,	headings,	fonts,	logos,	and	other	elements.	A	slide	master’s	colours,	
typefaces,	and	effects	are	all	editable.	Placeholders	can	be	hidden	or	displayed.

Change the slide master:
•	 Select	View	>	Slide	Master.

•	 Make	the	text,	color,	and	alignment	changes	you	want.

If	you	want	to	use	a	predefined	theme,	select	that	first	by	clicking	Themes	on	the	Slide	Master	
tab.	Then	proceed	with	selecting	Colours,	Fonts,	Effects,	and	Background	Styles.

•	 When	you’re	done,	select	Close	Master	View.
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1.4.2. MODIFY THE HANDOUT MASTER:
Open	the	handout	master	by	selecting	VIEW	>	Handout	Master	to	make	more	precise	formatting	
and	layout	changes	than	are	possible	in	Print	view.

Create or change a presentation’s handout:
Use	 the	 HANDOUT	 MASTER	 tab	 to	 edit	 the	 appearance	 and	 layout	 of	 presentation	 handouts.	
Changes	made	to	the	handout	master	appear	on	all	the	pages	of	the	printed	handout.

• On	 the	VIEW	 tab,	 in	 the	Master	Views	group,	click	Handout	Master.	 This	opens	 the
HANDOUT	MASTER	tab.

• On	the	page,	click	on	a	text	placeholder	(Header,	Footer,	Date,	or	Page	Number)	to
make	your	changes.	These	changes	can	include:

• Edit	or	add	content	in	the	text	placeholders:	In	addition	to	text	changes,	you	can	use
commands	on	the	INSERT	tab	to	add	graphics	or	other	content	types.

• Format	 the	 text	 shape	 and	 appearance:	 Select	 the	 text	 and	 use	 the	 FORMAT	 tab
commands	under	DRAWING	TOOLS.

• Change	the	text	placeholders:	Drag	a	text	placeholder	to	move	it,	and	use	the	text
box	sizing	handles	to	change	its	size.

• Turn	placeholders	on	or	off:	On	the	HANDOUT	MASTER	tab,	in	the	Placeholders	group,
uncheck	the	box	of	the	placeholder	that	you	want	to	turn	off.

• Add	or	change	 the	background:	On	 the	HANDOUT	MASTER	 tab,	 in	 the	Background
group,	 click	 Background	 Styles	 and	 then	 click	 a	 background,	 or	 click	 Format
Background	to	create	a	background.

• To	finish,	on	the	HANDOUT	MASTER	tab,	in	the	Close	group,	click	Close	Master	View.

PREVIEW YOUR HANDOUTS:

To preview how your handout will look when printed:
• Click	the	FILE	tab,	and	then	click	Print.

• Under	Settings,	click	Full	Page	Slides,	and	then	under	Handouts,	select	the	layout	you
want	and	look	at	the	preview	pane.	Click	the	FILE	tab	again	to	return	to	your	previous
view.

1.4.3. MODIFY THE NOTES MASTER:
You	can	alter	how	your	presentation	appears	when	printed	with	notes	using	the	notes	master.

Open the Notes Master View:

You	can	format	the	background,	change	the	typefaces,	and	position	headers	and	footers	when	
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viewing	notes	in	Notes	Master	view.	Options	for	page	setup	are	also	available.
•	 Click	the	View	tab	on	the	ribbon.

•	 Click	the	Notes	Master	button

 

Figure 1.7. Notes master

You	are	brought	to	Notes	Master	view.	Just	like	with	Slide	Master	view,	any	changes	you	make	
here	will	apply	to	all	notes	in	the	presentation.

Edit the Notes Master:
•	 While	in	Notes	Master	view,	select	the	notes	placeholders	you	want	to	use.

•	 Click	Notes	Page	Orientation	and	select	an	option.

•	 Make	any	additional	changes	to	the	Notes	Master.

•	 Click	the	Close	Master	View	button.

 
Figure 1.8. Edit the Notes Master
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1.5. ORDER AND GROUP SLIDES:
Slides	can	be	organized	into	logical	groups	using	sections,	much	as	folders	are	used	to	organize	
files.

•	 Right-click	between	slides	and	select	Add	Section.

•	 An	Untitled	Section	is	added	in	the	thumbnail	pane,	and	the	Rename	Section	dialog	
box	opens.

•	 Type	a	name	in	the	Section	name	box.

• Select Rename.

•	 To	collapse	a	section,	click	the	triangle	next	to	the	section	name.	The	numeral	by	the	
section	name	shows	the	number	of	slides	in	that	section.

To	move	or	delete	a	section,	select	View	>	Slide	Sorter.

From here, you can:
•	 Move	a	section:	Right-click	and	select	Move	Section	Up	or	Move	Section	Down.

•	 Delete	a	section:	Right-click	and	select	Remove	Section.

You	can	also	drag	and	drop	sections.

1.6. CHANGE PRESENTATION OPTIONS AND VIEWS:

Changing	presentation	options	and	views	can	help	you	customize	how	your	slides	are	displayed	
and	how	you	deliver	your	presentation.

1.6.1. CHANGE THE SLIDE SIZE:
To change the slide size:

•	 Select	the	Design	tab	of	the	toolbar	ribbon.

•	 Select	the	Slide	Size	Slide	Size	icon			near	the	far-right	end	of	the	toolbar.

•	 Select	Standard	(4:3	aspect	ratio)	or	Widescreen	(16:9)	or	Custom	Slide	Size.

Figure 1.9. Change the slide size

Standard, 4:3

Widescreen, 16:9
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1.6.2. CHANGE VIEWS OF A PRESENTATION:

To	select	the	appropriate	view	for	your	needs,	click	the	PowerPoint	View	tab.	The	task’s	bottom-
screen	icons	allow	you	to	choose	a	different	view	as	well.	

For	creating	and	editing	your	presentations,	the	default	Normal	option	works	well.

To	see	all	of	your	slides	listed	in	a	column,	choose	Outline	View.	To	view	thumbnails	of	all	your	
slides,	 use	 Slide	 Sorter.	 By	 choosing	 a	 slide	 and	 dragging	 it	 to	 a	 different	 position,	 you	 can	
rearrange	your	slides	in	either	view.

Choose	Notes	Page	to	view	your	speaker	notes.	You’ll	see	each	slide	separately.

To	see	your	presentation	full	screen,	select	the	Slide	Show	icon	 	from	the	task	bar	at	the	
bottom	of	the	screen.	If	you	want	to	see	your	current	slide,	next	slide,	and	speaker	notes	while	
you	present,	select	three	dots	 	at	the	bottom	of	screen,	then	Show	Presenter	View.

1.6.3.SET FILE PROPERTIES:
Document	 properties,	 commonly	 referred	 to	 as	 metadata,	 are	 informational	 elements	 that	
identify	or	characterize	a	fi	le.	They	contain	information	that	identifi	es	the	subject	or	contents	of	
the	document,	such	as	the	title,	author,	subject,	and	keywords.

You	can	quickly	organize	and	categorize	your	fi	les	later	on	if	you	include	the	document	properties.	
Additionally,	you	can	insert	documents	into	your	papers	or	do	a	search	for	them	depending	on	
their properties.

• Standard properties: Microsoft	 365	 documents	 come	 with	 a	 basic	 set	 of	
characteristics	by	default,	 including	author,	 title,	and	subject.	 For	 these	attributes,	
you	can	provide	custom	text	values	to	make	it	simpler	to	categorize	and	identify	your	
documents.	For	instance,	with	Word,	you	can	add	the	keyword	“customers”	to	your	
sales	papers	by	using	the	Keywords	feature,	commonly	known	as	Tags.	After	that,	
you	can	use	that	term	to	look	through	all	sales	documents.

• Automatically updated properties:	 Both	fi	le	 system	data	 (such	as	fi	le	 size	or	 the	
dates	 a	 fi	le	 was	 created	 or	 last	 modifi	ed)	 and	 statistics	 that	 are	 kept	 for	 you	 by	
Microsoft	365	programs	(such	as	the	number	of	words	or	characters	in	a	document)	
are	included	in	this	list	of	properties.	The	properties	that	are	automatically	updated	
cannot	be	specifi	ed	or	altered.

• Custom properties:	 Your	 Microsoft	 365	 documents	 can	 have	 additional	 custom	
characteristics	defi	ned.	Custom	attributes	allow	you	to	set	a	text,	time,	or	numeric	
value	in	addition	to	the	yes/no	options.	A	list	of	suggested	names	is	available,	or	you	
can	defi	ne	your	own.
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• Document library properties: These	are	attributes	connected	to	files	in	a	public	folder	
or	a	document	library	on	a	website.	One	or	more	document	library	properties	can	
be	specified,	and	their	values	can	be	subject	to	rules	when	a	new	document	library	
is	created.	You	are	prompted	to	provide	values	for	any	properties	that	are	needed	
or	 to	 rectify	 any	 incorrect	 properties	 when	 you	 add	 documents	 to	 the	 document	
library.	A	document	 library	 that	compiles	product	 ideas,	 for	 instance,	can	ask	 the	
user	for	information	like	Submitted	By,	Date,	Category,	and	Description.	By	selecting	
File	>	 Info,	you	may	modify	and	update	these	document	library	settings	when	you	
open	a	document	from	a	document	library	in	Word,	Excel,	or	PowerPoint.	All	required	
properties	from	the	document	library	are	outlined	with	red	borders	on	the	Info	tab	in	
Word,	Excel,	and	PowerPoint.

1.7.CONFIGURE A PRESENTATION FOR PRINT

Even	though	PowerPoint	presentations	are	designed	to	be	watched	on	a	computer,	you	may	
want	to	print	them	on	occasion.	

You	 may	 even	 print	 customized	 versions	 of	 a	 presentation,	 which	 can	 come	 in	 handy	 while	
giving	a	presentation.	The	Print	pane	makes	previewing	and	printing	your	presentation	a	breeze.
When	printing	a	presentation,	PowerPoint	has	numerous	layout	options.	The	arrangement	you	
select	will	mostly	be	determined	by	the	reason	for	printing	the	slide	presentation.	

Print layouts are divided into four categories:
• Full Page Slides: Each	slide	in	your	presentation	will	be	printed	on	a	full	page.	If	you	

need	to	review	or	update	a	printed	copy	of	your	presentation,	this	layout	is	ideal.

• Notes Pages: This	publishes	each	slide,	as	well	as	any	speaker	notes	associated	with	
that	slide.	You	might	keep	a	printed	copy	of	the	notes	with	you	during	the	presentation	
if	you’ve	included	a	lot	of	notes	for	each	slide.

• Outline:	This	prints	the	slide	show’s	overall	outline.	You	might	use	this	to	go	over	your	
slide	show’s	organization	and	get	ready	to	give	your	presentation.

• Handouts:	This	generates	thumbnail	versions	of	each	slide	with	space	for	notes	 if	
desired.	This	arrangement	is	very	beneficial	if	you	want	to	hand	out	a	tangible	copy	
of	your	presentation	to	your	audience.	They	can	take	notes	on	each	slide	using	the	
optional area.

1.7.1. PRINT ALL OR PART OF A PRESENTATION:
•	 Select	the	File	>	Print.

•	 For	Printer,	select	the	printer	you	want	to	print	to.
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•	 For	Settings,	select	the	options	you	want:

•	 Slides	-	From	the	drop-down,	choose	to	print	all	slides,	selected	slides,	or	the	current	
slide.	Or,	in	the	Slides	box,	type	which	slide	numbers	to	print,	separated	by	a	comma.

•	 Print	Layout	-	Choose	to	print	just	the	slides,	the	speaker	notes,	an	outline,	or	handouts.

•	 Collated	-	choose	if	you	want	them	collated	or	uncollated.

•	 Color	-	choose	if	you	want	color,	grayscale,	or	pure	black	and	white.

•	 Edit	Header	&	Footer	-	Select	to	edit	the	header	and	footer	before	printing.

•	 For	Copies,	select	how	many	copies	you	want	to	print.

•	 Select	Print.

1.7.2. PRINT NOTES PAGES:

You	can	print	your	speaker	notes,	with	or	without	thumbnail	images	of	the	accompanying	slides,	
and	distribute	them	to	your	audience	after	your	presentation	for	them	to	review.

This	publishes	each	slide,	as	well	as	any	speaker	notes	associated	with	 that	slide.	You	might	
keep	a	printed	copy	of	the	notes	with	you	during	the	presentation	if	you’ve	included	a	lot	of	notes	
for	each	slide.

1.7.3. PRINT HANDOUTS:

The	audience	receives	handouts,	which	are	paper	copies	of	your	PowerPoint	presentation.	They	
provide	something	substantial	for	your	audience	to	refer	to	and	take	home.	
They	can	also	make	their	own	notes	by	writing	on	the	handouts.	(Some	handout	designs	even	
contain	writing	lines.)
This	generates	thumbnail	versions	of	each	slide	with	space	for	notes	if	desired.	This	arrangement	
is	very	beneficial	if	you	want	to	hand	out	a	tangible	copy	of	your	presentation	to	your	audience.	
They	can	take	notes	on	each	slide	using	the	optional	area.

1.7.4. PRINT IN COLOR, GRAYSCALE, OR BLACK AND WHITE:

To	print	your	presentation	in	color,	grayscale,	or	black	and	white,	you	typically	need	to	adjust	
your	printer	settings	and	the	way	your	slides	are	formatted.	Here’s	how	you	can	do	it	in	
common	presentation	software	like	Microsoft	PowerPoint:

•  Go to the “File” Menu: Click	on	the	“File”	tab	in	the	upper	left	corner	of	the	PowerPoint	
window.

•  Select “Print”:	In	the	File	menu,	select	“Print”	from	the	options	on	the	left-hand	side.
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• Choose Printer and Settings:

1. In	the	Print	menu,	make	sure	the	correct	printer	is	selected	in	the	Printer	dropdown
menu.

2. Below	the	Printer	dropdown	menu,	you	should	see	“Settings.”	Click	on	“Settings”	to
open	the	Print	Settings	dialog	box.

• Color/Grayscale/Black and White:

1. In	the	Print	Settings	dialog	box,	you’ll	find	the	“Color”	dropdown	menu.	Click	on	it	to
reveal	the	options.

2. Select	one	of	the	following	options:

a) Color: To print in full color.

b) Grayscale: To	print	in	shades	of	grey.

c) Black and White: To	print	in	black	and	white.

• Adjust Other Print Settings (Optional): You	can	also	adjust	other	print	settings	like
the	number	of	copies,	which	slides	to	print,	and	the	layout.	Make	sure	to	configure
these	settings	as	needed.

• Print: After	 configuring	 your	 print	 settings,	 click	 the	 “Print”	 button	 to	 print	 your
presentation	with	the	selected	color	mode.

1.8. CONFIGURE AND PRESENT A SLIDE SHOW
Configuring	 and	 presenting	 a	 slide	 show	 effectively	 involves	 several	 steps	 to	 ensure	 your	
presentation	goes	smoothly.	Here’s	a	step-by-step	guide	on	how	to	do	this	using	PowerPoint	365

1.8.1. CREATE CUSTOM SLIDE SHOWS:
A	subset	of	slides	in	a	presentation	file	can	essentially	be	tagged	with	the	intention	of	showing	
that	portion	to	a	certain	audience.	It	might	come	to	mind	as	a	playlist.	This	is	a	bespoke	show,	
according	to	PowerPoint.

You	can	customize	a	presentation	in	PowerPoint	so	that	it	is	appropriate	for	various	audiences.	
Use	a	custom	show	to	exhibit	only	a	select	few	of	your	presentation’s	slides	or	to	establish	a	link	
to	a	selection	of	your	slides.

Basic	and	hyperlinked	custom	shows	are	the	two	types	available.	A	basic	custom	show	is	either	a	
stand-alone	presentation	or	a	presentation	that	incorporates	a	few	of	the	original	presentation’s	
slides.	A	custom	show	with	links	provides	a	convenient	way	to	access	one	or	more	independent	
presentations.
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Basic custom shows: 

To	display	a	portion	of	the	slides	in	a	presentation	file,	use	a	simple	custom	show.	For	instance,	
if	your	presentation	has	five	slides	altogether,	a	custom	show	called	“Site	1”	might	only	include	
slides	1,	3,	and	5.	Slides	1,	2,	4,	and	5	could	be	a	part	of	a	second	unique	show	called	“Site	2”.	You	
can	always	run	the	entire	presentation	in	its	original	sequential	order	when	you	make	a	custom	
show	from	a	presentation.	

																																																																									1.		Slides	for	Site	1
																																																																										2.		Slides	for	Site	2

 

Figure 1.10. Basic custom shows

Hyperlinked custom shows:

1.	Slide	with	hyperlinks

2.	Custom	show	for	Department	A

3.	Custom	show	for	Department	B	

 
Figure 1.11. Hyperlinked custom shows
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Use	a	custom	show	with	hyperlinks	to	arrange	the	presentation’s	material.	For	instance,	if	you	
make	a	primary	custom	show	describing	the	new	organizational	structure	of	your	business,	you	
may	then	make	custom	shows	for	each	department	 inside	it	and	link	to	them	from	the	main	
presentation.

A	custom	show	with	hyperlinks	can	also	be	used	to	make	a	slide	for	the	table	of	contents.	You	
can	choose	which	sections	of	your	presentation	to	show	to	your	audience	at	a	given	time	by	
navigating	to	them	using	a	table	of	contents	slide.

Create a basic custom show:
• Go	to	Slide	Show	>	Custom	Slide	Show,	and	then	select	Custom	Shows.

• In	the	Custom	Shows	dialog	box,	select	New.

Tip:	To	preview	a	custom	show,	click	the	name	of	the	show	in	the	Custom	Shows
dialog	box,	and	then	click	Show.

• Under	Slides	in	presentation,	choose	the	slides	that	you	want	to	include	in	the		custom
show,	and	then	select	Add.

• To	change	the	order	in	which	slides	appear,	under	Slides	in	Custom	Show,	select	a
slide,	and	then	click	one	of	the	arrows	to	move	the	slide	up	or	down	in	the	list.

• Type	a	name	in	the	Slide	show	name	box,	and	then	click	OK.

Create a hyperlinked custom show:
• Go	to	Slide	Show	>	Custom	Slide	Show,	and	then	select	Custom	Shows.

• In	the	Custom	Shows	dialog	box,	select	New.

• Under	Slides	 in	presentation,	click	 the	slides	 that	you	want	 to	 include	 in	 the	main
custom	show,	and	then	click	Add.

Tip: To	change	the	order	in	which	slides	appear,	under	Slides	in	Custom	Show,	select
a	slide,	and	then	click	one	of	the	arrows	to	move	the	slide	up	or	down	in	the	list.

• Type	a	name	in	the	Slide	show	name	box,	and	then	click	OK.

• To	create	a	hyperlink	 to	a	supporting	show	 in	your	presentation,	select	 the	text	or
object	that	you	want	to	be	the	link.

• Go	to	Insert	>	Hyperlink.

• In	the	Insert	Links	dialog	box,	under	Link	to,	click	Place	in	This	Document.

Do one of the following:

• To	link	to	a	custom	show,	in	the	Select	a	place	in	this	document	list,	select	the	custom
show	that	you	want	to	go	to,	and	then	select	the	Show	and	return	check	box.
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• To	link	to	a	location	in	the	current	presentation,	in	the	Select	a	place	in	this	document	
list,	select	the	slide	that	you	want	to	go	to.

Start a custom show from within PowerPoint:
•	 On	the	Slide	Show	tab,	in	the	Set-Up	group,	click	Set	Up	Slide	Show.

•	 In	the	Set-Up	Show	dialog	box,	under	Show	slides,	click	Custom	show,	and	then	click	
the	custom	show	that	you	want.

•	 Click	OK.

•	 On	the	Slide	Show	tab,	in	the	Start	Slide	Show	group,	click	Custom	Slide	Show,	and	
then	click	Custom	Shows.

•	 In	the	Custom	shows	list,	select	a	show,	and	then	click	Show.

1.8.2. CONFIGURE SLIDE SHOW OPTIONS:
There	are	various	things	you	should	think	about	before	presenting	to	an	audience.	Set	up	the	
slide	show	to	best	suit	the	delivery	method	once	you’ve	selected	how	you’ll	give	the	presentation.

Set Up Slide Shows:
•	 Click	the	Slide	Show	tab	on	the	ribbon.

•	 Click	the	Set-Up	Slide	Show	button	to	view	more	options.

 

Figure 1.12. Set Up Slide Shows
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Make any desired changes to the settings.

• Show	Type:	Select	the	type	of	presentation	you	are	giving.

• Show	Options:	Adjust	looping,	narration,	animation,	graphics,	pen,	and	laser	options.

• Show	Slides:	Select	which	slides	to	show	in	the	presentation.

• Advance	Slides:	Choose	to	advance	slides	manually	or	automatically.

• Multiple	Monitors:	Set	up	for	presenting	using	multiple	monitors.

• Click OK.

Figure 1.13. Make any desired changes to the settings.
• Now	the	slide	show	will	play	according	to	the	settings	you	chose.

1.8.3. REHEARSE SLIDE SHOW TIMING:
There	 are	 several	 things	 to	 keep	 in	 mind	 when	 getting	 ready	 to	 present.	 How	 long	 do	 you	
anticipate	it	lasting?	What	will	you	say	as	a	result?	Fortunately,	PowerPoint	includes	a	variety	of	
tools	that	can	help	you	practice	your	slide	show.	To	allow	viewers	to	watch	it	on	their	own,	you	
can	also	record	a	copy	of	the	presentation	with	audio	commentary.	Practicing	timings	can	be	
beneficial	if	you	want	to	set	up	a	presentation	to	play	at	a	specified	tempo	without	having	to	
manually	scroll	through	the	slides.	You	can	also	use	it	to	practice	your	talking	points.	With	this	
feature,	timings	for	each	slide	and	animation	can	be	saved.	PowerPoint	will	use	these	times	to	
play	the	presentation	on	its	own.	PowerPoint	helps	you	record	and	time	a	presentation	before	
you	present	it	to	an	audience.

• Select	Slide	Show	>	Rehearse	Timings.

• Select	Next,	click	the	mouse	or	press	the	Right	Arrow	key	to	go	to	the	next	slide.
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•	 The	time	for	the	current	slide	is	shown	to	the	right	of	the	Pause	icon.	The	time	to	the	
right	of	that	is	the	time	for	the	whole	presentation.

•	 Select	Pause	to	pause	the	recording.	Select	Resume	Recording	to	resume.

•	 Select	Yes	to	save	the	slide	timings,	or	No	to	discard	them.

•	 You	can	also	press	Esc	to	stop	the	recording	and	exit	the	presentation.

View the timings:
•	 Select	 View	 >	 Slide	 Sorter.	 The	 amount	 of	 time	 allotted	 to	 a	 slide	 is	 shown	 at	 the	

bottom-right	of	the	slide.

Turn off recorded slide timings before you give a presentation:

To prevent slides from automatically advancing, use the recorded slide timings as follows:
•	 Select	Set	Up	>	Slide	Show.

•	 Clear	the	Use	Timings	or	Use	Rehearsed	Timings	check	box.

•	 To	turn	the	slide	timings	on	again,	select	Use	Timings.

1.8.4. PRESENT A SLIDE SHOW BY USING PRESENTER VIEW:
In	order	to	help	you	concentrate	while	presenting	and	engage	with	your	audience,	PowerPoint	
Presenter	View	displays	the	current	slide,	the	next	slide,	and	your	speaker	notes.

•	 Select	the	Slide	Show	tab.

•	 Select	the	Use	Presenter	View	checkbox.

 
Figure 1.14. Present a slide show by using Presenter View

•	 Select	which	monitor	to	display	Presenter	View	on.

•	 Select,	 		From	Beginning	or	press	F5.
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In Presenter View, you can:

• See	your	current	slide,	next	slide,	and	speaker	notes.

• Select	the	arrows	next	to	the	slide	number	to	go	between	slides.

• Select	the	pause	button	or	reset	button	to	pause	or	reset	the	slide	timer	in	the
upper left.

• See	the	current	time	to	help	you	pace	your	presentation.

• Select	the	font	icons	to	make	the	speaker	notes	larger	or	smaller.

• Select	the	annotations	pen	icon	to	draw	on	the	screen	in	real	time,	or	select	a
laser pointer.

• Select	the	thumbnail	icon	to	see	all	the	slides	in	your	presentation	and	quickly
jump	to	another	slide.

• Select	the	magnifying	glass	icon	to	zoom	in	on	a	particular	part	of	a	slide.

• The	screen	icon	lets	you	make	the	screen	temporarily	black	to	focus	the	attention
on	you.

• Select	END	SLIDESHOW	when	you’re	done	presenting.

SUMMARY:

• Managing	presentations	and	slides	in	PowerPoint	365	involves	various	tasks	and
features	that	help	users	create,	organize,	and	deliver	effective	presentations.

Creating Presentations:

• PowerPoint	365	allows	users	to	create	new	presentations	from	scratch	or	use
pre-designed	templates.

• Users	can	start	with	a	blank	slide	or	utilize	various	layout	options	for	different
content	types.

• PowerPoint	provides	a	range	of	formatting	options,	including	text	formatting,	shapes,
images,	and	multimedia	elements.

• PowerPoint	365	enables	users	to	reorder,	duplicate,	or	delete	slides	easily.

• Sections	can	be	used	to	group	and	organize	slides	in	larger	presentations.
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MULTIPLE CHOICE QUESTIONS (MCQ) FOR PRACTICE

1. What is the purpose of creating a new presentation in PowerPoint?

	a)	To	apply	slide	layouts

	b)	To	modify	existing	presentations

	c)	To	start	a	presentation	from	scratch	

	d)	To	add	transitions	to	slides

2. When would you use a presentation template in PowerPoint?

	a)	To	duplicate	a	slide

	b)	To	create	a	new	presentation	quickly	with	a	predefined	design	

	c)	To	rearrange	slide	order

	d)	To	add	headers	and	footers	to	slides

3. How can you add new slides to your presentation?

	a)	By	right-clicking	on	the	slide	sorter	view

	b)	By	pressing	Ctrl+D

	c)	By	going	to	the	Insert	tab	and	clicking	“New	Slide”	

	d)	By	copying	and	pasting	an	existing	slide

4. What action allows you to remove unnecessary slides from a presentation?

	a)	Pressing	Ctrl+X

	b)	Right-clicking	and	selecting	“Delete	Slide”	

	c)	Dragging	the	slide	to	the	Recycle	Bin

	d)	Pressing	Ctrl+S

5. To make a copy of a slide within a presentation, you should:

	a)	Right-click	the	slide	and	choose	“Copy	Slide”	

	b)	Delete	the	slide	and	then	create	a	new	one

	c)	Use	the	“Replace	Slide”	function

	d)	Select	the	slide	and	press	Ctrl+V

6. How can you rearrange the order of slides in a presentation?

	a)	By	dragging	and	dropping	slides	in	the	Slide	Sorter	view	

	b)	By	using	the	“Sort	Slides”	option	in	the	Home	tab
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	c) By	copying	and	pasting	slides	in	the	desired	order

	d) By	right-clicking	and	selecting	“Rearrange	Slide	Order”

7. What does hiding a slide in PowerPoint mean?

	a) Making	it	invisible	during	a	presentation

	b) Deleting	the	slide	permanently

	c) Changing	the	background	color	of	the	slide

	d) Adding	animation	effects	to	the	slide

8. Which feature allows you to choose and insert different slide layouts?

	a) Slide	Sorter

	b) Slide	Transitions

	c) Slide	Design

	d) Slide	Layout

9. How can you modify and reuse a slide layout in PowerPoint?

	a) By	deleting	the	layout	and	creating	a	new	one

	b) By	right-clicking	on	the	layout	and	selecting	“Edit”

	c) By	changing	the	slide’s	background	color

	d) By	resizing	the	slide

10. What is used to add consistent branding elements like headers and footers to slides?

	a) Slide	Master

	b) Slide	Design

	c) Slide	Properties

	d) Slide	Format

11. What feature allows you to incorporate zoom functionality into a presentation?

	a) Zoom	Transition

	b) Zoom	Effect

	c) Zoom	Master

	d) Zoom	in	PowerPoint

12. How can you change the slide master theme or background in PowerPoint?

	a) By	right-clicking	on	the	slide	master	and	choosing	“Change	Theme”
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	b)	By	going	to	the	Slide	Master	view	and	applying	a	new	theme	

	c)	By	using	the	Format	Painter	tool

	d)	By	selecting	the	theme	from	the	Design	tab

13. What does modifying the handout master in PowerPoint allow you to do?

	a)	Edit	the	content	of	individual	slides

	b)	Adjust	the	layout	and	content	of	printed	handouts	(Correct	Answer)

	c)	Change	the	design	of	slide	transitions

	d)	Customize	slide	animations

14. Which part of a presentation can you modify when working on the notes master?

	a)	Slide	titles

	b)	Slide	transitions

	c)	Presenter	notes	

	d)	Slide	background

 

Answers:
	1.	 c)	To	start	a	presentation	from	scratch	

	2.	 b)	To	create	a	new	presentation	quickly	with	a	predefined	design	

	3.	 c)	By	going	to	the	Insert	tab	and	clicking	“New	Slide”	

	4.	 b)	Right-clicking	and	selecting	“Delete	Slide”

	5.	 a)	Right-click	the	slide	and	choose	“Copy	Slide”	

	6.	 a)	By	dragging	and	dropping	slides	in	the	Slide	Sorter	view	

	7.	 a)	Making	it	invisible	during	a	presentation	

	8.	 d)	Slide	Layout	

	9.	 b)	By	right-clicking	on	the	layout	and	selecting	“Edit”	

	10.	d)	Slide	Format	

	11.	 d)	Zoom	in	PowerPoint	

	12.	b)	By	going	to	the	Slide	Master	view	and	applying	a	new	theme	

	13.	b)	Adjust	the	layout	and	content	of	printed	handouts	

	14.	c)	Presenter	notes	
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       SELF-EXAMINATION QUESTIONS FOR PRACTICE:

1. What	is	the	importance	of	effective	presentation	management?

2. How	can	you	create	a	new	presentation	from	scratch?

3. Explain	how	to	create	a	presentation	based	on	a	template.

4. What	are	the	steps	to	add	slides	to	a	presentation?

5. How	do	you	delete	a	slide	from	a	presentation?

6. Describe	how	to	duplicate	a	slide	in	a	presentation.

7. How	can	you	rearrange	the	order	of	slides	in	a	presentation?

8. What	is	the	purpose	of	hiding	and	unhiding	slides	in	a	presentation?

9. How	can	you	insert	specific	slide	layouts	into	your	presentation?

10. Explain	the	process	of	editing	and	reapplying	a	slide	layout.
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CHAPTER 2
INSERT OBJECTS, TRANSITIONS  
AND ANIMATIONS
 
LEARNING OBJECTIVE:
Upon completing this module, participants will:

1. Manage Presentations and Slides

•	 Create,	edit,	and	organize	presentations.

•	 Customize	slides,	layouts,	and	master	themes.

•	 Prepare	presentations	for	various	needs,	including	printing.

•	 Deliver	engaging	slide	shows	effectively.

•	 Assess	understanding	through	summaries	and	practice	questions.

2. Insert Objects, Transitions, and Animations

•	 Add	and	format	text,	media,	and	shapes.

•	 Enhance	presentations	with	transitions	and	animations.

•	 Control	timing	and	effects	for	dynamic	presentations.

2.1. INTRODUCTION:

Inserting	objects,	transitions,	and	animations	can	enhance	the	visual	appeal	and	engagement	
of	your	presentations.

2.2. INSERT AND FORMAT TEXT:

Inserting	 and	 formatting	 text	 in	 a	 presentation	 is	 a	 fundamental	 skill	 when	 creating	 visually	
appealing	and	effective	slides.	Here’s	how	to	do	it	in	PowerPoint	365:

2.2.1. INSERT TEXT ON A SLIDE:

By	placing	a	text	box	and	entering	text	inside	of	it,	you	can	add	text	to	a	PowerPoint	slide	or	slide	
master.	Then,	after	selecting	the	text	or	the	full	box,	you	can	format	that	text.	Both	shapes	and	
placeholders	can	have	text	added	to	them.
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Insert a text box:

•	 Open	the	slide	you	want	to	add	the	box	to.

•	 On	the	ribbon,	select	the	Insert	tab,	then	select	Text	box	button	Text	Box.

•	 On	the	slide,	click	and	drag	to	draw	the	text	box	in	the	position	and	size	you	want.

2.2.2. ADD AND FORMAT TEXT:

•	 Select	a	text	box	and	type	some	text.

•	 To	 format,	 select	 the	 text,	 and	 select	 an	 option	 to	 change	 the	 font,	 spacing,	 or	
alignment.

•	 To	 create	 bulleted	 or	 numbered	 lists,	 select	 the	 text,	 and	 then	 select	 Bullets	 or	
Numbering.

 
Figure 2.1. Add and format text

2.2.3. INSERT PICTURES:

•	 Select	where	you	want	to	insert	the	picture	on	the	slide.

•	 Select	 Insert	>	Pictures	and	where	to	find	the	image:	This	device,	OneDrive,	or	Bing	
pictures.

•	 In	the	dialog	box	that	opens,	browse	to	the	picture	that	you	want	to	insert,	tap	that	
picture,	and	then	Insert.
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Figure 2.2. Insert pictures

2.2.4. INSERT SHAPES, ICONS, AND SMARTART:

The	Insert	tab	allows	you	to	add	visual	appeal	to	your	slides.

•	 Select	Insert	>	Shapes	and	in	the	drop-down	select	the	shape.

•	 Select	Insert	>	Icons	and	in	the	drop-down	select	the	icon.

•	 Select	Insert	>	SmartArt	and	in	the	gallery	tap	the	layout	for	the	SmartArt	graphic	you	
want.

Figure 2.3. Insert Shapes, Icons, and SmartArt

2.2.5. INSERT VIDEOS:

•		Select	Insert	>	Video	and	in	the	drop-down	select	either	a	video	from	the	PC	or	from	web
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Figure 2.4. Insert videos

2.3. INSERT AND FORMAT SHAPES AND TEXT BOXES

Shapes	are	an	excellent	way	to	spice	up	your	displays.	You	can	choose	from	a	range	of	shapes	in	
PowerPoint,	and	each	one	can	be	customised	to	match	your	unique	requirements	by	using	your	
own	colour	scheme,	style	preferences,	and	other	elements.	 Forms	can	provide	visual	appeal	
to	presentations;	however,	they	are	not	always	necessary.	When	a	shape	or	text	box	is	clicked,	
handles	appear,	allowing	you	to	edit	the	shape.

2.3.1. FORMAT TEXT:

When	you	select	text	and	choose	a	format,	hover	over	a	menu	option	to	see	a	live	preview	in	your	
slide.Format	options	include:

• Font	Color	-	Choose	a	font	color	for	your	text.

• Numbering	or	Bullets	-	Create	a	list	using	numbers	or	bullets.

• Add	or	Remove	Columns	-	Add	or	remove	columns	in	your	text.

• Text	Direction	-	Change	the	direction	of	text.

• Align	Text	-	Connect	your	text	to	the	top,	middle,	or	bottom	of	a	bounding	box.

• Align	Left,	Center,	Align	Right,	or	Justify	-	Align	your	text	the	way	you	want.

• Increase	List	Level	or	Decrease	List	Level	-	Increase	or	decrease	a	list	indent.

2.3.2. INSERT OR REPLACE SHAPES:

Many	of	the	regular	Microsoft	365	or	Microsoft	365	programs	allow	you	to	modify	forms.	When	
you	do	 this,	all	of	 the	original	 shape’s	characteristics—such	as	 its	color,	border,	and	any	 text	
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within	it—remain	unchanged.
• Select the shape.

•	 Go	to	Shape	Format	and	near	the	left	end,	select	 	Edit	Shape.

• Select 	Change	Shape,	then	choose	another	shape	from	the	gallery.

2.3.3. RESIZE SHAPES AND TEXT BOXES:
In	your	Offi	ce	fi	le,	you	may	simply	resize	images,	text	boxes,	shapes,	and	WordArt.	By	cropping	a	
photo,	you	can	also	get	rid	of	undesirable	elements	from	it.

If	you	want	to	stretch,	shrink,	or	just	change	the	size	of	a	picture	(or	shape),	use	the	sizing	handles	
or	for	more	precise	control,	the Size options on the Picture Tools Format tab	or	the	Drawing Tools 
Format tab.

2.3.4. APPLY STYLES TO SHAPES AND TEXT BOXES:

By	altering	a	shape’s	fi	ll	or	adding	effects	to	it,	such	as	shadows,	glows,	refl	ections,	soft	edges,	
bevels,	and	three-dimensional	(3-D)	rotations,	you	can	alter	the	appearance	of	a	shape	or	text	
box.

A	shape’s	 interior	can	be	fi	lled	with	any	colour,	design,	pattern,	 texture,	 image,	or	gradient.	A	
gradient	is	a	smooth	transition	of	hues	and	tones,	typically	from	one	hue	to	another	or	from	one	
shade	of	the	same	hue	to	another.

Changing	the	fi	ll	color	of	a	shape	affects	only	the	inside	or	front	of	the	shape.	If	you	add	an	effect	
to	a	shape,	such	as	a	shadow,	and	want	a	different	color	for	that	effect,	you	must	change	the	
color	of	the	shadow	separately	from	the	fi	ll	color.

A	3-D	effect	adds	depth	to	a	shape.	You	can	add	a	built-in	combination	of	3-D	effects	to	your	
shape,	or	you	can	add	individual	effects.	You	can	add	combinations	of	individual	effects	to	your	
shape	in	these	programs:	Excel,	Outlook,	Word,	and	PowerPoint.

Add a fi ll or effect:

To	add	a	fi	ll	or	effect,	click	your	shape,	click	Format,	click	the	arrow	next	to	Shape	Fill	or	Shape	
Effects,	and	select	a	color,	gradient,	texture,	or	effect.

•	 Click	the	shape	that	you	want	to	fi	ll.	To	add	the	same	fi	ll	to	multiple	shapes,	click	the	
fi	rst	shape,	and	then	press	and	hold	Ctrl	while	you	click	the	other	shapes.

•	 On	the	Format	tab,	in	the	Shape	Styles	group,	click	the	arrow	next	to	Shape	Fill.
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Do one of the following:

• To	add	or	change	a	fill	color,	click	the	color	you	want.

• To	choose	no	color,	click	No	Fill.

• To	use	a	color	that	isn’t	one	of	the	theme	colors,	click	More	Fill	Colors,	and	then	either
click	the	color	that	you	want	on	the	Standard	tab,	or	mix	your	own	color	on	the	Custom
tab.	Custom	colors	and	colors	on	the	Standard	tab	do	not	update	if	you	later	change
the	document	theme.

• To	adjust	the	transparency	of	the	shape,	click	More	Fill	Colors.	At	the	bottom	of	the
Colors	dialog	box,	move	the	Transparency	slider,	or	enter	a	number	in	the	box	next	to
the	slider.	You	can	vary	the	percentage	of	transparency	from	0%	(fully	opaque,	the
default	setting)	to	100%	(fully	transparent).

• To	add	or	change	a	fill	picture,	click	Picture,	locate	the	folder	that	contains	the	picture
that	you	want	to	use,	click	the	picture	file,	and	then	click	Insert.

• To	add	or	change	a	fill	gradient,	point	to	Gradient,	and	then	click	the	gradient	variation
that	you	want.	To	customize	the	gradient,	click	More	Gradients,	and	then	choose	the
options	that	you	want.

• To	add	or	change	a	fill	texture,	point	to	Texture,	and	then	click	the	texture	that	you
want.	To	customize	the	texture,	click	More	Textures,	and	then	choose	the	options	that
you	want.

2.4. APPLY SLIDE TRANSITIONS

Applying	slide	transitions	in	PowerPoint	365	serves	several	important	purposes,	enhancing	the	
overall	quality	and	effectiveness	of	your	presentation.

2.4.1. INSERT SLIDE TRANSITIONS:

When	you	switch	from	one	slide	to	the	next	in	a	presentation,	an	animation-like	effect	is	called	a	
slide	transition.	To	give	your	PowerPoint	presentation	life,	add	slide	transitions.

• Select	the	slide	you	want	to	add	a	transition	to.

• Select	the	Transitions	tab	and	choose	a	transition.

• Select	a	transition	to	see	a	preview.

• Select	Effect	Options	to	choose	the	direction	and	nature	of	the	transition.

Note: Not	every	transition	has	Effect	Options.
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•	 Select	Preview	to	see	what	the	transition	looks	like.

•	 To	remove	a	transition,	select	Transitions	>	None.

2.4.2. REMOVE A TRANSITION:
A	transition	determines	how	a	slide	enters,	and	how	the	previous	slide	exits.	So	if	(for	example)	
you	didn’t	want	a	transition	effect	between	slides	2	and	3,	you	would	remove	the	transition	from	
slide	3.

•	 Select	the	slide	that	has	the	transition	you	want	to	remove.

•	 On	the	Transitions	tab,	in	the	Transitions	gallery,	select	None.

•	 If	you	want	 to	 remove	all	 transitions	 from	the	presentation,	after	you	select	None,	
select	Apply	to	All.

2.4.3. CHANGE A TRANSITION:
A	slide	can	only	have	one	transition	effect	active	at	once.	As	a	result,	 if	a	slide	already	has	a	
transition	effect	applied	to	it,	you	can	switch	to	a	different	effect	by	heading	to	the	Transitions	
tab	and	choosing	the	one	you	like	most.

If	you	want	to	change	an	existing	effect	by	modifying	the	timing	or	direction	of	it,	you	can	do	that	
by	using	the	options	on	the	Transitions	tab	of	the	ribbon,	at	the	far	end:

•	 Select	the	slide	that	has	the	transition	you	want	to	modify.

•	 On	the	Transitions	tab,	select	Effect	Options,	then	choose	an	option	from	the	menu	
that appears.

•	 In	the	Timing	group	on	the	Transitions	tab,	you	can	change	the	duration	of	the	effect.	
You	can	also	specify	whether	the	effect	takes	place	after	a	mouse	click	or	after	a	
certain	amount	of	 time	passes.	 There	are	also	options	 for	adding	a	sound	 to	 the	
transition	effect	or	applying	the	transition	to	all	slides	in	the	slide	show.

2.5. ANIMATE SLIDE CONTENT
In	 your	 PowerPoint	 presentation,	 you	 can	 animate	 the	 text,	 images,	 shapes,	 tables,	 SmartArt	
graphics,	and	other	objects.	An	object	may	appear,	vanish,	or	move	as	a	result	of	an	effect.	They	
can	alter	the	size	or	colour	of	an	object.

2.5.1.ADD ANIMATIONS TO TEXT, PICTURES, SHAPES, AND MORE IN YOUR PRESENTATION:
•	 Select	the	object	or	text	you	want	to	animate.

•	 Select	Animations	and	choose	an	animation.

•	 Select	Effect	Options	and	choose	an	effect.
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2.5.2.MANAGE ANIMATIONS AND EFFECTS:
There are different ways to start animations in your presentation:

• On	Click:	Start	an	animation	when	you	click	a	slide.

• With	Previous:	Play	an	animation	at	the	same	time	as	the	previous	animation	in	your
sequence.

• After	Previous:	Start	an	animation	immediately	after	the	previous	one	happens.

• Duration:	Lengthen	or	shorten	an	effect.

• Delay:	Add	time	before	an	effect	runs.

2.5.3. ADD MORE EFFECTS TO AN ANIMATION:

• Select	an	object	or	text	with	an	animation.

• Select	Add	Animation	and	choose	one.

2.5.4.CHANGE THE ORDER OF ANIMATIONS:

• Select	an	animation	marker.

• Choose	the	option	you	want:

 � Move Earlier: Make	an	animation	appear	earlier	in	the	sequence.

 � Move Later: Make	an	animation	occur	later	in	the	sequence.

2.5.5.ADD ANIMATION TO GROUPED OBJECTS:
You can add an animation to grouped objects, text, and more.

• Press	Ctrl	and	select	the	objects	you	want.

• Select	Format	>	Group	>	Group	to	group	the	objects	together.

• Select	Animations	and	choose	an	animation.

2.6.SET TIMING FOR TRANSITIONS AND ANIMATIONS
The	length	of	a	transition,	its	appearance,	and	even	the	sound	that	will	play	during	it	can	all	be	
changed.	Additionally,	you	may	select	how	long	should	be	spent	on	each	slide	before	moving	
on	to	the	next.

2.6.1.SET THE SPEED OF THE TRANSITION:
Use	Duration	to	set	transition	speed.	A	shorter	duration	means	that	a	slide	advances	faster,	and	
a	larger	number	makes	the	slide	advance	more	slowly.
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•	 Select	the	slide	that	has	the	transition	that	you	want	to	modify.

•	 On	the	Transitions	tab,	in	the	Timing	group,	in	the	Duration	box,	type	the	number	of	
seconds	that	you	want.

 

Figure 2.5. Set the speed of the transition

2.6.2.MODIFY THE EFFECT OPTIONS FOR A TRANSITION:
Many, but not all, of the transitions in PowerPoint can be customized.

•	 Select	the	slide	that	has	the	transition	you	want	to	modify.

•	 On	the	Transitions	tab,	in	the	Transition	to	This	Slide	group,	click	Effect	Options	and	
select	the	option	that	you	want.

 

Figure 2.6. Modify the Effect options for a transition

2.6.3.SPECIFY A TIME TO ADVANCE TO THE NEXT SLIDE:
By	defining	how	long	a	slide	remains	visible	before	switching	to	the	following	slide,	Advance	Slide	
determines	the	timing	of	transitions.	When	you	click	the	mouse,	slides	advance	if	timing	is	not	
selected.

•	 Select	the	slide	that	you	want	to	set	the	timing	for.

•	 On	 the	 Transitions	 tab,	 in	 the	 Timing	 group,	 under	 Advance	 Slide,	 do	 one	 of	 the	
following:
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Figure 2.7. Specify a time to advance to the next slide

•	 To	make	the	slide	advance	to	the	next	slide	when	you	click	the	mouse,	select	the	On	
Mouse	Click	check	box.

•	 To	 make	 the	 slide	 advance	 automatically,	 select	 the	 “After”	 check	 box,	 and	 then	
enter	the	number	of	minutes	or	seconds	that	you	want.	The	timer	starts	when	the	
final	animation	or	other	effect	on	the	slide	finishes.

•	 To	enable	both	the	mouse	and	automatic	advance,	select	both	the	On	Mouse	Click	
check	box	and	the	“After”	check	box.	Then,	at	After,	enter	the	number	of	minutes	or	
seconds	that	you	want.	The	slide	will	advance	automatically,	but	you	can	advance	it	
more	quickly	by	clicking	the	mouse.

2.6.4. SET A SOUND TO PLAY DURING A TRANSITION:
•	 Select	the	slide	that	has	the	transition	that	you	want	to	modify.

•	 On	the	Transitions	tab,	in	the	Timing	group,	in	the	Sound	list,	select	the	sound	that	you	
want.

Figure 2.8. Set a Sound to play during a transition
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SUMMARY:

• PowerPoint	365	allows	you	to	insert	various	objects	into	your	slides,	including	images,	videos,
audio,	shapes,	charts,	and	tables.	These	objects	can	be	resized,	moved,	and	formatted	to
suit	your	presentation’s	needs.

• Slide	 transitions	 and	 animations	 can	 be	 added	 to	 enhance	 the	 visual	 appeal	 of
presentations.	Transitions	in	PowerPoint	365	control	how	slides	move	from	one	to	the	next
during	a	presentation.	There’s	a	wide	range	of	transition	effects	to	choose	from,	such	as
fade,	slide,	zoom,	and	more.	You	can	set	the	duration,	timing,	and	even	apply	transitions	to
specific	slides	or	slide	elements.

• Animations	 add	 movement	 and	 interactivity	 to	 individual	 elements	 within	 a	 slide.
PowerPoint	365	offers	entrance,	exit,	emphasis,	and	motion	path	animations.	Users	can
customize	animation	effects,	speed,	and	sequence	to	make	content	more	engaging.

MULTIPLE CHOICE QUESTIONS (MCQ) FOR PRACTICE:

1. What can you insert to enhance the visual appeal of a PowerPoint presentation?

	a) Transitions
	b) Animations
	c) Objects
	d) All	of	the	above

2. How do you insert text onto a PowerPoint slide?

	a) By	selecting	“Insert”	and	then	“Text	Box”
	b) By	selecting	“Format”	and	then	“Font”
	c) By	selecting	“Design”	and	then	“Insert	Text”
	d) By	selecting	“View”	and	then	“Text	Editor”

3. Which tab in PowerPoint allows you to add visual elements like shapes and icons?

	a) Design
	b) Insert
	c) Format
	d) Home
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4. What feature allows you to add or remove columns in text boxes in PowerPoint?

	a) Font	Color
	b) Numbering
	c) Add	or	Remove	Columns
	d) Text	Direction

5. Which option allows you to insert pictures into a PowerPoint slide?

	a) Insert	>	Pictures
	b) Format	>	Pictures
	c) Design	>	Pictures
	d) File	>	Pictures

6. What type of elements can be animated in a PowerPoint presentation?

	a) Text	only
	b) Images	only
	c) Text,	images,	shapes,	and	more
	d) Shapes	and	icons	only

7. What is the purpose of slide transitions in PowerPoint?
	a) To	add	visual	elements
	b) To	insert	videos
	c) To	enhance	the	overall	quality	and	effectiveness	of	the	presentation
	d) To	change	the	slide	background

8. How can you remove a transition from a specific slide in PowerPoint?
	a) Delete	the	slide
	b) Select	the	slide	and	press	“Delete	Transition”
	c) Select	the	slide	and	choose	“Transitions	>	None”
	d) You	cannot	remove	transitions	from	individual	slides

9. Which tab in PowerPoint allows you to customize the timing and effects of slide
transitions?

	a) Design
	b) Transitions
	c) Format
	d) Home

10. What is the purpose of applying animations to objects in PowerPoint?
	a) To	change	the	background	color
	b) To	enhance	slide	transitions
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	c) To	make	objects	appear,	disappear,	or	move	in	a	slide
	d) To	add	sound	effects

11. What does “On Click” animation mean in PowerPoint?
	a) The	animation	occurs	automatically
	b) The	animation	starts	when	you	click	a	slide
	c) The	animation	starts	after	the	previous	one	happens
	d) The	animation	is	applied	to	text	only

12. How can you change the order of animations in PowerPoint?
	a) By	selecting	“Edit	Animation”	from	the	Animation	tab
	b) By	using	the	“Move	Earlier”	or	“Move	Later”	options
	c) By	deleting	and	recreating	animations
	d) Animations	cannot	be	reordered

13. What does “Advance Slide” determine in PowerPoint?
	a) Slide	background	color
	b) Timing	of	transitions
	c) The	order	of	animations
	d) Slide	content

14. How can you set the speed of a slide transition in PowerPoint?
	a) By	selecting	the	desired	slide	and	clicking	“Speed”
	b) By	adjusting	the	font	size
	c) By	using	the	“Duration”	option	in	the	Transitions	tab
	d) By	selecting	the	“Fast”	or	“Slow”	transition	preset

15. What feature allows you to specify a time to advance to the next slide automatically in
PowerPoint?

	a) On	Mouse	Click
	b) Duration
	c) Delay
	d) After

Answers:

	1. d)	All	of	the	above

	2. a)	By	selecting	“Insert”	and	then	“Text	Box”

	3. b)	Insert

	4. c)	Add	or	Remove	Columns
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	5. a)	Insert	>	Pictures

	6. c)	Text,	images,	shapes,	and	more

	7. c)	To	enhance	the	overall	quality	and	effectiveness	of	the	presentation

	8. c)	Select	the	slide	and	choose	“Transitions	>	None”

	9. b)	Transitions

	10. c)	To	make	objects	appear,	disappear,	or	move	in	a	slide

	11. b)	The	animation	starts	when	you	click	a	slide

	12. b)	By	using	the	“Move	Earlier”	or	“Move	Later”	options

	13. b)	Timing	of	transitions

	14. c)	By	using	the	“Duration”	option	in	the	Transitions	tab

	15. d)	After

  SELF-EXAMINATION QUESTIONS FOR PRACTICE:

1. What	are	some	key	elements	you	can	insert	into	a	PowerPoint	presentation	to	enhance	its
visual	appeal	and	engagement?

2. How	do	you	insert	text	onto	a	PowerPoint	slide	or	slide	master?

3. What	are	the	steps	to	format	text	in	a	PowerPoint	presentation,	and	what	formatting	options
are	available?

4. Explain	how	to	insert	pictures,	shapes,	icons,	and	SmartArt	in	a	PowerPoint	presentation.

5. How	can	you	insert	videos	into	a	PowerPoint	presentation,	and	where	can	you	source	these
videos?

6. Describe	the	purpose	and	importance	of	slide	transitions	in	a	PowerPoint	presentation.

7. What	steps	do	you	follow	to	insert	a	slide	transition,	and	what	options	can	you	customize
for transitions?

8. How	can	you	remove	a	transition	from	a	specific	slide	in	your	PowerPoint	presentation?

9. What	are	the	animation	options	available	for	text,	images,	and	shapes	in	PowerPoint,	and
how	do	you	apply	them?

10. How	do	you	customize	the	timing	of	transitions	and	animations	in	a	PowerPoint	presentation,
and	what	options	are	available	for	timing	adjustments?
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TASK STATEMENT KNOWLEDGE STATEMENT 

Create a structured presentation outline, 
categorizing slides based on layout 

Students must understand the basics of 
presentation and its objectives 

Generate engaging presentations by 
inserting various multimedia objects like 
images, videos, audios and shapes 

Students must be creative while applying 
the transitions and selecting the suitable 
images, settings etc 

Generate animated presentations To enhance the visual appeal and convey 
complex process effectively 
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TAX COMPLIANCES

CHAPTER 1
E PAN

   LEARNING OBJECTIVES:

a  Understanding the Purpose of a PAN Card

a  Eligibility and Documentation

a  Online Registration Process

a  Document Submission

a  Payment of Fees

a		 Verification	and	Acknowledgment

a		 Downloading	E-PAN

INTRODUCTION
The	registration	of	an	E-PAN	(Electronic	Permanent	Account	Number)	is	a	digital	process	used	
in	India	to	obtain	a	PAN	card,	which	is	a	unique	identification	number	for	taxpayers.	The	E-PAN	
serves	the	same	purpose	as	a	physical	PAN	card	but	is	issued	in	electronic	format.

The Indian government has been actively promoting digital governance and encouraging 
citizens	 to	 use	 online	 platforms	 for	 various	 services.	 E-PAN	 aligns	 with	 this	 broader	 digital	
transformation	initiative,	making	it	easier	for	individuals	and	entities	to	obtain	and	use	their	PAN	
cards	without	the	need	for	physical	copies.

E-PAN	cards	are	accessible	anytime,	anywhere.	Once	 issued,	 individuals	can	download	 their	
E-PAN	cards	from	the	official	Income	Tax	Department	website,	reducing	the	risk	of	physical	card	
loss	or	damage.

However,	 it’s	 important	 to	 note	 that	 the	 specific	 details	 and	 requirements	 related	 to	 E-PAN	
registration may change over time due to evolving government policies and technological 
advancements.	Therefore,	individuals	and	entities	seeking	to	register	for	E-PAN	should	regularly	
check	the	official	website	of	the	Income	Tax	Department	of	India	or	consult	with	tax	professionals	
to	ensure	compliance	with	the	latest	regulations	and	procedures.

TASK
Susana	 Adler	 needs	 to	 invest	 in	 the	 stock	 exchange.	 For	 that,	 she	 needs	 a	 Demat	 account,	
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which	 makes	 the	 process	 of	 holding	 investments	 like	 shares,	 bonds,	 government	 securities,	
Mutual	Funds,	insurance,	and	ETFs	easier	by	taking	away	the	hassles	of	physical	handling	and	
maintenance	 of	 paper	 shares	 and	 related	 documents.	 For	 having	 a	 Demat	 account,	 she	 is	
required	to	have	a	PAN.

1.2 STEPS FOR APPLICATION OF INSTANT E-PAN
Generate	New	e-PAN	

Go	to	the	‘e-Filing’	Portal	https://www.incometax.gov.in/iec/foportal/and,	Click	Instant	E-PAN.	

On	the	E-PAN	page,	click	Get	new	E-PAN.	
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On	the	Get	new	E-PAN	page,	a	space	is	provided	to	enter	12	digital	Aadhar	number

On	the	Get	new	E-PAN	page,	enter	your	12	digital	Aadhar	number.	

Select	the	“I	confirm	that”	box	after	reading	the	conditions	given	below	and	click	Continue.	

225



TAX COMPLIANCES

Read	the	consent	declaration	for	generation	of	new	PAN	based	on	Aadhaar	e-KYC	details.

Click	the	“I	have	read	the	consent	terms	and	agree	to	proceed	further”	box,	and	after	that	click	
Continue.
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On	the	OTP	validation	page,	enter	the	6-digit	OTP	received	on	the	mobile	number	 linked	with	
Aadhar.

Enter	the	6	digit	OTP	and	Click	the	“I	agree	to	validate	my	Aadhar	details	with	UIDAI”	box	and	click	
Continue.
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On	the	validated	Aadhar	details	page,	your	Aadhar	e-KYC	details	are	displayed.	
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Enter	the	6-digit	OTP	given	and	click	the	submit	button

Validate	Email	ID	from	Aadhar	e-KYC	for	the	PAN	database	on	this	page.	

Click	validate	email	ID,	and	you	will	receive	a	6-digit	OTP	on	the	e-mail	OTP	and	click	submit.

Click	the	“I	accept	that”	box	after	reading	the	conditions	below	it.	Then	click	continue.
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All	 the	 procedures	 related	 to	 the	 application	 of	 E	 PAN	 is	 completed	 and	 a	 message	 will	 be	
displayed	for	the	completion	of	task

 MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the primary purpose of E-PAN registration in India?
a) To	apply	for	a	passport
b) To	obtain	a	unique	identification	number
c) To	streamline	the	taxation	process
d) To	access	government	healthcare	services
Answer:	c)	To	streamline	the	taxation	process

2. Which type of document is NOT typically required during the E-PAN registration
process?
a) Proof	of	identity
b) Proof	of	address
c) Proof	of	educational	qualifications
d) Proof	of	date	of	birth
Answer:	c)	Proof	of	educational	qualifications

3. Where can you complete the E-PAN registration process in India?
a) Only	at	designated	government	offices
b) Online	through	the	official	Income	Tax	Department	website
c) Through	mobile	apps	provided	by	private	companies
d) By	visiting	any	bank	branch
Answer:	b)	Online	through	the	official	Income	Tax	Department	website
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4. What is the benefit of having an E-PAN card?
		 a)	It	is	a	physical	card	that	cannot	be	lost
		 b)	It	provides	access	to	government	housing	schemes
		 c)	It	reduces	paperwork	and	is	accessible	online
		 d)	It	is	valid	only	for	foreign	nationals
		 Answer:	c)	It	reduces	paperwork	and	is	accessible	online

5. Which of the following is NOT a step in the E-PAN registration process?
		 a)	Payment	of	processing	fees
		 b)	Uploading	scanned	documents
		 c)	Providing	a	handwritten	signature
		 d)	Verification	of	application
		 Answer:	c)	Providing	a	handwritten	signature
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CHAPTER 2
ITR REGISTRATION

LEARNING OBJECTIVE
						At	the	end	of	this	chapter,	you	will	be	able	to,

a		Understand	the	procedure	for	taking	an	income	tax	registration

a		Necessary	details	to	take	income	tax	registration.

2.1 STEPS FOR ITR REGISTRATION

TASK

Rajesh	Kumar	is	an	individual	with	income	from	multiple	sources	that	exceeds	the	basic	exemp-
tion	limit.	He	needs	to	register	under	the	income	tax	department.	By	registering	on	the	e-Filing	
portal,	he	will	gain	access	 to	various	 functionalities	and	tax-related	services	provided	by	 the	
portal.	Rajesh	has	provided	you	with	the	necessary	information.	As	a	tax	practitioner,	advise	him	
to	proceed	with	the	registration	under	income	tax.

Details for Registration of PAN
PAN: WERPX4578G
Legal Status: Individual
Name: Rajesh	Kumar
Gender: Male
Residential Status: Resident
Date	of	Birth: April	25th,	1990
Mobile: 9072424341
E-mail	Id: rajesh12345@gmail.com

Postal Address:

Flat/Door/Building: 13/BB,	Skyline,
Road/Street/Block/Sector: Ajmer Road,
Post	Office: Madrampur,
Area/Locality: Madrampur,
Town/City/District: Jaipur
State: Rajasthan
Pin code: 302006
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STEP 2.1: Access the page https://www.incometax.gov.in
STEP 2.2: Click	on	the	Register	switch	provided	on	the	top	right	corner.	

Fig.	1

STEP 2.3: Input	the	PAN	Number	in	the	provided	column	and	click	on	validate.
• Validateà 
• Yes	(If	it	wants	to	register	as	Individual	Taxpayer)à	
• Continue
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FIG	2

STEP 2.4: Fill	the	columns	with	the	basic	details	of	taxpayer	such	as	
• Name
• Date	of	Birth
• Gender
• Resident or not
• After	fi	lling	this	click	on	continue
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Fig	3

STEP 2.5: Fill	the	columns	with	the	contact	details	of	taxpayer	such	as

•  Primary Contact Number

•  Primary Mail Address

•  Postal Address Details

• 	 After	fi	lling	this	details,	please	click	on	continue
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Fig 4
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STEP 2.6: Confi	rm	the	OTP	Validation	through	registered	phone	number	and	registered	mail	id	
and	click	on	continue.

Fig 5
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STEP 2.7: Verify	the	details	and	click	on	confi	rm	if	the	information	is	right.

Fig 6

STEP 2.8: Finally	set	a	password	which	meets	criteria	and	set	a	personized	message	and	then	
click	on	the	Register	Icon.

The password must fulfi l the following criteria:
• Use	8	to	14	characters
• Use	uppercase	and	lowercase	letters(eg.Aa)
• Use	a	number	(eg.123)
• Use	a	special	character	(eg.@#%*)

The personalized message criteria:
Don’t	use	your	personally	identifi	able	information	like	full	name,	Aadhar	number,	bank	account	
number,	passport	number	and	email	address.
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It	should	be	something	you	can	remember.	
Some examples:
The personalized message criteria:

• I love my family
• My pet name is Tommy 
• Bangalore	is	my	birthplace.

Fig 7
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STEP 2.9: At	last,	a	pop	message	will	be	shown	that	the	Registration	has	been	completed	suc-
cessfully.

Fig 8
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     MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the primary purpose of income tax registration?

a.	 To	track	personal	expenses

b.	 To	determine	eligibility	for	government	benefits	

c.	 To	calculate	and	pay	income	tax	

d.	 To obtain a driving license

2. In India, what is the government agency responsible for income tax registration and 
collection?

a.	 Reserve	Bank	of	India

b.	 Ministry of Finance 

c.	 Central	Board	of	Direct	Taxes	(CBDT)

d.	 State	Bank	of	India

3.In India, which form is used for filing individual income tax returns? 

a.	 ITR-1	(Sahaj)	

b.	 ITR-4	(Sugam)

c.	 ITR-7

d.	 ITR-10

4.What is the last step to complete income tax registration?

a.	 Confirm	OTP

b.	 Provide Aadhar number

c.	 Set a personalized message 

d.	 Click	on	Cancel

     5. Which website should you visit to initiate income tax registration? 

a.	 https://www.incometax.gov	

b.	 https://www.taxregistration.gov	

c.	 https://www.irs.gov	

d.	 https://www.taxportal.in
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ANSWERS

1 c
2 c
3 a
4 a
5 a
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CHAPTER 3
E-FILING OF ITR1

   LEARNING OUTCOMES 

a	 Understand	the	applicability	and	filing	strategies	of	ITR1.

a	 Identify	and	understand	the	heads	of	income	applicable	and	calculated	in	the	ITR1.

a	 Learning	the	possible	deductions	for	an	individual.

a	 Understand	the	guidelines	of	online	filing	of	ITR1.

INCOME TAX RETURN ( ITR1)- SAHAJ 
TASK

Mrs.	Roopa	is	a	resident	individual	working	in	a	private	sector	bank.	Roopa	was	born	on	August	
25th	1986,	and	draws	salary	of	Rs.	13,25,486/-.	

She	also	gets	the	following	perquisites	&	allowances:	

HRA:	Rs.	24,000/-	

Bonus:	Rs.	20,000/-	

Car:	Rs.	20,000/-	

Newspaper:	Rs.	2,000/-	

Professional	Tax:	Rs.	2,500/-	

Roopa	paid	the	following	expenses:	

Contribution	to	PF:	Rs.	95,000/-	

Payment	of	LIC	Premium:	Rs.	46,750/-	

Mutual	Fund	(Tax	Saver):	Rs.	25,000/-	

Tuition	Fee	for	the	Minor	Child:	Rs.	15,000/-	

Housing	Loan	(Principal):	Rs.	65,000/-	

Housing	Loan	(Interest):	Rs.	1,35,000/-	

Medical	Insurance	(Self):	Rs.	26,000/-	

Donation	to	Chief	Minister	Disaster	Relief	Fund	via	NEFT:	Rs.	25,000/-	(Pan	number-	AAAXA6807E,	
Address:	 3rd	 Floor,	 North	 Block,	 Secretariat,	 Thiruvananthapuram,	 Kerala,	 PIN-	 695001	 state	
code:32).	
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In	addition	 to	 the	salary,	Mrs.	 Roopa	earned	Rs.	 32,400/-	as	 interest	on	fi	xed	deposit	and	Rs.	
5,500/-	as	interest	on	saving	bank	account.	

Employer	deducted	tax	(TDS):	Rs.	1,15,000/-	(TAN	-	AAAX12345A,	Name	of	Deductor:	ABC	Ltd.,	CGS	
Colony,	Sector	3,	Kane	Nagar,	Antop	Hill,	Mumbai,	Maharashtra	PIN-	400037).	

Income	Chargeable	under	Salaries:	Rs.	8,55,000/-	

Compute	taxable	income,	tax	liability,	and	balance	tax	payable	or	refund,	if	any,	for	Mrs.	Roopa	
for	the	assessment	year	2021-2022.	

3.1 STEP BY STEP GUIDE ON HOW TO E-FILE ITR1 ON INCOME TAX PORTAL

Visit	the	simulated	Income	tax	refi	ling	portal	and	click	to	login	

Enter	the	given	below	“User Id” and “Password”	in	respective	column	and	click	to	Continue	
• PAN:	ABXIV9123A
• Password:	abxiv9123a@

Step	1
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Click	to	“File Now” Tab 

Step	2

Step	3
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Select	the	Assessment	and	mode	of	fi	ling,	Click to Continue 

Click	Start New Filing 

Step 4

Step 5
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Select	the	Filing	Status	as	Individual	and	Click	to	Continue 

Select	the	form	ITR1	and	“click	to	Proceed with ITR1”

Cleck	“Let’s Get Started” Button	

Step 6

Step 7
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In	the	following	step,	you	will	be	prompted	to	specify	the	reason	for	fi	ling	your	returns,	here	you	
have	to	select	“Taxable	Income	more	than	exemption	limit”	and	Click to Continue 

In the Personal Information section	of	the	ITR,	you	need	to	validate	the	pre-fi	lled	data	which	is	
auto-fi	lled	from	your	e-Filing	profi	le

Step 8

Step	9
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Select Nature of Employment “Others”  

	Verify	other	prefi	lled	Data	and Click to Confi rm 

Step	10

Step	11
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Click	to	Gross Total Income Tab and Enter the abovementioned details 

  

Click	the	Edit	button	and	Enter	the	Gross Salary 

Step	12

Step	13
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Enter	the	salary	as	per	section	17(1)	Rs.	13,69,486,	Value	of	perquisites	Rs.	22,000,	Professional	
Tax	2,500	and	Click to Save 

Step	14
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Select	self-occupied	property	and	enter	135000	as	an	interest	on	borrowed	capital	and	click	to	
add button 

Select	Income	from	Other	Source	and	Enter	the	Amount	32400	and	5500

Step	15

Step	16
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	Verify	the	Gross	Total	Income	and	click	to	Confi	rm	

Click	the	Chapter	VI	A	deductions	and	Enter	the	Given	below	details	

• 80C-	246750	
• 80D-	26000

Step	17

Step	18
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Enter	the	80G	Details	In	given	Column	and	Click	to	Save,	Click to Confi rm

254



TAX COMPLIANCES

Select	the	Tax	Paid	details	and	Click	to	Confi	rm	

Select	Total	tax	Liability	and	Click	to	Confi	rm	

Step	20

Step	21
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Enter/	Edit	your	income	and	total	deductions	details	in	the	different	sections.	After	completing	
and	confi	rming	all	the	sections	of	the	form,	click	Proceed.

View	the	Tax	Summary	details	and	Click	to	Pay	Now

Step	22

Step	23
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View	the	Tax	Summary	details	and	Click	to	Pay	Now

On the Preview and Submit Your Return page,	select	the	declaration	checkbox	and	click	Proceed 
to Preview

Step	24

257



TAX COMPLIANCES

Preview	your	return	and	click	Proceed to Validation

Validation Successful 

Step	25

Step	26
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   MULTIPLE CHOICE QUESTIONS (MCQS)

1. In fi ling of ITR1 Net salary is/are____

a.	Salary	as	per	section	17(1)

b.	Salary	as	per	section	17(1)	+	Perquisites

c.	Salary	as	per	section	17(1)	+	Perquisites	+	Profit	in	lieu	of	salary

d.	None	of	the	above

2. What is the sole basis for an individual to choose  for ITR form fi ling.

a.	  Sources of Income

b.	 Residential status

c.	 Neither	(a)	nor	(b)

d.	 Both	(a)	and	(b)
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3. Considering ITR 1 filing, choosing new tax regime is_______

a.			Mandatory

b.			Optional

c.			Neither	(a)	nor	(b)

d.			None	of	the	above

4. AIS Stands for ________

a.		Annual	Information	Statement

b.		Assessees	Information	Statement

c  Accounting Information Statement

d.			None	of	the	above

5.		Mr.	June	is	a	resident	individual	working	in	a	Private	Sector	Bank.	Drawing	a	salary	of	Rs.	
13,25,486/-	he	also	gets	the	following	Perquisites	&	Allowances	HRA	24000,	Bonus	20000,	
Newspaper	2000,	The	cost	of	the	car	provided	to	employees	for	personal	use	20000.	His	
Salary	as	per	section	17(1)_________

a.	13,25,486

b.	13,69,486

c.	13,91,486

d.	13,45,486

ANSWERS:

1.	c.	Salary	as	per	section	17(1)	+	Perquisites	+	Profit	in	lieu	of	salary

2.	d.	Both	(a)	and	(b)

3.	b.	Optional

4.	c.	Accounting	Information	Statement

5.	b.	13,69,486
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CHAPTER 4
INTRODUCTION TO TAX SOFTWARES
COMPUTAX SOFTWARE
CompuTax	is	income	tax	software	which	now	deals	with	taxation	software.	It	is	of	immense	help	
for	preparing	and	filing	income	tax	returns,	TDS,	service	tax,	ROC,	and	financial	XBRL.	You	can	also	
prepare	profit	and	loss	accounts,	balance	sheets	as	per	revised	Schedule	VI,	statutory	and	tax	
audit	reports,	and	more	using	CompuTax

FEATURES
PAN	Verification:	It	automatically	transfers	master	data	like	name,	address,	PAN,	TAN,	WDV	of	de-
preciation	assets,	NSC	details,	MAT	credits,	and	more.	Also,	it	looks	into	carrying	forward	of	losses.
File	e-TDS:	Import	data	like	TDS,	TCS,	Advance	Tax,	and	Self	Assessment	Tax	from	Form	26AS	ef-
fortlessly.

With	CompuTax,	you	can	generate	Form-16s,	import	data,	and	calculate	tax	as	well	as	interest.	
Moreover,	transferring	files	is	also	made	easier	with	CompuTax.	Along	with	computing	taxes,	it	
takes	care	of	ceiling,	deduction;	set-off	carry	forward	of	losses	and	more.	You	can	quickly	pre-
pare	for	income	tax,	wealth	tax,	and	e-returns.	Additionally,	it	enables	you	to	e-fill	the	return	with	
a	single	click.
 
CompuTax	 is	proficient	 to	auto-pick	any	 intimation	and	 letters	 received	 from	CPC	 from	your	
email	 account.	 Hence,	 you	 can	 free	 yourself	 from	 the	 process	 of	 providing	 passwords	 every	
time.	Moreover,	the	master	data	gets	transferred	to	the	next	assessment	years	automatically.	It	
supports	importing	data	from	26AS,	TDS	entries	from	CompuTds,	balance	sheet,	P&L,	and	return	
form	from	CompuBal,	and	permanent	information	from	the	XML	file.

ADVANCED FEATURES:

• Advance	Tax	Estimation,	Tax	Calendar,

• Club	Computation	for	new	and	old	scheme	u/s	115BAC.

• Comparison	Chart	for	Companies	u/s	115BAA	/115BAB.

• Display	of	current	&	previous	year	figures	of	income	&	tax	on	screen.

• E-return	error	Locator	with	facility	of	correction	on	same	screen.

• Direct	navigation	from	one	screen	to	other	screen.

• Ready	reckoner,	Capital	Gain	Index,	Gold	&	Silver	rate,	Tax	rates.
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• Auto	picking	of	listed	share	price	as	on	31	January	2018.

• Facility	of	creating	User	defined	password	for	all	clients

• Easy Data Transfer

• Import	data	from	xml	file	with	bulk	facility.

• Import	of	Balance	Sheet,	P&L,	computation	from	CompuBal	software.

• Automatic	transfer	of	master	data	and	particulars	to	the	next	assessment	year(s).

• Transfer	 of	 Allowable	 Remuneration	 &	 other	 details	 of	 firm’s	 partner	 to	 the	 Partner	
individual	ITR.

• Keeps	Investment	details	and	transfer	income	in	Computation	&	ITR	for	relevant	years.

 
DIRECT ONLINE ACTIVITIES FROM SOFTWARE

• Register/update	User	Profile,	DSC,	and	relevant	detail	at	IT	Portal.

• Online	filing	of	e-return	and	e-Verify	through	Aadhaar	OTP	or	generating	EVC	or	Bank	
Pre-Validation.

• Auto	download	of	ITR-V	and	auto	Fill	their	Receipt	date	from	CPC.

• View	Import	26AS	data,	My	Return/ITR/XML/JSON,	Intimation	Order.

• Request/Download	Large	26AS	&	PAN	Registration	at	TRACES.

• Auto	pick	&	management	of	Intimations	&	communications	received	on	your	email	Id	
(sent	by	ITD).

• Submit	Rectification	of	ITR,	Response	to	outstanding	tax	demand.

• Add	CA	&	Approve	Audit	Report.

Bulk	Function	Utilities	for	Link	Aadhaar	with	PAN,	Return	E-Verification,	Bank	Pre-Validation,	down-
load	26AS,	Download	Xml/JSON,	Return	Filing	Status,	Refund	Status,etc.

E-PROCEEDINGS MANAGEMENT:
	 Auto	download	all	notices,	replies	along	with	attachments	by	single	click.
	 Ease	 in	uploading	 response,	auto	naming	of	attachment	 taking	care	of	 restrictions	of	 
	 site,	allow	to	attach	more	than	10	attachments.

STATUS OF PROCEEDINGS (CLOSED/OPEN/SUBMITTED)

Facility	to	view	all	e-proceedings	and	status	of	all	clients	at	one	screen.
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WINMAN

Winman	is	a	software	solution	designed	for	accounting	and	taxation	purposes.	It	primarily	caters	
to	the	needs	of	businesses,	accountants,	and	tax	professionals	by	providing	tools	and	features	
that	streamline	fi	nancial	management	and	compliance	with	tax	regulations.	

Below	is	an	overview	of	Winman	software’s	key	features	and	functionalities	related	to	accounting:

FINANCIAL ACCOUNTING:
Winman	 offers	 a	 comprehensive	 set	 of	 tools	 for	 recording	 fi	nancial	 transactions,	 managing	
accounts	payable	and	receivable,	and	maintaining	general	ledgers.

Users	 can	 create,	 edit,	 and	 view	 various	 fi	nancial	 reports,	 including	 balance	 sheets,	 income	
statements,	cash	fl	ow	statements,	and	trial	balances.

GST (GOODS AND SERVICES TAX) COMPLIANCE:
In	countries	like	India,	where	GST	is	a	signifi	cant	tax	regime,	Winman	software	helps	businesses	
and	professionals	comply	with	GST	regulations.

It	assists	in	GST	return	fi	ling,	reconciliation,	and	tax	calculation,	ensuring	accuracy	and	compliance	
with	tax	laws.

INCOME TAX COMPUTATION:
Winman	simplifi	es	income	tax	calculations	by	providing	tax	computation	features.

It	helps	users	calculate	income	tax	liabilities,	deductions,	and	exemptions	based	on	the	prevailing	
tax	laws.
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TDS (TAX DEDUCTED AT SOURCE) MANAGEMENT:
Businesses	 and	 professionals	 can	 manage	 TDS-related	 processes	 efficiently,	 including	 TDS	
deduction,	deposit,	and	return	filing.

E-FILING AND COMPLIANCE:
Winman	often	includes	features	for	e-filing	various	tax	returns	and	forms	electronically,	making	
it	easier	to	comply	with	tax	requirements.

It	keeps	users	updated	on	tax	law	changes	and	ensures	that	returns	are	filed	accurately	and	on	
time.

PAYROLL PROCESSING:
Some versions of Winman may include payroll processing features for managing employee 
salaries,	deductions,	and	statutory	compliances.

FINANCIAL ANALYSIS AND REPORTING:
The	software	offers	tools	to	generate	financial	reports	and	conduct	financial	analysis,	helping	
businesses	make	informed	decisions.

DATA SECURITY AND BACKUP:
Winman	typically	provides	data	security	features	to	protect	sensitive	financial	information	and	
offers	options	for	regular	data	backup	to	prevent	data	loss.

USER-FRIENDLY INTERFACE:
The	software	often	features	an	intuitive	and	user-friendly	interface,	making	it	accessible	to	both	
accounting	professionals	and	those	with	limited	accounting	knowledge.

CUSTOMIZATION:
Users	can	often	customize	Winman	to	suit	their	specific	business	needs	and	industry	requirements.

CUSTOMER SUPPORT AND UPDATES:
Winman	typically	offers	customer	support	services	to	assist	users	with	software-related	queries	
and	provides	regular	updates	to	keep	the	software	compliant	with	changing	tax	laws.
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FEATURES IN WINMAN CA-ERP
• Income	Tax

• Income	Tax	computation	in	Single	window

• Bulk	Import	of	Previous	year	fi	les	with	data

• Import	all	data	from	xml	fi	le

• Depreciation table covering all situations

• Copy	/	paste	from	Excel

• Document	Map	for	fi	lled-up	ITRs

• Paper	return	&	e-Return

• Automatic	carry	forward	and	set-off	of	losses

• Auto-import	data	from	Firm	fi	le	to	Partner	fi	le

• Warnings on incomplete data entry

• Icon	indicating	mandatory	e-Return

• User	list	with	editing	option

• Computation option for any status

• Option to convert an output cell to input cell
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E-FILING TOOLS
• e-Return	submit	tool

• CA	e-report	filing	tool

• e-Return	error	locator	utility

• ITR	V	-	Auto-download	&	remove	password	&

• E-verify	ITR	using	EVC	/	Aadhaar	OTP

• Register digital signature

• Change	/	Export	e-filing	password

• Mass import of Login details

• E-filing	profile	update

• Generates	‘.	signature’	file	using	Digital	Signature	Utility

AUDIT REPORTS
• Form	3CD	/	29B	/	29C	/	3CEB	/	10B	/	10BB	e-return

• Auto-transfer	of	data	from	computation	&	ITR

• Carry	forward	of	relevant	data	to	future	years

• Import	TDS	data	to	3CD	from	Winman	TDS	software

• CA	e-Tools	-	Register	CA,	CA	login,	Add	CA,	approve	e-report

• User-friendly	reports

• e-Return	filed	/	not	filed	report

• User-defined	MIS	report

• Changes	Summary	-	when	locked	/	finalised	files	are	edited

SOFTWARE UPDATE TOOLS
• Auto-download	updates

• Software	update	status	display

ONLINE TOOLS
• PAN Validation

• e-Challan	utility

• Rectification/Refund	status	report
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• Mass	e-return	processing	status	report

• Import	data	from	26AS	in	a	single	click

• Quick	access	to	Income	Tax	Act	/	Rules

• Auto-import	of	intimation	e-mails	and	analysis	report

• Download	&	import	XML	from	IT	website

• Download	all	filed	Forms	/	XML	from	IT	website

• Add / Register as Representative

• Link	Aadhaar	to	PAN

• Submit	e-Sahyog	/	Compliance

• Check	PAN	/	TAN	Application	Status

E- SERVICES
• e-Payment

• Submission of payment details

• Message services

• Download	digitally	signed	e-invoice

• Registration	on	renewal

• Auto-registration	on	formatting	/	surrendering	license

OTHER TOOLS
• Billing

• Advance IT calculator

• Mass	Advance	Tax	Planner

• Compare	current	year	figures	to	previous	year

• Lock	file	on	finalisation

• Export	/	import	salary	data	to	Winman	TDS

• View	Bank	-	IFSC	&	BSR	code

ADD- ON FEATURES
• FAQ / Instant table help / Training Videos

• Clarifications	with	law	reference

267



TAX COMPLIANCES

• Query Manager Tool

• Enter Formula instead of value

• Keyboard	shortcuts

• Show	Desktop	to	Winman

• Integration	with	Cloud	data	services

• Open	CA-ERP	files	in	read-only	mode

• View	Data-path

• Easy	to	Group	files	within	data-path

• Add	‘File	No.’

• Search	file	using	PAN	/	part	of	PAN	/	File	No.

• List	out	recently	opened	files

• Auto repair tool

• Format	wizards

• Auto saving data

• Password	Security

• Undo and Redo facility

• Periodic	3-way	Auto-backup

• Concurrently	edit	many	files	in	a	PC

• Access	attached	file	path	in	a	single	click
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TAXMANN

Taxmann	is	a	well-known	provider	of	tax	and	accounting	software	solutions	in	India.	They	offer	a	
range	of	software	products	and	services	to	help	individuals,	businesses,	and	professionals	with	
their	taxation	and	financial	needs.

Here’s	 an	 overview	 of	 Taxmann’s	 software	 and	 some	 common	 features	 that	 their	 products	
typically include:

INCOME TAX SOFTWARE: 

Taxmann	provides	software	for	preparing	and	filing	income	tax	returns.	These	software	tools	are	
designed	to	simplify	the	tax	return	filing	process	and	help	individuals	and	businesses	comply	
with	Indian	tax	laws.	

Key features may include:

• Step-by-step	guidance	for	filling	out	tax	forms.

• Automatic	calculation	of	tax	liabilities.

• Importing	financial	data	from	various	sources.

• E-filing	of	tax	returns.

• Updates	to	incorporate	changes	in	tax	laws	and	regulations.

GST (Goods and Services Tax) Software: 

With	the	introduction	of	GST	in	India,	Taxmann	offers	software	solutions	to	assist	businesses	in	
managing	their	GST	compliance.	Common	features	include:

• GST	return	filing	and	reconciliation.

• Invoice	and	inventory	management.

• Real-time	GSTIN	validation.

• E-way	bill	generation.

• Compliance	reports	and	analytics.

Accounting Software: 
Taxmann	may	also	offer	accounting	software	for	businesses.	These	tools	help	organizations	
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manage	their	financial	transactions,	bookkeeping,	and	reporting.	Features	often	include: 

• General	ledger	and	chart	of	accounts.

• Accounts	payable	and	receivable.

• Bank	reconciliation.

• Financial	statement	generation.

• Multi-currency	support.

TDS (Tax Deducted at Source) Software: 

• For	 businesses	 and	 individuals	 required	 to	 deduct	 TDS,	 Taxmann’s	 software	 may	
include features such as:

• TDS	calculation	and	deduction.

• TDS	return	preparation	and	filing.

• TDS	certificate	generation.

• Compliance	tracking	and	reporting.

Compliance Updates:

Taxmann	typically	provides	 regular	updates	 to	ensure	 that	 their	software	 remains	compliant	
with	changing	tax	laws	and	regulations	in	India.

CUSTOMER SUPPORT: 

Taxmann	 usually	 offers	 customer	 support	 services	 to	 assist	 users	 with	 any	 software-related	
queries	or	issues	they	may	encounter.
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TRAINING AND DOCUMENTATION: 
Taxmann	may	provide	training	materials,	documentation,	and	tutorials	to	help	users	make	the	
most	of	their	software	products.
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FEATURES OF TAXMANN

Taxmann One Solution

Taxmann’s	One	Solution	 is	a	TDS	filing	software	that	helps	users	generate	TDS	or	TCS	returns,	
along	with	TDS	certificates.	 It	 is	a	comprehensive	solution	 for	all	your	 tax	filing	needs,	having	
built-in	calculation	tools	to	make	way	for	error-free	return	submissions.	One	can	even	deposit	
challan	and	make	a	detailed	calculation	of	allowances,	retirement	benefits	and	perquisites	for	
the	ease	of	availing	tax	deductions	on	salary.

Taxmann’s Help for Tax Professionals

Taxmann	helps	to	automate	all	the	tax	compliances	of	the	users	and	is	designed	to	fit	 in	the	
requirements	of	 every	 tax	professional.	 The	 software	enables	users	 to	handle	 various	 tax	 fil-
ing	operations,	including	Income	Tax	filing,	managing	GST	returns,	Indirect	Tax	filing,	managing	
Corporate	Laws,	and	dealing	with	International	Taxation.	Taxmann	also	assists	tax	filers	with	Ac-
counts	and	Audit	management	and	offers	support	and	guidance	with	the	latest	Indian	Acts	and	
Rules	and	the	Insolvency	and	Bankruptcy	Codes.	Users	can	even	import	their	data	from	another	
software	via	consolidated	TDS	files.	Moreover,	the	application	has	the	functionality	of	auto-gen-
eration	of	TDS	or	TCS	forms,	including	12BA,	16,	16A	and	27D.

Unique Features of Taxmann

There	is	also	a	facility	for	reverse	tax	calculation	to	enable	users	to	calculate	the	amount	of	TDS	
and	payment	accurately.

It	even	has	shortcut	keys	to	help	users	have	quick	access	to	all	the	functionalities	of	Taxmann.	
Taxmann	has	a	bulk	PAN	verification	feature,	allowing	users	to	verify	the	PAN	of	all	deductees	or	
employees	with	a	single	click.	Moreover,	 it	also	provides	alerts	for	duplicate	names,	duplicate	
PAN	or	blank	names.	Taxmann	can	also	help	users	define	employee	salary	structures	to	ensure	
faster	TDS	entries.

How is Taxmann Different?

With	this	 ITR	preparation	software,	users	can	generate	TDS	or	TCS	returns	and	even	TDS	cer-
tificates	and	deposit	challans	directly	from	TRACES.	Taxmann’s	One	Solution	enables	users	to	
check	Traces	request	and	download	TDS	certificates,	along	with	the	consolidated	files,	and	Jus-
tification	Reports	directly	from	TRACES.	The	application	has	a	functionality	of	importing	Deduc-
tion	Entry	directly	 from	Excel	 that	helps	 in	bulk	creation	of	deduction	entries.	One	can	 import	
deduction	entries	directly	from	Excel	to	enable	a	bulk	creation.	The	application	helps	them	to	
automate	tax	calculations	for	other	TDS	returns	including	26Q,	27Q	and	27EQ.
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GENIUS SOFTWARE
INTRODUCTION
Genius	software	is	the	return	furnishing	software	made	by	the	taxation	and	accounting	software	
development	company	SAG	Infotech	which	is	situated	in	Jaipur.	It	is	recognized	and	accepted	
software	that	assists	professional	customers	to	furnish	distinct	returns	since	the	AY	2001-02.

FEATURES OF GENIUS SOFTWARE (TAX RETURN FILING)

The	software	provides	unlimited	client	return	filing	of	income	tax,	TDS,	AIR/SFT,	etc	with	it’s	up	to	
date	taxation	procedure.	The	Genius	has	a	total	of	6	modules	including	GEN	BAL	(Balance	Sheet),	
GEN	IT	(Income	Tax),	GEN	CMA,	GEN	FORM	MANAGER,	GEN	TDS	(Tax	Deducted	at	Source)	and	AIR/
SFT.	Genius tax return software	offers	multiple	features	like	Backup,	Restore,	Password	Settings	
which	makes	it	an	overall	tax	filing	software	among	the	category	of	best	taxation	software	in	
India.

GEN IT INCOME TAX (SOFTWARE FEATURES):

GEN CMA/EMI CREDIT MONITORING ANALYSIS SOFTWARE FEATURES:
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GEN BAL (BALANCE SHEET) SOFTWARE FEATURES:

GEN TDS (TAX DEDUCTED AT SOURCE) SOFTWARE FEATURES:

USER INTERFACE OF GENIUS TAX FILING SOFTWARE:
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FEATURES OF GENIUS TAX RETURN FILING SOFTWARE 
User	Friendly	Software
Genius	 tax	 furnishing	software	 for	CA	 is	 simpler	 to	execute,	practice	and	 is	adaptable	 to	 the	
company’s	working	nature.	Its	interface	has	been	developed	as	per	the	compliance	of	the	char-
tered	accountants,	company	secretary	and	tax	professionals.

REDUCED COST
Prevent	the	cost	and	time-consuming	manual	steps	of	handling	ITR	filing.	A	manual	filing	con-
sumes	more	time	and	is	indeed	not	efficient	in	filing	the	taxes	and	thus	wastes	lots	of	resources	
along	with	the	man-hours	that	will	be	costlier	to	you.

CUTTING-EDGE TECHNOLOGY
The	newer	technology	is	being	used	to	make	the	Genius	software	that	helps	in	the	automatic	
filing	of	ITR	or	TDS	returns.	Also,	the	company	is	putting	resources	into	developing	the	ERP	system	
for	complete	software	packages	to	create	a	better	infrastructure	for	the	clients	working	on	filing.

FURNISH ITR OR TDS RETURNS QUICKLY
Genius	can	file	the	self-assessment,	advance	tax	along	with	the	computation	of	interest	with	a	
quick	ITR	filing	of	TDS	return	also.	The	overall	CA	tax	software	algorithm	has	been	set	up	in	accor-
dance	with	the	government	compliance	for	better	synchronization	within	the	filing.

UNLIMITED CLIENT TAX RETURNS FILING
You	can	add	unlimited	clients	to	the	filing	software	and	file	their	tax	returns	simultaneously.	The	
software	will	add	each	client	as	an	individual	account	and	will	also	maintain	the	data	separa-
tion	between	each	account	to	create

ROLE-BASED ACCESS CONTROL
The	best	tax	return	management	software	can	be	controlled	by	role-based	access	as	the	ad-
ministrator	can	assign	operative	control	to	any	of	the	subordinates	or	clients.	The	role-based	
access	gives	better	control	to	the	tax	details	and	login	security.

DATA SECURITY AND BACKUP
Genius	is	the	advanced	CA	tax	return	filing	software.	It	has	encryption	security	for	complete	cus-
tomers’	tax	data	with	the	facility	to	store	and	backup	the	overall	tax	details	with	a	master	copy	
for	each	individual	client	account.	It	is	a	bigger	relief	to	the	taxpayers.

TRUSTWORTHY SOFTWARE SINCE 2001
The	Genius	software	package	has	an	all-India	presence	in	the	taxation	industry	and	has	been	
filing	clients’	taxes	since	2001.	The	Genius	package	has	been	a	worthy	tax	filing	software	and	is	
officially	recognized	by	the	government	department	on	the	portal.
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CHAPTER5
E FILINGS UNDER GST

LEARNING OUTCOMES

a	 GST	Portal	and	associated	features.

a	 The	steps	involved	in	obtaining	a	TEMPORARY	REFERENCE	NUMBER	(TRN).

a	 Guidelines	for	generating	TRN.

TASK 
Mr.	Alwin	Thomas	is	doing	business	in	Bangalore	under	the	name	Alwin	Agencies,	and	he	wants	
to	register	for	GST	as	a	normal	taxpayer.	As	a	GST	consultant,	based	on	the	given	information	
you	are	required	to	advice	on	obtaining	a	GST	TRN	registration.

Aadhaar	No:	1605	9325	8741	

PAN	No:	BCBXJ3012K	

Gender: Male 

DOB:	April	08th,	1997	

Email	Id:	alwint@gmail.com	

Phone	No:	2363987456	

Address:	Bangalore	(Rural),	Karnataka	

You	are	required	to	generate	a	unique	TRN	(Temporary	Reference	Number)	in	order	to	initiate	
the	GST	registration	process.	

5.1 STEPS FOR GENERATING A TRN
CLICK	CONTINUE	TO	START	THE	TASK.	
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Fig	no.1.1.a

PART A: 
Generate Temporary Reference Number for obtaining GSTIN:
Open	Services	>	Registration	>	New	Registration
Details	and	documents	required	for	generating	TRN:
Address
PAN 
Email
Mobile
        
ENTER THE DETAILS AS MENTIONED IN THE DOCUMENTS IN THE NEXT PAGE. 
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Fig	no.1.1.b

Click	on	New registration.
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Select the type of Taxpayer/ deductor as	the	case	in	the	drop-down	box	shown.
Select the State and District from	the	drop-down	box.
Enter	the	name	mentioned	in	the	PAN	of	the	Proprietor	or	Business	as	the	Legal name.
Provide a valid Mobile No. and Email address for	OTP	verifi	cation.
Type	the	captcha	code	shown	in	the	box	and	click	on	the proceed button.

VERIFY WITH THE OTPs SENT TO THE MAIL AND MOBILE.

Fig	no.1.1.c

Click	on the proceed button	after	entering	the	OTPs.

Temporary	reference	number	will	be	sent	to	you	through	Email	or	SMS.	It	will	be	valid	for	15 days 
for completing the registration procedure PART B.

After	 successful	 completion	 of	 TRN	 Generation,	 a	 Pop-Up	 window	 will	 be	 shown	 as	
CONGRATULATIONS.
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Fig	no.1.1.D

The	TM	sent	through	email	or	mobile	will	be	used	for	further	registration	process	and	will	be	valid	
for	15	days.

MULTIPLE CHOICE QUESTIONS (MCQS)

1.What does GST TRN stand for? 
(a)	Goods	and	Services	Tax	Transaction	Reference	Number	

(b)	Goods	and	Services	Tax	Taxpayer	Registration	Number	

(c)	Goods	and	Services	Tax	Transaction	Reporting	Number	

(d)	Goods	and	Services	Tax	Refund	Number

2.Who is required to obtain a GST TRN? 
(a)	All	individuals	in	the	country	

(b)	Only	businesses	engaged	in	manufacturing	

(c)	Businesses	and	individuals	liable	to	pay	GST	

(d)	Only	large	corporations

3.Which government authority is responsible for issuing a GST TRN? 
(a)	Local	Municipality	

(b)	State	Tax	Authority	
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(c)	Central	Tax	Authority	

(d)	Ministry	of	Finance

4. What information is typically required when applying for a GST TRN? 
(a)	Passport	number	and	date	of	birth	

(b)	Business	name,	address,	and	PAN	(Permanent	Account	Number)	

(c)	Driver’s	license	and	vehicle	registration	details	

(d)	Educational	qualifications	and	employment	history

5. How often should a business renew its GST TRN? 
(a)	Annually	

(b)	Every	five	years	

(c)	It	doesn’t	need	to	be	renewed	

(d)	Whenever	there	is	a	change	in	business	ownership

ANSWERS

1	(b)	Goods	and	Services	Tax	Taxpayer	Registration	Number

2	(c)	Businesses	and	individuals	liable	to	pay	GST

3	(c)	Central	Tax	Authority

4	(b)	Business	name,	address,	and	PAN	(Permanent	Account	Number)

5	(c)	It	doesn’t	need	to	be	renewed
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CHAPTER 6
GST REGISTRATION

LEARNING OBJECTIVE 

a	 Learn	how	to	take	a	GST	registration.

a	 Necessary	documents	needed	for	registration.

In	order	to	obtain	GST	registration,	the	person	liable	to	get	registered	should	have	with	him,	the	
necessary	details	which	include	the	generated	TRN,	his	reason	to	get	registered,	commence-
ment	date,	residential	details,	business	details,	HSN	or	SAC	codes	on	the	basis	of	what	the	per-
son	is	dealing.

TASK 
Ornate	Enterprises	is	engaged	in	wholesale	supply	of	non-alcoholic	soft	drinks	in	Panaji,	Goa.	It	
also	supplies	alcoholic	liquor	for	human	consumption	from	Nagaland.	Its	turnover	in	the	current	
financial	year	is	Rs.	38,00,000/-	in	Goa	and	Rs.	9,00,000/-	in	Nagaland.	Since	Ornate	Enterprises	
is	exclusively	engaged	in	making	taxable	supplies	of	goods	from	Goa,	the	applicable	threshold	
limit	for	obtaining	registration	is	Rs.	40,00,000/-.	

Further,	the	threshold	limit	will	not	be	reduced	to	Rs.	10,00,000/-	in	this	case,	as	supply	of	alco-
holic	 liquor	 for	human	consumption	 from	Nagaland	(one	of	 the	special	category	states)	are	
non-taxable	supplies.	In	the	given	case,	since	the	aggregate	turnover	of	Ornate	Enterprises	ex-
ceeds	the	applicable	threshold	limit	of	Rs.	40,00,000/-,	it	is	liable	to	obtain	registration.	

They	will	obtain	registration	in	Goa,	but	it	is	not	required	to	obtain	registration	in	Nagaland	as	
they	are	not	making	any	taxable	supplies	from	the	said	state.	Ornate	Enterprises	tried	to	register	
for	GST	by	themselves	and	completed	the	first	stage	of	registration	and	a	temporary	reference	
number	 (TRN)	 is	generated.	 For	completing	GST	 registration	as	a	normal	 taxpayer,	as	a	GST	
practitioner	you	are	required	to	complete	the	GST	registration	process.

Further details are given below:  
• Temporary	Reference	Number:	234765871299TRN	

• Reason to obtain Registration: Crossing the threshold
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• The	date	of	Commencement	of	Business:	10-08-2022	

• The	date	on	which	Liability	to	Register	arises:	05-09-2022

Details of Proprietor:
 
Name: Abhay Lal   
Father’s	Name:	Anand	Lal
PAN	No:	KJLXA6754H
Aadhar	No:	4534	9856	7234
Mob:	2324534534, 
DOB:	May	13th,	1990,
Email Id: abhaylal90@gmail.com
Residential Address:  
No.	6,	3rd	Floor, 
World One, 
MO	Road,	Sector	14, 
Panaji,  
Goa,  
Pin	code:	403001.	
Business	Address: 
No.	645,	
2nd	floor,	Wild	Estates,	 
MG	Road,	Sector	25, 
Panaji, 
Goa,  
Pin	code:	403001. 
Email Id: abcltd@gmail.com

Other Information:  

Commissionerate: Goa 
Division:	22 
Range: Goa 
Ward: 6 
Product’s	HSN:	220110,	220210	&	2202

6.1 STEPS FOR GST REGISTRATION
Access the page https://www.gst.gov.in/
Click	on	the	services	option,	and	under	registration,	select	new	registration.
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Fig	no:1.2.a

Select	TRN	option	and	insert	the	TRN	and	provide	the	CAPTCHA	code	as	well	and	click	PROCEED.

Fig	no:1.2.b

A	One-time	password	would	be	sent	to	your	mobile	no	and	email	ID,	insert	the	OTP	in	the	respec-
tive	column	and	click	PROCEED.
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Fig	no:1.2.c

In	the	dashboard,	click	on	the	edit	symbol	under	Action. 

Fig	no:1.2.d

BUSINESS DETAILS

10	boxes,	from	Business	details	of	the	person	to	the	verification,	would	be	shown	and	after	giving	
information	in	each	box	separately,	each	box	would	turn	blue,	and	a	tick	would	appear	on	the	
box.
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Fig no:1.2.e

• Provide Tradename of	 the	person,	and	 from	the	drop-down	box,	 select	which	 the	
constitution of the business of	the	assessee	is.

• There	would	be	an	ON/OFF	button	asking	whether	he/she	 is	applying	as	a casual 
taxable person or for a composition scheme, select according to their relevant 
preferences.

• From	 the	 drop-down	 box,	 select	 the	 reason to obtain registration, Date of 
commencement of Business and the Date on which liability to register arises.

• 	If	the	person	has	any	existing	registrations	standing	in	his	name,	the	assessee	needs	
to provide information including the Type of registration, Registration no. as	well	
as the Date of registration in prescribed columns and if more than one registration 
been	taken,	press	ADD+	to	fill.

• Press Save and continue,	then	the	website	would	take	us	to	the	details	to	be	filled	in	
the	next	box.
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PROMOTORS/ PARTNERS
Fig	no:	1.2.	f
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• In personal information, provide the First and Last name of the person, his father, 
Mobile-no., DOB, valid Email-ID and specify Gender	of	the	person.

• Under Identity information,	 from	 the	 drop-down	 box,	 specify	 the	 Designation/
Status of	the	person,	whether	the	person	has	a	Director	Identification	Number,	insert	
DIN and PAN in	the	respective	fields.

• Under Residential Address, specify building/flat no., Floor no., Name of premises/
Building, Road/street, City / Town / Locality / Village, Country, state, district and 
Pin code.

• Under Document Upload, the person may upload his photo, but should be in JPEG 
format	less	than	100kb	or	may	take	a	picture	using	the	device	camera	and	upload	
instantly.

• In other information, if the person is the Authorized signatory and Authorized, then 
the	 person	 may	 switch	 ON	 the	 button	 provided,	 and	 the	 next	 two	 boxes	 named	
Authorized signatory and Authorized representative	 would	 be	 Auto	 filled.	 If	 the	
person is not the Authorized signatory, details of the signatory and representative 
need	to	be	filled	out	separately.

• Press save and continue.
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PRINCIPAL PLACE OF BUSINESS
Fig	no:1.2.	g
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• Under	 the	 Details	 of	 Principle	 place	 of	 Business,	 provide	 specified	 building/flat no., 
Floor no., Name of premises/Building, Road/street, City / Town / Locality / Village, 
Country, state, district and Pin code.

• The Latitude and Longitude of	 the	 PPOB	 would	 be	 automatically	 found	 by	 the	 GST	
website	and	would	be	auto	filled.

• Provide	State	jurisdiction	Circle	as	well.

• Under	Contact	information,	provide	Office	Email	ID,	Office	Telephone	Number	(with	STD	
Code)	(IF	ANY),	Mobile	Number,	Office	Fax	Number	(with	STD	Code)	(IF	ANY).

• Provide the NATURE OF POSSESSION OF PREMISES and upload relevant documents 
regarding the proof of Authorized signatory as	well.		Documents	need	to	be	less	than	
1	MB	in	Size	and	should	be	in	PDF	or	JPEG	format.

• Under Nature of Business Activity being carried out at above mentioned premises, 
Click	on	the	relevant	checkbox	of	the	activity	of	the	person.

• If the person has an Additional place of business, the	button	may	be	switched	ON	and	
details	of	APOB	may	be	provided.

• Press save and continue.
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1.2.5 GOODS AND SERVICES
Fig	no:1.2.	h

• Search for the HSN or SAC codes depending upon the Goods or services the person is 
dealing	with	from	the	Drop-down	box.

• Press Save and Continue.
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STATE SPECIFIC INFORMATION
Fig	no:1.2.	i

• Provide	(if	any)	details	of	Professional Tax Employee Code (EC) No., Professional Tax 
Registration Certificate (RC) No., State Excise License No. and Name of the person in 
whose name Excise License is held.

• Press save and continue.

AADHAR AUTHENTICATION
Fig	no:1.2.	j

• In	 order	 to	 authenticate	 Aadhar,	 the	 option	 needs	 to	 be	 switched	 ON.	 A	 checkbox	
specifying	the	details	of	the	person	would	appear	and	the	check	box	needs	to	be	ticked.	

• Press Save and Continue.
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VERIFICATION
Fig	no:1.2.	j

• Click	 on	 the	 verification	 checkbox	 for	 as	 a	 Self-declaration	 and	 then	 select	 the	
Authorized	signatory	from	the	drop-down	list	and	insert	the	Place	of	Business.

• Press Submit with	EVC or DSC.

• In	the	field	shown	above,	insert	the	OTP	sent	to	the	specified	E-mail/Mobile	no.	and	click 
PROCEED.

A POP-UP message indicating that we have completed the GSTIN REGISTRATION will Appear.
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     MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the purpose of the OTP sent to your mobile number and email during GST 
registration?

a)	To	verify	your	email	address

b)	To	confirm	your	mobile	number	

c)	To	proceed	with	the	registration	process	

d)	To	provide	access	to	the	GST	portal

2. What is the purpose of the “Authorized Signatory” in GST registration?

a)	To	represent	the	business	

b)	To	upload	documents

c)	To	verify	Aadhar

d)	All	of	the	above.

3. What does “PPOB” stand for in GST registration?

	 a)	Principal	Place	of	Business

	 b)	Primary	Point	of	Business	

	 c)	Professional	Place	of	Business

	 d)	Personal	Place	of	Business.

4. What does “EVC” stand for in GST registration?

	 a)	Electronic	Verification	Code

	 b)	Enhanced	Verification	Credential	

	 c)	Effective	Verification	Code

	 d)	Encrypting	Verification	Certificate

5. What is the purpose of the HSN or SAC codes in the “Goods and Services” section? 

	 a)	To	verify	the	business

	 b)	To	calculate	taxes

	 c)	To	classify	products	and	services

	 d)	To	provide	contact	information
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ANSWERS

1 C
2 A
3 A
4 A
5 C
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CHAPTER 7
NIL RETURN FILING

LEARNING OUTCOMES

             AT THE END OF THIS CHAPTER, YOU WILL BE ABLE TO :

a Understand GST Nil Return 

a File GST Nil Return

TASK 1

Mr.	 Rahul	 Kishan	 started	 a	 manufacturing	 company	 named	 RK	 Associates	 on	 September	
5th,	 2022,	 and	 completed	 all	 necessary	 legal	 compliance,	 including	 GST	 registration,	 before	
beginning	operations.	However,	due	to	technical	reasons,	the	company	could	only	commence	
its	operations	in	October	2022.	Mr.	Rahul	Kishan	has	requested	that	you	file	NIL	GST	returns	for	
September	2022,	as	no	purchases	or	sales	occurred	during	the	return	period.	

You	are	required	to	submit	NIL	GSTR-1	and	GSTR-3B	returns.	

	 User	Id:	RAHUL@45	 	 	 	 	 	 	

	 Password:	Rk@123	 	 	 	 	 	 	

	 GSTIN:	20AFSXN5937H1Z2

7.1 STEPS FOR NIL RETURN FILING

Click continue to start the task.  
Then	Click	the	login	button	>	Enter	User	Id	&	Password	>	login.

296



TAX COMPLIANCES

Fig	1.3.a

Click on RETURN DASHBOARD 
Fig	1.3.b

Select	appropriate	Financial	Year,	Quarter	and	Period,	then	Click	the	SEARCH	button.
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Fig	1.3.c

Open	GSTR	1	>	Tick	in	File	Nil	GSTR	–	1	>	Click	on	FILE	STATEMENT

Fig	1.3.d

Fig	1.3.e
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Tick	in	the	declaration	Statement	>	Select	Appropriate	Authorised	Signatory	>	Click	FILE	WITH	
EVC	button.

Fig	1.3.f

Enter	the	OTP	and	Click	the	Verify	button	to	File	the	Nil	Return
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Fig	1.3.g

After	 successful	 completion	 of	 Nil	 Return	 Filing,	 a	 Pop-Up	 window	 will	 be	 shown	 as	
CONGRATULATIONS.

Fig	1.3.h
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   MULTIPLE CHOICE QUESTIONS (MCQS)

1. When is a GST Nil Return typically required to be filed?
(a)	Weekly	
(b)	Monthly	
(c)	Annually	
(d)	Only	when	requested	by	the	tax	authorities

2. Why is it important to file a Nil Return under GST even when there are no transactions 
to report?
(a)	To	receive	a	refund	from	the	government	
(b)	To	avoid	paying	a	late	filing	fee	
(c)	To	maintain	compliance	with	tax	regulations	
(d)	To	report	exempt	transactions

3. What can be the consequence of not filing a required GST Nil Return?
(a)	The	government	will	automatically	calculate	and	charge	a	penalty.	
(b)	The	taxpayer	will	be	exempt	from	GST	in	the	future.	
(c)	No	consequences,	as	Nil	Returns	are	not	mandatory.	
(d)	The	taxpayer	will	receive	a	tax	refund.

4. What is the primary purpose of maintaining records even when filing Nil Returns? 
(a)	To	qualify	for	lower	GST	rates	
(b)	To	provide	proof	of	income	to	lenders	
(c)	To	comply	with	tax	laws	and	facilitate	audits	
(d)	To	claim	input	tax	credit

5. Which GST return type is specifically used to report Nil Returns for regular 
taxpayers? 

(a)	GSTR-1	
(b)	GSTR-2	
(c)	GSTR-3B	
(d)	GSTR-9

ANSWERS
1	(b)	Monthly
2	(c)	To	maintain	compliance	with	tax	regulations
3	(a)	The	government	will	automatically	calculate	and	charge	a	penalty.
4	(c)	To	comply	with	tax	laws	and	facilitate	audits
5	(c)	GSTR-3B
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CHAPTER 8
GSTR-1 FILING

LEARNING OBJETIVES: 

a Understanding the GST Framework: Gain a comprehensive understanding of the 
Goods	and	Services	Tax	(GST)	system	in	 India,	 including	 its	purpose,	scope,	and	
applicability.

a Applicability and Thresholds: Learn the criteria for mandatory registration under 
GST	and	the	threshold	limits	for	businesses	to	determine	if	they	need	to	file	GSTR-1.

a Registration and Compliance: Understand the process of GST registration, 
including	the	documentation	and	requirements	involved	in	becoming	a	registered	
taxpayer.

a Filing Frequency and Due Dates:	 Learn	 about	 the	 filing	 frequency	 of	 GSTR-1	
(monthly	or	quarterly)	and	the	specific	due	dates	for	filing,	ensuring	compliance	
with	timelines.

a Components of GSTR-1: Familiarize	 yourself	 with	 the	 different	 sections	 and	
components	of	GSTR-1,	such	as	B2B	supplies,	B2C	supplies,	exports,	and	more

Invoices and Documentation:  Understand the importance of maintaining accurate records 
and documentation for invoices, credit notes, debit notes, and advance receipts

INTRODUCTION:
GSTR-1	 is	a	return	form	under	the	Goods	and	Services	Tax	(GST)	system	in	 India.	 It	 is	used	by	
registered	 taxpayers	 to	 provide	 details	 of	 outward	 supplies	 of	 goods	 and	 services.	 GSTR-1	 is	
designed	to	capture	comprehensive	information	about	a	taxpayer’s	outward	supplies.	It	helps	
in	determining	the	tax	liability	of	the	supplier	and	the	eligibility	of	the	recipient	for	claiming	Input	
Tax	Credit	(ITC).	Registered	taxpayers	whose	annual	turnover	exceeds	the	prescribed	threshold	
limit	are	required	to	file	GSTR-1	regularly.	The	threshold	limit	may	vary	for	different	categories	of	
taxpayers.	GSTR-1	is	typically	filed	on	a	monthly	basis.	However,	certain	categories	of	taxpayers	
can	opt	for	quarterly	filing.

GSTR-1	was	introduced	as	part	of	the	GST	regime	from	its	inception.	It	was	designed	to	capture	
the	details	of	outward	supplies	made	by	registered	taxpayers	Over	time,	the	government	made	
several	amendments	and	simplifications	to	the	GST	law	and	the	GSTR-1	filing	process	to	address	
concerns	and	facilitate	smoother	compliance.	GSTR-1	remained	a	critical	component	of	the	GST	
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compliance	system	in	India.	Its	relevance	in	the	current	period,	GSTR-1	data	is	used	by	recipients	
to	claim	Input	Tax	Credit.	Businesses	can	offset	the	GST	they	have	paid	on	purchases	against	the	
GST	they	collect	on	sales,	thereby	reducing	their	tax	liability.

Taxpayers	can	make	amendments	or	corrections	to	previously	filed	GSTR-1	returns	in	subsequent	
returns,	using	specific	 tables	provided	 for	 this	purpose.	 Failure	 to	file	GSTR-1	by	 the	due	date	
may	result	in	penalties	and	interest	charges.	Late	filing	can	also	affect	input	tax	credit	claims.	
Taxpayers	are	required	to	maintain	accurate	records	of	all	invoices,	documents,	and	supporting	
data	related	to	the	information	provided	in	GSTR-1	for	a	specified	period.

In	summary,	GSTR-1	is	a	vital	component	of	GST	compliance	in	India.	It	ensures	transparency	in	
the	tax	system	and	facilitates	the	matching	of	input	tax	credit	claims.	Filing	GSTR-1	accurately	
and	 on	 time	 is	 crucial	 for	 businesses	 to	 avoid	 penalties	 and	 maintain	 compliance	 with	 GST	
regulations.

TASK 
STC	 Pvt.	 Ltd.	 is	 a	 wholesale	 dealer	 of	 electronic	 hardware	 in	 Kochi,	 registered	 in	 the	 state	 of	
Kerala.	As	a	GST	practitioner,	you	are	requested	to	file	GSTR-1	for	the	below	sales	records	for	the	
month	of	September	2022.

The	monthly	summary	of	their	sales	is	given	below.

Sales Details

Date Invoice 
No.

Recipient GST 
Number Recipient Name Taxable  

Value
GST 
Rate

Invoice 
Value

03-09-2022	 INV456 32ADFXH-
5236K1Z2	 Fiber Spares 1,00,000 18% 1,18,000

11-09-2022	 INV457   Jaya	Shankar	(Kerala)	 10,000 18% 11,800

15-09-2022	 INV458   Ravi	Krishnan	 
(Karnataka)	 2,60,000 12% 2,91,200

18-09-2022	 INV459 33AERXF-
6598H1ZQ	 Sakthi	Electricals 1,00,000 18% 1,18,000

22-09-2022	 INV460   Rajeev	(Tamil	Nadu)	 10,000 18% 11,800

Document	Issued:	from	INV456	to	INV460										
Total Issued Invoice: 5 
Cancelled	Invoice:	0		
         
User	Id:	NERGYINDIA	
Password:	Nergy@123	
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8.1 STEPS FOR GSTR1 FILING

Clicking	the	“Start”	button	on	the	question	page	will	redirect	you	to	the	portal’s	homepage,	where	
you can log in

Click	on	the	login	button

Fig1.4	a

 

After the login page appears, proceed to enter the necessary credentials in order to successfully 
log	in.

Fig1.4.	b

.
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Fig1.4.	c

Click	on	“Return	Dashboard”	to	file	GSTR	1	Return.

Fig1.4.	d

In	the	dashboard,	enter	the	necessary	credentials	based	on	the	scenario.	In	this	case,	you	are	
asked	to	file	the	GSTR-1	for	the	month	of	September	2022.

 
Fig1.4.	e
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Financial	year	–	2022-2023
Quarter		-Quarter	2	(July-September)
Period				-September
Click	the	search	button

Fig1.4.	f

Select	GSTR	1	and	click	on	“PREPARE	ONLINE”

Fig1.4.	g

According	to	the	provided	question,	there	are	B2B	and	B2C	transactions;	therefore,	credentials	
need	to	be	provided	accordingly.
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Fig1.4.h

Invoices	associated	with	B2B	transactions	should	be	documented	by	selecting	the	‘ADD	RECORD’	
option.

Fig1.4.	i

Provide	the	information	provided	as	per	the	question.

Fig1.4.	j
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03-09-2022	 INV456 32ADFXH5236K1Z2	 Fiber Spares 1,00,000 18% 1,18,000

Fig1.4.	k
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To	add	the	other	B2B	transaction	click	on ADD RECORD.
Fig1.4.	l

18-09-2022	 INV459	 33AERXF6598H1ZQ	 Sakthi	Electricals 1,00,000 18% 1,18,000

Fig1.4.	m
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B2C	transactions	can	be	categorized	into	two.B2B	large	and	B2B	others.	

Inter-state	outward	supplies	 to	an	unregistered	person	having	an	 invoice	value	greater	 than	
2,50,000	will	be	entered	under	B2B	large.

Taxable	supplies	to	an	unregistered	person	other	than	covered	under	Table	5.

Fig1.4.	n

Invoices	associated	with	B2C	Large	transactions	should	be	documented	by	selecting	the	‘ADD	
RECORD’	option.

Fig1.4.	n

Provide	information	as	per	the	question.
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Fig1.4.	o

15-09-2022	 INV458   Ravi	Krishnan	(Karnataka)	 2,60,000 12% 2,91,200
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Fig1.4.	p

313



TAX COMPLIANCES

Transactions	related	to	B2C	others	(as	explained	above)	have	to	be	entered	under	B2C	large.

Fig1.4.	q

Invoices	associated	with	B2C	Others	transactions	should	be	documented	by	selecting	the	‘ADD 
RECORD’ option.

Fig14.	r
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Information	should	be	provided	as	per	question

Fig1.4.	s

11-09-2022	 INV457   Jaya	Shankar	(Kerala)	 10,000 18% 11,800

Fig1.4.	t
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To	add	another	invoice,	click	on	the	“ADD	RECORD”	button.

Fig1.4.	u

22-09-2022	 INV460	   Rajeev	(Tamil	Nadu)	 10,000 18% 11,800

Fig1.4.	v

Number	of	Invoices	issued	should	be	updated	under	“Documents	Issued”.
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Fig1.4.	w

All	the	credentials	provided	in	the	question	are	to	be	given	accordingly. 

Fig1.4.	x
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Fig1.4.	y

Save	the	document	after	providing	necessary	credentials.

Fig1.4.	z

Click	on	generate	summary	to	create	a	summary	of	the	above	

Fig1.4.	aa

There	will	be	a	message	displayed	before	filing	the	summary	then	click	to	“PROCEED	TO	FILE/
SUMMARY”.

Fig1.4.	ab

A	consolidated	summary	is	displayed	and	click	on	the	button	“FILE	STATEMENT”	to	file	the	
statement.
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There	 is	 a	 display	 of	 an	 affirmation/declaration	 before	 filing	 GSTR	 1.	 After	 submitting	 the	
declaration,	there	display	a	drop	down	to	select	the	authorized	signatory.	Then	click	“FILE	WITH	
EVC”.

Fig.1.4.	ad

Fig.1.4.	ae

Enter	the	one	term	password	as	provided	in	the	question	and	click	on	“VERIFY”

Fig.1.4.	af
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There	displays	a	message	for	completion	of	GSTR-1	filing.

Fig.1.4.	ag

      MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the primary purpose of filing GSTR-1 under the Goods and Services Tax (GST) 
system in India?

a)	To	claim	Input	Tax	Credit	(ITC)

b)	To	report	outward	supplies	of	goods	and	services

c)	To	pay	GST	liability

d)	To	request	a	GST	refund

Answer: b)	To	report	outward	supplies	of	goods	and	services

2. Which of the following taxpayers is required to file GSTR-1 on a monthly basis?

a)	Businesses	with	an	annual	turnover	below	Rs.	20	lakhs

b)	Composition	scheme	taxpayers

c)	Businesses	with	an	annual	turnover	above	Rs.	1.5	crores

d)	All	registered	taxpayers

Answer: c)	Businesses	with	an	annual	turnover	above	Rs.	1.5	crores
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3. When is the due date for filing GSTR-1 for monthly filers?

a)	10th	of	the	following	month

b)	11th	of	the	following	month

c)	15th	of	the	following	month

d)	20th	of	the	following	month

Answer: b)	11th	of	the	following	month

4. What type of supplies are reported in the B2C section of GSTR-1?

a)	Business-to-business	(B2B)	supplies

b)	Business-to-government	(B2G)	supplies

c)	Business-to-consumer	(B2C)	supplies

d)	Export	supplies

Answer: c)	Business-to-consumer	(B2C)	supplies

5. What happens if a taxpayer fails to file GSTR-1 by the due date?

a)	They	are	automatically	granted	an	extension.

b)	They	lose	their	GST	registration.

c)	They	may	be	liable	to	pay	penalties	and	interest.

d)	They	can	continue	to	make	GST	payments	without	filing	GSTR-1.

Answer: c)	They	may	be	liable	to	pay	penalties	and	interest.
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CHAPTER 9
GSTR-3B FILING

LEARNING OBJECTIVES:

a	 Understanding GST Basics: Gain a foundational understanding of the GST system  
	 in	India,	including	its	objectives,	structure,	and	key	concepts.

a  Purpose of GSTR-3B: Learn	the	specific	purpose	of	GSTR-3B,	which	is	to	provide	a	 
	 summary	of	GST	liabilities	for	a	tax	period.

a  Applicability and Filing Frequency: Understand	which	businesses	are	required	to	 
	 file	GSTR-3B	and	the	frequency	of	filing	(monthly	or	quarterly).

a  Components of GSTR-3B: Familiarize	 yourself	 with	 the	 various	 sections	 of	 the	  
	 GSTR-3B	 form,	 including	 the	 details	 of	 outward	 supplies,	 inward	 supplies,	 and	  
	 input	tax	credit.

a  Tax Calculation: Learn	how	to	calculate	GST	liability	for	different	types	of	supplies	 
	 (e.g.,	 taxable,	 exempt,	 or	 nil-rated)	 and	 different	 tax	 rates	 (e.g.,	 5%,	 12%,	 18%,	  
	 or	28%).

a  Input Tax Credit (ITC) Reconciliation: Understand the process of reconciling  
	 input	tax	credit	with	GSTR-2A/2B	data	and	how	to	claim	ITC	accurately.

a  Late Filing and Penalties: Comprehend	 the	 consequences	 of	 late	 filing	 of	  
	 GSTR-3B,	including	penalties	and	interest	charges.

INTRODUCTION

GSTR-3B	 is	 a	 crucial	 return	 form	 under	 the	 Goods	 and	 Services	 Tax	 (GST)	 system	 in	 India.	 It	
serves	as	a	simplified	summary	return	that	taxpayers	use	to	report	their	GST	liabilities	for	a	par-
ticular	tax	period.	GSTR-3B	is	filed	monthly	or	quarterly,	depending	on	the	taxpayer’s	category,	
and	it	plays	a	significant	role	in	ensuring	compliance	with	GST	regulations.	
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Here’s an introduction to GSTR-3B:

When	GST	was	introduced	on	July	1,	2017,	there	were	technical	challenges	and	a	learning	curve	
for	both	businesses	and	the	GST	Network	(GSTN)	portal,	which	led	to	difficulties	in	filing	compre-
hensive	GST	returns.	Initially,	GSTR-3B	was	introduced	for	a	few	months	to	help	businesses	get	
accustomed	to	the	GST	framework.	However,	it	continued	to	be	used	as	a	parallel	return	filing	
system	alongside	the	more	detailed	GSTR-1,	GSTR-2,	and	GSTR-3	forms.

GSTR-3B	continued	to	be	relevant	in	the	GST	landscape	in	India.	Here’s	why	it	remains	important	
in	the	current	period.	GSTR-3B	streamlines	the	GST	compliance	process	by	allowing	taxpayers	
to	report	summary	data,	making	it	less	administratively	burdensome	than	the	detailed	returns.	
This	simplification	eases	the	compliance	process	for	businesses.

GSTR-3B	consists	of	various	sections	where	taxpayers	need	to	provide	details	of	their	GST	liabil-
ities,	input	tax	credit	(ITC)	claims,	and	tax	payments.	

These sections include:

•	 Outward	supplies	and	tax	liability.

•	 Inward	supplies	attract	reverse	charge	mechanism	(RCM).

•	 ITC	claimed	and	reversed.

•	 Tax	liability	and	ITC	reconciliation.

•	 Tax	payment	details.

In	conclusion,	GSTR-3B	has	played	a	crucial	role	 in	the	Goods	and	Services	Tax	(GST)	system	
in	India	since	its	introduction.	It	was	initially	introduced	as	a	temporary	measure	to	simplify	the	
transition	to	the	new	tax	regime	and	address	early	implementation	challenges.	However,	it	has	
continued	to	be	relevant	and	remains	a	key	component	of	GST	compliance	for	businesses.

TASK

Karnataka	The	sales	and	purchase	report	for	the	month	of	August	is	provided	below	for	in	makes	
Infotech,	a	registered	dealer	located	in	Bangalore.
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Sales Details

Date Invoice 
Number

Recipient GST 
Number

Recipient 
Name

Taxable 
Value

GST 
Rate

GST 
Amount

Invoice 
Value

12-08-
2022 625

 
32ASQXE-
1297H1Z3

RBG	Pvt.	Ltd. 2,000 18% 360 2,360

18-08-
2022 626 Ajay	(Kerala) 2,50,000 12% 30,000 2,80,000

The	purchase	details	given	below	and	the	same	are	also	reflected	in	GSTR-2B.

Date Invoice 
Number

Recipient GST 
Number

Recipient 
Name

Taxable 
Value GST Rate GST 

Amount

15-08-
2022 INV/126 33ACSXR4691H1ZG JK	Traders 50,000 18% 9,000

File	GSTR-1	&	GSTR-3B.

9.1 STEPS FOR FILING GSTR 3B

Clicking	the	“Start”	button	on	the	question	page	will	redirect	you	to	the	portal’s	homepage,	where	
you can log in

Click	on	the	login	button

Fig..1.5.a
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After the login page appears, proceed to enter the necessary credentials in order to successfully 
log	in.

Fig..1.5.b

Fig..1.5.c
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Click	on	“Return	Dashboard”	to	file	GSTR	1	Return.

Fig..1.5.d

In	the	dashboard,	enter	the	necessary	credentials	based	on	the	scenario.	In	this	case,	you	are	
asked	to	file	the	GSTR-1	for	the	month	of	September	2022.

Fig..1.5.e

 

• Financial	year	–	2022-2023

• Quarter	-Quarter	2	(July-September)

• Period	-	August

• Click	the	search	button

Fig..1.5.f

Select	GSTR	1	and	click	on	“PREPARE	ONLINE”.
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Fig..1.5.g

According	to	the	provided	question,	there	are	B2B	and	B2C	transactions;	therefore,	credentials	
need	to	be	provided	accordingly.

Fig..1.5.h

Invoices	associated	with	B2B	transactions	should	be	documented	by	selecting	the	‘ADD	RECORD’	
option
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Fig..1.5.

Provide	the	information	provided	as	per	the	question.

	Fig..1.5.i

12-08-2022 625 32ASQXE1297H1Z3 RBG	Pvt.	Ltd. 2,000 18% 360 2,360
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Fig..1.5.j

To	add	the	other	B2B	transaction	click	on	ADD	RECORD.
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Fig..1.5.k

B2C	transactions	can	be	categorized	into	two.B2B	large	and	B2B	others.	

Inter-state	 outward	 supplies	 to	 an	 unregistered	 person	 having	 invoice	 value	 greater	 than	
2,50,000	will	be	entered	under	B2B	large

Taxable	supplies	to	an	unregistered	person	other	than	covered	under	Table	5.

Fig..1.5.l

Invoices	associated	with	B2C	Large	transactions	should	be	documented	by	selecting	the	‘ADD	
RECORD’	option.
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Fig..1.5.m

Provide	information	as	per	the	question.

Fig..1.5.n

18-08-2022 626 Ajay	(Kerala) 2,50,000 12% 30,000 2,80,000
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Fig..1.5.o

 

To	add	another	invoice,	click	on	the	“ADD	RECORD”	button.	Otherwise	click	the	BACK	button.
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Fig..1.5.p

Number	of	Invoices	issued	should	be	updated	under	“Documents	Issued”.

Fig..1.5.q

All	the	credentials	provided	in	the	question	are	to	be	given	accordingly.

Fig..1.5.r
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Fig..1.5.s

Save	the	document	after	providing	necessary	credentials.

Fig..1.5.t

There	will	be	a	message	displayed	before	filing	the	summary	then	click	 to	“PROCEED	TO	FILE/
SUMMARY”.

Fig..1.5.u

A	consolidated	summary	is	displayed	and	click	on	the	button	“FILE	STATEMENT”	to	file	the	state-
ment.
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Fig..1.5.v
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There	is	a	display	of	an	affirmation/declaration	before	filing	GSTR	1.	After	submitting	the	decla-
ration,	there	display	a	drop	down	to	select	the	authorized	signatory.	Then	click	“FILE	WITH	EVC”.

Fig..1.5.w

Fig..5.1.x

Enter	the	one	term	password	as	provided	in	the	question	and	click	on	“VERIFY”

Fig..1.5.y
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There	displays	a	message	for	completion	of	GSTR-1	filing	and	to	proceed	for	GSTR	3B.

Fig..1.5.z

FILING OF GSTR 3B

After	the	completion	of	GSTR	1	filing,	move	on	to	GSTR	3B	filing	for	that	move	your	curser	to	GSTR	
3B	and	click	on	“PREPARE	ONLINE”.

Fig.1.5.2.a
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There	displays	a	confirmation	for	filing	nil	return.	Select	“NO”	and	click	next	to	proceed	to	the	next	
page.	

Fig..1.5.2.b

All	the	information	such	as	tax	on	reverse	charge,	ITC	eligible	and	interest	for	late	fee	etc.	are	
displayed	and	click	on	save	GSTR	3	B.

Fig..1.5.2.c

Click	on	to	“PROCEED	TO	PAYMENT”.
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Fig.1.5.2.c

Click	on	“CREATE	CHALLAN”	to	creat	a	new	challan.
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Fig.1.5.2.d

Next	step	is	to	confirm	the	payment	method.	Select	the	E	payment.
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Fig..1.5.2.e

After	selecting	the	mode	of	payment	click	on	to	“GENERATE	CHALLAN”.

Fig..1.5.2.f

Select	the	Bank	for	the	payment	and	accept	the	terms	and	conditions.	Click	on	to	make	pay-
ment.
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Fig..1.5.2.g

There	displays	a	payment	summary	page	and	click	on	to	“CONTINUE”.

Fig.1.5.2.h
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Click	on	to	make	payment.

Fig..1.5.2.i

There	 is	a	warning	message	for	 the	confirmation	of	credit	claim	and	utilization.	Click	“YES”	 to	
continue

Fig..1.5.2.j
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A	pop-up	screen	for	the	successful	utilization	of	credit.	Click	ok	to	continue.

Fig..1.5.2.k

After	the	completion	of	the	payment	select	“PROCEED	TO	FILE”.

Fig..1.5.2.l

An	affirmation/declaration	is	displayed.
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Select	the	authorized	signatory	from	the	drop-down	list	and	select	“FILE	GSTR	3B	WITH	EVC.

Fig..1.5.2.n

A	one-time	password	should	be	validated.	Provide	 the	OTP	as	shown	on	the	screen.	Click	on	
“VERIFY”.

Fig..1.5.2.o

Displays	a	pop-up	screen	for	the	completion	and	successful	filing	of	GSTR	3B.
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Fig..1.5.2.p

       MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the primary purpose of filing GSTR-3B under the Goods and Services Tax (GST) 
system in India?

	 a)	To	claim	Input	Tax	Credit	(ITC)
	 b)	To	provide	a	summary	of	GST	liabilities
	 c)	To	report	detailed	invoice-level	information
	 d)	To	request	a	GST	refund
 Answer: b)	To	provide	a	summary	of	GST	liabilities

 2. Who is required to file GSTR-3B on a monthly basis?

	 a)	All	registered	taxpayers
	 b)	Businesses	with	an	annual	turnover	above	Rs.	1.5	crores
	 c)	Composition	scheme	taxpayers
	 d)	small	businesses	with	an	annual	turnover	below	Rs.	20	lakhs
 Answer: b)	Businesses	with	an	annual	turnover	above	Rs.	1.5	crores
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 3. What is the purpose of Input Tax Credit (ITC) in GSTR-3B?

	 a)	To	claim	a	refund	from	the	government
	 b)	To	report	GST	paid	on	outward	supplies
	 c)	To	offset	GST	paid	on	purchases	against	GST	collected	on	sales
	 d)	To	calculate	penalties	for	late	filing
 Answer: c)	To	offset	GST	paid	on	purchases	against	GST	collected	on	sales

 
 4. What happens if a taxpayer fails to file GSTR-3B by the due date?

	 a)	They	automatically	receive	an	extension	for	filing.
	 b)	They	lose	their	GST	registration.
	 c)	They	may	be	liable	to	pay	late	fees	and	interest	charges.
	 d)	They	can	continue	to	make	GST	payments	without	filing.
 Answer: c)	They	may	be	liable	to	pay	late	fees	and	interest	charges.

 5. Which section of GSTR-3B is used to report the summary of inward supplies subject 
to the reverse charge mechanism (RCM)?

	 a)	Section	A:	Outward	Supplies	and	Tax	Liability
	 b)	Section	B:	Inward	Supplies	Attracting	RCM
	 c)	Section	C:	ITC	Claimed	and	Reversed
	 d)	Section	D:	Tax	Liability	and	ITC	Reconciliation
 Answer: b)	Section	B:	Inward	Supplies	Attracting	RCM
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CHAPTER 10
GENERATING JSON U SING THE GST OFFLINE 
CREATION TOOL

LEARNING OBJECTIVES:

At	the	end	of	this	chapter,	you	will	be	able	to:
a	 Attain	the	knowledge	of	constructing	json	fi	les	utilizing	the	gst	offl	ine	tool

10.1 STEPS FOR JSON CREATION
Download the latest version of GST Offl ine Tool 

Go	to	GST	Portal>	Downloads	>	Returns	Offl	ine	Tool.	It	contains	excel	utility	for	GSTR-1	to	generate	
JSON	fi	le

 Clear the sample data in the excel worksheet
	Enter	details	of	the	relevant	tax	period	in	each	of	the	sections	displayed
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Open the GST Offl ine Tool and follow these steps 

Click	on	New

	Enter	GSTIN,	Financial	Year,	Tax	Period	and	click	on	Proceed
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Enter Data or Import Data

You	can	either	enter	data	manually	or	import	data	from	excel	utility.	Click	on	Import	Files.

Import Excel

You	can	either	import	the	entire	excel	sheet	or	selected	sections.	Select	Import	CSV	to	import	the	
.csv	fi	le.
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Generate File

Select	the	Excel	data	of	the	section	you	wish	to	import.	Click	on	View	Summary.	Review	the	data	
and	click	on	Generate	File	to	create	a	JSON	fi	le

Open GST Portal

Log	in	to	GST	Portal	with	a	valid	username	and	password.	Select	the	Financial	Year	and	Period	of	
fi	ling.	Click	on	PREPARE	OFFLINE	under	GSTR-1
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Upload JSON fi le

Upload	the	JSON	File	that	you	have	saved.

Once	the	status	changes	to	processed,	go	back	to	the	returns	dashboard	and	click	on	prepare	
online
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Generate GSTR-1 Summary

Click	on	Generate	GSTR	1	Summary	to	generate	the	latest	summary	of	GSTR-1
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File Return

     MULTIPLE CHOICE QUESTIONS (MCQS)

1.How can you import data into the GST Offl ine Tool?

a)	Manually enter data only

b)	Import	data	only	from	Excel

c)	Both	manually	enter	data	and	import	data	from	Excel

d)	None of the above

2.What is the fi nal step in the GST Offl ine Tool before creating a JSON fi le? 

a)	Review	data

b)	Select	the	Excel	data	of	the	section	

c)	Click	on	“View	Summary”

d)	Import CSV
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3.When should you click on “Generate GSTR 1 Summary” on the GST Portal? 

a)	After uploading the JSON File 

b)	After	downloading	the	GST	Offline	Tool

c)	Before	importing	data	into	the	Excel	worksheet

d)	After	clicking	on	“New”	in	the	GST	Offline	Tool

4. What file format is used to create a JSON file from the Excel data? 

a)	PDF 

b)	CSV 

c)	XLSX

d)	HTML

5.What is the full form of “JSON”?

a)	JavaScript Standard Object Notation

b)	Java Script Objective Notation 

c)	JavaScript Object Notion 

d)	JavaScript Object Notation

ANSWERS

1 C

2 D

3 A

4 B

5 D
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CHAPTER 11
EMPLOYEES’ PROVIDENT FUND ORGANISATION 
(EPFO)

INTRODUCTION

The	 Employees’	 Provident	 Fund	 (EPF)	acts	as	a	 saving	 tool.	 The	employee	and	 the	employer	
contribute	 an	 equal	 amount	 towards	 savings	 that	 can	 be	 availed	 upon	 retirement	 or	 after	
switching	jobs.	The	Employees’	Provident	Fund	(EPF)	came	into	existence	with	the	enactment	of	
the	Employees’	Provident	Funds	(EPF)	Ordinance	in	1951.	The	EPF	Ordinance	was	later	replaced	by	
the	EPF	Funds	Act,	1952.	The	EPF	Bill	was	introduced	in	the	parliament	in	1952	to	provide	provident	
funds	for	employees	in	factories	and	other	establishments.

If	a	company	employs	more	than	20	people,	it	is	required	to	enroll	in	the	Employees	Provident	
Fund	Organisation	of	India.	Companies	with	less	than	20	workers	have	the	option	to	voluntarily	
sign	up	for	the	Employees	Provident	Fund.	The	Employee	Provident	Fund	or	EPF	 is	available	to	
all	 individuals	who	receive	a	wage.	 In	addition,	all	employees	earning	 less	than	15000	rupees	
annually	must	enroll	 in	the	EPF.	Employees	earning	more	than	15000	annually	may	choose	to	
continue	contributing	to	the	EPF	system.	

OBJECTIVES: 

Employees	 holding	 an	 EPF	 account	 must	 have	 a	 minimum	 wage	 of	 15,000	 rupees	 or	 above.	
Only	when	the	employee	is	an	account	holder	can	they	benefit	from	the	scheme.	The	Human	
Resources	(HR)	department	deals	with	things	like	what	employees	of	the	company	must	hold	
an	EPF	or	a	Provident	Fund	account.	While	an	employee	is	a	part	of	the	EPF,	they	must	ensure	
every	contribution	to	the	account	goes	in.	Every	member	of	the	EPF	has	access	to	their	accounts	
online.	Earlier	claim	settlements	were	of	20	days,	but	it	has	been	reduced	to	3	days	recently.	

FUNCTIONS: 

The various functions of an Employees’ Provident Fund Organization are as follows: 

Individual	account	management:	Individual	accounts	are	available	for	each	employee,	which	
can	 be	 managed	 and	 used	 for	 investments	 that	 are	 later	 withdrawable	 during	 any	 kind	 of	
contingencies	such	as	sickness	or	death,	post-retirement.	

357



TAX COMPLIANCES

•	 Settlement of claims:	 During	 a	 case	 of	 death,	 sickness,	 injury,	 or	 any	 other	 kind	 of	
emergency, the invested amount can be claimed by the employee according to the 
EPFO	guidelines	and	regulations.	

•	 Investment of funds: The amount invested and contributed by the employer and the 
employee,	which	is	12%,	will	turn	out	to	be	an	investment	amount	for	the	employee	and	
this	can	further	help	lead	to	development.	

•	 Ensuring timely payment of pensions:	Through	this	scheme,	employees	working	in	the	
private	sector	will	be	ensured	pension	post-retirement.	

•	 Record updating:	 EPF	 ensures	 that	 every	 investment	 and	 claim	 settlement	 will	 be	
recorded	and	updated	in	a	timely	manner.	

ROLES AND RESPONSIBILITIES OF EPF 

The	 EPF	 helps	 employees	 who	 are	 economically	 weak,	 and	 the	 custodians	 of	 the	 EPF	 are	 its	
central	board	of	trustees.	The	employee	contribution	to	the	EPF	is	deducted	from	the	salary	by	
nationalized	banks,	every	month.	These	Banks	are	responsible	for	the	disbursement	of	funds	and	
activities	 like	administrating	pensions.	The	EPF	contribution	rate	as	mentioned	earlier	 is	3.67%	
by	the	employer	and	8.33%	being	the	employee	contribution.	Of	the	8.33%,	1.1%	is	the	Employees’	
Deposit	Linked	Insurance	Scheme	(EDLIS),	of	which	0.5%	is	the	administration	charge.	

The	EPF	has	some	salient	features,	some	of	which	are	the	employees	registered	with	the	scheme	
are liable to pay a particular percentage of salary every month to the EPF, and the ones eligible are 
employees	earning	more	than	15,000	Rupees.	The	EPF	act	has	20	sections	to	it	and	4	schedules,	
the	applicability	of	the	EPF	act	is	mentioned	and	spoken	about	in	the	first	section	of	the	act.	

BENEFITS 

As	mentioned	earlier,	the	EPFO	is	among	one	of	the	world’s	most	important	organizations	that	
provide	employees	with	social	security.	There	are	multiple	benefits	to	EPF,	and	they	are:	

Tax	saving	scheme:	While	an	employee	contributes	or	invests	in	EPF	for	a	span	of	five	years,	the	
paid	amount	will	hold	no	taxes.	Even	after	withdrawing	the	amount	after	5	years,	the	employee	
will	not	be	liable	to	pay	any	tax.	But,	if	an	employee	withdraws	the	contributed	amount	before	
five	years,	then	they	are	liable	to	pay	taxes	according	to	the	tax	slab.	

•	 Capital appreciation: The Government of India has an interest rate for the amount 
contributed.	 The	 regulations	 state	 that	 once	 an	 employee	 starts	 investing,	 the	
contributions	must	be	given	every	month	without	fail.	The	withdrawable	amount	in	the	
end	will	be	the	invested	amount	and	the	interest	calculated.	
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•	 Retirement: The EPF helps provide pensions to private sector employees, as they may not 
have	an	allotted	pension.	This	scheme	indeed	helps	people	with	less	savings	by	providing	
them	with	security.	

•	 Financial emergency:	In	the	case	of	a	financial	emergency	or	any	kind	of	contingencies,	
the	amount	 invested	can	be	withdrawn	by	 the	employee	either	partially	or	 fully.	More	
details	 regarding	 the	 same	 are	 available	 on	 the	 official	 website	 and	 can	 be	 referred	
accordingly.	

•	 Unemployment:	 If	an	employee	loses	their	 job,	the	EPF	scheme	will	provide	them	with	
compensation	of	kind,	in	which	75%	of	the	amount	invested	can	be	withdrawn	in	the	first	
month	and	the	rest	25%	can	be	withdrawn	in	the	latter	two	months.	

•	 Death:	If	there	is	a	case	of	death,	the	EPF	amount	will	be	given	to	the	dependents	or	the	
nominee	of	the	employee,	which	can	further	help	them	financially.	

•	 Easy access:	While	an	EPF	account	is	registered	in	an	employee’s	name,	they	will	receive	
a	Universal	Account	Number	(UAN)	allotted	by	the	EPFO	which	can	be	further	used	by	the	
employee,	even	if	there	is	a	change	in	the	workplace	or	organization,	as	the	UAN	remains.	

APPLICABILITY OF THE EPF 

The	EPF	scheme	applies	to	all	the	establishments	that	have	employed	a	minimum	of	20	people.	
The	employer	must	obtain	EPF	registration	within	1	month	of	meeting	the	eligibility	criteria.	

Even	if	the	employee	strength	of	a	registered	establishment	falls	below	the	requisite	number,	the	
rules	or	regulations	of	the	act	will	continue	to	apply	to	it.	

Establishments	 with	 less	 than	 20	 employees	 can	 also	 opt	 for	 voluntary	 registration.	 All	 the	
employees	of	 such	an	establishment	will	 be	eligible	 for	 EPF	 right	 from	 the	beginning	of	 their	
employment.	

There are certain situations when a 10% rate is applicable. For instance, if a company meets 
the following criteria: 

•	 Has	employed	less	than	20	employees

•	 Has	suffered	losses	more	than	its	entire	net	worth

•	 Belongs	to	beedi,	brick,	jute	or	guar	gum	industry

•	 Is	 a	 sick	 industrial	 company	 and	 which	 has	 been	 declared	 as	 such	 by	 the	 Board	 for	
Industrial	and	Financial	Reconstruction	(BIFR)
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Here’s the breakup of EPF contribution: 

The	whole	12%	of	an	employee’s	salary	goes	to	their	EPF	account	while	the	employer’s	contribution	
is	divided	among	the	following:

•	 8.33%	to	the	Pension	Fund

•	 3.67%	to	the	EPF	account

UNIVERSAL ACCOUNT NUMBER

The	Universal	Account	Number	(UAN)	 is	a	 12-digit	number	 that	 registered	employees	receive	
which	can	be	used	to	avail	of	benefits	from	the	EPF,	EPS,	and	so	on.	The	employer	is	responsible	
to	sign	the	employees	up	for	the	same.	It	is	through	the	UAN	the	details	of	employee	payment,	
contributions,	withdrawal,	period	of	service	is	kept	track	of.	

Now,	 there	 are	 exceptions	 when	 it	 comes	 to	 wages,	 bonuses,	 overtime	 allowance,	 dearness	
allowance,	food	allowance,	housing	allowance,	or	rent	allowance	in	the	EPF.

To be registered with EPF the employer or the company must have the following details: 

•	 The	name	and	address	of	the	firm	

•	 The	head	office	or	branch	details	

•	 The date of the company incorporation 

•	 The nature of business 

•	 The business partner or director details 

•	 The	employee	details.	

•	 Employee salary details 

•	 Company PAN details 

The online procedures to register with EPF are: 

•	 Employer registration:	The	employer	must	 register	via	EPF	website	or	 their	portal	with	
mentioned	above	information.	

•	 Verification:	Once	registered,	the	employer	will	receive	an	OTP	in	the	registered	mobile	
number,	with	a	Permanent	Account	Number.	The	E-PAN	card	will	be	verified	online.	
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•	 Establishment login:	With	the	receive	PAN,	the	employer	can	login	after	the	registration.	

•	 Registration certificate:	After	the	employer	fills	the	form	5,	a	Universal	Account	Number	
will	be	assigned.	

•	 KYC Updation:	 Then,	 employee	 details	 and	 KYC	 updation	 can	 be	 done	 through	 the	
common	registration	portal.	

After	the	signup	procedure	EPFO	registration	can	be	done	with	the	created	user	Id	and	password.	

     MULTIPLE CHOICE QUESTIONS (MCQS)

1. Who is required to register for EPF in India?

a.	 Only government employees
b.	 All employees in the private sector
c.	 Employees	with	a	monthly	salary	above	a	certain	threshold
d.	 Self-employed	individuals

2. What is the primary purpose of registering in EPF?

a.	 Providing	unemployment	benefits
b.	 Offering health insurance to employees
c.	 Promoting employee savings for retirement
d.	 Funding employee training programs

3. In which government department does EPF registration and management typically 
fall?

a.	 Ministry of Finance
b.	 Ministry of Commerce and Industry
c.	 Ministry of Human Resource Development
d.	 Ministry of Labor and Employment

4. How many digits does the UAN (Universal Account Number) consist of?

a.	 16	
b.	 11	
c.	 12	
d.	 14	

361



TAX COMPLIANCES

5. What does EPF stand for?

a.	 Employee Pension Fund
b.	 Employer Provident Fund
c.	 Employee Provident Fund
d.	 Employment Protection Fund

Answer Key:	(1-b),	(2-c),	(3-d),	(4-c),	(5-c)

EXPLANATORY QUESTIONS 

1.	 What is EPF?

2.	 What	are	the	benefits	of	having	an	EPF	account?

3.	 What	is	UAN?	Explain.

4.	 What	all	criteria	that	has	to	be	satisfied	for	the	successful	registration	with	EPFO?

5.	 Explain	the	functions	of	EPF
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CHAPTER 12
EMPLOYEES’ STATE INSURANCE SCHEME OF INDIA 
(ESIC)

INTRODUCTION

The	Employees’	State	Insurance	Scheme	of	India	(ESIC)	is	a	multi-faceted	Social	Security	Scheme	
designed	 to	 provide	 socio-economic	 protection	 to	 ‘employees’	 in	 the	 organised	 sector.	 ESIC	
Scheme	is	administered	by	a	statutory	corporate	body	called	the	Employees’	State	Insurance	
Corporation	under	Employees	State	Insurance	Act,	1948.

The	ESI	scheme	is	applicable	to	all	factories	and	other	establishments	as	defined	in	the	Act	with	
10	or	more	people	employed	in	such	establishment	and	the	beneficiaries’	monthly	wage	does	
not	exceed	Rs	21,000	are	covered	under	the	scheme.	Whether	the	employer	has	employed	10	or	
more	employees,	all	employees	employed	by	the	employer,	agnostic	of	the	salary	are	reckoned.	
It	protects	employees	against	sickness,	maternity,	disablement,	and	death	as	a	result	of	a	work-
related	injury,	as	well	as	provides	medical	care	to	insured	employees	and	their	families.

ESIC	is	a	statutory	responsibility	for	all	the	employers.	All	the	establishments	covered	under	the	
ESI	Act	must	register	with	the	ESIC	and	contribute	towards	the	ESI	scheme.	Registration	should	
be	done	within	15	days	of	applicability	to	them.	(All	the	employees	earning	more	than	21,000	per	
month	are	exempted	from	the	ESI	contribution)

The	 Employee	 State	 Insurance	 (ESI)	 scheme	 in	 India	 is	 a	 comprehensive	 social	 security	 and	
healthcare	program	designed	to	safeguard	the	interests	of	workers	in	the	organized	sector.	 It	
aims	 to	provide	financial	protection	and	medical	benefits	 to	employees	and	 their	 families	 in	
times	of	need.	Here	are	the	key	objectives	and	benefits	of	the	ESI	scheme	and	its	contribution	to	
employee	welfare

In	an	area	notified	u/s	1(3)	by	Central	Govt.	all	factories	where	10	or	more	persons	are	employed	
attract	 coverage	 under	 Section2	 (12)	 of	 ESI	 Act.	 Further,	 according	 to	 the	 notification	 issued	
by	 the	 appropriate	 Government	 (Central/State)	 under	 Section	 1(5)	 of	 the	 Act,	 the	 following	
establishments	employing	10	or	more	persons	attract	ESI	coverage.	

•	 Shops

•	 Hotels	or	restaurants	not	having	any	manufacturing	activity,	but	only	engaged	in	‘sales’.	

•	 Cinemas	including	preview	theaters;

•	 Road	Motor	Transport	Establishments;
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•	 Newspaper	establishments.	(that	is	not	covered	as	factory	under	Sec.2(12));

•	 Private	 Educational	 Institutions	 (those	 run	 by	 individuals,	 trustees,	 societies	 or	 other	
organizations	and	Medical	Institutions	(including	Corporate,	Joint	Sector,	trust,	charitable,	
and	private	ownership	hospitals,	nursing	homes,	diagnostic	centers,	pathological	labs).

In	some	states	coverage	 is	still	 for	20	or	more	persons	employed	under	sec	 1(5).	A	 few	State	
Governments	have	not	extended	scheme	to	Medical	&	Educational	Institutions.

While registering with ESIC following are the benefits:
•	 Medical Benefit

• Benefits	are	in	effect	from	the	day	he	becomes	an	employee.	
• It	extends	to	the	family	as	well.	

•	 Sickness Benefit

• During	a	medical	leave,	70%	of	their	average	wages	during	the	period	of	sickness	for	
a	maximum	of	91	days	in	a	year.	

• The	worker	cannot	seek	this	benefit	 if	he	contributes	for	 less	than	78	days	out	of	6	
months.	

•	 Maternity Benefit

• This	benefit	is	provided	with	100	%	average	daily	wage	for	a	mother	up	to	26	weeks,	
for	6	weeks	in	case	of	miscarriage,	12	weeks	for	a	commissioning	mother/adopting	
mother.

• (Can	be	extendable	for	one	more	month	depending	on	medical	advice)	

•	 Dependants Benefit

• In	case	of	death	during	course	of	employment	or	occupational	hazard.

• The	monthly	payment	is	granted	to	dependents.	

•	 Disablement Benefit

• In case of injury during course of employment, monthly payment for temporary 
disablement	till	injury	lasts.

Whereas lifelong payment in the case of permanent disablement, based on the determination 
of	medical	board.

Other Benefits

•	 Funeral	Expense:	It	will	be	borne	by	the	ESIC	for	the	dependants.

•	 Vocational/	Physical	Rehabilitation	Expense
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•	 Old Age Medical Care

•	 Unemployment	Allowance	-	In	case	of	involuntary	loss	of	employment,	ESIC	provides	for	
monthly	cash	allowance	for	a	duration	of	24	months	(maximum).

The	ESI	scheme	is	a	self-financing	scheme.	The	ESI	funds	are	primarily	built	out	of	contributions	
from	employers	and	employees	payable	monthly	at	a	fixed	percentage	of	wages	paid.	The	State	
Governments	also	bear	1/8th	share	of	the	cost	of	Medical	Benefit.

ESI	Scheme	is	implemented	in	phases	in	different	part	of	the	country	through	Gazette	notification	
after	 making	 the	 infrastructure	 available	 towards	 dispensation	 of	 medical	 as	 well	 as	 other	
benefits	provided	under	the	provisions	of	the	Act	to	the	prospective	beneficiaries.

After	the	signup	procedure	ESIC	registration	can	be	done	with	the	created	user	Id	and	password.

     MULTIPLE CHOICE QUESTIONS (MCQS)

1. Which year did the ESIC Act came into existence?

a)	1948
b)	1944
c)	1960
d)	1958

2. What is the primary purpose of ESI registration?

a)	Providing	unemployment	benefits
b)	Promoting employee savings for retirement
c)	Offering health insurance to employees
d)	Funding employee training programs

3. Expand ESIC

a)	Employees State Insurance Company 
b)	Employees State Insurance Cooperation
c)	Employees State Insurance Corporation
d)	Employers State Insurance Corporation
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4. What is the slab rate of salary for registering with ESIC?

a)	25000/-
b)	18000/-
c)	20000/-
d)	21000/-

5. How many days can be claimed for sickness benefit?

a)	30
b)	91
c)	60
d)	71

Answer Key:	(1-a),	(2-c),	(3-c),	(4-d),	(5-b)

EXPLANATORY QUESTIONS  

1.	 What is ESIC?

2.	 What	are	the	benefits	of	ESIC?

3.	 What	are	the	criteria	for	registering	with	ESIC?

4.	 Write	a	short	note	on	maternity	benefit	under	ESIC

5.	 What are the objectives of ESIC?
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CHAPTER 13
EMPLOYEES’ PROVIDENT FUND ORGANISATION 
(EPFO)/ EMPLOYEES STATE INSURANCE 
CORPORATION (ESIC) SIGN-UP

       LEARNING OBJECTIVES:

        At the end of this chapter, you will be able to:

a 	Understand	EPFO/ESIC	basics	and	its’	services	

a 	Explain	how	EPFO/ESIC	is	being	beneficiary	to	the	employees	as	well	as	employer	

a 	Sign-up	with	the	EPFO/ESIC	portal

a 	Generate	the	new	user	Id	and	password	

INTRODUCTION

The Employees’ Provident Funds and Miscellaneous Provisions Act, 1952, and the Employees’ 
State Insurance Act, 1948	make	 it	mandatory	 for	companies	employing	20	or	more	workers	
to	register	for	EPF	and	ESI	schemes.	Failure	to	comply	with	these	regulations	can	result	in	legal	
penalties,	fines,	and	imprisonment.

EPFO	 is	among	one	of	 the	world’s	most	 important	organizations	that	provide	employees	with	
social	security.	There	are	multiple	benefits	to	EPF,	and	they	are:	

•	 Tax saving scheme:	While	an	employee	contributes	or	invests	in	EPF	for	a	span	of	five	
years,	 the	amount	paid	will	 hold	no	 taxes.	 Even	after	withdrawing	 the	amount	after	5	
years,	the	employee	will	not	be	liable	to	pay	any	tax.	But,	if	an	employee	withdraws	the	
contributed	amount	before	five	years,	then	they	are	liable	to	pay	taxes	according	to	the	
tax	slab.	

•	 Capital appreciation: The Government of India has an interest rate for the amount 
contributed.	The	regulations	state	that	once	an	employee	starts	investing,	contributions	
must	be	made	every	month	without	fail.	The	withdrawable	amount	in	the	end	will	be	the	
invested	amount	and	the	interest	calculated.	
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•	 Retirement: The EPF helps provide pensions to private sector employees, as they may not 
have	an	allotted	pension.	This	scheme	indeed	helps	people	with	less	savings	by	providing	
them	with	security.	

•	 Financial emergency:	In	the	case	of	a	financial	emergency	or	any	kind	of	contingency,	
the	amount	 invested	can	be	withdrawn	by	 the	employee	either	partially	or	 fully.	More	
details	regarding	the	same	are	available	on	the	official	website	and	can	be	referred	to	
accordingly.	

•	 Unemployment:	 If	an	employee	loses	their	 job,	the	EPF	scheme	will	provide	them	with	
compensation	of	kind,	in	which	75%	of	the	amount	invested	can	be	withdrawn	in	the	first	
month	and	the	rest	25%	can	be	withdrawn	in	the	latter	two	months.	

•	 Death:	If	there	is	a	case	of	death,	the	EPF	amount	will	be	given	to	the	dependents	or	the	
nominee	of	the	employee,	which	can	further	help	them	financially.	

•	 Easy access:	While	an	EPF	account	is	registered	in	an	employee’s	name,	they	will	receive	
a	Universal	Account	Number	(UAN)	allotted	by	the	EPFO	which	can	be	further	used	by	the	
employee,	even	if	there	is	a	change	in	the	workplace	or	organization,	as	the	UAN	remains.	

TYPES OF PROVIDENT FUND

•	 Statutory provident fund (SPF):	The	Statutory	Provident	Fund	also	known	as	Provident	
Fund	(PF),	according	to	1925,	helps	registered	employees	avail	benefits	of	the	scheme.	
The	SPF	predominantly	provides	financial	or	social	security	to	government	employees.	

•	 Public provident fund (PPF):	 According	 to	 the	 public	 provident	 fund	 Act,	 1908	 the	
employees	 were	 only	 required	 to	 pay	 a	 minimum	 of	 rupees	 500	 and	 a	 maximum	 of	
rupees	150,000	Lakhs	of	contribution	before	the	withdrawal.	

•	 Recognized provident fund (RPF):	According	to	RPF,	registered	employees’	and	provident	
fund	miscellaneous	act,	1952,	the	employees	can	be	registered	with	the	EPF	if	a	firm	has	
more	than	twenty	employees.	And	in	that	case,	the	employees	must	mandatorily	register	
with	EPF.	

•	 Unorganized provident fund:	The	employees	as	well	as	the	employers	working	in	a	firm	
can	benefit	from	this.	

BENEFITS OF ESIC

The	 Benefits	 include	 monthly	 pensions	 in	 case	 of	 a	 deceased	 employee,	 the	 widow	 of	 the	
employee,	the	children,	or	the	nominee	of	the	employee	can	benefit	from	the	same.
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•	 Medical Benefit

• Benefits	are	in	effect	from	the	day	he	becomes	an	employee.	
• It	extends	to	the	family	as	well.	

•	 Sickness Benefit

• During	a	medical	leave,	70%	of	their	average	wages	during	the	period	of	sickness	for	
a	maximum	of	91	days	in	a	year.	

• The	worker	cannot	seek	this	benefit	 if	he	contributes	for	 less	than	78	days	out	of	6	
months.	

•	 Maternity Benefit

• This	benefit	is	provided	with	100	%	average	daily	wage	for	a	mother	up	to	26	weeks,	
for	6	weeks	in	case	of	miscarriage,	12	weeks	for	a	commissioning	mother/adopting	
mother.	

• (Can	be	extendable	for	one	more	month	depending	on	medical	advice)	

•	 Dependents Benefit

• In	case	of	death	during	course	of	employment	or	occupational	hazard.	
• The	monthly	payment	is	granted	to	dependents.	

•	 Disablement Benefit

• In case of injury during course of employment, monthly payment for temporary 
disablement	till	injury	lasts.	

• Whereas lifelong payment in the case of permanent disablement, based on the 
determination	of	medical	board.	

•	 Other Benefits

• Funeral	Expense-	It	will	be	borne	by	the	ESIC	for	the	dependents.
• Vocational/	Physical	Rehabilitation	Expense

•	 Old Age Medical Care

• Unemployment	Allowance-	In	case	of	involuntary	loss	of	employment,	ESIC	provides	
for	monthly	cash	allowance	for	a	duration	of	24	months	(maximum).	

By	registering	for	the	EPF	and	ESI	schemes,	companies	can	provide	their	employees	with	a	range	
of	social	security	benefits	such	as	pensions,	health	insurance,	and	maternity	benefits.	This	can	
help	to	attract	and	retain	quality	employees	and	improve	employee	morale	and	satisfaction.	
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For the registration of ESIC and EPFO the ‘signup’	has	to	be	completed	in	order	to	create	new	user	
Id	and	password	

    MULTIPLE CHOICE QUESTIONS (MCQS)

1. In which year did the EPF & MP Act came in to force?

a.	 1964
b.	 1968
c.	 1958
d.	 1954

2. At which percentage can an employee claim for their medical leave for the leave 
encashment?

a.	 70%	
b.	 50%
c.	 85%
d.	 100%

3. Expand UAN

a.	 Unified	Allotment	Number
b.	 Unique	Account	Number
c.	 Universal Allotment Number
d.	 Universal Account Number 

4. Expand SPF

a.	 State Provident Fund
b.	 Statutory Provident Fund 
c.	 Senior	Citizens’	Provident	Fund
d.	 Stipulated Provident Fund

5. From the following ESI benefits pick the odd one out

a.	 Maternity	Benefit
b.	 Dependents	Benefit
c.	 Marriage	Benefit
d.	 Sickness	Benefit

 Answer Key: (1-c),	(2-a),	(3-d),	(4-b),	(5-c)
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DEFINITIVE QUESTIONS (DESCRIPTIVE QUESTIONS)

1.	 What	are	the	benefits	of	ESIC?	Explain.

2.	 What are the four types of Provident Funds? 

3.	 What	are	the	benefits	of	EPF?	

4.	 What	are	the	consequences	that	to	be	faced	by	a	company	who	failures	to	comply	with	
the rules and regulations of EPFO/ESIC?

5.	 What	is	meant	by	the	“Tax	Saving	Scheme”	of	EPF?
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CHAPTER 14
EMPLOYEES’ PROVIDENT FUND ORGANIZATION,  
INDIA – PAYMENT GENERATION

INTRODUCTION

The	 Employee’s	 Provident	 Fund	 (EPF)	 is	 regulated	 by	 the	 Employees’	 Provident	 Funds	 and	
Miscellaneous	Provisions	Act	of	 1952,	commonly	 known	as	 the	PF	Act.	 Its	primary	objective	 is	
to encourage the accumulation of savings among both employees and employers through 
mandatory	contributions	to	the	provident	fund.

The	administration	and	oversight	of	the	PF	Fund	are	entrusted	to	the	Employees’	Provident	Fund	
Organization	 (EPFO).	 The	EPFO	operates	under	 the	authority	of	 the	Central	Board	of	 Trustees,	
which	is	a	statutory	body	established	by	the	PF	Act.

While contributions to the PF account are made by both the employer and the employee, the 
responsibility	for	making	payments	into	the	PF	account	lies	with	the	employer	who	is	registered	
under	the	PF	Act.	Here’s	how	to	generate	an	online	challan	with	the	necessary	steps:

14.1 STEPS FOR EPF

Login	to	unified	portal	of	EPFO	using	your	Electronic	Challan	cum	Return	(ECR)	portal	credentials	
https://unifiedportal-emp.epfindia.gov.in/epfo/.

You	already	received	a	username	and	password	during	the	establishment	registration.	Please	
enter	these	credentials	and	click	the	“Submit” button.
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Fig.	1.0

Once	you’ve	entered	your	credentials,	you	will	be	directed	to	a	page	where	you	can	select	the	
payment	option	from	the	choices	provided	above	the	fields.
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Fig.	1.1

Click	 on	 the	 “Payments” tab,	 and	 you	 will	 encounter	 a	 dropdown	 menu.	 If	 you	 are	 making	
monthly contributions, you can select “Payment (ECR).”

Fig.	1.2
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Once	you’ve	chosen	the	“Payment (ECR)”	option,	you	will	be	automatically	redirected	to	the	
next	tab	where	you	can	select	the	“ECR Upload” option.

Fig.	1.3

Next,	you	will	find	the	option	to	“Download ECR file.”	Click	on	it	to	download	the	file.	In	this	file,	you	
can	review	and	enter	the	details	of	employees,	including	their	UAN	(Universal	Account	Number),	
member	name,	and	other	required	information	 in	the	specified	Excel	 format.	This	 information	
typically includes:

•	 GROSS WAGES

•	 EPF WAGES

•	 EPS WAGES

•	 EDLI WAGES

•	 EPF	CONTRIBUTION	REMITTED

•	 EPS	CONTRIBUTION	REMITTED

•	 EPF EPS DIFF REMITTED

•	 NCP	DAYS	(Non-Contributory	Period	Days)

•	 REFUND OF ADVANCES
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Ensure	that	you	accurately	input	these	details	in	the	designated	fields	as	per	the	provided	Excel	
format.

Fig.	1.4

The	next	step	 involves	preparing	the	Excel	file	 for	upload.	Before	proceeding,	you	will	need	to	
select several options:

•	 Wage Month:	Choose	the	specific	month	and	year	for	which	you	are	making	the	contri-
bution.

•	 Salary Disbursal Date:	Select	the	date	on	which	the	salary	was	disbursed	for	that	month.

•	 Upload ECR Excel File:	Click	the	option	to	upload	the	ECR	Excel	file	that	you’ve	prepared.

•	 After	uploading	the	file,	you	will	be	prompted	to	take	the	following	actions:

•	 Select “ECR”	as	the	type	of	submission.

•	 You	can	see	the	contribution	percentage,	typically	set	at	12%.

•	 In	the	“Remarks”	option,	you	can	type	a	note	indicating	the	month	for	which	you	are	mak-
ing	the	payment.	Please	enter	this	information	as	required.
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Fig.	1.5

Upon	 clicking	 the	 “Upload”	 button,	 you	 should	 encounter	 a	 message	 indicating	 that	 the	 file	
validation	was	successful.	Subsequently,	you	will	notice	a	message	stating	that	the	system	is	
currently	processing	the	file

 

Fig.	1.6

Proceed to the “Progress”	tab,	where	you	can	select	the	“Prepare Challan” option for each in-
dividual	employee.
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Fig.	1.7	

Next,	you	can	navigate	to	the	ECR	summary	section,	where	you	will	find	the	information,	you’ve	
already	entered	in	the	Excel	file.

 

Fig.	1.8

Please	click	on	the	option	that	says	“Generate Challan”	to	continue.
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Fig.	1.9

Once	 you	 have	 generated	 the	 challan,	 you	 will	 find	 the	 TRRN	 (Temporary	 Return	 Reference	 
Number)	displayed	in	a	pop-up	on	the	left	side	of	the	page.

Fig.	1.10

Next,	proceed	to	make	an	online	payment	 for	your	employees	by	clicking	on	the	“Payment” 
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option	and	following	the	instructions	to	continue.

Fig.	1.11

You	will	be	 redirected	 to	 the	payment	page,	where	you	can	choose	your	bank	 for	 the	online	
transaction.

Fig.	1.12

Upon	completing	the	transaction,	you	will	receive	a	message	confirming	that	the	payment	has	
been	successfully	processed.	The	final	step	involves	downloading	the	challan	by	selecting	the	
“Download	Challan”	option	from	the	tab.	Once	downloaded,	you	can	view	the	details	and	retain	
them	for	future	reference.
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Fig.	1.13

     MULTIPLE CHOICE QUESTIONS (MCQS)

1. Why EPF is important?
a.	 To help in saving money for the retirement
b.	 To help in saving money for the medical emergency
c.	 For	the	employee/	employer	benefits
d.	 For	the	growth	of	the	organization	

2. EPFO Act was passed in which year?
a.	 1950
b.	 1948
c.	 1952
d.	 1960

3. Who is responsible for EPF?
a.	 Employer
b.	 Organization 
c.	 State Government 
d.	 Employee 

4. Who is compulsory to register with EPFO?
a.	 Employee	who	receives	salary	≤	21000	/-
b.	 Employee	who	receives	salary	>	21000	/-
c.	 Employee	who	receives	salary	≤	15000	/-
d.	 Employees	who	receive	salary	≥	15000	/-
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5. What is the minimum number of employees required for a company to be eligible for 
EPF registration in India?
a.	 10
b.	 15
c.	 20
d.	 25

Answer Key:	(1-a),	(2-c),	(3-d),	(4-d),	(5-c)

DESCRIPTIVE QUESTIONS 

1.	 What	is	the	Employees’	Provident	Fund	(EPF)?	Explain

2.	 Explain	the	contribution	structure	of	the	EPF	in	India.	How	are	contributions	divided	be-
tween	employees	and	employers?

3.	 How	does	EPF	help	employees	in	building	a	financial	safety	net	for	retirement?

4.	 What are the obligations of an employer regarding EPF contributions?

5.	 Explain	the	benefits	of	EPFO
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CHAPTER 15
EMPLOYEES’ STATE INSURANCE CORPORATION (ESIC) 
PAYMENT GENERATION

INTRODUCTION

Individuals	who	are	part	of	the	Employees’	State	Insurance	Corporation	(ESIC)	can	convenient-
ly	make	their	ESIC	e-Challan	payments	online.	To	complete	an	ESIC	e-Challan	payment,	you	
should	visit	 the	ESIC	e-Challan	payment	webpage	and	provide	essential	 information,	 includ-
ing	your	employer	code.	To	proceed	with	the	payment,	simply	click	on	the	respective	challan	
number	link.	The	ESIC	(Employees’	State	Insurance	Corporation)	is	an	autonomous	organization	
responsible	for	overseeing	the	Employees’	State	Insurance	program,	which	offers	health	insur-
ance	and	social	security	benefits	to	Indian	employees.	Online	payments	for	ESIC	challans	are	
accessible	to	individuals.

15.1 STEPS

Open	the	official	website	of	ESIC:	https://www.esic.gov.in

Upon	entering	the	ESIC	portal,	you	can	access	the	Employers	Login	section	by	clicking	on	it.

Fig.	1.0
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Enter	your	user	ID,	password,	and	Captcha.	Then	click	‘Login.’

Fig.	1.1

After	logging	in,	you	will	be	directed	to	a	new	webpage	where	you’ll	find	a	comprehensive	list	of	
modules	and	hyperlinks.	

Select the option to access the File monthly contribution.

Fig.	1.2
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Once the page redirects you to the “File Monthly Contribution” tab, proceed to input the re-
quired	values	as	per	your	specific	requirements.

Fig.	1.3

After	entering	the	details	as	the	fields	

Fig.1.4

• Choose	the	month	and	year	from	the	contribution	details	field.

• Opt for “Monthly Contribution”	in	the	Contribution	Details	Type	dropdown	menu.

• Enter	the	Employer	Code	Number.

• If you have a larger number of employees, you can opt for “Upload Data Using an Excel File.”

• Upon	clicking	the	“Submit”	button,	the	subsequent	page	will	display	as	follows:
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Fig.	1.5

The	eligible	employees’	details	will	be	displayed	as	follows:	You	should	then	enter	the	number	of	
days	for	which	wages	are	paid	or	payable,	as	well	as	input	the	total	monthly	wages.

Once	you	have	inputted	the	employee	details	as	per	the	specified	requirements,	the	display	will	
appear	as	follows:

Fig.	1.6

Upon	clicking	the	“Submit” button,	a	new	pop-up	window	titled	“Payment History” will	appear,	
where	you	will	be	prompted	to	enter	values	for	the	following	categories:

•	 Total IP Contribution

•	 Total Employer Contribution

•	 Total Central Government Contribution

•	 Total Wages 
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Click	here	to	Submit	and	Continue

Fig.	1.7

The	page	will	redirect	to	the	payment	details	section,	where	you	can	choose	your	bank	for	on-
line	transactions.	You	will	notice	that	a	unique	challan	number	has	already	been	generated	for	
further	proceedings.	In	the	event	of	a	connection	loss,	you	can	input	the	challan	number	and	
continue	seamlessly.

Fig.	1.8

Select	your	preferred	bank	for	making	the	payment	and	proceed	with	the	transaction.
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Fig.	1.9

After	entering	your	banking	details	and	completing	the	payment	generation	process,	you	will	
receive	a	message	indicating	that	your	transaction	has	been	successfully	completed.	

Additionally,	you	will	be	provided	with	a	unique	transaction	ID	for	reference.

      MULTIPLE CHOICE QUESTIONS (MCQS)

1.	 ESI Act was passed in which year?

a)	 1947
b)	 1946
c)	 1948
d)	 1950

2.	 Why ESIC is needed?

a)	 For the protection of the organization
b)	 For educating labours
c)	 For	the	workers	to	compensate	their	losses	of	wages	during	the	absence	of	labour	

due to the medical needs
d)	 For	the	assurance	of	labours’	wages	

3.	 Who should pay ESIC

a)	 Employer
b)	 Employee
c)	 Individual
d)	 All of the above
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4.	 Who is eligible for ESIC?

a)	 Employee	who	receives	salary	≤	21000	/-
b)	 Employee	who	receives	salary	>	21000	/-
c)	 Employee	who	receives	salary	≤	15000	/-
d)	 Employees	who	receives	salary	>	15000	/-

5.	 What is the salary slab for disabled employees to avail ESIC benefits?

a)	 ≤	21000	/-
b)	 ≤	25000	/-
c)	 <	25000	/-
d)	 ≤	30000	/-

Answer Key:	(1-c),	(2-c),	(3-a),	(4-a),	(5-b)

DESCRIPTIVE QUESTIONS 

1.	 What is the purpose of ESIC contribution?

2.	 What	is	ESI	and	its	benefits?

3.	 What are the main functions of ESI?

4.	 Who	is	eligible	for	ESI?	Explain	with	its	limitations	

5.	 Why	is	ESI	required?	Explain	
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CHAPTER 16
DIGITAL SIGNATURE CERTIFICATE (DSC)

    LEARNING OBJECTIVES:

At the end of this chapter, you will be able to:

a  DSC and various services/applications.

Explain all the important aspects relating to various e-services including efiling the e-forms etc.

DIGITAL SIGNATURE CERTIFICATE ( DSC)

Digital Signature Certificates (DSC) are the digital equivalent (that is electronic format) of 
physical or paper certificates. Digital signature certificate can be presented electronically to 
prove one’s identity, to access information, documentation purpose or services on the Internet 
or to sign certain documents digitally. A licensed Certifying Authority (CA) issues the digital 
signature. Digital Signatures are legally admissible in a Court of Law, as provided under the 
provisions of IT Act, 2000.

FEATURES

•	 Digital Identity: A DSC serves as a digital representation of an individual or entity’s 
identity. It is issued by a trusted Certifying Authority (CA) after verifying the identity of the 
certificate holder.

•	 Authentication: DSCs are used to verify the authenticity of the sender or signer of a 
document or message. When a document is digitally signed with a DSC, recipients can 
verify that it was indeed signed by the claimed sender.

•	 Data Integrity: Digital signatures provide a means to ensure that the content of a 
document has not been tampered with during transmission. Any changes to the 
document after it is signed will invalidate the signature.
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•	 Validity Period: The different types of Digital Signature Certificates are:

o Class 2: Here, the identity of a person is verified against a trusted, pre-verified 
database.

o Class 3: This is the highest level where the person needs to present himself or 
herself in front of a Registration Authority (RA) and prove his/ her identity.

•	 Revocation Checking: Certifying Authorities maintain Certificate Revocation Lists (CRLs) 
and Online Certificate Status Protocol (OCSP) services to check if a DSC has been revoked. 
This helps ensure that expired or compromised certificates are not used.

•	 Encryption: DSCs can be used in conjunction with encryption to secure the contents of 
a document. This ensures that only authorized recipients can access and decrypt the 
information.

•	 Compatibility: DSCs are typically compatible with various software applications, 
operating systems, and platforms, making them versatile for a wide range of digital 
transactions.

•	 Password Protection: DSCs are often protected with a password or Personal Identification 
Number (PIN) to prevent unauthorized use. The password is required to access and use 
the private key associated with the certificate.

•	 Multi-Purpose Use: DSCs can be used for a variety of purposes, including signing email 
messages, authenticating to secure websites, and signing legal contracts.

•	 Different Classes: DSCs are issued in different classes, each with varying levels of identity 
verification. Higher-class certificates require more rigorous identity checks and are 
typically used for more sensitive transactions.

APPLICATION OF DSC IN MCA WEBSITE

The e-forms are required to be authenticated by the authorized signatories using digital 
signatures as defined under the Information Technology Act, 2000. A digital signature is the 
electronic signature duly issued by a certifying authority that shows the authority of the person 
signing the same. It is an electronic equivalent of a written signature. 
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Digital Signature Certificates (DSC) are the digital equivalent (that is electronic format) of physical 
or paper certificates. Few Examples of physical certificates are drivers’ licenses, passports or 
membership cards. Certificates serve as proof of identity of an individual for a certain purpose; 
for example, a driver’s license identifies someone who can legally drive in a particular country. 
Likewise, a digital certificate can be presented electronically to prove one’s identity, to access 
information or services on the Internet or to sign certain documents digitally.

Physical documents are signed manually, similarly, electronic documents, for example e-forms 
are required to be signed digitally using a Digital Signature Certificate. Every user who is required 
to sign an e-form for submission with MCA is required to obtain a Digital Signature Certificate. 
For MCA-21, the following four types of users are identified as users of Digital Signatures and are 
required to obtain digital signature certificate:

•	 MCA (Government) Employees.

•	 Professionals (Company Secretaries, Chartered Accountants, Cost Accountants and 
Lawyers) who interact with MCA and companies in the context of Companies Act.

•	 Authorized signatories of the Company including Managing Director, Directors, Manager 
or Secretary.

•	 Representatives of Banks and Financial Institutions. A person requiring a Digital Signature 
Certificate can approach any of the Certifying authorities identified by the MCA, with 
original supporting documents and self-attested copies, for issuance of Digital Signature 
Certificate. DSCs can also be obtained, wherever offered by CA, using Aadhar eKYC based 
authentication, and herein supporting documents are not required.

HIGHLIGHTS

• DSC of either Class 2 and Class 3 signing certificate category issued by a licensed Certifying 
Authority (CA) needs to be obtained for e-Filing on the MCA Portal.

• Director Identification Number (DIN) is not a pre-requisite to apply for DSC.

• The Certifying Authorities are authorized to issue a Digital Signature Certificate with a validity 
of one or two years.

• Registration of DSC is a onetime activity on the MCA portal. For registration of DSC, steps are 
given on the MCA Portal.

• All companies (Public Company, Private Company, Company not having share capital, 
Company limited by share or guarantee, Unlimited Company) must comply with this 
requirement of registration of DSC by the director, manager and secretary.

• Foreign directors are required to obtain Digital Signature Certificate from an Indian Certifying 
Authority (List of Certifying Authorities is available on the MCA portal). 
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• The process of registration of DSC is same as applicable to others.

CERTIFYING AUTHORITIES (CAS)

A Certifying Authority is a trusted agency whose central responsibility is to issue, revoke, 
renew and provide directories for Digital Signature Certificates. According to Section24 of the 
Information Technology Act 2000, “Certifying Authority” means a person who has been granted 
a license to issue Digital Signature Certificates.

The Controller of Certifying Authorities (CCA) is a Government of India undertaking that license 
and regulate the working of Certifying Authorities. The CCA certifies the public keys of CAs, which 
enables users in the cyberspace to verify that a given certificate is issued by a licensed CA. For 
this purpose, CCA operates, the Root Certifying Authority of India (RCAI).The CCA also maintains 
the National Repository of Digital Signature Certificate (NRDC), which contains all the certificates 
issued by all the CAs in the country.

Certifying Authority (CA) means a person who has been granted a license to issue a digital 
signature certificate under Section 24 of the Indian IT-Act 2000.
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STEPS FOR OBTAINING DSC

SIGN INTO E MUDRA PORTAL AND LOGIN USING THE CREDENTIALS
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HOME PAGE

CLICK ON PAPERLESS DSC ISSUANCE LINK > VISIT PAGE
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CLICK ON QUICK INDIVIDUAL DSC

FILL REQUIRED FIELDS (AS PER DOCUMENTS)
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SELECT TYPE OF DSC

COMPLETE OTP VERIFICATION WITH THE MOBILE NO, EMAIL AND AADHAAR
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TO CONFIRM AND CLICK ESIGN AND SUBMIT

CLICK ON APPLICATIONS> MANAGE APPLICATIONS>VIEW
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APPROVE

CERTIFICATE CAN BE DOWNLOAD
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SUMMARY

A Digital Signature Certificate (DSC) is an electronic identity proof issued by trusted 
Certifying Authorities (CAs) that validates a person or entity’s identity for secure online 
transactions, document signing, and authentication. DSCs ensure data integrity, 
authenticity, and legal validity, with different classes of certificates requiring varying 
levels of identity verification. They are widely used, including on government websites like 
India’s Ministry of Corporate Affairs (MCA) for e-form authentication. CAs, regulated by 
the Controller of Certifying Authorities (CCA), are responsible for issuing and managing 
DSCs. These certificates are pivotal in maintaining the security and legality of digital 
transactions and interactions.

        MULTIPLE CHOICE QUESTIONS (MCQS)

1.  What is the primary purpose of a Digital Signature Certificate (DSC) in India?

a) To encrypt emails

b) To verify the authenticity of digital documents and efiling

c) To provide access to government websites

d) To make online payments
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2. Which government body in India is responsible for regulating and certifying Digital 
Signature Certificates?

a) RBI (Reserve Bank of India)

b) UIDAI (Unique Identification Authority of India)

c) CCA (Controller of Certifying Authorities)

d) TRAI (Telecom Regulatory Authority of India)

3. Which law in India governs the use and legality of Digital Signature Certificates?

a) IT Act, 2000

b) IPC (Indian Penal Code)

c) RTI Act (Right to Information Act)

d) Consumer Protection Act

4. Which of the following documents is NOT typically required as part of the application 
process for obtaining a Digital Signature Certificate in India?

a) Proof of identity

b) Proof of address

c) Income tax returns

d) Passport-sized photograph

5. To sign a PDF document digitally using a Digital Signature Certificate in India, which software 
tool or application is commonly used?

a) Adobe Acrobat Reader

b) Microsoft Word

c) Google Docs

d) Notepad

Answers

1. B 2. C 3. A 4. C 5. A

402



TAX COMPLIANCES

CHAPTER 17
IEC (IMPORT EXPORT CODE)

LEARNING OBJECTIVES:

At the end of the chapter, you will be able to:

a  Acquire knowledge about the Importer Exporter Code (IEC) and become familiar  
 with the services provided by the Directorate General of Foreign Trade (DGFT) in  
 association with IEC.

a  Comprehend the significance of IEC and its pivotal role in facilitating import and  
 export activities.

a  Familiarize yourself with the established guidelines for the application and   
 obtaining of an IEC.

a  Gain an understanding of how to leverage specified services and technologies  
 associated with IEC.

a  Encourage students to explore further details on IEC and related services by visiting  
 the official website of DGFT at www.dgft.gov.in.

INTRODUCTION TO DGFT 

The Directorate General of Foreign Trade (DGFT) is the agency of the Ministry of Commerce and 
Industry of the Government of India responsible for administering laws regarding foreign trade.

It implements the foreign trade policy or the EXIM (export-import) policy of the government and 
it mandates is to promote exports from India.

In accordance with the principles of liberalization and globalization and the overall objective of 
increasing exports, DGFT has since been assigned the role of ‘Facilitator’.

The DGFT is the licensing authority for export/import businesses in India.

DGFT offers online services and platforms to facilitate trade-related activities, including the 
issuance of licenses and certificates, filing applications, and tracking the status of trade-related 
matters and grievance Redressal mechanism for resolving disputes and grievances related to 
foreign trade.

The India’s foreign trade legislation is controlled by the Foreign Trade (Development and 
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Regulation) Act, 1992. Through this policy, the Indian government permits the imports into India 
and encourages exports from India.

IMPORTER-EXPORTER CODE 

The Importer-Exporter Code (IEC) is a business identification number that is mandatory for 
all imports and exports. No person shall engage in any import or export activities without an IEC 
number granted by the Directorate General of Foreign Trade (DGFT). The IEC is required for 
various purposes, including import and export processes, shipment and customs clearance, and 
making payments in relation to both exports and imports. It is also a fundamental document for 
accessing various benefits related to customs, DGFT, and Export Promotion Councils, among 
others.

The ITC (HS) Code, known as the Indian Trade Classification (Harmonized System) Code, has 
been adopted in India for managing and regulating export and import operations. The Indian 
customs use an 8-digit ITC (HS) Code to fulfill national trade requirements

17.1. HOW TO OBTAIN IEC?
Detailed steps to obtain an IEC Certificate through online are given below:

To obtain the IEC, visit the DGFT official website at www.dgft.gov.in.

You have an option to obtain IEC either as an individual/ on behalf of a firm.

For that, click on ‘Apply for IEC.’
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To create a new user account, click on ‘REGISTER’

Select ‘Importer/ Exporter’ option from the dropdown menu labeled ‘Please Select ‘

Next, furnish all necessary information and ‘Send OTP’
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Then, Enter the Email OTP and Mobile OTP & Then click ‘Register’

Now a popup message will appear on the screen, notifying you that the registration process 
been successfully completed & a username and password will be sent to your Email address
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The Authority will send a Username & Password to your E-mail address for Login.

‘Login’ to the website using the provided Username & Password received via E-mail
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Once logged in, an option to set a New Password will be appear

 After changing the Password, click on ‘Submit’
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Subsequently, a message will be displayed, advising you to Sign in again, using the changed 
Password

On the following page, proceed to ‘Apply IEC’
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After that, Click on ‘Start fresh application’ located below

Next, navigate to the ‘Nature/Concern of firm’ under ‘Basic Details’ & select the

nature of your firm.
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Enter the firm’s details including PAN, GSTIN & other required information specified on the portal.
After uploading the necessary information, click on ‘Save & Next
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Then go for ‘Firm Address Details’

Once all information has been provided & documents are uploaded, click on
‘Save & Next’

Afterwards, fill out the ‘Branch details ‘and click ‘Save & Next’
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Then, move onto the ‘Details of Proprietor/Partner/Director/Karta/Managing Trustee’ & Provide 
necessary information

After giving the required information, a brief of your details will be appear in a box.
Then, click on ‘Save & Next.
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The next step is to provide ‘Bank Account Details.’

Once you are provided the required information, there is a need to upload a cancelled
cheque in the appropriate format.

If you are applying for an IEC as an individual, upload the cancelled cheque belonging to
that individual.

If the IEC application is being submitted for a firm, it is essential to upload a cancelled
cheque of that particular firm.
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After updating the bank account details, go for ‘Other details.’

Choose the sector of operation that corresponds to the intended- business dealings.

And then, choose the sector of your business under ‘Import’ and ’Export’
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If you have any business other than the mentioned ones, then specify the business in the given 
box.

Then, Click on ‘Save & Next’
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Next, move onto the ‘Declaration’ part.

Afterwards, fill out the date and place column, then click ‘Save & Next’.
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Then, make a tick on the given box, as an acceptance of declaration.

Then, Click to the ‘Sign’ tab given below.
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There you will be able to see a message about payment details.

Once you signed, a notification will pop up on the screen.

Click ‘ok’ to move on or click ‘cancel’ to edit any information.

Thereafter, proceeds with the signing submission.
You are able to sign either with your DSC or with the Aadhaar.
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After completing the process, you will receive a message confirming that, the signing has been 
successfully done

Next, a summary of given details will be appear.

Indicate your agreement with the terms & conditions, by ticking the box below.

Then, Click on the tab of ‘Proceeds to Payment’.
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Following that, you will see an option to give your payment details.
After entering the relevant details, click ‘Submit’.
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Once you have done with submitting your details, you will be eligible to view an online payment 
information in the form of a challan.

Click on ‘Confirm’ to initiate the payment process.
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Then, a payment gateway will be appear.

You have to select the mode of payment & then enter the captcha.

Click on ‘Pay’
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Afterwards, you will be able to view an online receipt of your payment details.

You can check the transaction status on receipt, to ensure your payment.

You could download the receipt if you want. Then click on ‘Ok’.
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In the subsequent step, a pop-up message will be shown on your screen, indicating that your 
application has been subjected to further proceedings by the DGFT.
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After that, an instant page will open up to show your application status.

Under the head of ‘File Status’, you will be able to see your application status.

Then return to the dashboard, go for ‘Services’ & select ‘View and Register Digital Signature Token’ 
to Complete the Procedure.
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Subsequently, you can provide your details & sign in with either using DSC or your E-Aadhaar.

In the next step, you will be able to see a notification to indicate that, your IEC Certificate has 
been registered successfully.

Finally, you can view your IEC Certificate online.
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17.2 ADVANTAGES OF TAKING THE BENEFITS OF IEC

• Lifetime Validity:
• Once the IEC is granted, there is no need of any renewal. It is valid until lifetime.

• Preventing illegal transactions:
• IEC helps the Government to keep an eye on cross-border transactions & reduce the risks 

of illegal transactions.

• No additional cost required:
• Since the IEC is granted for lifetime, there is no need of any additional maintenance cost.

• Easy registration:
• IEC registration can be easily done through online.

• Quick process:
• After submitting the online application, IEC registration certificate can be obtained within 

2 weeks period, usually.

• Helps to claim Export incentives:
• IEC Registration helps to get various types of export incentives like Duty Draw Back (DDB), 

Refund of goods exported, Merchandise Export from India Scheme (MEIS), etc.

• Easy access on global markets:
• People who complete IEC Registration have a competitive advantage over the local 

dealers.

• No requirement of any compliance:
• IEC holder does not have to fulfil the requirements of return filing.

 
          SUMMARY

This chapter provides an overview of the importance of IEC, how to obtain it through the 
DGFT website, and the advantages it offers to businesses engaged in import and export 
activities. It encourages learners to explore further details on IEC and related services by 
visiting the official DGFT website at www.dgft.gov.in.
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       MULTIPLE CHOICE QUESTIONS (MCQS)

1. What does ‘IEC’ stand for?

a) Importer- Exporter Certificate

b) International Export Certificate

c) Importer-Exporter Code

d) Import-Export Credentials

2. Who has the authority to grant an IEC?

a) Directorate General of Foreign Trade

b) Department General of Foreign Trade

c) Ministry of Corporate Affairs

d) Ministry of Skills & Development

3.What role has DGFT been assigned in accordance with New Economic Policy?

a) Regulator

b) Facilitator

c) Enforcer

d) Auditor

4. What is the validity of an IEC?

a) 1 year

b) 5 years

c) 10 years

d) Lifetime

5. How does IEC help to prevent illegal transactions?

a) By reducing tax liability

b) By increasing tariffs

c) By monitoring cross-border transactions

d) By promoting tax evasions

431



TAX COMPLIANCES

6. Which one is an advantage of IEC Registration?

a) Helps to claim export incentives

b) Helps to explore global markets

c) No need of return filing

d) All of the above

7. Where we can apply for an IEC certificate online?

a) www.iec.gov.in

b) www.dgft.org.in

c) www.dgft.gov.in

d) www.iecgov.ac.in

8. What is the cost of IEC registration for a company?

a) Rs.250

b) Rs.500

c) Rs.1000

d) Rs.1500

9. How long does it typically take to get an IEC Certificate once we applied?

a) 2 weeks

b) 3 weeks

c) 30 days

d) 2 months

10. IEC is primarily used for _____?

a) Tax computation

b) Foreign Trade calculation

c) Employee Identification

d) Business Identification
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TASK

1. C 

2. A 

3. B  

4. D  

5. C

6. D  

7. C  

8. B  

9. A  

10. D
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CHAPTER 18
MICRO, SMALL AND MEDIUM ENTERPRISES

 
        LEARNING OBJECTIVES:

a     Definition of MSME and the Advantages of MSME Registration.

a     The formal procedure for obtaining MSME registration.

 
INTRODUCTION
WHAT IS MSME

The Micro, Small, and Medium Enterprises Development (MSMED) Act was enforced in 2006 to 
tackle concerns impacting MSMEs, alongside revising sector coverage and investment limits. 
This legislation aims to foster these enterprises’ growth while boosting their competitiveness. 
It introduces the initial legal structure acknowledging the “enterprise” concept, encompassing 
manufacturing and service entities. The Act establishes a formal advisory mechanism 
encompassing a broad array of functions. Furthermore, it sets up dedicated funds, introduces 
competitive enhancement strategies, announces schemes/programs, implements progressive 
credit policies, and offers preferential treatment in Government procurement for micro and small 
enterprises. Additionally, it enhances mechanisms for tackling delayed payments and assures a 
scheme for streamlining business closures among these enterprises.

CLASSIFICATION MICRO SMALL MEDIUM
MANUFACTURING 
ENTERPRISES 

&

ENTERPRISES REN-
DERING SERVICES

Investment in plant 
and machinery- 

• NOT MORE THAN

 1 CRORES

Annual Turnover- 

• NOT MORE THAN 

 5 CRORES.

Investment in plant 
and machinery-

• NOT MORE THAN 

 10 CRORES.

 

Annual Turnover-

• NOT MORE THAN 

 50 CRORES.

Investment in plant 
and machinery-

• NOT MORE THAN 50 

 CRORES

Annual Turnover-

• NOT MORE THAN

 250 CRORES.
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FEATURES OF MSME

The apex authority responsible for MSME policy formulation is the Central Government.

The classification of MSMEs is determined by their investment in plant and machinery, as well 
as their turnover and MSME actively promote entrepreneurship and skill development through 
specialized training centers.

Ministry of MSME has launched E-book on schemes and benefits on MSME ( https://www.msme.
gov.in/e-book-schemes-msme )

That all companies, who get supplies of goods or services from MSME and whose payments 
to MSME suppliers exceed forty-five days from the date of acceptance or the date of deemed 
acceptance of the goods or services shall submit a half yearly return to the MCA (Form: MSME 1)

The National Board for MSME (NBMSME) was established by the Government under the Micro, 
Small and Medium Enterprises Development Act, 2006 and Rules made thereunder, assesses 
factors influencing the advancement of MSME. It evaluates current policies and initiatives and 
advices the government on shaping policies and programs to foster MSME growth.

Initiatives like the “Make in India” and “Startup India” campaigns aim to boost the growth and 
competitiveness of MSMEs

BENEFITS OF MSME  
(DETAILS OF SCHEMES CAN BE ACCESSED FROM HTTPS://MSME.GOV.IN/SCHEMES)

Collateral-free loans: - There is a Scheme called CGTMSE (Credit Guarantee FUND Trust for 
Micro and Small Enterprises). Under this scheme, MSME’s can avail credit-free loans up to 200 
lakhs from eligible enterprises.

Reimbursement of ISO certification expenses: - Those expenses incurred by MSME’s while 
taking ISO certification can apply for reimbursement of ISO expenses if applied to respective 
authorities.

Electricity bill concession: - MSME’s can apply for concession on their electricity bills if applied 
to respective Electricity boards.

Subsidy on Industrial Promotion Subsidy (IPS) & Patent Registration: -As a part of industrial 
promotion, MSME’s applying for patent registration and IPS would get a 50% subsidy.

Protection against delayed payments: - At the time of credit supplies, the buyer is expected to 
pay within the time period specified in the agreement, which in no case shall not exceed 45 days 
(about 1 and a half months). If the buyer has exceeded the limit, he is liable to pay compound 
interest with monthly rest at three times the rate notified by the RBI.
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Credit Linked Capital Subsidy Scheme: - This is applicable for new and existing Micro and small 
enterprises where the government provide 15%CLCSS in order to promote technology upgrades.

Government Tenders: - Registered MSME’s can participate in government tenders without 
paying any security/bid money.

Technological and Quality support: - The government supports MSMEs with excellent technology 
in order to motivate them to adopt energy-effi cient technologies that lower production costs 
and lower greenhouse gas emissions. Subsidies for the purchase of assets will be given to MSMEs.

18.1  PROCEDURE FOR MSME REGISTRATION
Access the page http://udyamregistration.gov.in/UdyamRegistraion.aspx

Udyam Registration portal would appear. From the portal, select “For New Entrepreneurs who 
are not Registered yet as MSME or those with EM-II”, as shown in the fi gure below.

Provide AADHAR NO., Name of the Entrepreneur in the specifi ed boxes, tick the checkbox 
agreeing to the terms and conditions, then click on “validate and Generate OTP”. An OTP would 
be sent to the AADHAR linked mobile number. Insert the OTP in the specifi ed box and click on 
“Validate “as shown in the fi gure below.
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In the PAN verifi cation section, you will see a dropdown menu. Choose the “PROPRIETOR” option 
from the dropdown menu under the “Type of organization.” Enter the proprietor’s PAN and click 
on the “PAN validate” button. If the PAN is successfully validated, a confi rmation message will 
appear. Afterward, click on “CONTINUE,” as illustrated in the fi gure below.

A binary option would appear, asking if the person has fi led an ITR or possesses a GSTIN in his/
her name. Choose the appropriate response, either “Yes” or “No” as shown in the fi gure below.
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Under Udyam registration, Name, as per the PAN, will be automatically populated. You’ll need to 
input the mobile number and email address. Additionally, you will have the option to select a 
special category, specify the gender, and indicate whether the person is speci ally abled or not.

Enter the Name of the Enterprise and the plant/unit’s name, then click on “Add.” After clicking 
“Add,” choose the plant you just added from the dropdown menu located under “Location of the 
Plant”, Unit name. Enter details such as fl at number, premises name, village/town, block, road/
street/lane, city, PIN code, state, district (selected from the dropdown), and click on “Add.”
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In the official address section of the enterprise, please input details such as flat/door/block 
number, premises/building name, block, road/street/lane, city, PIN code, state, and district. 
After entering these details, click on “Get latitude and longitude” to pinpoint the office location 
on the map. Additionally, if applicable, provide any Previous EM-II/UAM Registration Number.
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Regarding the status of the enterprise, please furnish the Date of Incorporation/registration, 
specify date of Incorporation, and provide the Date of commencement. In the bank details 
section, input the Bank Name, IFS Code, and Bank Account Number. Also, indicate the primary 
activity of the unit, whether it’s in manufacturing or service. If “service” is selected, please specify 
whether it pertains to trading or non-trading activities.

Explore the National Industrial Classification (NIC) Code. It assigns codes to different activities. 
Find the NIC codes matching your business activities. If the proprietor engages in more activities, 
click “Add More Activities” and include them. Additionally, input the number of male, female, or 
other employees working in the business.
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Check the box to confi rm compliance with the provisions of the Child & Adolescent Labour 
(Prohibition and Regulation) Act, 1986. In the following section, input the Written Down Value 
(WDV) as of March 31st of the Previous Year 2021-22, exclusion of costs of Pollution Control, 
Research & Development, and Industrial Safety Devices for 2021-22 (to be provided based 
on self-declaration). The Net Investment in Plant and Machinery OR Equipment will be 
automatically populated by the website. Enter the Total Turnover (A) for the year 2021-22.

•  You will fi nd “Yes” or “No” options for the following. Select as per necessary: -
• Are you interested in registering on the Government e-Market (GeM) Portal?
• Are you interested in registering on TReDS Portals (one or more)?
• Are you interested in registering on the National Career Service (NCS) Portal?
• Are you interested in registering on the NSIC B2B Portal?
• Are you interested in availing a Free .I N Domain and a business email ID?

The District Industries Center will be automatically selected from the dropdown menu.

Mark the checkbox to confi rm that the information provided is accurate to the best of your 
knowledge. Then, click “Submit and get fi nal OTP”.
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National Career Service (NCS) Portal Click here

Upon clicking the “Submit and Get Final OTP” button, a pop-up message will appear, inquiring 
about the accuracy of the entered data and confi rming the correctness of the provided mobile 
number. Press “ok”.
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After selecting “OK,” a section for entering the OTP and verifi cation code will be displayed. Input 
the OTP sent to your mobile number and the verifi cation code in the designated fi elds, then click
“FINAL SUBMIT.”

An alert message will appear at the top, indicating that the information provided is unalterable. 
Click “OK” to proceed.
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A subsequent pop-up message will confi rm the successful completion of the Udyam registration. 
Click “OK” to acknowledge this achievement.

A message will be displayed on the screen with a checkmark, indicating the Udyam registration 
number.
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SUMMARY

MSMEs are vital to India’s economic fabric, contributing significantly to employment 
generation, technological advancement, production, and innovation. Government 
support and digital transformation are key factors in their growth and sustainability. 
Despite challenges, MSMEs are poised to play a crucial role in India’s economic future

MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the primary aim of the MSMED Act? 

a) Promote large-scale industries 

b) Foster the growth of MSMEs and enhance their competitiveness 

c) Regulate the export sector

d) Promote foreign investments

445



TAX COMPLIANCES

2. Which government authority is responsible for policy formulation for MSMEs?

a) State Government

b) District Industries Center 

c) Central Government 

d) Local Municipal Corporation

3.  How are MSMEs classified based on their size?

a) By the number of employees 

b) By their annual profit 

c) By their investment in plant and machinery and turnover 

d) By their location

4. What kind of loans are available to MSMEs under the CGTMSE scheme? 

a) Collateral-free loans 

b) Long-term loans

c) Personal loans 

d) Mortgage loans

5. What is the purpose of the CGTMSE scheme? 

a) To promote export-oriented businesses 

b) To provide subsidies to large-scale industries

c) To offer collateral-free loans to MSMEs 

d) To regulate labor practices in MSMEs.

6. Which act requires companies to include information about delayed payments to MSME 
units in their annual reports? 

a) Child & Adolescent Labour (Prohibition and Regulation) Act, 1986 

b) Companies Act, 2013 

c) Income Tax Act, 1961 

d) Foreign Exchange Management Act (FEMA)
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7. What is the full form of “NIC” in the context of MSMEs? 

a) National Investment Corporation 

b) National Infrastructure Committee 

c) National Industrial Classification 

d) New Industry Consortium

8. MSMEs are encouraged to adopt energy-efficient technologies that lower production costs 
and greenhouse gas emissions. Which subsidy is provided to support the purchase of such 
assets? 

a) Technological Advancement Subsidy 

b) Green Manufacturing Subsidy

c) Energy Efficiency Subsidy 

d) Credit Linked Capital Subsidy Scheme (CLCSS).

9. What does the term “CGTMSE” stand for?

a) Central Government Trust for Micro and Small Enterprises

b) Credit Guarantee FUND Trust for Micro and Small Enterprises

c) Comprehensive Guarantee Fund for Technical Enterprises 

d) Common Gateway for Trade and Small Enterprises.

10. If a unit possesses an investment in plant and equipment totaling ₹55 crore and a turnover 
of ₹300 crore, how would it be classified?

a) Micro

b) Small

c) Medium

d) None of the options above

Answers

1. B 2. C 3. C 4. A 5. A

6. B 7. C 8. D 9. B 10. D
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CHAPTER 19
MCA 21 E- FILING

   LEARNING OUTCOMES
     At the end of this chapter, you will be able to:

a   MCA 21 and various services.

a  Explain all the important aspects relating to various e-services including   
 e-stamping, e-inspection, all about filling and filing the e-forms etc. 

a  Guidelines for filling and filing e- forms and description of e-forms.

a  Know about E-governance in corporate sector, Various forms and filings related  
 to company administration

The students may refer to www.mca.gov.in for the format of various e-Form and further details. 

19.1. INTRODUCTION TO MCA

Ministry of Corporate Affairs (MCA), Govt. of India ministry primarily concerned with administration 
of the Companies Act 2013, the Companies Act 1956, the Limited Liability Partnership Act, 2008, 
and the Insolvency and Bankruptcy Code, 2016 and also responsible for the regulation of industrial 
and services sector in India. MCA also exercises supervision over the three professional bodies, 
namely, Institute of Chartered Accountants of India (ICAI), Institute of Company Secretaries of 
India (ICSI) and the Institute of Cost Accountants of India (ICAI) which are constituted under 
three separate Acts of the Parliament. The Ministry also has the responsibility of carrying out 
the functions of the Central Government relating to administration of Partnership Act, 1932, the 
Companies (Donations to National Funds) Act, 1951 and Societies Registration Act, 1980.

19.2.E -GOVERNANCE AND MCA 21

E-Governance is the use of information and communication technology (ICT) to provide 
government services, exchange information, conduct transactions, and integrate previously 
existing services and information portals. The “e” in “e-Governance” refers for “electronic.” MCA-21 
is an ambitious e-governance initiative of Government of India that builds on the Government’s 
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vision of National e-governance in the country The Government of India’s Mission e-Governance, 
in combination with Digital India, has undergone a paradigm shift. This E-governance initiative, 
a flagship program executed by MCA in partnership with Private Player, is a fine example of 
public private partnership, and is built on a BOOT (Built, Operate, Own and Transfer) model. MCA 
has initiated the MCA-21 project in the year 2006, to enable an easy and secure access to MCA 
services in a manner that best suits the corporate entities and professionals and the public. 
MCA services are made available at the place of their choice, be it their homes or offices.MCA-
21 project introduced in the process of E-filing, storage of records, electronic repository and 
inspection of records of registered companies and LLP. Electronic Governance is the application 
of Information Technology to the Government functioning in order to bring about Simple, Moral, 
Accountable, Responsive and Transparent (SMART) Governance. E-governance is a highly 
complex process requiring provision of hardware, software, networking and re-engineering of 
the procedures for better delivery of services.

19.3.MCA- 21 AND ITS LEGAL VALIDITY

Section 398 of the Companies Act, 2013 has provision related to filing of applications, documents, 
inspections in electronic form.

Section 398(1) provides that notwithstanding anything to the contrary contained in this Act, 
and without prejudice to the provisions contained in section 6 of the Information Technology 
Act, 2000, the Central Government may make rules so as to require from such date as may be 
prescribed in the rules that –

(a) Such applications, balance sheet, prospectus, return, declaration, memorandum, 
articles, particulars of charges, or any other particulars or document as may be required 
to be filed or delivered under this Act or the rules made thereunder, shall be filed in the 
electronic form and authenticated in such manner as may be prescribed;

(b) Such document, notice, any communication or intimation, as may be required to be 
served or delivered under this Act, in the electronic form and authenticated in such 
manner as may be prescribed;

(c) Such inspection of the memorandum, articles, register, index, balance sheet, return or 
any other particulars or document maintained in the electronic form, as is otherwise 
available for inspection under this Act or the rules made thereunder, may be made by 
any person through the electronic form in such manner as may be prescribed;

(d) Such fees, charges or other sums payable under this Act or the rules made thereunder 
shall be paid through the electronic form and in such manner as may be prescribed; and 
The Central Government has provided all the e-forms as an annexure to the relevant 
Rules.
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Rule 7 of Companies (Registration offices and fees) Rules, 2014 relates to manner and 
conditions of filing provides that Every application, financial statement, prospectus, 
return, declaration , memorandum, articles, particulars of charges, or any other 
particulars or documents or any notice , or any communication or intimation required to 
be filed or delivered or served under the Act and rules made there under , shall be filed or 
delivered or served in computer readable electronic form , in portable document format 
(pdf) or in such other format as has been specified in any rule or form in respect of 
such application or form or document or declaration to the Registrar through the portal 
maintained by the Central Government on its web-site or through any other website 
notified by the Central Government

19.4. ORGANIZATION OF ROC OFFICE UNDER MCA

The Registrar of Companies (ROC) as defined under Sub-Section 75 of Section 2 of the Companies 
Act, 2013, is an appointment of the Ministry of Corporate Affairs vested with the primary duty of 
registering companies and LLPs floated in the respective states and the Union Territories and 
ensuring that such companies and LLPs comply with statutory requirements under the Act. 
These offices function as registry of records, relating to the companies registered with them, 
which are available for inspection by members of public on payment of the prescribed fee. The 
Central Government exercises administrative control over these offices through the respective 
Regional Directors.

FRONT OFFICE
The major components involved in this comprehensive e-governance project are front office 
and back office.

Front Office represents the interface of the corporate and public users with the MCA-21 system. 
This comprises of Virtual Front Office and Registrar’s Front Office.

VIRTUAL FRONT OFFICE
Virtual front office is one of the various channels available to stakeholders (companies and the 
professionals) to enable them to do the statutory filing with ROC Offices across the country. It 
merely represents a computer facility for filing of digitally signed e-forms by accessing the MCA 
portal through internet (www.mca.gov.in). It also presupposes availability of related facilities to 
convert documents into PDF format and scanning of documents wherever required.

REGISTRAR’S FRONT OFFICE (RFO)
To facilitate the change over from Physical Document Filing to Digital Document Filing, the Ministry 
started offices known as the Registrar Front Office. It is one of the various channels available to 
stakeholders to enable them to do the statutory filing with ROC Offices across the country. 
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BACK OFFICE

Back Office represents the offices of Registrar of Companies, Regional Directors and Headquarters 
and takes care of internal processing of the forms filed by the corporate user as per MCA norms 
and guidelines. The e-forms are routed dynamically to the concerned authority for processing 
depending upon the assigned role. All the e-forms along with attachments are stored in the 
electronic depository, which the staff of MCA can view depending upon the access rights.

Central Registration Centre (CRC)

The Central Registration Centre (CRC) is an initiative of Ministry of Corporate Affairs (MCA) in 
Government Process Re-engineering (GPR) with the specific objective of providing speedy 
incorporation related services in line with global best practices.

19.5. MCA SERVICES

MCA-21 is providing wide variety of services to its users for facilitating different compliance 
activities. MCA Services are broadly classified as follows:

19.5.1. DSC SERVICES

A user can acquire Digital Signature Certificate (DSC), register DSC and update particulars of the 
DSC through the MCA Portal.

Fig 1.1
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STEPS

Visit www.mca.gov.in

MCA SERVICES ----DSC SERVICES 

a) Acquire DSC- To obtain DSC and MCA provide related links and artefacts related to 
certifying authorities and important notice on DSC

b) Associate DSC- Directors, Manager, Practicing professionals, Authorized offi cer and MCA 
offi cers can register their DSC with MCA 21 portal for certifying and signing of various 
forms

c) Update DSC – If DSC is expired the registered users can update their DSC in MCA portal

19.5.2. DIN SERVICES

A user can enquire about the DIN status and verify DIN and PAN details of Director of the company.

Fig 2.1
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STEPS

Visit www.mca.gov.in

MCA SERVICES

a) Apply for DIN: 

• DIN is an 8-digit unique identification number and every individual, who is director of 
the company or wants to be director in a company needs to obtains DIN

• DIN can be applied by filing Form DIR 3

• Fees for obtaining DIN is 500 Rs

• PAN Card copy, ID Proof, DSC, digitally signed by existing CS/director and such other 
documents required for obtaining DIN

b) Enquire DIN Status

Fig 2.2

The existing DIN and its approval status can be checked to find its active or inactive. DIN may be 
inactive due to various reasons including non-filing of DIR-3 KYC or disqualification of directors 
under section 164 of companies act 2013 
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c) By using DIN and PAN card number, the user can verify the details in respective database is 
same or not.

19.5.3. MASTER DATA
A user can view Master Data of a Company or an LLP, Index of Charges of the company, signatory 
details of a particular company, details of companies and directors under prosecution, details 
of Companies and LLP’s registered in the last 30 days, master data of directors specifying the 
name of Companies/LLP’s they are director/ partner in, director/designated partner’s details, 
etc.

STEPS

Visit www.mca.gov.in

a) VIEW COMPANY MASTER DATA: 

• MCA Services---View company master data---Either mention company CIN/Search CIN by 
indicates first word of name of company

• Master data/Index of charges/Signatory details of the company is available of all companies 
and LLP registered in India to the public without payment of any fees/registration or login in 
MCA portal

Fig 3.1
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b) INDEX OF CHARGES 

• According to section 2(16) of the Companies act 2013, charge means an interest or lien 
created on the property or assets of a Company or any of its undertakings or both as security 
and includes a mortgage.

• When company repays its secured loan fully to the lender or when property or asset charged 
has been released from charge then it is known as satisfaction of charges.

• MCA Home> MCA Services> View Index of charges> Search company name/CIN and submit.

Fig 3.2

c) SIGNATORY DETAILS: 

• The details of existing directors of the company can be availed

• MCA Home> MCA Services> View Signatory details> Search company name/CIN and submit
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Fig 3.3

d) VIEW DIRECTOR MASTER DATA/PARTNERS DETAILS: 

• This service is available only after login with MCA portal 

• The details of existing directorship in companies and LLP of a directors /designated partners 
can be availed by indicate the DIN

• MCA Home> MCA Services> View Directors master data> Search company name/CIN and 
submit
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Fig 3.4

19.5.4. LLP SERVICES

A user can check LLP name, find LLPIN (Limited Liability Partnership Identification Number), avail 
services related to incorporation of an LLP, services related to annual e-Filing for an LLP, services 
related to change in LLP information and services related to closure of an LLP.
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Fig 4.1

Visit www.mca.gov.in

a) MCA Services--- LLP E Filing---Select forms

• This service is available to users only after registration and login with MCA 
V3 portal 

• Registration in MCA V3 portal can be done in registered user or business 
user category
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Fig 4.2

Any individual can register under Registered user can be done by using the PAN and business 
user registration is mandatory for e filing services in LLP forms and mostly all forms in company 
services too. Registration is completed only after verifying OTP in Email and Phone.

Fig 4.3
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19.5.5. E-FILING

A user can download LLP Forms or Company Forms from the Portal, submit application for PAN 
and TAN, upload e-forms, download Submitted Form for resubmission, check annual filing status 
of the company, upload details of security holders or debenture holders or depositors.

E filing can be done only after registration and login with MCA portal.

All forms of LLP and mostly all forms of company services is integrated to MCA V3 portal.

Fig 5.1
19.5.6. COMPANY SERVICES

A user can check company name, find CIN (Corporate Identity Number), services related 
to incorporation of a company, avail services related to compliance filing of a company, 
services related to change in company information, services related to charge management, 
informational services and services related to closure of a company.

Company E filing services includes Incorporation services, DIN related services, Charges related 
filings, Deposit related filings, DIN related forms, Nidhi services, change services, foreign company 
services, Informational services, Approval services (ROC, RD and headquarters), compliance 
services, Check annual filing status, update subsidiary details and annual filings.
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19.5.7. COMPLAINTS

A user can raise service-related complaints, track the complaints created, create investor/
serious complaint, track the status of complaints created as ‘investor/serious complaint’, give 
feedback or suggestions to MCA-21 and raise employee grievances.

Fig 7.1

The complaint service is available only after login with MCA portal

Once a complaint is registered the users can track the status of their complaint by using the 
acknowledgement number and also can give their feedback and suggestions 

The details of issue, form SRN, contact details and other such information can be given along 
with complaint.
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Fig 7.2

19.5.8. DOCUMENT RELATED SERVICES

A user can get certified copies of Forms and documents of a company, view forms and 
documents online etc.

ONLINE INSPECTION OF DOCUMENTS
The documents filed online, once taken on record by ROC Offices are available for public viewing 
on payment of requisite fees. These documents, which are in domain of public documents, include 
documents relating to incorporation, charges, annual returns and balance sheets and change 
in directors. A certified copy of the documents can also be obtained by anyone so interested. For 
this purpose there is also an option to mention the number of pages in the document for which 
a certified copy is required as well as the number of copies required.

Inspection, production and evidence of documents kept by Registrar – Rule 14 of Companies 
(Registration offices and fees) Rules, 2014

The inspection of the documents maintained in the electronic registry so set up by MCA and 
which are otherwise available for inspection under the Act or rules made thereunder, shall be 
made by any person in electronic form.

Inspection of documents – [Rule 15 of Companies (Registration offices and fees) Rules, 2014]

Any person may –
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Inspect any document kept by the Registrar, being documents filed or registered by him in 
pursuance of this Act or the Companies Act 1956 or making a record of any fact required or 
authorized to be recorded or registered in pursuance of this Act, on payment for each inspection 
of fee.

Require a certificate of incorporation of any company, or a copy or extract of any other document 
or any part of any other document to be certified by the Registrar, on payment of fee.

No person shall be entitled under section 399 to inspect or obtain copies of resolutions referred 
to in clause (g) of sub- section (3) of section 117 of the Act.

This service is available only after logging with MCA V2 portal

If user has to only view the Public Documents, then the logging in on the MCA Portal is not required, 
however if user wants to download the Public Documents, then he has to log in on the MCA Portal 
before following this process

After login- Type company name/ search CIN and then submit

Fig 8.1
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Fig 8.2

Select the document of the company to be downloaded and select the year and later add to the 
card and pay fees either by electronic means

Fig 8.3
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Once the appropriate Document Category and Year of Filing is selected user can view the 
documents, forms filed during that year. Facility to download the documents is also available 
on the MCA Portal. *For only viewing the “Public Documents” user is not required to log on to the 
MCA Portal. Log in is mandatory only in case the user is required to download the documents by 
paying fees of Rs. 100/-

Fig 8.4

Once the payment is made user will be able to download the documents, forms. Company for 
which the payment is made will be reflected in “My Workspace “under “Documents” tab.
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Fig 8.5

19.5.9. FEE AND PAYMENT SERVICES

A user can avail services through Enquire Fees, pay later, link NEFT payment, pay miscellaneous 
fee, pay stamp duty and track the payment status.

Enquire Fees

Fig 9.1
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Fig 9.2

Fig 9.3
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Fig 9.4
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Fig 9.5

19.5.10. PUBLIC SEARCH OF TRADEMARK

A user can search whether trademark has been registered or applied for a particular name by 
a company.

Trademarks are regulated under the Trademarks Act, 1999 (‘Act’) and Trade Marks Rules, 2017 
(‘Rules’). When a trademark is registered under the Act, it is protected from infringement which 
means that a third party cannot use the registered trademark for their products or services 
without authorized permission.

A name that violates section 4 or any other provision of the Trademark Act,1999 . The similarity 
or resemblance of trade mark is not allowed while applying the name of the company or later ( 
Under Incorporation rules and naming guidelines under companies act 2013)

Before application or alteration of name of the company , TM can be search from the public 
portal to check any similarity or resemblance of any existing TM 

Go to www.mca.gov.in
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Fig 10.1

Fig 10.2

Website shall proceed to external website by clicking
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Fig 10.3

The details of class can be availed from the website itself.

19.5.11. INVESTOR SERVICES

A user can search amount unclaimed/unpaid amount due to be transferred to the Investor 
Education and Protection Fund (IEPF), upload investor details, confirm uploaded files.

19.5.12. TRACK SRN/TRANSACTION STATUS

A user can track the transaction status of the uploaded forms i.e., whether they are approved or 
pending for approval or required for resubmission or are rejected.

19.5.13. MCA E BOOK

MCA has launched E-Book for 10 acts and applicable Rules and Regulations for companies and 
LLPs administered by it.
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Fig 13.1
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19.6. PREREQUISITES FOR E-FILING ON MCA- 21

19.7. STAMP DUTY

Stamp duty is a state subject. It is payable on Memorandum and Articles of Association of every 
Company. In some states, duty is also payable on the authorized capital mentioned in the 
Memorandum of Association of the Company. States have authorized MCA to collect the stamp 
duty on their behalf and to remit the same to them. 

( https://www.mca.gov.in/MCA21/dca/efiling/eStamp_rate.pdf )

Introduction of e-stamping facility by MCA and dispensation of physical submission there of For 
the purpose of making all transactions faster, improving service delivery and making office of the 
Registrar paperless, the process of physical submission of documents has been dispensed with. 
The Central Government shall initially collect the stamp duty on behalf of State Governments 
and Union Territories for specific purpose of e-filing of documents under the provisions of the 
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Companies Act, 2013 and to remit the same directly to their accounts in accordance with the 
approved payment and accounting procedures.

19.8. HIGHLIGHTS
Stamp Duty applicable on filing of e-form SPICe (including MOA & AOA), SH-7 and FC-1 shall 
be electronically paid through MCA21 system. A person applying for certified true copy is also 
required to pay stamp duty through MCA21 portal.

With effect from 1st April, 2010, stamp duty shall have to be paid only through electronic mode for 
the states which have agreed for e-stamping.

Stamp duty can be paid through MCA21 system with any of the option such as net banking, 
credit card, debit card, NEFT or offline with banks.

Stamp duty can be paid immediately or stamp duty can be paid later on also, using “Pay Stamp 
Duty Fees” facility.

If user pays stamp duty through MCA21 system, there is no need to visit stamping authorities.

The rates of stamp duty in the respective states may be revised through finance bill.

19.8.MCA V2, V3 PORTALS AND VARIOUS FORMS

STP FORMS 
STP stands for “Straight Through Process”. Some e-forms are identified as informatory in nature. 
These forms are filed under Straight through process may be examined by the Registrar at any 
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time on Suo- moto or on receipt of any information or complaint from any source at any time 
after its filing. It means the information given in the e-forms is being taken on file maintained by 
the Registrar of Companies through electronic mode on the basis of statement of correctness 
given by the filing Company and further verification by the practicing professionals.

MCA V3
MCA21 V3 Project is a technology driven project, envisioned to strengthen enforcement, promote 
ease of Doing Business, enhance user experience, facilitate seamless integration and data 
exchange among various regulators in India. The project will have Micro-services architecture 
with high scalability and capabilities for advanced analytics.

MCA V2
V2 portal is Version 2 of the MCA portal which was used to file various forms relating to Companies 
and LLP’s. LLP Services have been discontinued on V2 portal and have been migrated to V3 portal.

MCA V3 FORMS

FORM PURPOSE FORM PURPOSE

RUN
Change of Name of Existing 
company

NDH 1 Return of statutory compliances

SPICE +
Application for change of new 
company and Incorporation

NDH 2 Application for extension of time

DIR 
3-KYC

KYC of directors NDH 3 Return of Nidhi company

DIR 3 KYC 
-WEB

Verify directors KYC details NDH 4 Declaration as Nidhi company

CHG-9
Registration/modification of 
charge for debentures

INC 4 OPC-Change in member/Nominee

CHG-8
RD approval for delay in creation/
modification/satisfaction of 
charge

INC 22
Notice of situation of registered 
office

CHG-6
Appointment/cessation of 
receiver/manager

INC 27
Conversion of company

CHG-4 Satisfaction of charge SH 7 Alteration of share capital

CHG-1
Creation or modification of 
charge

MR 1 Appointment of MD/WTD/Manager
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DPT 4
Statement regarding deposit 
existing on the commencement 
of the act

FC 1 Information by foreign company

DPT 3 Return of deposits FC 2
Alteration in the documents of 
foreign company

DIR 3 Application for allotment of DIN FC 3
Annual accounts by foreign 
company

DIR 3C Intimation of DIN by the company FC 4 Annual return by foreign company

DIR 6
Changes in particulars of 
directors

GNL 4 Addendum to form

DIR 12 Appointment of directors and KMP MGT 3
Notice of situation where foreign 
register is kept

DIR 11 Resignation of director INC 28
Notice of order of the court/
competent authority

DIR 5 Surrender of DIN PAS 2 Information memorandum

DIR 10
Removal of disqualification of 
directors

INC 20
Intimation of revocation of license 
issued u/s 8

DIR 9 Disqualification of directors INC 20A
Declaration of commencement of 
business

MSC 4
Application for obtaining active 
status

INC 23 Application for shift registered office

INC 24 Application for change of name INC 18 Conversion of section 8 companies

INC 12
Application for license to an 
existing company u/s 8

RD 1 Filing application to RD

INC 6 OPC- conversion form MR 2
CG approval for appointment/
reappointment of director

MSC 1
Application for obtaining status of 
dormant company

AOC 5
Notice of address at which books of 
accounts are maintained

STK 2
Removal of name from registrar 
of companies

SH 11 Buy back of securities

PAS 3 Return of allotment MSC 3 Return of dormant companies

SH 9 Declaration of solvency MGT 14 Resolutions and agreement u/s 117

GNL 2
Submission of documents with 
registrar

PAS 6
Reconciliation of share capital audit 
report

GNL 3
Particulars of person(s) of clause 
60 of section 2

REFUND For refund
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MCA V2 FORMS

FORM PURPOSE FORM PURPOSE

CRL 1
Information to the Registrar by 
company regarding the number 
of layers of subsidiaries

CRA 4 Form for filing Cost Audit Report with 
the Central Government.

CRA 2

Form of intimation of 
appointment of cost auditor 
by the company to Central 
Government.

ADT 1 Information to the Registrar by 
Company for appointment of Auditor

ADT 2
Application for removal of 
auditor(s) from his/their office 
before expiry of term

ADT 3 Notice of Resignation by the Auditor

ADJ Memorandum of Appeal MGT 6 Persons not holding beneficial interest 
in shares

RD GNL 
5

Form for filing Addendum for 
Rectification of Defects or 
Incompleteness

MGT 15 Form for filing Report on Annual 
General Meeting

GNL 1 Applications made to Registrar of 
Companies CFI Reply To Call for Information on CSR

FTE
Application for striking off the 
name of company under the Fast 
Track Exit (FTE) Mode

ICP Investor Complaint Form

INC 3 One Person Company- Nominee 
consent form SCP Serious Complaint Form

CSR 1 Registration of Entities for 
undertaking CSR Activities

AOC 4 
CFS

Form for filing consolidated financial 
statements and other documents 
with the Registrar.

INC 22A
Active Company Tagging 
Identities and Verification 
(ACTIVE)

AOC 4

(XBRL)

Form for filing XBRL document in 
respect of financial statement and 
other documents with the Registrar

BEN 2 Return to the Registrar in respect 
of declaration under section 90 MGT 7 Form for filing annual return by a 

company.

MSME

Form for furnishing half yearly 
return with the registrar in respect 
of outstanding payments to Micro 
or Small Enterprise.

MGT 
7A

Form for filing annual return by OPCs 
and Small company.

AOC 4
Form for filing financial statement 
and other documents with the 
Registrar

AOC 4 
NBFC

Form for filing financial statement and 
other documents with the Registrar 
for NBFCs
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PAS 4
Private Placement Offer Letter 
 23C

Form of application to the Central 
Government for appointment of cost 
auditor.

I-XBRL

Form for filing XBRL document in 
respect of cost audit report and 
other documents with the Central 
Government

23D Information by cost auditor to Central 
Government

A-XBRL

Form for filing XBRL document in 
respect of compliance report and 
other documents with the Central 
Government

DPT-1 Circular or circular in the form of 
advertisement inviting deposits

MCA V3- LLP FORMS

FORM PURPOSE FORM PURPOSE

RUN-
LLP

Reserve Unique name 15
Notice for change of place of regis-
tered office

Fillip Incorporation of LLP 22
Notice of intimation of order to the 
registrar

3
Information of LLP agreement and 
changes

23
Application for direction to LLP to 
change its name to the registrar

4
Notice for change in information of 
partners/designated partners

24 Application for striking off name

5 Notice of change of name 25
Reservation/renewal of name by a 
FLLP or foreign company

8 Statement of account and solvency 27 Registration of particulars by FLLP

11 Annual return of LLP 28 Reporting of alteration/closure

12
Form for intimating other address 
for service of documents

31
Application for compounding for an 
offence under the act

32
Filing addendum for rectification of 
defects or incompleteness

19.9. REGISTRATION
INFORMATION REQUIRED FOR REGISTRATION

The following will be needed for registration based on category of the user. Some requirements 
are generic across all categories, there are special data requirements for other categories and 
a few are illustrated below
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•	 E Mail Id / Phone Number / Address are required for both Registered and Business Users)

•	 PAN is non mandatory for registered users but compulsory for business users

•	 Company/LLP User - CIN /LLPIN /FLLPIN / FCRN

•	 Director/Designated Partner – DIN / DPIN

•	 Manager/Secretary/Authorized Representative – General inputs only

•	 Officer in Default – General inputs only

•	 Professional – Professional Membership Number / Professional Institute

19.10. ASSOCIATE THE DSC
This is a process by which a DSC (or a unique signature) is mapped to a user id. This is required 
because the forms are filled and submitted online rather than in physical mode.

STEPS
Associating the DSC is done in the following manner. For this purpose,

•	 Go to mca.gov.in

•	 Log in to the portal as if you are filing an LLP form ( V3 )

•	 Go to MCA Services

•	 Go to FO Services

•	 Go to Associate DSC

SYSTEM SPECIFICATIONS
You can associate your DSC only as a Business user in V3.

•	 Login using your credentials

•	 Go to MCA services-> FO LLP Services-> Associate DSC

•	 Download & run emBridge- 2nd option provided on the screen

•	 Latest Version of emBridge should be installed in user’s system for DSC to work

•	 emBridge Client must be running in the background
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•	 For Associate DSC Service - The DSC user is using must be of Class 2 or higher Class

•	 Change the DSC password/PIN (for 1st time users on V3)

•	 In the token field, select ePass option from the available drop downs.

•	 Select Certificate details from the drop down and enter the DSC password.

•	 Click on Register.

•	 You will receive confirmation message on portal
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HIGHLIGHTS

In the version 2, forms are required to be filled and uploaded in the portal while in V3 the forms 
are to be filled online. This enables user convenience including the ability to save a half-filled 
form and file it later. When a user logs in to V3, the login is through the email id whereas in V2 it 
was possible with the user id
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When a business user logs in to the MCA system, an OTP will be sent to your mobile and e mail 
address to ensure the authenticity of the user

A USER CAN BE A REGISTERED USER OR A BUSINESS USER.
DSC is mandatory only for those forms which are required to be digitally signed. For example, for 
RUN LLP/SPICE +A there is no requirement to affix DSC

Registered users comprise of any individuals. Such users can only perform 2 functions in the LLP 
module – RUN Form and fillip form (Log in functions)

A business user can be any of the following and they can access and file all the forms. There is 
no change in the naming or position of a Business user between V2 and V3. The most suitable 
category may be selected

•	 Company/LLP

•	 Director/Designated Partner

•	 Manager/Secretary/Authorized Representative

•	 Officer in Default

•	 Professional

19.11.E FILING AND GUIDELINES FOR FILING
PRE-CERTIFICATION OF CERTAIN E-FORMS [RULE 8(12)]

(Chapter XXIV The Companies (The Registration Offices and Fees) Rules, 2014)

The authentication of e-forms by authorized signatories using digital signatures, some e-forms 
are also required to be pre-certified by practicing professionals. Pre-certification means 
certification of correctness of any document by a professional before the same is filed with the 
Registrar.

Ministry of Corporate Affairs has entrusted practicing professionals registered as Members of 
professional bodies namely ICAI, ICSI and ICAI-CMA with the responsibility of ensuring integrity 
of documents filed by them with MCA in electronic mode including filing of financial statements 
in XBRL mode. This pre-certification is to be carried out by inter-alia, Company Secretaries or 
chartered accountant or as the case may be the Cost Accountant in whole-time practice. The 
forms filled by companies, other than OPC and small companies which has to be pre-certified 
by practicing professionals 
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Section 2(85) of CA, 2013 which reads as under- “(85) “small company” means a company, 
other than a public company-

a) paid-up share capital of which does not exceed Four crores rupees or such higher 
amount as may be prescribed which shall not be more than ten crore rupees; and 

b)  turnover of which as per profit and loss account for the immediately preceding financial 
year does not exceed Forty crore rupees or such higher amount as may be prescribed 
which shall not be more than one hundred crore rupees. ( w.e.f 15th September 2022)

Provided that nothing in this clause shall apply to— 

a) a holding company or a subsidiary company. 

b) a company registered under section 8; or 

c) a company or body corporate governed by any special Act;”

CONDONATION OF DELAY

According to Section 460, Notwithstanding anything contained in this Act, –

a) where any application required to be made to the Central Government under any 
provision of this Act in respect of any matter is not made within the time specified therein, 
that Government may, for reasons to be recorded in writing, condone the delay; and

b) where any document required to be filed with the Registrar under any provision of this Act 
is not filed within the time specified therein, the Central Government may, for reasons to 
be recorded in writing, condone the delay.

PENALTY FOR FILING FALSE DOCUMENTS/STATEMENTS WITH THE REGISTRAR
According to Section 448 of the Companies Act 2013, if in any return, report, certificate, financial 
statement, prospectus, statement or other document required by, or for, the purposes of any of 
the provisions of this Act or the rules made thereunder, any person makes a statement, –

1. which is false in any material particulars, knowing it to be false; or

2. which omits any material fact, knowing it to be material, he shall be liable under section 
447.

Further Section 447, Without prejudice to any liability including repayment of any debt under 
this Act or any other law for the time being in force, any person involving an amount of at least 
ten lakh rupees or one percent. of the turnover of the company, whichever is lower shall be 
punishable with imprisonment for a term which shall not be less than six months, but which 
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may extend to ten years and shall also be liable to fine which shall not be less than the amount 
involved in the fraud, but which may extend to three times the amount involved in the fraud:

Provided that where the fraud in question involves public interest, the term of imprisonment shall 
not be less than three years.

“Provided further that where the fraud involves an amount less than ten lakh rupees or one per 
cent. of the turnover of the company, whichever is lower, and does not involve public interest, 
any person guilty of such fraud shall be punishable with imprisonment for a term which may 
extend to five years or with fine which may extend to twenty lakh rupees or with both.”.

IMPORTANT TERMS USED IN E-FILING- MCA V3
Pre-fill

Pre-fill is functionality in an e-Form that is used for filling automatically, the requisite data 
from the system without repeatedly entering the same. For example, by entering the CIN of the 
company, the name and registered office address of the company shall automatically be pre-
filled by the system without any fresh entry.
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Attachment

An attachment refers to a document that is sent as an enclosure with an e-Form by means of 
an attached file.

The objective of the attachment is to provide details relevant to the e-Form for processing. While 
some attachments are optional, some are mandatory in nature.

The attachments to an e-Form have to be in Adobe PDF format only (certain forms attachments 
may be in Excel/Jpeg mode too) 
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Submit

The online filled form can be submitted after filling all required fields along with necessary 
attachments.

Upload

Once the form is submitted then SRN (Service request Number) shall be generated and can 
proceed with payment of fees.
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Service Request Number (SRN)
Each transaction under e-filing is uniquely identified by a Service Request Number (SRN). On 
filing of an e-form, the system generates and provides a nine-character alphanumeric string 
starting with an alphabet (A-Z), called a Service Request Number (SRN). A user can check the 
status of the document/transaction, by entering the SRN.

Status of application

Status of the filed forms can be tracked from ‘My application’ after login with MCA V3 portal (only 
filed from respective login ID can be tracked)

Auto check/Save and Submit

While applying for the name of the company/LLP form, after entering the proposed name 
(Maximum 2 names) along with relevant NIC code, it must be auto checked to find out any 
company is existing with similar name or resemblance with any registered trade mark. Thereafter 
the form is required to be saved and submit and later pay fees.
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Resubmission of forms

Forms submitted to the MCA may require resubmission for various reasons, including incorrect 
information, missing documents, non-compliance with regulatory requirements, or errors in the 
initial submission. To initiate the resubmission process, the applicant must identify and rectify 
the errors or deficiencies in the original submission. The corrected or amended forms must 
be resubmitted to the MCA within specified timeline stated in resubmission remarks/relevant 
rules of companies Act 2013. Failure to adhere to this timeline may result in penalties or other 
regulatory actions including rejection of forms.

ANNUAL FILING

As a part of Annual Filing, Companies incorporated under the Companies Act 1956 or Companies 
Act 2013, are required to file the following e-Forms with the Registrar of Companies (ROC)

Form AOC-4: For filing financial statement and other documents (For FY start on or after 
01.04.2014)

Form AOC4- CFS: Form for filing statement containing salient features of consolidated financial 
statement of a group (For FY start on or after 01.04.2014)

Form AOC4-XBRL: For filing XBRL document in respect of financial statement and other 
documents (For FY start on or after 01.04.2014)
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Form MGT-7: Form for filing Annual Return by Companies having share capital other than small 
company (For FY ending on or after 01.04.2014)

Form MGT-7A: Form for filing Annual Return by Companies having share capital by small 
company (For FY ending on or after 01.04.2014)

XBRL Filing
XBRL (Extensible Business Reporting Language) is a language for the electronic communication of 
business and financial data which is revolutionizing business reporting around the world. It helps 
in the preparation, analysis and communication of business information. It offers cost savings, 
greater efficiency and improved accuracy and reliability to all those involved in supplying or 
using financial data.
The following class of companies shall file their financial statements and other documents under 
section 137 of the Act with the Registrar in e-form AOC-4 XBRL as per Annexure-I:-

• companies listed with stock exchanges in India and their Indian subsidiaries;
• 
• companies having paid up capital of five crore rupees or above;
• 
• companies having turnover of one hundred crore rupees or above;

all companies which are required to prepare their financial statements in accordance with 
Companies (Indian Accounting Standards) Rules, 2015

Provided that the companies preparing their financial statements under the Companies 
(Accounting Standards) Rules, 2006 shall file the statements using the Taxonomy provided in 
Annexure-II and companies preparing their financial statements under Companies (Indian 
Accounting Standards) Rules, 2015, shall file the statements using the Taxonomy provided 
in Annexure-II A: Provided further that non-banking financial companies, housing finance 
companies and companies engaged in the business of banking and insurance sector are 
exempted from filing of financial statements under these rules.”.”

However, the companies in banking, insurance, power sector, non-banking financial companies 
and housing finance companies are exempted from XBRL filing till further orders. 

Key benefits of XBRL filing are as under:

Relevant data has tags and selective information can be fetched for specific purposes by various 
government and regulatory agencies. It is in conformity with Global Reporting Standards, which 
helps in improved data mining and relevant information search.
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19.12. TASK BASED PRACTICALS

19.12.1. BUSINESS USER REGISTRATION PROCESS

A Business User has access to certain specific functionalities, in addition to all the basic 
e-Services of MCA which are available to a Registered User. Business users can be companies, 
Limited Liability Partnerships (LLPs), Professionals, government officials etc. They typically use 
the MCA portal to file various statutory documents, such as annual returns, financial statements, 
and other compliance-related filings. Business users may have the option to appoint individuals 
within their organization as authorized representatives or directors who can access and interact 
with the MCA portal on their behalf.

Fig. 1.a

Fig. 1.b
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Fig. 1.c

Fig. 1.d
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The user roll can be any of above. The required fields will be slightly differed accordingly. Ex : If 
director role is selected , DIN is required to be specified for further proceeds instead of PAN details. 

The user role registration as a 'Professional staff member' is as follows: 

Fig. 1. e

Fig. 1.f
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Fig. 1.g

Fig. 1.h
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Fig. 1.j
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After submitting the OTP the user ID will be created and the same will be displayed

Note : If a user ID is created as the authorized representative of a company, then the said 
company’s forms can only be filed through the respective ID.

DIR 3 KYC AND KYC WEB

Any DIN holder who is filing his KYC details for the first time with MCA, must file all KYC details only 
through eForm DIR-3 KYC. There is no option for such a person to access the web-service for his 
KYC.

Further, any DIN holder who wants to update any information of his KYC details must update the 
same through filing of eForm DIR-3 KYC only. Please note that no update in details can be made 
by accessing the web-service for DIR-3 KYC.

Any DIN holder who has already submitted eForm DIR-3 KYC in any of the previous financial 
years and who does not require update in any of his KYC details as submitted, may perform his 
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annual KYC by accessing DIR-3 KYC web service. No fee is payable up to the due date of each 
financial year. After the due date, a fee of Rs.5000 shall be payable.

As per the provisions of Rule 12A of the Companies (Appointment and Qualification of Directors) 
Rules, 2014, every individual who is allotted DIN as on 31st March of a financial year must submit 
his KYC on or before 30th September of the immediately next financial year.

If the DIN holder does not file his annual KYC within the due date of each financial year, such 
DIN shall be marked as ‘Deactivated due to non-filing of DIR-3 KYC’ and shall remain in such 
Deactivated status until KYC is done with a fee of Rs.5000.

Any person who has been allotted DIN and where the status of such DIN is ‘Approved’, is required 
to file form DIR-3 KYC. Hence, disqualified directors are also required to file form DIR-3 KYC

Relevant Sections: Section 153 of companies Act 2013 and Rule 9A, 12A, 11, 12 of the Companies 
(Appointment and Qualification of Directors) Rules, 2014 and Companies (Appointment and 
Qualification of Directors) Fifth Amendment Rules, 2019 along with MCA circulars and notifications.

STEPS
•	 Login to MCA V-3 

•	 Click of My Application, Company e-filing, Din Related Filing 

•	 Click on DIR-3 KYC Web 

•	 Mention DIN and Click on send OTP (DG) 

•	 Mention the OTP received on Mobile No. & Email ID of DIN Holder 

•	 After mention OTP proceed on next slide

496



TAX COMPLIANCES

19.12.2.DIR 3 KYC WEB

Fig 2.a

Fig 2.b
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19.12.3. DIR 3 KYC

Fig 3.a

Fig 3. B
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Fig 3.c
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Fig 3.d
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Fig 3.e
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Fig 3.f
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19.12.4. OBTAIN DIN

DIN is a unique, 8-digit alphanumeric number assigned to each director and Under Section 153 
of the Companies Act, 2013, it is mandatory for every individual intending to be appointed as a 
director of a company to obtain a DIN before their appointment.

DIN is valid for a director’s lifetime, unless it is surrendered, canceled, or deactivated by the 
regulatory authorities due to non-compliance or other reasons and DIN KYC must be fi led in 
every year within specifi ed timeline.

Directors can apply for DIN online through the MCA portal by submitting Form DIR-3 along with 
the necessary documents and fees and the form shall be certifi ed/signed by the director/KMP 
of the company which he proposed to be appointed.

Relevant section: Section 153, 154 and 155 of the companies Act 2013 and Rule 9, 10, 11,12, 13, 14 of the 
Companies (Appointment and Qualifi cation of Directors) Rules, 2014 along with MCA circulars 
and notifi cations.

Fig 4.a

Fig 4.b
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Fig 4.c
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Fig 4.d
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Fig 4.e
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Fig 4.f
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19.12.5. APPLY FOR A NAME FOR A NEW COMPANY
The proposed company name is unique and does not resemble the name of any existing 
company (Name availability, Domain and Trademark resemblance can be checked in MCA 
Website) and should not violate any guidelines or restrictions and does not contain any prohibited 
or undesirable words, phrases, or terms set forth in the Companies Act, 2013 and its rules.

The reserved name is valid for 20 days from the date of approval (Form SPICE +A) and an 
existing company seeking to change its name shall apply for reservation by filing Form RUN 
(Validity period 60 days) with Central Registration Centre (CRC). Ensure that you complete the 
incorporation process within this period.

Relevant section: Section 4, 16, 20 of the companies act 2013 and Rules 8, 9, 10, 11, 12, 13, 14 of the 
Companies (Incorporation) Rules, 2014 along with MCA circulars and notifications.

Fig 5.a

Fig 5.b
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Fig 5.c
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Fig 5.d

Fig 5.e
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Fig 5.f

Fig 5.h
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Fig 5.i
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Fig 5.j

Fig 5.k
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Fig 5.l

19.12.6APPOINTMENT OF DIRECTORS

Private Limited Companies must have a minimum of 2 directors, while Public Limited Companies 
must have at least 3 directors. One Person Companies (OPCs) must have at least 1 director. The 
maximum number of directors allowed is 15, and this limit can be increased by passing a special 
resolution during a general meeting.

Directors must provide their consent and make a declaration ( DIR 2) confirming their eligibility 
and willingness to act as directors and disclosure of interest in other entities must be given ( MBP 
1)

Relevant sections: sections 7(1) (c), 149, 152, 153, 160, 161, 162, 170, 197 and Rules 8, 9, 15, 16, 17, 
18 of the Companies (Appointment and Qualification of Directors) Rules, 2014 along with MCA 
circulars and notifications
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Fig 6.a

Fig 6.b
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Fig 6.c
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Fig 6.d
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Fig 4.f
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Fig 6.f
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Fig 6.g
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19.12.7. RESIGNATION/CESSATION OF DIRECTORS

Directors may resign by providing written notice to the board of directors and the resignation 
takes effect from the date mentioned in the notice or the date of receipt by the company, 
whichever is later.

The board must accept the resignation by passing a resolution at a board meeting and recording 
it in the minutes and the company must inform the Registrar of Companies (ROC) about the 
cessation of a director by filing the necessary form (DIR 12) within 30 days of the resignation.

Cessation of office of directors may be either due to resignation, disqualification of directors, 
vacation of office of directors, Death, Retirement, Exceeding maximum number of directorships, 
Removal etc.

Fig 7.a

Fig 7.b
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Fig 7.c
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Fig 7.d
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Fig 7.e
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Fig 7.f
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Fig 7.g
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19.12.8. CHANGE IN DESIGNATION OF DIRECTORS

Any change in the designation of directors, such as appointing a managing director or whole-
time director, must be filed with the ROC within the prescribed time frame.

For regularization of additional directors to directors at AGM or change in designation of director 
to MD or executive director to non-executive directors etc. this form ( DIR 12) is required to be 
filed.

Fig 8.a

Fig 8.b
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Fig 8.c
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Fig 8.d
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Fig 8.e
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Fig 8.f
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Fig 8.g
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Fig 8.h
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 19.12.9. SPECIAL RESOLUTION AND AGREMENTS TO BE FILED

Form MGT-14 should be filed with the ROC within 30 days of the passing of the resolution or 
agreement by the company.

Resolutions/Agreements to be Filed Under Section 117(3)

SPECIAL RESOLUTIONS.

Resolutions which have been agreed to be passed as special resolutions by all the members of 
the company.

Any resolution passed by the BOD with regard to appointment / reappointment / renewal / 
variation of the terms of appointment of the managing director.

Resolutions that have been agreed to be passed by a specified majority or in a particular manner 
by any class of members.

Resolutions requiring winding up of the company as specified under section 59 of the Insolvency 
and Bankruptcy Code 2016.

Resolutions passed under Section 179(3).

Fig 9.a
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Fig 9.b
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Fig 9.c
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Fig 9.d
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Fig 9.e

Fig 9.f
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Fig 9.g
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         SUMMARY

Electronic Governance is the application of Information Technology to the Government 
functioning in order to bring about Simple, Moral, Accountable, Responsive and 
Transparent (SMART) Governance. E-governance is a highly complex process requiring 
provision of hardware, software, networking and re-engineering of the procedures for 
better delivery of services.

E Filings is an important part of the Companies Act and noncompliance with such 
provisions will arise the liability to the company, its directors and officers.

Professionals are responsible for submitting/certifying documents (to be signed digitally 
by them) and the system would accept most of these documents online without approval 
by Registrar of Companies or other officers of the Ministry (STP). If a professional gives a 
false certificate or omits any material information knowingly, he is liable to punishment 
under section 447 and 448 of the Companies Act, 2013 besides disciplinary action by the 
Institute which issued the Certificate of Practice.

The Ministry of Corporate Affairs is implemented the third version of its flagship project 
MCA21 (NCA 21 V-3)

MCA introduced new services such as E-Book (E-Book has been revised to include 
e-books for all Acts administered by MCA) and E-Consultation (A new online platform 
wherein, stakeholders/users can submit their comments and suggestions on the 
proposed amendments/draft legislations that are posted by MCA)

SELF TEST

1. Discuss E-Governance, E-Filing and MCA 21

2. Register and login as registered User.

3. Analyze the master data along with director details and index of charges.

4. Download last year filed financial statements and Annual return of a company.

5. Apply name of a company (Just submit the form without payment of fees)

6. File resolution passed for alteration of object clause (Without payment of fees)
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         MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the primary responsibility of the Ministry of Corporate Affairs in India?

a) Promoting agricultural development

b) Regulating corporate financial institutions

c) Ensuring the welfare of small businesses

d) Regulating corporate entities and companies

2. Which of the following is NOT a function or responsibility of the Ministry of Corporate 
Affairs in India?

a) Regulation of corporate entities and companies

b) Regulations of Banks and NBFC

c) Implementation of company law and policies

d) Ensuring transparency and good governance in corporate practices

3. Which department under the Ministry of Corporate Affairs is primarily involved in matters 
related to intellectual property rights?

a) Department of Finance

b) Department of Economic Affairs

c) Department of Industrial Policy and Promotion (DIPP)

d) Department of Commerce

4. The National Company Law Tribunal (NCLT) and National Company Law Appellate 
Tribunal (NCLAT) were established to handle legal matters related to:

a) Criminal cases involving individuals

b) Corporate disputes and insolvency matters

c) Tax disputes between companies and the government

d) Environmental violations by corporations
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5. What is the primary role of the Serious Fraud Investigation Office (SFIO), which operates 
under the Ministry of Corporate Affairs?

a) Promoting fraud in corporate entities

b) Investigating and prosecuting cases of corporate fraud and related crimes

c) Promoting tax evasion

d) Regulating foreign direct investment

6. In India, which of the following is a major initiative of the Ministry of Corporate Affairs 
aimed at enhancing the ease of doing business by simplifying various regulatory processes?

a) National Health Insurance Scheme

b) National Skills Development Program

c) Insolvency and Bankruptcy Code (IBC)

d) SPICe (Simplified Proforma for Incorporating Company Electronically)

7. The Insolvency and Bankruptcy Code (IBC) was enacted to address issues related to:

a) Labor disputes in the corporate sector

b) Tax evasion by companies

c) Corporate insolvency and bankruptcy

d) Intellectual property infringement

8. Which regulatory body operates under the Ministry of Corporate Affairs to oversee the 
functioning of corporate auditors and ensure the quality of financial reporting in India?

a) Securities and Exchange Board of India (SEBI)

b) Reserve Bank of India (RBI)

c) Institute of Chartered Accountants of India (ICAI)

d) National Stock Exchange (NSE)

9. The Ministry of Corporate Affairs plays a key role in regulating corporate governance. 
What does “good corporate governance” primarily entail?

a) Maximizing profits for shareholders at any cost

b) Ensuring fair treatment of all stakeholders and transparency in decision-making
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c) Avoiding government regulation at all levels

d) Promoting hostile takeovers in the corporate sector

10. The term “ROC” in the context of the Ministry of Corporate Affairs stands for:

a) Registrar of Companies

b) Records of Corporations

c) Regulatory Oversight Committee

d) Responsible Officers for Corporations

Answers

1. D 

2. B 

3. C 

4. B 

5. B

6. D 

7. C 

8. C 

9. B 

10. A
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CHAPTER 20
TDS AND TCS

        LEARNING OUTCOME:

a Understanding TDS Basics: Define TDS and explain its fundamental concept. 
Differentiate between TDS and other forms of taxation.

a Applicable Provisions and Rates: Learn about the relevant sections of the Income 
Tax Act or relevant tax laws that govern TDS. Understand the rates at which TDS 
should be deducted for different types of payments, such as salaries, interest, rent, 
and professional fees.

a TDS Deduction and Collection Process: Describe the process of deducting 
and collecting TDS from payments. Understand the roles and responsibilities of 
deductors (those making payments) and deductees (those receiving payments) 
in the TDS process.

a Understanding TCS Basics: Define TCS and explain its fundamental concept.

a Differentiate between TCS and other tax collection mechanisms.

a Applicable Provisions and Rates: Learn about the relevant sections of the Income 
Tax Act or relevant tax laws that govern TCS. Understand the rates at which TCS 
should be collected for different types of transactions, such as sale of goods, sale 
of immovable property, and more.

a TCS Collection Process: Describe the process of collecting TCS from transactions. 
Understand the roles and responsibilities of collectors (those collecting TCS) and 
buyers/sellers in the TCS process.

20.1 INTRODUCTION:
Tax Collected at Source (TCS) is a tax collection mechanism used in several countries, including 
India. Under TCS, a person or entity collecting payments from another party is required to collect 
a certain percentage of the payment as tax and remit it to the government on behalf of the 
payee. TCS is applicable in various scenarios, typically involving the sale of goods, services, or 
certain specified transactions.
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Tax Deducted at Source (TDS) is another tax collection mechanism used in several countries, 
including India. Under TDS, a person or entity making payments to another party is required to 
deduct a certain percentage of the payment as tax and remit it to the government on behalf 
of the payee. TDS is applicable to a wide range of payments, including salaries, interest, rent, 
professional fees, and more. 

The concept of Tax Collected at Source (TCS) has been in existence for several decades and has 
evolved over time. In India, the initial idea behind TCS was to ensure that taxes were collected 
at the time of certain high-value transactions, such as the sale of goods or property, to prevent 
tax evasion. TCS is relevant for several reasons, TCS contributes significantly to government 
revenue. It allows the government to collect taxes in a phased manner, rather than waiting until 
the end of the financial year, thereby improving cash flow.

Tax Deducted at Source (TDS) has a long history and has been used in various forms in different 
countries. In India, TDS provisions were introduced under the Income Tax Act, 1961. The primary 
objective was to collect taxes throughout the year as and when income was earned or payments 
were made, rather than collecting the entire tax liability at the end of the financial year. TDS 
remains highly relevant for several reasons. TDS ensures a steady and regular collection of taxes 
by deducting a portion of the income at the source itself. This helps the government manage its 
finances effectively.

In summary, both TCS and TDS are tax collection mechanisms that involve the deduction or 
collection of tax at the source of income or transactions. They serve as tools for governments to 
ensure tax compliance and revenue collection. Understanding the basics of these mechanisms 
is essential for businesses, individuals, and professionals to meet their tax obligations and avoid 
legal issues.

TDS (TAX DEDUCTED AT SOURCE) AND TCS (TAX COLLECTED AT SOURCE)

TDS (Tax Deducted at Source)/ TCS (Tax Collected at Source) quarterly return filing is a crucial 
compliance requirement for individuals and entities responsible for deducting TDS/TCS from 
payments made to others and depositing it with the government. TDS/TCS is a mechanism by 
which the government collects taxes at the source itself, ensuring a steady flow of revenue.

Here are the key steps and guidelines for filing TDS/TCS quarterly returns in India, which is a 
common example of TDS return filing:

Determine TDS/TCS Applicability: First, determine if TDS/TCS is applicable to you. TDS/TCS is 
typically applicable when making payments like salary, interest, rent, professional fees, etc., 
above specified thresholds.
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TAN Registration: 

You need to obtain a Tax Deduction and Collection Account Number (TAN) if you are liable 
to deduct TDS/TCS. This is a 10-digit alphanumeric number and is mandatory for TDS/TCS 
compliance.

Deduct TDS: 

Deduct TDS/TCS from payments as per the applicable rates and rules. Ensure you collect a valid 
PAN (Permanent Account Number) of the payee.

Deposit TDS: 

Deposit the TDS/TCS amount within the due dates. The due date for depositing TDS/TCS is 
typically the 7th of the following month (except for March when it’s April 30th). You can make 
these deposits online through the NSDL or UTIITSL websites.

Quarterly TDS/TCS Return Filing: 

Quarterly TDS/TCS return filing is mandatory for entities deducting TDS/TCS. These returns 
are filed using Form 24Q (for salaries), Form 26Q (for non-salary payments), or Form 27Q (for 
payments made to non-residents).

Quarterly Return Due Dates: 

The due dates for filing TDS/TCS returns are typically as follows:

•	 Quarter 1 (April to June): July 31

•	 Quarter 2 (July to September): October 31

•	 Quarter 3 (October to December): January 31

•	 Quarter 4 (January to March): May 31

TDS/TCS Return Preparation: 

Prepare the TDS/TCS return forms accurately, including details of TDS/TCS deductions made 
during the quarter. You can use return preparation utilities provided by the Income Tax 
Department.

Submit TDS Return: 

Submit the TDS/TCS return online through the NSDL or UTIITSL websites or through authorized TIN-
FCs (TIN Facilitation Centers).

TDS Certificates: 

Issue TDS/TCS certificates in Form 16 (for salary) or Form 16A (for non-salary) to the deductees 
within due dates.
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Rectifi cation of Errors: 

If you make any errors in TDS/TCS returns, you can fi le corrections using the same forms with the 
correct details.

TDS/TCS Payment Challans: 

Keep records of TDS/TCS payment challans, return fi ling acknowledgments, and other relevant 
documents.

Penalties and Interest: 

Be aware of the penalties and interest charges for late TDS/TCS return fi ling or depositing TDS/
TCS beyond the due dates.

It’s crucial to ensure accurate and timely compliance with TDS/ regulations, as non-compliance 
can lead to penalties and legal issues. Additionally, the rules and forms for TDS/TCS return fi ling 
may change, so it’s essential to stay updated with the latest guidelines from the Income Tax 
Department or consult a tax professional for assistance.

Filing TDS/TCS quarterly returns is a crucial responsibility for entities and individuals who deduct 
TDS from payments made to others and deposit it with the government. In India, this process is 
typically done through the Tax Information Network (TIN) facilitated by NSDL (National Securities 
Depository Limited). Below are the steps for fi ling TDS quarterly returns in India.

20.2 STEPS FOR FILING TDS QUARTERLY RETURNS IN INDIA
 1) Open www.tin-nsdl.com for fi ling your quarterly return.
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After logging in, you can access the relevant TDS/TCS return forms. The common forms are:
• Form 24Q: For TDS on salaries.

• Form 26Q: For TDS on non-salary payments made to residents.

• Form 27Q: For TDS on payments made to non-residents.

• Form 27EQ: For TCS according to Section 206C of the Income Tax Act 1961

2) Go to “Downloads” tab Click on it, then click on “Quarterly Returns” and select “Regular”.
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3) Click on “e-TDS/e-TCS RPU”.

Download the applicable TDS/TCS return form for the relevant quarter.

Use appropriate software or utilities provided by NSDL or third-party vendors to fi ll in the TDS/
TCS return form offl ine. Ensure that you have all the necessary details such as PAN (Permanent 
Account Number) of deductees, TDS/TCS amounts, etc.

4) Click on “Download RPU version 4.7”
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5) Go to downloads, extract and open “TDS_RPU_4.7”
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6) Select the relevant return to be fi led for the quarter from the drop down. In case of TCS quarterly 
fi ling the commonly used forms for TCS returns are Form 27EQ (for TCS on non-salary payments) 
and Form 27Q (for TCS on salaries). Select the appropriate form for your transactions. Before you 
start the fi ling process, gather all the relevant information and documents, including details of 
TDS/TCS collected during the quarter, TDS/TCS certifi cates issued to the payees, and any other 
records related to TDS/TCS transactions.

•	 TDS

•	 TCS 
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7) Fill up all the mandatory fi elds. Deductors details and responsible persons details should be 
entered for completing the process. 
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8) Click on “Add Rows” button and enter the total number of TDS/TCS challans paid during the 
previous quarter. Specify the number in the fi eld.

558



TAX COMPLIANCES

9) Fill up the required fi elds as per the data requires by referring the payment challans of TDS/
TCS.
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10) In this tab users need to enter details regarding each challan. Click on “Insert a Row”. The 
number of challans that you entered in the previous tab will be displayed. Here user should enter 
the number of parties involved in each challan.
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11) Enter the required details of deductees from challan. Save the fi le if it has no errors and 
omissions. Click on “Save” button and save it in a folder.

12) Click on “Create File”

“Challan Input File Name with Path”: Browse the RPU fi le you saved just before this step. 

In “Error/Upload & Statistics Report File Path” browse the folder path where you want to save 
this fi le.

Then click “Validate”.
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After that go to the income tax portal www.incometax.gov.in for further process.

13) Click on “Login” and login with user TAN and password.
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14) Click on “e-File” and click on e-Pay Tax.

15) Click on “Challan Status Inquiry (CSI) File” enter the payment date and click on “Download 
Challan File”. Extract and open the fi le.

563



TAX COMPLIANCES

16) Open “TDS_STANDALONE_FVU_8.2”

17) Browse the details needed.

• TDS/TCS Input File Name with Path: Browse and select the RPU fi le which you have 
saved in the earlier step.

• Challan Input File Name with Path: Browse and select the .csi fi le which you have saved 
from Income tax site.

• Error/Upload & Statistics Report File Path: Browse and select the folder which you are 
going to save the .fvu fi le which will generate after this step.

• Then click on “Validate” Button. The .fvu fi le generated above will be downloaded. Zip 
the fi le for further upload.
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18) For the purpose of fi ling Quarterly return user should upload the utility fi le which we created 
in t he Income Tax Portal.

Click “e-File”, then click “Income Tax Forms” and “File Income Tax Forms”.
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19) Click on “Deduction of tax at source (Form TDS). 
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20) Click on “Let’s Get Started”.

21) Select the form for fi ling from the drop down.

• Select fi nancial year and Quarter, select upload type.

• At last, attach the zip fi le of utility FVU.
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22) Then Proceed to e-Verify will be activated and the verifi cation should be done by using
Digital Signature of the Authorised person of the organisation.

• After successful validation and submission, an acknowledgment receipt will be
generated.

• Print and retain this acknowledgment for your records.

• Ensure that you have paid the TDS amount on time using the appropriate TDS challans.
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      MULTIPLE CHOICE QUESTIONS (MCQS)

1. What is the primary purpose of TDS in the Indian taxation system?
a) To collect taxes from taxpayers at the end of the financial year
b) To encourage tax evasion
c) To ensure a steady collection of taxes throughout the year
d) To exempt certain individuals from paying taxes

2. Who is responsible for deducting TDS in the case of salary payments in India?
a) The employee
b) The employer
c) The tax authorities
d) The bank

3. Under which section of the Income Tax Act, 1961, are TDS provisions in India outlined?
a) Section 80C
b) Section 44AD
c) Section 194C
d) Section 192

4. What is the consequence of not depositing TDS with the government within the due dates?
a) No consequences
b) Penalty and interest on the deducted amount
c) Tax exemption
d) Extended due dates for deposit

5. Which of the following types of income payments typically requires TDS deduction in 
India?

a) Payment for purchasing groceries.
b) Rental income
c) Pocket money given to a child.
d) Personal gifts

Answers:

1. c) To ensure a steady collection of taxes throughout the year

2.  b) The employer

3. c) Section 194C

4. b) Penalty and interest on the deducted amount

5.  b) Rental income
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MULTIPLE CHOICE QUESTIONS (MCQS) - TCS

1. What is the primary objective of TCS (Tax Collected at Source)?

a) To encourage tax evasion

b) To collect taxes at the source of certain transactions

c) To provide tax refunds to taxpayers

d) To reduce the overall tax burden on individuals

2. Who is responsible for collecting TCS in a sale of goods transaction?

a) The buyer

b) The seller

c) The government

d) The financial institution

3. In which type of transaction is TCS commonly applicable in India?

a) Personal gifts

b) Grocery shopping

c) Sale of immovable property

d) Payment of salary

4. What happens to the TCS amount collected by the collector?

a) It is kept by the collector as additional income.

b) It is refunded to the buyer.

c) It is deposited with the government.

d) It is given as a discount to the seller.

5. Which of the following is a common exemption under TCS provisions?

a) Sale of luxury cars

b) Sale of immovable property below a specified threshold

c) Sale of groceries

d) Sale of electronics
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Answers:

b) To collect taxes at the source of certain transactions

b) The seller

c) Sale of immovable property

c) It is deposited with the government.

b) Sale of immovable property below a specified threshold
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Identify the softwares and prerequisites 
used for MCA 21 E filing 

The learners must be able to identify the 
softwares used for various E filing 

Students must remember the limit and 
mandatory applicability of various 
statutory laws 

KNOWLEDGE STATEMENT 

Recommend the measures to be taken and 
assess the informations for obtaining GST 
registration 

Formulate a detailed plan for ITR 1 Filing 
and support for collecting relevant 
documents for filing 

Summaraize the benefit of registration of 
MSME and convince the small organaization 
to obtain the registration 

Students must understand the registration 
procedures of Tax, MSME and IE Code 

Recommend the tax softwares for filing IT 
and choose the documents mandatory 
required for IT registration in Income tax 
site 

Create a case study to analayze the 
applicability of EPF, ESI in organaization by 
evaluate the number of employees and 
their salary  

Generate E-PAN using simulation (If 
simulation software is using) 

Obtain DSC by using simulation (If 
simulation software is using) 

TASK STATEMENT 

Students must be able to describe the 
benefits and features of various 
registration 
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CHAPTER 1
MANAGE DATABASES

LEARNING OBJECTIVE:

a	 Understand the basics of databases, including their advantages and the structure of 
Access databases.

a  Create, navigate, and effectively use Access databases, both from scratch and using 
 templates.

a  Create, manage, and relate tables, as well as create and modify queries using SQL  
 commands.

a  Integrate Access with Outlook, Word, and Excel for data sharing and manipulation.

a  Modify forms and reports, automate tasks with macros, and enhance functionality  
using modules.

1.1. INTRODUCTION:

A database is a device for gathering and arranging data. Databases can store data about 
people, things, orders, and other things. Many databases begin as a list in a spreadsheet or 
word processing program. Redundancies and inconsistencies start to show up in the data as 
the list gets longer. The list style makes the data difficult to grasp, and there are few options 
for searching or extracting specific data sets for analysis. Transferring the data to a database 
made by a database management system (DBMS), such as Access, is a good solution once 
these issues start to arise.

An object container is a computerized database. More than one table may be present in a 
database. For instance, a system for tracking inventory that uses three tables is made up of 
one database that has three tables rather than three databases. An Access database contains 
its tables in a single file along with additional objects like forms, reports, macros, and modules 
unless it has been specially created to use data or code from another source. The file extension. 
accdb is used for databases generated in the Access 2007 format (which is also supported by 
Access 2016, Access 2013, and Access 2010), while the .db file extension is used for databases 
created in earlier Access formats. You can use Access 2016, Access 2013, Access 2010, or Access 
2007 to create files in earlier file formats (for example, Access 2000 and Access 2002-2003).
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Using Access, you can:

• Add new data to a database, such as a new item in an inventory

• Edit existing data in the database, such as changing the current location of an item

• Delete information, perhaps if an item is sold or discarded

• Organize and view the data in different ways

• Share the data with others via reports, e-mail messages, an intranet, or the Internet

1.2 THE PARTS OF AN ACCESS DATABASE:

Tables:
In that rows and columns are used to organise data, database tables resemble spreadsheets 
in appearance. Consequently, importing a spreadsheet into a database table is frequently 
relatively simple. The way the data is organised determines whether you save it in a database or 
a spreadsheet, which is the fundamental distinction.

The data must be organised into tables in order to prevent redundancies and maximise database 
flexibility. When storing data about employees, for instance, each employee should only need to 
be entered once in a database that is specifically designed to handle employee data. Products’ 
data will be kept in their own table, while branch offices’ data will be kept in another table. The 
normalisation of this process is known.

Records are the individual rows in a table. Records are the places where the various bits of 
information are kept. One or more fields are present in every record. The table’s columns and 
fields match up. For instance, you might have a table called “Employees” where each record 
(row) has details about a unique person and each field (column) provides a distinct type of 
information, such as first name, last name, address, and so on. Any data type, including text, 
dates and times, numbers, and other types, must be specified for each field.

Forms:
Using forms, you may design a user interface where users can enter and amend data. Forms 
frequently include command buttons and other controls that carry out different functions. Simply 
changing your data in the table datasheets will allow you to establish a database without the 
use of forms. The majority of database users, however, favour using forms to see, insert, and 
amend data in the tables.

You may programme command buttons to do a variety of things, such launch additional forms 
or reports, choose the data that displays on the form, and execute other actions. To use an 
example, suppose you have a form called “Customer Form” where you may work with client 
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information. A button on the customer form may open an order form, where you may enter a 
new order for that customer.

Reports:
You prepare, summarise, and present data using reports. A report typically provides an answer 
to a certain query, such as “What cities are our customers located in?” or “How much money did 
we receive from each customer this year?” Each report’s format can be adjusted to make the 
content as readable as feasible.

Running a report at any time will always show the most recent information in the database. The 
majority of the time,reports are structured to be printed, but they can also be read on a screen, 
exported to another programme, or sent as an attachment to an email message.

Queries:
In a database, queries can carry out a wide range of tasks. The majority of the time, they are 
used to obtain specific data from the tables. Queries enable you to view data that is typically 
dispersed over multiple tables in a single datasheet. Additionally, queries allow you to set criteria 
to “filter” the data down to just the records you want because you often don’t want to see all the 
records at once.

In cases where a query is “updateable,” it allows you to modify the information in the underlying 
tables using the query datasheet. Keep in mind that your changes are made in the tables as well 
as the query datasheet when working in an updateable query.

Select queries and action queries are the two fundamental types of queries. A select query only 
retrieves the information and makes it usable. The query’s results can be shown on the screen, 
printed, or copied to the clipboard. Another option is to utilise the query’s result as the record 
source for a form or report.

An action query, as the name implies, performs a task with the data. Action queries can be used 
to create new tables, add data to existing tables, update data, or delete data.

Macros:
Access macros can be considered of as a condensed kind of programming that you can use to 
enhance the functionality of your database. To make a macro run each time the button is clicked, 
for instance, you may connect a macro to a command button on a form. Actions that carry out 
activities, including opening a report, executing a query, or shutting down the database, are 
contained in macros. The majority of manual database procedures may be automated using 
macros, making them excellent time-saving tools.

Modules:
Like macros, modules are objects that you may employ to give your database extra capabilities. 
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While modules are written in the Visual Basic for Applications (VBA) programming language, 
macros are created in Access by selecting from a list of macro-operations. A group of 
declarations, statements, and methods are kept collectively as a module. A module may be a 
standard module or a class module. Forms or reports may have class modules attached to them, 
which often contain instructions particular to the form or report to which they are associated. 
There are general operations in standard modules that aren’t connected to any other objects. 
Class modules are not included in the list of standard modules under Modules in the Navigation 
Pane.

1.3 HOW TO USE MICROSOFT ACCESS FOR MANAGING DATABASES:

Microsoft Access is one of the most common programs businesses use for database 
management. Understanding how to use Microsoft Access can help you use all the program’s 
features. It can also help you manage databases more efficiently and effectively. Managing 
databases in Microsoft Access involves various tasks, including creating, opening, designing, 
querying, and maintaining databases. 

1.3.1. Create a new Access database:

Access includes a number of templates that you can use straight out of the box or as a jumping-
off point. A database that has all the tables, queries, forms, macros, and reports necessary to 
complete a certain task is known as a template. A few sample records are included in several 
templates to help illustrate how to use them. You can build tables, forms, reports, and other 
database objects to establish a database if you don’t want to use a template.

To create any new database in Microsoft Access, simply follow these steps. To build a blank 
database or web database for use with web publishing tools, follow these instructions. You can 
use these steps to build a database based on one of Access’s pre-built templates. 

The steps to build a new database are as follows:

1. Open Access.

2. If Access is already open, select File > New.

3. Select Blank database, or select a template.

4. Enter a name for the database, select a location, and then select Create.

5. If needed, select Enable content in the yellow message bar when the database opens.
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Figure 1.1. Create a new Access database

1.3.2. CREATE A DATABASE BY USING A TEMPLATE:

1. On the File tab, select New, and then select the template that you want to use. Several sets 
of templates are available in the “New” tab. 

2. Enter a fi le name in the File Name box. To change the location of the fi le from the 
default, select Browse for a location to put your database, browse to the new location, then 
select OK. 

3. Select Create.

1.3.2. CREATE A BLANK DATABASE:

1. On the File tab, select New, and then select Blank Database. 

2. Enter a fi lename in the File Name box. To change the location of the fi le from the default, 
select Browse for a location to put your database, browse to the new location, and then 
select OK. 

3. Select “Create”. Access creates the database with an empty table named Table1 and then 
opens Table1 in Datasheet view. The cursor is placed in the fi rst empty cell in the Click to 
Add column
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4. Begin entering the data. Entering data in the Datasheet view is designed to be very similar 
to working in an Excel worksheet. Create the table structure automatically as you enter 
data. Define new fields as you add a new column to the datasheet in the table. Access 
automatically sets each field’s data type, based on the data that you enter.

      SUMMARY

• A database is a structured collection of data that is organized and stored in a 
computer system. It serves as a repository for storing, retrieving, and managing 
data efficiently. Databases can store various types of information, such as 
customer records, product inventory, financial transactions, and more. They are 
essential tools for businesses and organizations to store, manipulate, and retrieve 
data for various purposes.

• Tables are the fundamental building blocks of a database. They resemble 
spreadsheets and consist of rows and columns, where each row represents a 
record, and each column represents a field or attribute. Tables are used to store 
structured data.

• Forms provide a user-friendly interface for entering, viewing, and editing data in 
tables. They often include controls like text boxes, buttons, and dropdown lists to 
facilitate data input.

• Reports are used to present data in a structured and printable format. They allow 
you to create formatted documents that summarize and analyze data from your 
tables.

• Queries are used to retrieve and manipulate data from one or more tables. They 
can filter, sort, and aggregate data to provide specific information based on 
criteria you define.

• Macros are sequences of actions that automate tasks within your database. 
They can be triggered by events like clicking a button on a form and can perform 
various operations, such as opening forms or running queries.

• Modules are used for more advanced programming and customization within 
Access. They contain Visual Basic for Applications (VBA) code, which allows you 
to create custom functions, automate complex tasks, and extend the functionality 
of Access beyond its built-in features.

• Microsoft Access is a versatile tool for managing databases, and it offers a 
range of features and components to help you organize and work with your data 
effectively. Understanding these components and how to use them can enhance 
your ability to manage and manipulate data within Access.
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  MULTIPLE CHOICE QUESTIONS (MCQ) FOR PRACTICE

1. What is the primary advantage of using a database over a simple data list?

a) Databases are more cost-effective.
b) Databases are easier to create.
c) Databases can handle larger amounts of data.
d) Databases don’t require any specialized software.

2. Which of the following is not a component of an Access database?

a) Tables
b) Forms
c) Spreadsheets
d) Macros

3.What is the purpose of normalizing data in a database?

a) To make data difficult to access
b) To maximize redundancy
c) To minimize flexibility
d) To prevent redundancies and maximize flexibility

4. Which of the following is a component of a database that allows users to enter and amend 
data with a user-friendly interface?

a) Tables
b) Forms
c) Reports
d) Macros

5. What is the primary purpose of reports in a database?

a) To create tables
b) To enter data
c) To summarize and present data
d) To write macros

6. What type of query allows you to view data from multiple tables in a single datasheet?

a) Select query
b) Action query
c) Update query
d) Append query
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7. What does SQL stand for in the context of databases?

a) Simple Query Language
b) Structured Query Language
c) Systematic Query Logic
d) Structured Query Logic

8. Which component of Access is used to automate database tasks and enhance  
functionality?

a) Forms
b) Reports
c) Macros
d) Tables

9. In Access, what is the primary purpose of modules?

a) To create tables
b) To design forms
c) To automate tasks and enhance functionality
d) To generate reports

10. To create a new Access database, which menu option should you choose after opening 
Access?

a) Edit
b) Tools
c) File
d) View

11. What is the file extension used for databases generated in the Access 2007 format?

a) .accdb
b) .mdb
c) .adp
d) .dat

12. Which type of query is used to perform actions on data, such as adding or deleting  
records?

a) Select query
b) Action query
c) Update query
d) Append query
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13. Which Microsoft Office tool can you integrate with Access for sending emails from your 
database?

a) Outlook
b) Word
c) Excel
d) PowerPoint

14. In Access, what is the primary purpose of Layout view for forms and reports?
a) Entering data
b) Designing tables
c) Modifying the appearance and layout
d) Writing macros

15. Which component of Access can be used to add titles and logos to forms?
a) Queries
b) Reports
c) Macros
d) Modules

Answers:
1. C) Databases can handle larger amounts of data.

2.  C) Spreadsheets

3.  D) To prevent redundancies and maximize flexibility

4.  B) Forms

5.  C) To summarize and present data

6.  A) Select query

7.  B) Structured Query Language

8.  C) Macros

9.  C) To automate tasks and enhance functionality

10.  C) File

11.  A) .accdb

12.  B) Action query

13.  A) Outlook

14.  C) Modifying the appearance and layout

15.  B) Reports
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          SELF-EXAMINATION QUESTIONS FOR PRACTICE:

1. What is the primary purpose of a database management system (DBMS) like Access?

2. What are some of the issues that can arise when managing data in a spreadsheet or 
word processing program instead of a database?

3. What is an object container in the context of a database?

4. How does Access organize its tables and other objects within a database file?

5. What are the file extensions used for Access databases created in different formats?

6. What are the key functions that can be performed using Microsoft Access?

7. Explain the concept of “normalization” in the context of database organization.

8. What are the main components of an Access database, and what are their respective 
purposes?

9. How do forms, reports, and queries enhance the usability of a database in Microsoft 
Access?

10. What is the role of macros and modules in Access, and how do they differ from each 
other?
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CHAPTER 2
CREATE & MANAGE TABLES, CREATE &  
MODIFY QUERIES, SQL COMMANDS

LEARNING OBJECTIVE:

a	  How to create tables.

a	  Adding, importing, and managing data.

a	  Understand table and field properties.

a	  Comprehend relational databases.

a	  Primary and foreign keys.

a	  Establishing table relationships.

a	  Crafting select queries.

a	  Using SQL for query definition.

a	  Sorting and summarizing data.

a	  Basic SQL understanding.

a	  Writing SELECT statements.

a	  Utilizing SQL clauses.

a	  Combining query results with UNION.

2.1  INTRODUCTION:

A straightforward database, like a contact list, might just have one table. But many databases 
employ a number of tables. A new file that serves as a container for all of the objects in your 
database, including your tables, is created when you establish a new database on your computer.

A table can be created by making a new database, inserting an existing database with a table, 
or importing or connecting to a table from another data source, such as a text file, a Microsoft 
Excel workbook, a Microsoft Word document, or another database. A brand-new, empty table is 
automatically added for you when you establish a brand-new, blank database. After that, you 
may begin defining your fields by entering data in the table.
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2.1.1 ADD A TABLE:

You can add new tables to an existing database by using the commands on the Create tab in 
the Tables group.

Figure 2.1. Tables group options

2.1.2. CREATE A TABLE, STARTING IN DATASHEET VIEW:

In Datasheet view, you can enter data immediately and let Access build the table structure 
for you. Field names are assigned numerically (Field1 and Field2, for example), and Access 
automatically sets each fi eld’s data type, based on the data that you enter. 

1.  On the Create tab, in the Tables group, select Table. Access creates the table and selects 
the fi rst empty cell in the Click to Add column. 

2.  On the Fields tab, in the Add & Delete group, select the type of fi eld that you want to add. 
If you don’t fi nd the type that you want, select More Fields. 

3.  You can move the fi eld by dragging it. When you drag a fi eld in a datasheet, a vertical 
insertion bar appears. 

4.  To add data, begin entering the information in the fi rst empty cell. 

5.  To rename a column (fi eld), select the column heading, and then enter the new name. 
You should give a meaningful name to each fi eld so that you can tell what it contains 
when you fi nd it in the Field List pane.

2.1.3. CREATE A NEW TABLE IN A NEW DATABASE:

1. Click File > New, and then select Blank desktop database.
2. In the File Name box, type a fi le name for the new database.
3. To browse to a different location and save the database, click the folder icon.
4. Click Create.
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2.1.4. CREATE A NEW TABLE IN AN EXISTING DATABASE:

1. Click File > Open, and click the database if it is listed under Recent. If not, select one of 
the browse options to locate the database.

2. In the Open dialog box, select the database that you want to open, and then click Open.

3. On the Create tab, in the Tables group, click Table.

4. A new table is inserted in the database and the table opens in Datasheet view.

2.1.5. ADD DATA TO A TABLE:

A blank table can be found in blank databases. In addition to a table, database templates also 
include forms, reports, and queries. The steps for adding data to a table in Access are as follows:

1. Name your columns for easy identification by double-clicking each heading and typing 
your preferred name. Take a new column for each new piece of information.

2. Complete the rows by clicking in a new field, then typing the relevant information into it. 
Each row relates to the same topic.

2.1.6. COPY DATA FROM ANOTHER SOURCE:

If your data is in another program, such as Excel, you can copy and paste it into an Access table. 
In general, this works best if your data is already separated into columns, as they are in an Excel 
worksheet. If your data is in a word-processing program file, it’s best to use tabs or tables to 
separate the columns of data in that file before you copy the data. If your data needs editing or 
manipulation (for example, separating full names into first and last names), you might consider 
doing this before you copy the data. 
When you paste data into an empty table, Access sets the data type of each field according to 
what kind of data it finds there. For example, if a pasted field contains nothing but date values, 
Access applies the Date/Time data type to that field. If the pasted field contains only the words 
yes and no, Access applies the Yes/No data type to the field.

If Access assigns generic field names, you should rename the fields as soon as possible to avoid 
confusion. Use the following procedure: 

1.  On the Home tab, in the Records group, select Save to save the table. 

2.  On the Home tab, in the View group, select Datasheet View, select each column heading, 
and then enter a descriptive field name for each column. 

3.  Save the table again. You can also rename the fields by switching to Design View and 
editing the field names there. To switch to Design View, on the Home tab, in the View 
group, select Design View.
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2.1.7. IMPORT, APPEND, OR LINK TO DATA FROM ANOTHER SOURCE:

You might have stored data in another application, and you want to import that data into a new 
table or append it to an existing table in Access. Or you might collaborate with people who keep 
their data in other applications, and you want to work with that data in Access by linking to it. 
Either way, Access makes it easy to work with data from other sources. You can import data from 
an Excel worksheet from a table in another Access database, from a SharePoint list, or from a 
variety of other sources. The process that you use differs slightly depending on your source, but 
you can use the following procedure to get started. 

1. On the External Data tab, in the Import & Link group, select New Data Source, and then 
select the type of file that you’re importing, as depicted in the following screenshot.

Figure 2.2. External Data options

 For example, if you’re importing data from an Excel worksheet, select Excel. If you don’t  
 find the application type that you need, select More. 

2. In the Get External Data dialog box, select Browse to find the source data file, or type the 
full path of the source data file in the File name box. 

3. Select the option that you want. Note that all programs let you import, and some let you 
append or link. 

4. In the Specify section, choose how and where you want to store the data in the current 
database. You can create a new table that uses the imported data or, with some 
programs, you can append the data to an existing table or create a linked table that 
maintains a link to the data in the source program. 
• If a wizard starts, follow the instructions on the wizard, and on the last page of the 

wizard, select Finish. 
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• If you import objects or link tables from an Access database, either the Import Objects 
or Link Tables dialog box is revealed. Choose the items that you want and then select, 
OK. 

The exact process that you use depends on whether you choose to import, append, or 
link data.

5. Access prompts you about whether you want to save the details of the import operation 
that you just completed. If you think that you’ll perform this same import operation again 
in the future, select Save import steps, and then enter the details. You can then easily 
repeat the operation in the future by selecting Saved Imports on the External Data tab 
in the Import & Link group; if you don’t want to save the details of the operation, select 
Close. 

• If you chose to import a table, Access imports the data into a new table and then 
displays the table under the Tables group in the Navigation Pane.

• If you chose to append data to an existing table, Access adds the data to that table. 

• If you chose to link to data, Access creates a linked table under the Tables group in 
the Navigation Pane.

2.2  TABLE AND FIELD PROPERTIES:

Figure 2.3. Table and Field Properties

1.  Table properties
2.  Field properties
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Table properties in an Access database are characteristics of a table that influence the overall 
look or behaviour of the table. In Design view, the table’s property sheet is where table properties 
are set. To indicate how a table is presented by default, for instance, you might set the Default 
View property.

A field property pertains to a specific field in a table and describes a feature or attribute of the 
field’s behaviour. In the Datasheet view, you can modify several field properties. Using the Field 
Properties pane, you may change any field property in Design view as well.

There are typically multiple connected tables in a relational database like Access. Each table 
in a well-designed database contains information about a certain topic, such as personnel or 
items. Records (rows) and fields (columns) make up a table. Data can be entered in fields in a 
variety of formats, including text, numbers, dates, and hyperlinks. 

Figure 2.4. Record, Field and Field value

A record: Contains specific data, like information about a particular employee or a product.

A field: Contains data about one aspect of the table subject, such as first name or e-mail address.

A field value: Each record has a field value. For example, Contoso, Ltd. or someone@example.
com.

2.2.1. DATA TYPES:

There is a data type for each field. The data type of a field describes the type of data that field 
stores, such as a lot of text or any connected files.

Figure 2.5. Data Type
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A data type is a field property, but it differs from other field properties as follows:
• You set a field’s data type in the table design grid, not in the Field Properties pane.
• A field’s data type determines what other properties the field has.
• You must set a field’s data type when you create the field.

You can create a new field in Access by entering data in a new column in Datasheet view. When 
you create a field by entering data in Datasheet view, Access automatically assigns a data type 
for the field, based on the value that you enter. If no other data type is implied by your input, 
Access sets the data type to Text. If needed, you can change the data type by using the Ribbon.

2.2.2. TABLE RELATIONSHIPS:

Although each table stores data about a different subject, tables in an Access database usually 
store data about subjects that are related to each other. For example, a database might contain:

• A customers table that lists your company’s customers and their addresses.
• A products table that lists the products that you sell, including prices and pictures for 

each item.
• An orders table that tracks customer orders.

You need a mechanism to connect the data together so that you can simply integrate related 
data from those individual tables because you save data about various subjects in separate 
tables. You establish relationships to link the data kept in various tables. A relationship is a logical 
link between two tables that identifies the fields they share. 

2.3 KEYS:

Fields that are part of a table relationship are called keys. A key usually consists of one field, but 
may consist of more than one field. There are two kinds of keys:

1. Primary key: 
There can only be one primary key per table. One or more fields that uniquely identify each 
record you store in the database make up a primary key. A main key is frequently an individual 
identification number, such as an ID number, serial number, or code. For instance, you might 
have a Customers table with a unique customer ID number for each customer. The primary key 
of the Customers database is the customer ID field. When a primary key has many fields, they 
are typically already-existing fields that when combined, produce unique values.

2. Foreign key:
Also possible are one or more foreign keys for a table. Values that match those in the primary 
key of another table are found in a foreign key. For instance, you might have a Customers table 
with a record for every order’s customer ID number in the Orders table. The Orders table’s foreign 
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key is the customer ID field.

The foundation of a table connection is the agreement of values between key fields. To merge 
data from related tables, you use a table connection. Consider having a Customers table and 
an Orders table, for instance. The main key field, ID, in your Customers table serves as the unique 
identifier for each record.

Create a relationship between the two keys after adding a foreign key field to the Orders database 
that matches the ID field of the Customers table in order to link each order to a customer. A 
customer ID value from the Customers dataset is used when adding a record to the Orders 
table. You utilise the relationship to determine which data from the Customers table relates to 
which records in the Orders table whenever you wish to access any information about the client 
who placed an order.

Figure 2.6. Keys

1. A primary key, identified by the key icon next to the field name.
2. A foreign key — note the absence of the key icon.

Do not add a field if you expect that each unique entity represented in the table might require 
more than value for the field. Continuing the preceding example, if you want to start tracking 
orders placed by your customers, you do not add a field to the table, because each customer 
will have more than one order. Instead, you create a new table to store orders, and then create 
a relationship between the two tables.

ADD A PRIMARY KEY TO A TABLE:

Create a primary key to associate data between multiple tables.
1. In the Navigation Pane, right click a table, and select Design View.
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2. Select the fi eld or fi elds you want to use as the primary key.
3. Select Design > Primary Key.

Figure 2.7. Create a primary key to associate data between multiple tables.

Figure 2.8. Primary Key

SET RELATIONSHIPS BETWEEN TABLES:

You can establish associations between several tables once they have been created. When 
two fi elds in distinct tables display the same data, you can establish a relationship between 
them. For instance, you may establish a connection between fi elds in tables for customers and 
orders that display the customer ID. Your data remains constant and correct by creating the 
relationship. The steps for establishing associations between tables are as follows:

1. Complete one table.
2. Fill out most of another table, leaving the fi eld you want to create a relationship with 

blank. Make sure the blank fi eld has the same format as the fi eld you’re creating the 
relationship with.

3. Navigate to the ‘Database tools’ tab.
4. Click the ‘Relationships’ button.
5. Drag the completed relationship fi eld to the blank fi eld and drop it.
6. Click ‘Create’ to create the relationship. A line connecting the two fi elds shows you have 

successfully created the relationship.
7. Check the ‘Enforce referential integrity’ box to automatically update one fi eld if the other 

gets updated.
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2.4 CREATE & MODIFY QUERIES:

A relational database’s true value resides in its capacity to execute queries rapidly and retrieve 
and analyse your data. You can use queries to retrieve data from one or more tables based on 
a defi ned set of search criteria. You will discover how to construct a straightforward one-table 
query in this lesson.

Figure 2.9. Query
2.4.1 WHAT ARE QUERIES?

Using queries, you can look up and compile information from one or more tables. A query is 
similar to posing a thorough inquiry to your database. To fi nd the precise data you need, you 
defi ne particular search criteria when creating a query in Access.

2.4.2 HOW ARE QUERIES USED?

Using queries to fi nd data within a database is much more effective than using straightforward 
searches or fi lters. This is so that queries can combine data from several tables. While you could, 
for instance, use a search in the customers database to locate the name of a single client of 
your company or a fi lter on the orders table to examine just orders made during the last week, 
neither would enable you to view both clients and orders simultaneously. To get the name and 
contact information of every consumer who has made a purchase in the last week, you may 
simply run a query. A well-designed query can give information you might not be able to fi nd out 
just by examining the data in your tables.

When you run a query, the results are presented to you in a table, but when you design one you 
use a different view. This is called Query Design view, and it lets you see how your query is put 
together.
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2.4.3 CREATE A SELECT QUERY:

Create a query to focus on specifi c data.
1. Select Create > Query Wizard.
2. Select Simple Query, and then OK.
3. Select the table that contains the fi eld, add the Available Fields you want to Selected 

Fields, and select Next.
4. Choose whether you want to open the query in Datasheet view or modify the query 

in Design view, and then select Finish.

2.4.4. CREATE A QUERY BY USING THE DESIGN VIEW:

To create a query within a database, you can use one of two methods. The fi rst method uses the 
Design view, where you can build new queries from scratch. The next topic explains the second 
method, which uses the Query Wizard. To display the Design view, go to the Create tab, and then 
in the Queries group, select Query Design, as the following screenshot depicts

Figure 2.10.The Query Design button on the Create tab

If you want to review data from a database table but have only certain fi elds from that table, you 
can build a basic select query. At its most fundamental level, a select query selects one or more 
fi elds from a table in the database.

Figure 2.11. Fields in a query

When you’re building a query, the questions you ask of the database are called criteria.
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Figure 2.12. Criteria in a query

Select source tables:

To begin creating a query, you fi rst select one or more database objects to use as the source 
of your query. For most queries, you’ll use existing database tables. The following screenshot 
depicts the list of tables that the Show Table dialog box makes available.

Figure 2.13. The Show Table dialog box

After you add the source tables, you’ll notice that the query editor displays them. The following 
screenshot depicts an empty query editor that references only a single table.

Figure 2.14. The query editor
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Select basic query fields:

You use the table in the pane following the query editor to build your questions for the database. 
Each query field in this table has a particular purpose for determining the results of your query. 
The following table describes what each query field can do in building your query.

Figure 2.15. The query field components

For example, you might create a query field that selects the CustomerID field from the 
tblCustomers table and sorts the IDs in descending order. The following screenshot depicts this 
query field.

Figure 2.16. A query field

Sort and display query fields:

You can add as many query fields as you need to build a comprehensive query. You can 
choose whether to sort each query field and whether to display it in the query results. By using a 
combination of these techniques, you can build sophisticated queries relatively quickly.
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Review your query results: 
When your query is ready, you can review the results by running your query. To run your query, go 
to the Design tab, and then in the Results group, select Run, as the following screenshot depicts.

Figure 2.17. The Run button on the Design tab

When you run the query, Access switches from the Design view to the Datasheet view. The 
Datasheet view displays the results of the query.

Example:
Assume that you want to anonymously list the postal code and state for each customer to find 
out where your customers live and plan for an expansion of the produce box program. You can 
build this query in the Design view by specifying two query fields, as the following table depicts.

Figure 2.18. A query that lists the state and postal code for each customer

After you finish building this query in the Design view, it resembles the following screenshot.

Figure 2.19. A query that returns the State and PostalCode fields from the tblCustomers
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After you run the query, the Datasheet view displays the query results, as the following screenshot 
depicts.

Figure 2.20. The Datasheet view

Create a simple query with Query Wizard:

You can use the Query Wizard to automatically create a query. When you use the Query Wizard, 
you have less control over the details of the query design at first, but the process is faster than 
manually creating a query. The Query Wizard might also help you avoid some common mistakes 
you might make when manually building queries.

Use the Query Wizard:

To open the Query Wizard, go to the Create tab, and then in the Queries group, select Query 
Wizard, as the following screenshot depicts.

Figure 2.21. The Query Wizard button on the Create tab

The New Query dialog box displays, offering four choices for you to start building your query, as 
the following screenshot depicts.
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Figure 2.22. The New Query dialog box

Use the Simple Query Wizard:

The Simple Query Wizard offers the easiest way to create a query that includes one or more 
fields from a single database table. To use this wizard, select Simple Query Wizard in the New 
Query dialog box. The Simple Query Wizard page displays and includes a list of the tables in the 
database. On this page, you select the table you want to include in your query. The following 
screenshot depicts selecting the tblCustomers table.

Figure 2.23. Selecting a table for your query

After you select a table, you can select one or more fields in the table to include in your query. 
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The following screenshot depicts selecting the CustomerID, FirstName, and LastName fields.

Figure 2.24.2 Selecting the CustomerID, FirstName, and LastName fields

In the final step of the wizard, you can change the title of your query and then select one of 
two choices: to open the query so you can review the results or to modify the query design. The 
following screenshot depicts this final step.

Figure 2.25. The final step of the Simple Query Wizard

Use the Find Duplicates Query Wizard:

You can use the Find Duplicates Query Wizard to find data that was incorrectly entered more 
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than once in your database. To use this wizard, select Find Duplicates Query Wizard in the New 
Query dialog box.

The Find Duplicates Query Wizard displays a list of the tables in the database. Select the table 
you want to include in your query. The following screenshot depicts selecting the tblCustomers 
table.

Figure 2.26. Selecting a table for your query

The next step in the Find Duplicates Query Wizard is to select the fields that you suspect contain 
duplicate information. The following screenshot depicts selecting the FirstName and LastName 
fields.

Figure 2.27. Selecting the FirstName and LastName fields
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The next step in the wizard asks if you want to display additional data in the query results. The 
fields you selected in the previous step will already automatically display in the query results. 
The following screenshot depicts selecting the CustomerID field.

Figure 2.28. Adding the CustomerID field to the query

As in the Simple Query Wizard, the final step of the Find Duplicates Query Wizard is to change the 
title of your query if you want and then select one of two choices: to open the query so you can 
review the results or to modify the query design, as the following screenshot depicts.

Figure 2.29. The final step of the Find Duplicates Query Wizard
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2.5 SQL COMMANDS:

SQL, or Structured Query Language, is the language you use to request data from a database. 
SQL is an English-like computer language that database programmes can understand. Behind 
the scenes, SQL is used for each query you execute.

Knowing how SQL operates can both help you write better queries and make it simpler for you to 
figure out how to improve a query that isn’t giving you the results you desire.

2.5.1 WHAT IS SQL?

A computer language called SQL is used to manipulate fact sets and the connections between 
them. SQL is the language used to manipulate data in relational database programmes like 
Microsoft Office Access. SQL is easier to read and grasp even for a beginner than many other 
computer languages. SQL is a recognised international standard by organisations like ISO and 
ANSI, like many other computer languages.

SQL is used to define data sets that can be used to provide answers to questions. The proper 
syntax must be used while using SQL. The collection of guidelines known as syntax ensures that 
a language’s constituent parts are combined correctly. Many of the components used in Visual 
Basic for Applications (VBA) syntax are also used in SQL syntax, which is based on English syntax.

For example, a simple SQL statement that retrieves a list of last names for contacts whose first 
name is Mary might resemble this:

SELECT Last_Name 
FROM Contacts 
WHERE First_Name = ‘Mary’;

2.5.2 SELECT STATEMENTS:

To describe a set of data by using SQL, you write a SELECT statement. A SELECT statement contains 
a complete description of a set of data that you want to obtain from a database. 

This includes the following:

• What tables contain the data.

• How data from different sources is related.

• Which fields or calculations will produce the data.

• Criteria that data must match to be included.

• Whether and how to sort the results.

604



MS ACCESS

2.5.3. SQL CLAUSES:

Like a sentence, a SQL statement has clauses. Each clause performs a function for the SQL 
statement. Some clauses are required in a SELECT statement. The following table lists the most 
common SQL clauses.

Figure 2.30. SQL Clauses

2.5.4. SQL TERMS:

Each SQL clause is composed of terms — comparable to parts of speech. The following table lists 
types of SQL terms.

Figure 2.31 SQL terms
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2.5.5. BASIC SQL CLAUSES: SELECT, FROM, AND WHERE:

A SQL statement takes the general form:
SELECT field_1 
FROM table_1 
WHERE criterion_1 
;

The following illustrates what a SQL statement for a simple select query might look like in Access:

Figure 2.33. Basic SQL clauses

1. SELECT clause

2. FROM clause

3. WHERE clause

This example SQL statement reads “Select the data that is stored in the fields named E-mail 
Address and Company from the table named Contacts, specifically those records in which the 
value of the field City is Seattle.”

Let’s look at the example, one clause at a time, to see how SQL syntax works.

The SELECT clause:

SELECT [E-mail Address], Company

This is the SELECT clause. It consists of an operator (SELECT) followed by two identifiers ([E-mail 
Address] and Company). If an identifier contains spaces or special characters (such as “E-mail 
Address”), it must be enclosed in square brackets. A SELECT clause does not have to say which 
tables contain the fields, and it cannot specify any conditions that must be met by the data to be 
included. The SELECT clause always appears in front of the FROM clause in a SELECT statement.
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The FROM clause:

FROM Contacts
This is the FROM clause. It consists of an operator (FROM) followed by an identifier (Contacts).A 
FROM clause does not list the fields to be selected.

The WHERE clause:

WHERE City=”Seattle”
This is the WHERE clause. It consists of an operator (WHERE) followed by an expression 
(City=”Seattle”). You can accomplish many of the actions that SQL enables you to do by using 
SELECT, FROM, and WHERE clauses.

Sorting the results: ORDER BY

Access offers the same ability to sort query results in a datasheet as Microsoft Excel. By using an 
ORDER BY clause in the query, you can also indicate how you want the results sorted after the 
query is executed. The ORDER BY clause is the final clause in the SQL statement, if one is used.The 
fields you wish to employ for sorting are listed in an ORDER BY clause in the same order that you 
want to perform the sort operations. 

For example, suppose that you want your results sorted first by the value of the field Company in 
descending order, and  — if there are records with the same value for Company — sorted next by 
the values in the field E-mail Address in ascending order. Your ORDER BY clause would resemble 
the following:
ORDER BY Company DESC, [E-mail Address]

Working with summarized data: GROUP BY and HAVING

Sometimes you need to work with summarised data, such as the total monthly sales or the priciest 
stock items. Applying an aggregate function to a field in your SELECT clause will accomplish this. 
As an illustration, your SELECT clause would look something like this if you want your query to 
display the number of email addresses listed for each business:
SELECT COUNT([E-mail Address]), Company

The aggregate functions that you can use depend on the type of data that is in the field or 
expression that you want to use.

Specifying fields that are not used in an aggregate function: The GROUP BY clause

The majority of the time, a GROUP BY clause must be created when using aggregate functions. 
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All the fields to which you don’t apply an aggregate function are listed in a GROUP BY clause. You 
don’t need to add the GROUP BY clause if you use aggregate functions on every field in a query.

The WHERE clause, or the FROM clause if there is no WHERE clause, is followed immediately by a 
GROUP BY clause. The fields are listed in the SELECT clause’s GROUP BY clause.

For example, continuing the previous example, if your SELECT clause applies an aggregate 
function to [E-mail Address] but not to Company, your GROUP BY clause would resemble the 
following:
GROUP BY Company

Limiting aggregate values by using group criteria: the HAVING clause

If you want to use criteria to limit your results, but the field that you want to apply criteria to 
is used in an aggregate function, you cannot use a WHERE clause. Instead, you use a HAVING 
clause. A HAVING clause works like a WHERE clause, but is used for aggregated data.

For example, suppose that you use the AVG function (which calculates an average value) with 
the first field in your SELECT clause:
SELECT COUNT([E-mail Address]), Company

If you want the query to restrict the results based on the value of that COUNT function, you 
cannot use a criteria for that field in the WHERE clause. Instead, you put the criteria in a HAVING 
clause. For example, if you only want the query to return rows if there are more than one e-mail 
addresses associated with the company, the HAVING clause might resemble the following:
HAVING COUNT([E-mail Address])>1

Combining query results: UNION

Use the UNION operator to examine all the data produced by a number of related select queries 
as a single, unified set.

You can combine two SELECT statements into one using the UNION operator. The output fields 
from the SELECT statements you combine must be the same number, in the same sequence, 
and include the same data types or ones that are compatible. Data from each set of related 
fields is combined into one output field during query execution, resulting in an output that has 
the same number of fields as the select statements.

When you use the UNION operator, you can also specify whether the query results should include 
duplicate rows, if any exist, by using the ALL key word.

608



MS ACCESS

The basic SQL syntax for a union query that combines two SELECT statements is as follows:
SELECT field_1 
FROM table_1 
UNION [ALL] 
SELECT field_a 
FROM table_a 
;

Consider having a table called Products and another table called Services, for instance. The 
product or service name, price, warranty or guarantee, and if you offer the good or service solely 
are all fields in both tables. The core information—whether a certain good or service comes with 
a quality guarantee—is the same whether it is stored in the Products table for products or the 
Services table for services. The four fields from the two tables can be combined using a union 
query, like the one shown below:

SELECT name, price, warranty_available, exclusive_offer 
FROM Products 
UNION ALL 
SELECT name, price, guarantee_available, exclusive_offer 
FROM Services;

SUMMARY:

CREATING A TABLE IN ACCESS:

You can create a table in Access in various ways:

Add a Table: Use the Create tab to add a new table to an existing database.

Datasheet View: Enter data directly in Datasheet view, and Access will create the table structure 
for you.

New Database: Create a new blank database, and a blank table is automatically included.
Existing Database: Open an existing database, click Table on the Create tab to add a new table.

Adding Data to a Table:

• Name the columns (fields) to identify them easily.
• Fill in rows with relevant data.
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• You can copy data from another source, but ensure data types match and rename 
fields if necessary.

Importing Data:

• Use the External Data tab to import data from various sources, like Excel or text files.
• Follow the wizard to specify the source and mapping.

Table and Field Properties:

• Table properties affect table behavior, set in Design view.
• Field properties define attributes of specific fields, adjusted in Datasheet view or Design 

view.

Table Relationships:

• Tables in a relational database are often connected.
• Relationships link data between tables, ensuring data integrity.
• Primary keys uniquely identify records in a table, while foreign keys link to primary keys 

in other tables.

Creating and Modifying Queries:

• Queries retrieve and analyze data from one or more tables based on specified criteria.
• You can create queries using the Query Wizard or Design view, selecting tables, fields, 

and criteria.
• Sort results using ORDER BY, aggregate data with GROUP BY and HAVING clauses, and 

combine results with UNION.

SQL Commands:

• SQL (Structured Query Language) is used to request data from a database.
• SQL consists of SELECT, FROM, and WHERE clauses, which specify data sources, fields, 

and criteria.
• Use GROUP BY and HAVING for summarized data and UNION to combine query results.
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MULTIPLE CHOICE QUESTIONS (MCQ) FOR PRACTICE

1. What is the purpose of a database table in Access?
a) To store queries
b) To store forms
c) To store data
d) To store reports

2. How can you add a new table to an existing database in Access?
a) Use the Create tab in the Queries group
b) Use the Create tab in the Tables group
c) Use the Design View tab in the Tables group
d) Use the Add Table tab in the Database Tools group

3. In Datasheet view, how are field names assigned when creating a table?
a) Manually by the user
b) Automatically based on the data entered
c) Numerically (e.g., Field1, Field2)
d) Randomly generated names

4. How can you rename a column (field) in Access?
a) Right-click the column and select Rename
b) Select the column heading and press F2
c) Double-click the column heading and enter a new name
d) All of the above

5. What is the first step to create a new table in a new database?
a) Click File > Open
b) Click File > New and select Blank desktop database
c) Click the Tables group in the Create tab
d) Click the Tables tab in the Design View

6. How can you add data to a table in Access?
a) By importing data only
b) By manually entering data only
c) By using forms only
d) By using both importing and manually entering data
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7. When pasting data into an empty table in Access, how does Access determine the data 
type of each field?

a) It sets all fields to Text data type
b) It uses the Date/Time data type for all fields
c) It assigns data types based on the data being pasted
d) It prompts the user to select data types

8. How can you establish a relationship between tables in Access?
a) By adding a foreign key to one table
b) By using the Join command in a query
c) By creating a primary key in one table that matches a foreign key in another
d) By sorting the tables in alphabetical order

9. What is a primary key in a database table?
a) A field with unique values that identifies each record
b) A field with the most important data
c) A field that is used for sorting records
d) A field with duplicate values

10. What is a foreign key in a database table?
a) A field with unique values that identifies each record
b) A field with duplicate values
c) A field that links to another table’s primary key
d) A field that stores hyperlinks

11. What does the SQL “SELECT” statement do in a query?
a) Adds a new record to the table
b) Updates an existing record
c) Retrieves data from one or more tables
d) Deletes records from the table

12. Which SQL clause is used to specify the source tables for a query?
a) SELECT
b) FROM
c) WHERE
d) GROUP BY
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13. Which SQL clause is used to filter data in a query based on specific criteria?
a) SELECT
b) FROM
c) WHERE
d) GROUP BY

14. How can you sort the results of a query in SQL?
a) Use the GROUP BY clause
b) Use the ORDER BY clause
c) Use the HAVING clause
d) Use the SELECT clause

15. When do you use the HAVING clause in SQL?
a) To filter data before aggregation
b) To specify the source tables for a query
c) To sort the query results
d) To filter aggregated data

Answers:

1. c. To store data
2. b. Use the Create tab in the Tables group
3. c. Numerically (e.g., Field1, Field2)
4. d. All of the above
5. b. Click File > New and select Blank desktop database
6. d. By using both importing and manually entering data
7. c. It assigns data types based on the data being pasted
8. c. By creating a primary key in one table that matches a foreign key in another
9. A field with unique values that identifies each record
10. A field that links to another table’s primary key
11. Retrieves data from one or more tables
12. b. FROM
13. c. WHERE
14. b. Use the ORDER BY clause
15. d. To filter aggregated data
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SELF-EXAMINATION QUESTIONS FOR PRACTICE:

1. What is the purpose of a database in Access, and why might it contain multiple 
tables?

2. How can you create a new table in an existing database in Access?

3. Explain the steps to add data to a table in Access, and why is it important to give 
meaningful names to columns?

4. What are some methods for copying data from another source into an Access table?

5. How do you establish relationships between tables in Access, and why is this 
important in a relational database?

6. What is a primary key, and why is it essential in a database table?

7. Differentiate between a primary key and a foreign key in Access.

8. Describe the purpose of SQL commands in Access, and provide an example of a 
simple SQL SELECT statement.

9. How can you sort the results of a query in Access using SQL?

10. Explain the role of the GROUP BY and HAVING clauses in SQL when working with 
aggregated data in Access.
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CHAPTER 3
INTEGRATING MS ACCESS WITH MS OUTLOOK,  
MS WORD, MS EXCEL:

LEARNING OBJECTIVE

By the end of this module, you will master the integration of Microsoft Access with Microsoft 
Outlook, gaining the ability to:

a	 Export Data to Outlook: Export Access data to Outlook in various formats.

a	 Link Access Tables: Create linked tables to access Outlook data seamlessly.

a	 Send Email from Access: Automate email sending via VBA code.

a	 Calendar Integration: Manage Outlook calendars from within Access.

3.1. INTEGRATING MS ACCESS WITH MS OUTLOOK

Integrating Microsoft Access with Microsoft Outlook can be a useful way to streamline data 
management and communication within your organization. Here are some common ways to 
integrate the two applications:

3.1.1. EXPORTING DATA TO OUTLOOK:

You can export data from your Access database to Outlook in various formats, such as CSV or 
Excel, and then import it into Outlook.

To do this, open your Access database, select the data you want to export, go to the “External 
Data” tab, and choose the export format. You can then follow the wizard to export the data to a 
file.

After exporting, you can import this file into Outlook by going to the “File” tab in Outlook, selecting 
“Open & Export,” and then choosing “Import/Export.” Follow the import wizard to bring the data 
into your Outlook contacts, calendar, or other items.
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3.1.2. LINKING ACCESS TABLES:

• You can create linked tables in Access that connect to Outlook data, such as your Outlook 
contacts or calendar.

• To link a table, open your Access database, go to the “External Data” tab, and select “More” 
in the “Import & Link” group. Choose “Outlook Folder” and follow the wizard to select the 
Outlook folder you want to link.

• Once linked, you can use Access to query and manipulate the Outlook data as if it were 
a regular Access table.

3.1.3. SENDING EMAIL FROM ACCESS:

• You can automate the process of sending emails from Access by using VBA (Visual Basic 
for Applications) code.

• In Access, you can create a form or a report with a button that triggers an email to be 
sent through Outlook.

• You’ll need to write VBA code to open Outlook, create a new email, and populate the 
email fields (recipient, subject, body, attachments) with the desired information.

3.1.4. CALENDAR INTEGRATION:

• You can also integrate Access with Outlook calendars to manage appointments and 
events.

• Use the Outlook Calendar API or VBA to create, update, or delete calendar events from 
within Access.

3.2 INTEGRATING MS ACCESS WITH MS WORD

• Integrating Microsoft Access with Microsoft Word can be beneficial for creating customized 
documents based on data stored in your Access database. Here are some common 
ways to integrate the two applications:

3.2.1 MAIL MERGE:

• One of the most common ways to integrate Access and Word is by using the Mail Merge 
feature in Word. You can use Access as the data source for your Word documents.

• Open Microsoft Word and create a new document.

• In the Word document, go to the “Mailings” tab and select “Start Mail Merge.”
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• Choose the type of document you want to create (e.g., letters, labels, envelopes).

• Select “Select Recipients” and choose “Use an Existing List.” Browse to your Access 
database and select the table or query containing the data.

• Insert merge fields into your Word document where you want the data to appear.

• Complete the merge, and Word will generate individual documents with data from your 
Access database.

3.2.2. EMBEDDING ACCESS DATA:

• You can embed Access data directly into a Word document. This is useful for creating 
reports or documents that include tables or charts based on Access data.

• In Word, go to the “Insert” tab and select “Object” or “Table.” Choose to insert an “Object.”

• In the “Object” dialog, select “Microsoft Office Access Database” and choose the Access 
database file.

• You can then select specific tables, queries, or forms to embed in the document.

• Word will display the Access data in your document, and you can format it as needed.

3.2.3. VBA (VISUAL BASIC FOR APPLICATIONS):

• To create more complex integrations, you can use VBA to automate interactions between 
Access and Word.

• Write VBA code in Access that opens Word, creates a new document, and populates it 
with data from the database.

• You can also automate the creation of reports or documents based on specific criteria.

3.3.  INTEGRATING MS ACCESS WITH MS EXCEL

• Integrating Microsoft Access with Microsoft Excel can be useful for sharing and analyzing 
data between the two applications. Here are some common ways to integrate the two:

3.3.1.  IMPORT AND EXPORT DATA:

• One of the simplest ways to integrate Access and Excel is by importing and exporting 
data.

• To export data from Access to Excel, open your Access database, select the table or 
query you want to export, go to the “External Data” tab, and choose “Excel” as the export 
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format. Follow the wizard to export the data.

• To import data from Excel to Access, you can use a similar process. Open Access, go to 
the “External Data” tab, choose “Excel,” and follow the wizard to select the Excel file and 
import the data into a new or existing table.

3.3.2. LINKING TABLES:

• You can link Excel tables in Access, which allows you to work with Excel data in Access 
without physically importing it.

• In Access, go to the “External Data” tab, choose “Excel” as the data source, and select 
the Excel file. Follow the wizard to link the Excel table.

• Linked tables can be used in queries, forms, and reports in Access, enabling you to 
combine data from both sources.

3.3.3. AUTOMATION WITH VBA:

• You can use VBA (Visual Basic for Applications) to automate the transfer of data 
between Access and Excel.

• Write VBA code in Access to open an Excel workbook, copy data from Access, and paste 
it into Excel or vice versa.

• You can also automate data transformations, calculations, and reporting using VBA.

3.3.4. EXCEL AS A REPORTING TOOL:

• Excel can be used as a reporting tool for Access data. You can design pivot tables, 
charts, and reports in Excel that update dynamically when Access data changes.

 

SUMMARY:

Integrating MS Access with MS Outlook:

• Export Data: Transfer Access data to Outlook for contacts and calendars.

• Link Tables: Create linked tables for seamless data interaction.

• Automate Emails: Use VBA to automate email sending from Access.

• Calendar Management: Integrate Access with Outlook calendars.
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`Integrating MS Access with MS Word:

• Mail Merge: Use Access as a data source for customized Word documents.

• Embed Data: Embed Access data directly into Word documents.

• VBA Automation: Develop VBA code for complex integrations.

Integrating MS Access with MS Excel:

• Import/Export Data: Easily move data between Access and Excel.

• Linked Tables: Work with Excel data in Access without importing.

• VBA Automation: Automate data transfers and calculations.

• Excel Reporting: Create dynamic Excel reports based on Access data.

MULTIPLE CHOICE QUESTIONS (MCQ) FOR PRACTICE

1. How can you export data from Microsoft Access to Microsoft Outlook?
a) Copy and paste the data
b) Use the “Export” option in Access
c) Use VBA to send data
d) There is no way to export data from Access to Outlook

2. Which format can you use to export data from Access to Outlook?
a) PDF
b) CSV
c) HTML
d) All of the above

3.  What is VBA in the context of integrating Access with Outlook?
a) Visual Business Application
b) Virtual Basic for Access
c) Visual Basic for Applications
d) Very Basic Automation
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4.  How can you link Access tables to Outlook data?
a) Through the Access “Link Tables” feature
b) By copying and pasting data
c) By importing a CSV file
d) This is not possible

5. Which of the following can you automate using VBA when integrating Access with 
Outlook?

a) Sending emails
b) Creating new Outlook folders
c) Importing data from Excel
d) All of the above

6.  What can you achieve by integrating Access with Outlook calendars?
a) Automatically importing Excel files
b) Managing appointments and events
c) Exporting data to PDF
d) Embedding Access forms in Word documents

7.  What is a common method for integrating Microsoft Access with Microsoft Word for 
document creation?

a) Using Excel as an intermediary
b) Sending data via email
c) Utilizing the Mail Merge feature in Word
d) Manually copying and pasting data

8.  What is the primary purpose of the Mail Merge feature when integrating Access and 
Word?

a) To send emails from Access
b) To create customized documents using Access data
c) To import Excel files into Access
d) To link Access tables with Word documents

9.  How can you embed Access data into a Word document?
a) By exporting data to Excel first
b) By using the “Insert” tab in Word
c) By linking Access tables in Word
d) By converting Access data to text files
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10.  What role does VBA play in integrating Access with Word?
a) Automating data exports to PDF
b) Creating complex database structures
c) Automating interactions and document population
d) Linking Access forms to Excel workbooks

11.  What is a common method for integrating Microsoft Access with Microsoft Excel for data 
sharing and analysis?

a) Exporting data to CSV
b) Creating custom charts in Access
c) Using Access as a pivot table tool
d) Importing and exporting data

12.  What is the advantage of linking Excel tables in Access compared to importing Excel 
data?

a) Linked tables are read-only
b) Linked tables are stored within Access
c) Linked tables allow real-time updates from Excel
d) Linked tables require manual updates

13. How can you automate data transfer between Access and Excel?
a) By manually copying and pasting data
b) By using VBA to automate the process
c) By converting Access tables to PDF
d) By importing/exporting data as CSV files

14. What can Excel be used for when integrated with Access data?
a) Real-time data updates
b) Creating pivot tables and charts
c) Sending emails from Access
d) Linking Access forms to Outlook

15. Which of the following is NOT a method of integrating Access with Excel?
a) Importing and exporting data
b) Using VBA for data transfer
c) Creating linked tables
d) Embedding Access forms in Excel
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ANSWERS:
1. B) Use the “Export” option in Access

2. B) CSV

3. C) Visual Basic for Applications

4. Through the Access “Link Tables” feature

5. Sending emails

6. Managing appointments and events

7. Utilizing the Mail Merge feature in Word

8. To create customized documents using Access data

9. By using the “Insert” tab in Word

10. Automating interactions and document population

11. Importing and exporting data

12. Linked tables allow real-time updates from Excel

13. B) By using VBA to automate the process

14. B) Creating pivot tables and charts

15. D) Embedding Access forms in Excel

SELF-EXAMINATION QUESTIONS FOR PRACTICE

1. How can you export data from Microsoft Access to Microsoft Outlook, and what are the 
supported export formats?

2. Describe the process of linking Access tables to Outlook data. What benefits does this 
provide?

3. What is VBA, and how can it be used to automate the process of sending emails from 
Access via Outlook?

4. How can you integrate Access with Outlook calendars, and what are the potential 
applications of this integration?

5. In what scenarios would you choose to integrate Microsoft Access with Microsoft Word, 
and what are the benefits of doing so?
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6. Explain the steps involved in using Mail Merge in Word with Access as the data source. 
What types of documents can you create using this method?

7. What is the purpose of embedding Access data directly into a Word document? How 
can this be accomplished?

8. How can VBA be utilized to create more complex integrations between Access and 
Word, and what are some examples of such integrations?

9. Why might you want to integrate Microsoft Access with Microsoft Excel, and what are 
some common methods for doing so?

10. What is the advantage of linking Excel tables in Access, and how does this differ from 
importing Excel data into Access?
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CHAPTER 4
MODIFY FORMS IN LAYOUT VIEW:

LEARNING OBJECTIVE:

a	 Effectively add titles and logos to Access forms.

a	 Differentiate Layout and Design views.

a	 Utilize Title and Logo options.

a	 Adjust logos and understand form view limitations.

a	 Understand title/logo importance.

a	 Use Title and Logo tools.

a	 Add, resize logos.

a	 Recognize form view limits.

4.1. ADD A TITLE TO A FORM:

You can add a title to a form in Layout view or Design view by using the Title option on the Design 
tab within the Form Design Tools or Form Layout Tools tab. Adding a title will add a Form Header 
if the form doesn’t have one already. If there is a title already, the Title option will select the text 
in the title and allow you to edit it.

The title is really a label control that is added to the form header in a layout. The layout has two 
columns: the first column contains an empty cell for an image or logo, and the second column 
contains the title label.

Note that you can add a title to any form, including a datasheet form. However, form headers 
and footers are not available when the form is in Datasheet view.

To add a title: 

1. In the Layout view of the form, go to the Design tab within the Form Layout Tools tab, and then 
in the Header/Footer group, select Title. Alternatively, in the Design view of the form, go to the 
Design tab within the Form Design Tools tab, and then in the Header/Footer group, select Title. 
The following screenshot highlights the Design tab within the Form Layout Tools tab and the Title 
option in the Header/Footer group.
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Figure 4.1. The Title option on the Design tab in the ribbon

2. Enter the title text and then select Enter.

4.1.1. ADD A LOGO TO A FORM HEADER:

You can add a logo to a form in Layout view or Design view by using the Logo option on the 
Design tab within the Form Design Tools or Form Layout Tools tab. Adding a logo in this way will 
add a Form Header to the form if the form doesn’t have one already. The logo is added to the 
form header in a layout. The layout has two columns: the first column contains the logo, and the 
second column contains a label in which you can add a title.

Note that you can add a logo to any form, including a datasheet form. However, form headers 
and footers are not available when the form is in Datasheet view.

To add a logo: 

1. Open a form in Design view. 

2. In the Layout view of the form, go to the Design tab within the Form Layout Tools tab, 
and then in the Header/Footer group, select Logo. Alternatively, in the Design view 
of the form, go to the Design tab within the Form Design Tools tab, and then in the 
Header/Footer group, select Logo. The following screenshot highlights the Design tab 
within the Form Layout Tools tab and the Logo option in the Header/Footer group.

Figure 4.2. The Logo option on the Design tab
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3. Browse to the picture you want to use, select it, and then select Open. 

4. Optionally, resize the picture by changing the Width and Height values in the Property 
Sheet pane or by resizing the layout with your cursor.

5. Optionally, select Title to add a title to the same layout.

Figure 4.3. Resizing the layout for a logo image and title

SUMMARY:

To enhance the appearance of forms in Microsoft Access in either Layout view or Design 
view, you can add titles and logos to form headers using the Form Design Tools or Form 
Layout Tools tab.

Adding a Title to a Form:

• Go to the Design tab in Form Layout or Form Design Tools.

• In the Header/Footer group, choose “Title.”

• Enter your title text and press Enter.

Adding a Logo to a Form Header:

• Open the form in Design view.

• In Form Layout or Form Design Tools, go to the Design tab.

• In the Header/Footer group, select “Logo.”

• Pick your image and click “Open.”

• Optionally, adjust the image size in the Property Sheet or resize the layout.

• Optionally, add a title to the same layout by selecting “Title.”
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Multiple Choice Questions (MCQ) for Practice:

1. What is the primary purpose of adding a title to an Access form?

a) To add a decorative element

b) To provide a description of the form’s purpose

c) To create a header for every record

d) To format the form background

2. In which views can you add or edit a title in Microsoft Access?

a) Only in Layout view

b) Only in Design view

c) Both in Layout and Design views

d) Only in Datasheet view

3. Where can you find the Title option for adding or editing a title in Access?

a) In the Format tab

b) In the Home tab

c) In the Design tab within Form Design Tools

d) In the Data tab

4. How can you edit an existing title in an Access form?

a) Right-click and select “Edit Title”

b) Double-click on the title text

c) Select the title, then press the Delete key

d) You cannot edit existing titles.

5. What is the primary function of a title added to an Access form?

a) To display a company logo

b) To provide a description of the form’s purpose

c) To sort data in the form

d) To create a footer for every record

6. How can you access the Logo option for adding a logo to an Access form in Design view?

a) By right-clicking on the form background
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b) By selecting “Insert Logo” from the Format menu

c) In the Design tab within Form Design Tools

d) In the Layout tab within Form Layout Tools

7. What typically appears in the first column of the layout when a logo is added to an Access 
form?

a) The form title

b) An empty cell for an image or logo

c) The form footer

d) The form record data

8. In which form view are form headers and footers not available when adding a logo?

a) Only in Layout view

b) Only in Design view

c) Both in Layout and Design views

d) Only in Datasheet view

9. Why might you want to resize a logo added to an Access form?

a) To distort the image

b) To fit it within the form header

c) To change its color

d) To remove it from the form

10. Which tab should you select to add a logo to an Access form in Layout view?

a) Format tab

b) Design tab within Form Design Tools

c) Layout tab within Form Layout Tools

d) Home tab

11. When adding a title to an Access form, what is the primary benefit it provides to users?

a) Enhancing form aesthetics

b) Increasing data storage capacity

c) Improving data validation

d) Adding extra rows to the form
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12. In Access, if there is already a title on a form, what does selecting the Title option allow 
you to do?

a) Delete the title

b) Change the font style

c) Select and edit the existing title text

d) Add a second title to the form

13. What is the main purpose of adding a logo to an Access form?

A) To add visual flair to the form

B) To resize the form

C) To create a second header

D) To change the form’s color scheme

14. In Access, which view allows you to browse for and select an image file when adding a 
logo to a form?

a) Form view

b) Datasheet view

c) Layout view

d) Design view

15. What options are typically available for resizing a logo added to an Access form?

a) Width and Height values

b) Color and background options

c) Font style and size

d) Sorting and filtering settings

ANSWERS:

1. B) To provide a description of the form’s purpose

2. C) Both in Layout and Design views

3. C) In the Design tab within Form Design Tools

4. B) Double-click on the title text

5. B) To provide a description of the form’s purpose

6. C) In the Design tab within Form Design Tools
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7. B) An empty cell for an image or logo

8. D) Only in Datasheet view

9. B) To fit it within the form header

10. C) Layout tab within Form Layout Tools

11. A) Enhancing form aesthetics

12. C) Select and edit the existing title text

13. A) To add visual flair to the form

14. C) Layout view

15. A) Width and Height values

     SELF-EXAMINATION QUESTIONS FOR PRACTICE:

1. Why is adding a title to an Access form important, and what is its purpose?

2. In which two views can you add a title to an Access form?

3. How do you access the Title option for adding or editing a form title in Microsoft 
Access?

4. Explain the procedure for editing an existing title in an Access form.

5. What is the primary function of a title in Access forms?

6. Describe the steps to add a logo to an Access form in Layout view.

7. How can you access the Logo option for adding a logo to an Access form in Design 
view?

8. What are the two columns typically found in the layout when a logo is added to an 
Access form?

9. Why might you want to resize a logo added to an Access form, and how can you do 
it?

10. In which form view are form headers and footers not available, and why is this 
important to consider when adding logos?
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CHAPTER 5
MODIFY REPORTS IN LAYOUT VIEW:

LEARNING OBJECTIVE:

By the end of this training module, you will be proficient in using Microsoft Access’s Layout View 
to enhance reports. They will understand how to:

a	 Navigate Layout View: Learn the benefits of Layout View in Access, which closely resembles 
the printed report and is suitable for various modifications.

a	 Modify Reports: Learn to switch between Layout and Design Views, adjust column/field 
widths, change row/field heights, and add new fields for improved report readability.

5.1  INTRODUCTION:

You can organize and summaries data in reports in a variety of ways. Layout view and Design 
view are two views that Access offers you for editing your report. Which view you choose will 
depend on the exact activity you’re attempting to do. However, you can utilize Layout View or 
Report View to assist with data locating after creating a report. For instance, you can quickly 
sort field data one at a time using Layout View, or you can use the Group, Sort, and Total pane 
to carry out more complicated sorts. Additionally, you can filter data in Layout View so that you 
only see the records that match the criteria you choose.

5.2 UNDERSTAND LAYOUT VIEW:

The easiest view to utilize for report modification is layout view, which can be used for almost 
all modifications you could wish to make to a report in Access. The report is actually running 
in Layout view, allowing you to see your data almost exactly as it will on paper. But in this view, 
you can also alter the report’s layout. It’s a very helpful view for altering column widths, adding 
grouping levels, or carrying out nearly any other action that impacts the layout and readability 
of the report because you can see the data while you are making the modifications. An example 
of a customer phone book report in layout view is shown in the example below.
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Figure 5.1. Report in Layout view

The report you see in Layout view does not look not exactly the same as the printed report. For 
example, there are no page breaks in Layout view. Also, if you have used Page Setup for format 
your report with columns, the columns are not displayed in Layout view. However, Layout view 
gives you a very close approximation of the printed report. If you want to see how the report will 
look when printed, use Print Preview.

Certain tasks cannot be performed in Layout view, and require you to switch to Design view. In 
certain situations, Access will display a message telling you that you must switch to Design view 
to make a particular change.

5.3 MODIFY REPORT ELEMENTS AND POSITIONING:

When creating reports, you also need to consider the report’s design layout and common report 
modifications that you can perform in Layout view. You can use the following steps to modify 
some report design elements for an existing report. 

1. On the Home tab, in the Views group, select View, and then select Design View. 

2. When the edit grids appear, to modify a column or field in Layout view: 

a. Select an item in a column that you want to adjust. A border appears around the item 
to indicate that the field is selected. 

b. Drag the right or left edge of the border until the column is the width you want. 
Alternatively, you can adjust report property values in the Property Sheet pane. To 
open the Property Sheet pane, on the Design tab, in the Tools group, select Property 
Sheet. You can also open the Property Sheet pane by selecting Fn+F4. Make edits 
to the report properties by adjusting the property values for the selected item, as 
depicted in the following screenshot:
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Figure 5.2. Property Sheet pane for a report

You can also select the Report drop-down list in the Property Sheet pane and then choose the 
option you want to modify, as depicted in the following screenshot.

Make the required modifications, and then save your report.
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Figure 5.3. Modifying a report option in the Property Sheet pane

5.4 CHANGE COLUMN OR FIELD WIDTH IN LAYOUT VIEW:

• Click an item in the column that you want to adjust.
     A border is drawn around the item to indicate that the field is selected.
• Drag the right or left edge of the border until the column is the width you want.

5.5 CHANGE ROW OR FIELD HEIGHT IN LAYOUT VIEW:

• Click an item in the row that you want to adjust.
   A border is drawn around the item to indicate that the field is selected.

• Drag the top or bottom edge of the border until the row is the height you want.
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5.6 ADD A FIELD IN LAYOUT VIEW:

• On the Design tab, in the Tools group, click Add Existing Fields. 
The list of available fields is displayed. If there are fields available in other tables, these 
will be displayed under Fields available in other tables.

• Drag a field from the Field List onto the report. As you move the field, a highlighted area 
will indicate where the field will be placed when you release the mouse button.

        

SUMMARY:

Access offers two report editing views: Layout View and Design View.

• Layout View is ideal for organizing data, sorting, filtering, and basic design changes.

• Design View is for more complex tasks.

• In Layout View, you can adjust column and row widths, add fields, and use the  
Property Sheet pane for fine-tuning.

• Layout View provides a close approximation of the printed report’s appearance.

• For complex changes, you may need to switch to Design View.

MULTIPLE CHOICE QUESTIONS (MCQ) FOR PRACTICE

1. What are the two primary views for editing reports in Microsoft Access?
a) Design View and Table View
b) Layout View and Print View
c) Design View and Layout View
d) Design View and Datasheet View

2. In which view can you see your report data almost exactly as it will appear on paper while 
still being able to make layout modifications?

a) Print View
b) Datasheet View
c) Design View
d) Layout View
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3. What is the purpose of the Group, Sort, and Total pane in Layout View?

a) To change font styles in the report
b) To filter data in the report
c) To carry out complex sorts and groupings
d) To switch between Design and Layout Views

4. Which view gives you a very close approximation of the printed report in Microsoft 
Access?

a) Print Preview
b) Datasheet View
c) Design View
d) Layout View

5. When might Access prompt you to switch from Layout View to Design View when editing a 
report?

a) When adding a new field
b) When adjusting column widths
c) When applying formatting styles
d) When saving the report

6. To modify the width of a column or field in Layout View, what action should you take?

a) Double-click the column
b) Right-click and select “Edit Width”
c) Click and drag the border of the column
d) Use the “Resize Column” button

7. Which of the following is not displayed in Layout View compared to the printed report?

a) Page breaks
b) Column headers
c) Page numbers
d) Formatting styles

8. How can you change the height of a row or field in Layout View?

a) Use the “Adjust Row Height” button
b) Double-click the row
c) Click and drag the top or bottom border of the row
d) Right-click and select “Resize Row”
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9. Which tab and group in Access do you need to select to open the Property Sheet pane for 
report modifications?

a) Design tab, Design group
b) Layout tab, Format group
c) Tools tab, Property Sheet group
d) Home tab, Views group

10. How can you add a new field to a report while in Layout View?
a) Use the “Insert Field” command
b) Right-click and select “Add Field”
c) Open the Property Sheet pane and choose “Add Field”
d) Drag a field from the Field List onto the report

11. Which view in Microsoft Access allows you to see exactly how your report will appear 
when printed, including page breaks and formatting?

a) Design View
b) Print View
c) Layout View
d) Datasheet View

12. In Layout View, how can you adjust the height of a row or field?
a) Right-click and select “Row Height.”
b) Use the “Resize Row” button.
c) Double-click the row.
d) Click and drag the left or right border of the row.

13. What is the main advantage of using Layout View when making modifications to a report 
layout?

a) It allows you to apply formatting styles easily.
b) It provides an exact preview of the printed report.
c) It enables you to add new fields directly.
d) It offers advanced filtering options.

14. In Microsoft Access, when adding a new field in Layout View, where can you find the list of 
available fields to choose from?

a) In the Field List pane
b) In the Group, Sort, and Total pane
c) In the Property Sheet pane
d) In the Navigation Pane
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15. Which view allows you to make advanced report design modifications, such as adding 
calculated fields or customizing the report’s structure?

a) Print View
b) Layout View
c) Design View
d) Datasheet View

Answers:

1. c. Design View and Layout View

2. d. Layout View

3. c. To carry out complex sorts and groupings

4. d. Layout View

5. a. When adding a new field

6. c. Click and drag the border of the column

7. a. Page breaks

8. c. Click and drag the top or bottom border of the row

9. c. Tools tab, Property Sheet group

10. d. Drag a field from the Field List onto the report

11. b. Print View

12. a. Right-click and select “Row Height.”

13. b. It provides an exact preview of the printed report.

14. a. In the Field List pane

15. c. Design View
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       SELF-EXAMINATION QUESTIONS FOR PRACTICE:

1. What are the two primary views for editing reports in Microsoft Access?

2. When should you use Layout View, and when should you use Design View for report
editing?

3. How can Layout View assist you in sorting field data in a report?

4. What is the purpose of the Group, Sort, and Total pane in Layout View?

5. In Layout View, how can you filter data to display only the records that match specific
criteria?

6. What are some common modifications you can make to a report in Layout View?

7. Why does the report in Layout View not look exactly the same as the printed report?

8. When might you need to switch from Layout View to Design View when editing a
report?

9. What steps can you follow to modify the width of a column or field in Layout View?

10. How can you add a new field to a report while in Layout View, and what is the process
for doing so?

639



MS ACCESS

TASK STATEMENT KNOWLEDGE STATEMENT 

Create database , put data and make 
relationship 

Students must understand the data , data 
warehouse, data mining 

Create different types of query to made 
your database interactive 

Must learn and understand query design and 
SQL command  

Formulate reports and design forms Must be apply to visual based coding in 
interactive mode 

Compose a visual based coding 
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